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The Importance of Inventory Control 

Inventory levels and open orders play the major role in determining what must be produced, purchased 
and inventoried. The material resource planning (MRP) engine built into EnterpriseIQ analyzes both the 
demand (open orders) and the supply (inventory and purchase orders) then builds work orders that meet 
the demand. Therefore, it is absolutely imperative that inventory levels are kept as accurate as possible. 

How is Inventory Maintained? 

Inventories are affected by many functions within EnterpriseIQ. The following list identifies the key 
activities which impact inventories. 

▪ Production Reporting or Floor Dispositions - As product is produced from work centers it is 
dispositioned, finished goods and raw material locations will be impacted, based on how the Bill of 
Manufacture (BOM) was set up. 

▪ Shipping - Finished goods are removed from inventory when a packing slip is created. 

▪ Transfers (Location to Location) - Because multiple locations are supported, the system must track 
any movement of the product from one physical location to another. Location transfers are 
commonly used in raw materials to account for material movements from a warehouse location to a 
work center, or from the work center back to the warehouse. 

▪ Manual transactions - These are typically used to make adjustments once the system is on line. 
Manual transactions are also used to return items to various locations if any adjustment to a count 
was made. 

Multi-Location Support 

EnterpriseIQ supports unlimited locations per inventory item. Using multiple locations, EnterpriseIQ can 
support lot number traceability, unique costing per location, and non-conforming or non-allocatable 
locations. 

Transaction Based 

In EnterpriseIQ, on-hand inventory amounts cannot be edited directly. All activity against inventory is 
entered as a transaction. EnterpriseIQ supports various types of transactions including adding, 
subtracting, adjusting, scrapping and location-to-location transfers. Please see the Transactions section 
for a full discussion of transactions in EnterpriseIQ. 

Traceability and Accountability-The Trans Log 

For the purpose of accountability, every transaction made in EnterpriseIQ is registered in the Translog 
table. This log contains information concerning the nature of the transaction, the amount involved, who, 
what, where and when the activity took place, if it was part of a particular job, and its actual and 
standard cost at that moment. A complete history of transactions against any single item is maintained 
and remains with the item until the file is purged. 

Inventory Numbering Schemes 
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Prior to entry of any inventory items, a coding mechanism should be devised to logically organize the 
materials. It is important to develop a workable part numbering scheme prior to entering information to 
eliminate the need to change the system later. The following section outlines a method which has been 
used, and is provided here only as an example. 

Each inventory item must contain at least four pieces of information - Class, Item Number, Revision Level 
and Description. The combination of Class, Item Number, and Revision Level and EPlant are what make 
an inventory item unique in EnterpriseIQ. For example, two inventory items with the same item number 
and revision level may exist in inventory as long as the class of the two items is different. 

Note: In many cases, items will not have a revision level. EnterpriseIQ will automatically add a space 
inside the field when an inventory item is created. This allows the system to use the field as part of the 
unique combination above. When assigning a revision to an item, be sure to backspace and enter the 
revision in the first space. 

Raw Material Inventory Number 

When assigning inventory numbers to raw material inventory items, one method that has proven to be 
effective is to define a basic material identification code such as ABS#Color. This will allow the grouping 
of various materials together for display on the pick lists. 

Examples: 

Part Number Description 

ABSFR0001 ABS, Flame Retardant 

SS21 Silicone Substrate 

NYLGP0248RD General Purpose Nylon, with Red Color added 

BSCR10MM Brass Screw, 10 mm 

Note: As stated earlier, the method described is only a suggestion. The only requirement that 
EnterpriseIQ imposes is that each item have a unique identifier. 

Note: When a user creates a User Defined Form field and grants security to that UDF field, if the UDF field 
is deleted the security to the field is removed. If the UDF field is re-added with the same name, security 
will need to be reestablished for users. 
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Inventory Classes 

EnterpriseIQ uses a combination of the class, the item number and the revision level to make an 
inventory item unique. 

Manufacture Any Class 

EnterpriseIQ supports the ability to manufacture any class of item. Under most circumstances, you will 
manufacture FG or WP class items. However, you can designate the class from within the BOM structure. 
This ability opens up the possibilities of how the BOM is used. For example, you can build a BOM to 
manufacture an item of class PL, then consume that item by another BOM that creates an item of class 
FG. This technique can be used to build blends, pre-operations that process material prior to 
manufacturing, etc. 

Note: You can create a BOM for a PK class item. The manufactured PK items will be calculated like an FG 
item if it has a Standard ID associated to it. 

EnterpriseIQ needs to understand if an item is purchased or manufactured. Stored within the inventory 
record is a field containing a manufacturing number - a BOM. If this field is filled in, the item is a 
manufactured item. If it is blank, then it is assumed the item is purchased. 

This topic is covered in greater detail in the BOM chapter of the manufacturing manual. 

How Classes are Used 

Classes are used to sort pick lists and reports into logical groups by the appropriate category, for 
example when selecting a raw material (PL) to be used in a configuration or for creating a report to show 
the value of finished goods (FG) inventory. 

EnterpriseIQ contains six pre-defined classes. An unlimited number of additional classes may be created 
through Misc|Inventory Classes menu (also found in the Lists menu in System Parameters). 
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FG Finished goods. This class includes items that are manufactured. This can also include Work-in-Process 
items although IQMS recommends setting up a separate class for these items to provide better 
inquiries and reports by class. 

PL Plastics and raw materials. This class is typically used to classify the main material consumed during 
production. 

IN Inserts or purchased components. 

PK Packaging materials. 

MT Maintenance items. Used by MRO for items used in the repair and maintenance of machinery. Work 
centers are automatically assigned the MT class. 

TL Tooling items. Used for classifying items used in tooling. 

UD User Defined. This is a free form class to be used for any miscellaneous purpose. 

 

Setting Up the Inventory Class Table 

To set up the Inventory Classes table, select Misc|Inventory Classes from the menu in Inventory or select 
Lists|Inventory Classes from the menu in Sys Setup|System Parameters. The following table will be 
shown: 

 



Inventory Management Page 9 of 478 

 

➢ Click on the Add [+] key add a new line, then enter a Class and a Description. 

➢ Select the Primary Material box if the class of inventory can be attached as the main raw 

material on a BOM or Quote. 

➢ Check the Dimensional Characteristics Mandatory check box to require that dimensional 

characteristics be entered when printing a label for a Serialized Inventory Control (SIC) item 

associated to the class.  

➢ The Plug Value is used for informational purposes only. 

➢ Save the entry by clicking on the check mark. 

Dimensional Inventory / Characteristics 

Specific dimensions/characteristics can be set up for specific inventory classes which are used for 
Serialized Inventory Control items when printing labels. For Serialized Inventory Control (SIC) items only 
there will be an additional tab on the Print Label form to enter the specific values for the item for the 
labels that will be printed. When this information is set up per class, when a new SIC item associated to 
that class is created the 'Dimensional Inventory/ Characteristics' form (accessed from the button next to 
the Serialized Inventory check box on the Main Inventory screen) will automatically populate with the 
specific dimensions/characteristics associated to the class.  

To create the dimensions/characteristics for a class, highlight the class and select the button in the top 

left of the list . The following form will appear to define the Caption of the Dimension or 
Characteristic, and the UOM (if a Dimension). 
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If the 'Dimensional Characteristics Mandatory' check box is checked when the user attempts to print a 
package label for a SIC item without entering the value(s) for the Dimensional Inventory/Characteristics a 
warning will appear stating 'Caption name' is a required dimension for this inventory item that has not 
been populated'. The form will remain open until a valid value is entered in the mandatory field(s). 
During receiving, after posting the receipt the Print Labels form appears. If the user skips mandatory 
fields they will receive the warning message above, and also receive the error, 'This is a serialized item - 
labels must be printed. Unable to continue'. Note that the cancel button is grayed out on this form to 
prevent cancelling. 

This information can be used for shipping and invoicing based on the Actual Inventory Unit of Measure 
(UOM) entered when a label is created. When printing a label from anywhere in the system for the item, 
users are required to enter a value for the mandatory dimension. Once labels are printed, the 
dimensional value for each serial is stored in MASTER_LABEL_DIM.NVALUE. During scanning of a pick 
ticket, if there is a match on the inventory item custom UOM and the mandatory label custom UOM the 
system will use the actual UOM value from the label instead of the calculated UOM conversion for the 
item. This will carry over to packing slip and AR invoice.   

Users can create calculated UOM fields through user-defined calculations that can be used in this 
process. UOMs included in the calculation must already exist on the Dimensional Inventory. To create a 

calculated dimension, select the 'Insert a new calculated UOM record' button  on the Dimensional 
Inventory/Characteristics form. A Formula Editor form will appear to enter the calculation. 
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The formula is entered in the blank space on the right (up to 2000 characters). Only the other UOM 
(characteristics) associated to the item will be listed on the left. These parameters can be added to the 
formula by dragging and dropping them with the mouse. Operators are found in the lower section. Just 
click on the operator to add it to the formula. (Note: Only the listed operators can be used). The 
calculated dimension will be highlighted in light blue. There are also an Edit Formula button that will 
open the Formula Editor to make changes, and a check formula for errors button. 

Users can enter an optional Default value for any UOM in the Default Value column on the Dimensional 
Inventory/Characteristics form. When the labels are printed the default values will fill in but are editable. 
When users post the actual values, if there is a calculated field it will populate based on the formula. 

 

Note: Inventory transactions take place as always in native UOM. 

NOTES: 

Security can be placed on IQMS standard classes of inventory: PL, FG, IN, PK, MT, TL, UD. Users without 
security clearance cannot edit or add new items to inventory. Security names are: FG_inv, Pk_inv, IN_inv 
etc. 

Security can be set up for User Defined (UD) classes as well. Through the Security Inspector on the Users 
tab, from the sub-tab called ‘Inv UD Class Access’ administrators can select which UD classes an 
individual can access. If nothing is specified in this grid, the user will have access to all UD class items. If a 
UD class is specified in the grid, the user will only have access to add/select inventory items for the 
specified UD class in the inventory module. When a user tries to access a UD class they do not have 
rights to, they will receive an error stating they have insufficient rights, access denied. The Inv UD Class 
Access only applies to the inventory module. Users will still be able to select any inventory class items in 
other modules such as adding a new part from a BOM, adding an item from inventory item groups, and 
the quick add item form. 
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Units of Measure 

The system allows inventory items to be maintained with different Units of Measure (UOM). EnterpriseIQ 
supports a master list of units of measure. The system supports internal conversions using several UOMs, 
including KG, LBS, GR, FT, and M (Meter). User defined UOM's can be created with specific conversions 
as well. 

Note: The UOM of GR should never be deleted even if none of the manufacturing types utilize grams. 

Setting Up the UOM Table 

To set up the UOM table, select Misc|UOMs from the menu in Inventory or select Lists|Inventory UOMs 

from the menu in Sys Setup|System Parameters. The following table will be shown: 
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➢ Several UOMs come with the system as defaults such as LBS, GR, KG, DAYS, and HOURS. To 
add a user defined UOM, click on the Add [+] key add a new line, then enter a UOM and a 

Description. Note: The system forces upper case for UOMs.  

The Seq # field will automatically populate with the next sequence number. The Seq # field can be 
modified to enable users to control the sorting (i.e. put the most used UOMs at the top).  

The ISO Code is used in credit cards for Level III processing. The ISO Code can be selected from the pick 
list accessed from the ellipsis button. For example, for the UOM of each the ISO Code defaults to NPT 
(Number of Parts). 

➢ Save the entry by clicking on the check mark. 

Converting between Units of Measure 

EnterpriseIQ provides a utility that allows the system to automatically convert one UOM to another 
UOM. This feature can be used when a raw material item is ordered from the Vendor in one unit of 
measure, but then inventoried, staged, and consumed in production in a different unit of measure. This 
feature can also be used for manufactured items where the item is manufactured and inventoried in one 
unit of measure, but then sold in another unit of measure. UOM calculations can either be created using 
a division or multiplication formula. The conversion is done on an item by item basis and conversion 
factors must be set up for each inventory item. 

Notes:  

Conversion factor for the default UOMs (such as KG, LBS, and M) are built into the system and do not 
need to be specified for each inventory item. For example, if an item with a UOM of FT can be converted 
to M without creating a specific conversion setting. 

For Class PL items the drop down list on the main inventory screen is hard coded and custom user 
defined UOMs are not displayed. 

For Serialized Inventory Control it is recommended to use two-decimal precision in System Parameters 
on the Inventory Setup tab.  This is particularly important with UOM conversion factors greater than 
two-decimal precision in regards to In vs. Out transactions (for example posting vs. voiding receipts).   

Each inventory item can have unlimited conversion factors and associated UOMs. The number of UOM 
conversions set up for an item will display next to the Unit field on the main screen in inventory. The 
procedure to input conversion factors is outlined below: 

➢ Enter the UOMs into the Master UOM table. 

➢ Select the inventory item that needs the conversion factor. 

➢  Click on the conversion factors to other UOMs speed button next to the UOM field. 
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➢ The upper portion of the screen shows the current item and UOM. The lower grid area 

supports unlimited alternate UOMs. 

➢ Click in the UOM field and select a secondary UOM from the arrow down list. 

➢ The user may specify a default unit of measure for Sales Orders and Purchase Orders. The 

default factor will be used when adding the item to a sales order or a PO unless an AKA 
UOM is established. Please note the defaults cannot be the same name.  

Note: You cannot have a PO Default UOM factor set on an outsource item. Backflushing will only 
calculate based on the BOM parts per, not taking into account a UOM PO factor.  

Note: A specific unit of measure (UOM) can be assigned to an AKA record by selecting one from the drop 
down list. If the AKA UOM is populated, when adding the AKA item to a sales order or a purchase order 
the UOM on the line item will  default to the UOM listed on the AKA. The hierarchy for assigning a UOM 
to a purchase order or sales order line item is as follows: 

▪ AKA UOM 

▪ Master Inventory UD UOM marked 'PO Default' or 'OE Default' 

▪ Master Inventory Native UOM 

➢ Enter the conversion factor. A factor is required unless it is for default UOMs with conversion 
factors built into the system such as LBS to KG. If the UOM has a conversion factor built into 

the system the On Hand field in the Conversion Factors form will immediately calculate upon 
selection. 

➢ Select divide or multiply from the drop down list. The divide option is the default and is the 

Factor of the Custom UOM =  1 of the Native UOM (or Division calculations simply put are 
Buy UOM/Inv UOM). Multiply is 1 of Custom UOM = Factor of the Native UOM (or Multiply 
calculations simply put are equivalent Inv UOM to Buy UOM).  

➢ General Tip: When setting up UOM conversions, using a factor with the smallest decimal 

precision possible will help alleviate rounding issues where possible, particularly in 
conjunction with label printing for which the quantity field is limited to two decimal places in 

master_label.  Generally this will mean using a ‘Multiply’ function rather than ‘Divide’.  

➢ For the TForm2 MFG Type only, the conversion factor can be calculated from entered values. 

Select the ellipsis button in the Factor field and enter a value in each field (Length, Width, 

Gauge, SPG) in the pop up form. All four fields must have a value. The conversion factor is 
calculated as follows: Width x Length x SPG x Gauge x .0361. NOTE: For TFORM2 MFG type 
BOM’s the Length and Width used to calculate the Sheet Weight come from the values 

entered here for the specified material on the BOM. If the sheet weight is in pounds the 
dimensions are entered in inches; if the sheet weight is in grams the dimensions are entered 
in centimeters. 

➢ Once the data is entered, the On Hand quantity based on the UOM factor will be visible form 
this screen. 

The following examples demonstrate the calculations: 
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Purchased Item examples 

UOM Conversion Factor Examples for purchased items: 

➢ Ink is purchased in Gallons and inventoried by the Ounce. (128 ounces to 1 gallon). 

▪ The conversion factor would be 1/128 = .007812 with the divide option selected. 

▪ Put a check in the PO Default box. 

▪ Set your inventory price and cost based on ounces. 

▪ When item is placed on PO the UOM will automatically be set to Gallons. 

▪ During the receiving function, EIQ will automatically convert Gallons to Ounces. 

➢ Foil is purchased in Rolls and inventoried by the Square Feet (where you can get 24 square feet 

from 1 roll). 

▪ The conversion factor would be 1/24 = .041667 with the Divide option selected, or 24 with the 
multiply option selected. 

▪ Create a user-defined unit of measure called square feet. 

▪ Attach square feet UOM to the Foil item (this is how you inventory this item) 

▪ Put a check in the PO Default box. 

▪ Set your inventory price and cost based on square feet. 

▪ When item is placed on PO the UOM will automatically be set to rolls. 

▪ During the receiving function, EIQ will automatically convert Rolls to Sq.Ft. 

Manufactured Item Example 

UOM Conversion Factor Example for manufactured: 

➢ The item is inventoried by the Each and sold by the Case (where you can get 100 pieces in a 

case) 

▪ The conversion factor would be 1/100 = .01 with the Divide option selected, or 100 with the 
multiply option selected. 

▪ Put a check in the OE Default box. 

▪ Set your inventory price and cost based on each. 

▪ When item is placed on Sales Order the UOM will automatically be set to cases. 

▪ During the shipping function, EIQ will automatically convert Each to Case. 
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Using the Conversion Factor 

To convert between UOMs: 

➢ Find the inventory item of choice. 

➢ Click on the drop down arrow next to the UOM. A warning message will appear stating: 

“Please note this item is consumed in the following modules: BOM Configuration. Changes 
made to inventory UOM must be propagated to the BOM Configuration, Sales Orders and 
Purchase Orders. If you continue you will be prompted to update each individual BOM 

consuming this item. Sales and Purchase Orders need to be revised manually. Are you sure 
you want to continue?” 

Note: Users are advised to create a new item rather than changing the existing conversion factor or 
changing the UOM itself once any activity has taken place on the item. This will prevent confusion as to 
what transaction was in what UOM.   

➢ To continue, click on the drop down arrow next to the UOM, the UOM pick list will appear. 
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Select the UOM that you want to convert to and click on Convert To. 

NOTE: If no UOM conversion is set up for the inventory item, an error message will indicate that the 
system does not know how to convert to the new UOM. Use the Conversion tool to create the 
conversion factor or select another UOM. 

If the UOM is supported a pop up window will appear displaying all of the places the item is used in. 
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The user can update the new UOM for each individual BOM consuming this item. (Select the ‘Where 
Used...’ button to access the Where Used form for more details). Select OK to continue.  

All On Hand quantities are updated to reflect the new factor. This includes all locations that maintain the 
item. 

Save As - The user also has the option to Save As a different UOM. This will not change the quantity of 
the item in inventory, but will only change the UOM associated with the item. When this option is 
selected a warning will appear stating something similar to the following: "'Save As' option does NOT 
convert but marks UOM as CS. Use 'Convert To' option to convert to CS if it is possible. Are you sure you 
want to continue?" 

Deleting a UOM Conversion 

When deleting a UOM conversion a warning will appear similar to the one below: 

Please note this item is consumed in the following modules: Sales Orders 

Changes made to inventory UOM must be propagated to the BOM Configuration, Sales Orders and 
Purchase Orders. If you continue you will be prompted to update each individual BOM consuming this 
item. Sales and Purchase Orders need to be revised manually. Are you sure you want to continue? 

If the factor is used on a BOM, a screen will appear to change the UOM on the affected BOM(s) (which 
will be highlighted in red). Enter the new UOM and parts per. Note: A null or zero quantity is allowed. A 
message will appear stating, "PtsPer should be a number greater than 0. Are you sure you want to 
continue?". Select Yes to continue or No to return to the form to enter a value.  

 

As the warning states the sales orders and purchase orders will have to be updated manually 
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Inventory Item Group 

The Inventory Item Group module is used to set up specific settings applicable to an inventory group. 
This enables users to enter the settings one time and then when adding new items to inventory from this 
module they will automatically have these settings applied. This will help prevent data entry error and 
ensure all new items added for a specific group have the same settings. 

 Select this module from the Manufacturing tab on the launcher bar, the following form will 
appear: 
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Note: Users can use the Inventory Group Code to filter inventory items in the picklists within the 
following modules:  

Manufacturing - Inventory and Inventory Transactions and Locations 

PO/Receiving - Outsource Central and Intercompany Receiving 

Quality - Deviation, ECO, Material Review Board, Repair Work Order, Control Plan, FEMA, Risk 
Assessment (FEMA), Inspection Setup, SPC, and Quick Inspection. 

Modules with Pick Lists for BOMs 

Create an Inventory Group 

➢ Select the insert record button and enter the Code and Description for the group. Then 

select the EPlant ID and Class. The EPlant filter is a soft filter, users will see both groups 
without an EPlant assigned and those associated to the logged in EPlant.  

➢ Next check the boxes next to the options that are relevant to this group. See the Additional 

Tab in Inventory for details on each field. 

The specific GL accounts that can be associated to an item can be associated to a group. These accounts 
are not written to the record in inventory but are used as defaults. The hierarchy the system will use in 
determining what default GL account to use for an item will first look at the inventory group table to 
determine if the item is associated to a group and then use the GL accounts from that group if 
populated. If the group does not have a GL account populated the system will use the defaults in System 
Parameters.  

Note: If the item has specific GL accounts associated to it the system will use those instead of the 
Inventory Group or System Parameter defaults. 

Note: Only the specific GL accounts that apply to the item in inventory will be picked up from the 
Inventory Item Group. The system will use the default account from system parameters or specific to 
Cost Elements instead of the GL accounts in the Inventory Item Group that do not apply to specific items 
in the Inventory Group. For example, in Inventory, purchased items cannot have their own inventory GL 
account associated to them – only the GL from the cost element. This is the same with any purchased 
item in an Inventory Group. Therefore, since users can only assign GL accounts to manufactured and 
non-material items in Inventory users can only assign GL accounts to manufactured and non-material 
items in an Inventory Item Group. Likewise, due to the fact that purchased items cannot have a 
production variance account assigned on the inventory level, they cannot therefore have a production 
variance account assigned on the group. 

Note: For groups with no EPlant assigned the system will take the GL account and EPlant plug based on 
the item. We recommend that if a group is associated to an EPlant all the GL accounts should be 
associated to that same EPlant so the correct EPlant plugged GL accounts are used. 
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Note: The 'Movement Classes' fields (Loose, Package, Pallet, and Max Pallet Stack) are only applicable for 
users with the Advanced WMS license.  Refer to the Advanced WMS https://my.iqms.com/cfs-
file.ashx/__key/Technote/advanced_2D00_wms.pdf TechNote on MyIQMS for more information. 

Note: The Tax Class field is used with the Avalara Tax Web Service to get the correct tax amount for the 
get taxes request. If an existing item is added to a group the tax code from the Group populates on the 
item when the Propagate button is used. This will override the Tax Class if one was already associated to 
the item. (The Tax Class list is created from the 'Tax Web Service Setting' module accessed from the Tax 
Code Maintenance form (System Parameters->Lists menu). Please see the Avalara Tax Web Service 
TechNote for more information). 

User Fields - The User Fields in the Inventory Group module are the same fields visible in Master 
Inventory. The information entered in the fields from here will populate in the corresponding user field 
in inventory. 

COGS Accounts - Specific COGS accounts can be associated to the Inventory Group to provide the ability 
to have different cost elements’ Shipped GL accounts for COGS based on the item's inventory group. On 
the AR Invoice, if the item is associated to an inventory group and the group has a different cost 
elements’ Shipped GL Account for a cost element associated to that inventory item, then the system will 
use that GL instead of the GL account on the cost element itself. To associate the cost elements and  GL 
accounts to the group select the ellipsis button in the Element field and select the cost element from the 
pick list. Select the corresponding GL account from the drop down list. 

Documents - From the Documents tab users can associate Internal or External documents, or Email 
Correspondence specific to the Inventory Group. These documents can be added to the Documents tab 

in Inventory for the items in the group by clicking on the Synchronize Documents button .  A 
confirm message will appear stating, "This option ensures all internal/external documents attached to a 
group are going to be attached to every inventory item in the group. Please confirm to continue." Select 
Yes to continue. Once completed a message will appear stating the synchronization is done. 

Create a New Inventory Item 

To create a new inventory item from Inventory Groups select the 'Add new inventory item' button . 
The Quick Add pop up form will display to enter the basic item information such as item #, description 
and unit of measure. The Class field will automatically be populated with the class from the group and 
cannot be changed. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/advanced_2D00_wms.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/advanced_2D00_wms.pdf
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Associate Existing Items 

Existing inventory items can be associated to the group by selecting the insert record (+) button in the 
lower navigator bar. A pick list of items will appear. This list includes both active and inactive items (in 
case they may become active later). The pick list can be sorted by clicking on a column header. Advanced 
filtering is available on this pick list. Multi-select the items using the toggle buttons at the top of the form 
or the Shift and Ctrl keyboard buttons.  
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Once the items are selected press the OK button and they will be added to the bottom section of the 
Inventory Group form.  

Note: Existing items associated to a group will not automatically inherit the group's check box settings. 
This only occurs when when a new item is created. The only automatic change to an existing item is the 
Inventory Group field on the Additional tab will be populated with the group. Also, for both new and 
existing items the system will use a hierarchy when determining what GL accounts to use: Item specific, 
Group, System Parameters default. 

Check box information can be propagated to existing items added to the group by using the Propagate 
button described below. 

Propagate Check boxes to Items Additional Tab - If a check box is changed for a group, or an existing item 
is added to the group, this button can be used to propagate the groups check box settings to the 
selected items. Highlight the items to be updated using the toggle buttons or the Shift or Ctrl keyboard 

buttons. Select the propagate button  , and select Yes on the confirm box, and the system will 
update the check boxes on the Additional tab in inventory to match the Groups settings for the selected 
items. 

Note: The 'Serialized Inventory Control' check box will be treated as follows: The system will not touch 
already serialized items with or without on hand inventory. The system will not change an item to 
serialized that has on hand inventory. The system will mark an item that has no on hand and is not 
serialized yet as serialized. If a user un-checks the serialized check box for a group and then hits 
propagate the system will un-check all the serialized inventory check boxes for the highlighted items. 

Note: The 'Lot date is Mandatory during receiving' can only be checked if 'Lot# is Mandatory' is also 
checked. 

Items can be removed from a group by selecting the Delete (-) button and selecting Yes on the confirm 
box.  The group designation will be removed, but no changes will be made to the item's Additional tab 
check boxes. 
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Main Inventory Screen 

The following discussion pertains to all classes of inventory - finished goods, plastics, inserts, and 
packaging. The differences among these types of inventory are discussed where appropriate. 

NOTE: The process of data entry is very similar between the material classes. Each screen contains 
almost identical fields. However, there are some differences that are noted throughout the following 
sections. 

For the purposes of clarity, the PL items section details all of the fields within the raw material screen. Be 
sure to read this section carefully. The two other material classes - inserts and packaging - are discussed 
later, but do not include a discussion of some of the common fields - such as user notes, documents, 
manufacturing, pricing and standard costing. Instead, these sections focus on the different information 
captured. 

Entering New Inventory Items 

Items can be entered from the Inventory Item Group module or from Master Inventory. When entering 
the information from the Inventory Item Group module specific settings will automatically populate the 
new item. See Inventory Item Group section for details. 

To enter a new item from Master Inventory follow the steps below: 

From the EIQ Launcher Bar, click on the Inventory speed button  or select 
File|Manufacturing|Inventory from the main menu. The Master Inventory pick list will appear. In the 
bottom right hand portion of the screen, click on [New] to enter a new item. The following screen will 
appear: 
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➢ Select an inventory class from the arrow down list and click on [OK]. 

Non-Material - When creating a new item, the user can check the Non-Material box. These items can be 
attached to BOMs but the system does not allow parts per to be entered for a non-material item. They 
can be shipped but are not dispositioned. Locations and On Hand quantities are not maintained for Non-
Material items. Non material items can have an inventory and shipments GL account numbers associated 
(on the Buy/Sell Pricing tab in Inventory). The inventory GL will populate on the purchase order and the 
shipments GL is used when posting shipments. Non-material items are not intended for manufacturing 
purposes, and work orders for non-material items are not generated when running update schedule. 
Non-Material items can be displayed in WebDirect if the 'OK for Sale on WebDirect' option is checked. 
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Inventory Management Page 28 of 478 

 

If this is the first time accessing the inventory screen, all data fields will be blank (as shown above). 

Use the field listing below to assist in filling in each of the fields shown on the inventory screen. 

Main Inventory Tab Information 
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Class Fills in automatically when the class is initially selected. This field cannot be modified. 

Item #  The inventory item number for this item (50 characters). 

If the System Generated Inventory # option is enabled in System Parameters->Sequential 
Numbering tab the Item # will be automatically populated with the next sequential number. 

Note: To view the ARINVT table ID for this item select the Alt F1 keys and a pop up will 
display the ID and the Table name. From the pop up users can right click to access copy, 
save, and print options. 

 

Revision The revision level of the item (15 characters). Used primarily for manufactured items. 

Description The description of the inventory item (100 characters). 

Ext Description A second description field for entering additional information (100 characters). 

Unit The unit of measure associated to the item. Select the UOM from the drop down list. A value 
cannot be typed in this field.  

For Class PL, this drop down list is hard coded and custom user defined UOMs are not 
displayed. Please see Units of Measure for details. 

If the item has unit of measure conversion(s) set up, the system will display the number of  
conversions associated with this item next to this field. 

Use This UOM for 
MRP 

Select this box to indicate the item’s UOM as the one to be used in MRP (Material 
Exceptions). If this box is not checked the system will use the Native UOM associated to the 
EPlant. For example, if the inventory item is in grams the material requirement planning will 
convert to pounds in material exceptions unless this box is checked. 

Note: GR or OZ will be converted to LBS in material exception unless "Use this UOM" is 
checked in inventory. This applies to both primary and attached components. 
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On Hand The current on hand inventory quantity (up to 4 decimal precision). This value cannot be 
edited directly from this screen. Go to the Locations and Transactions screen. 

On Hand by Plant 
(Button) 

Click on the button to the right of the On Hand field to show on hand at each EPlant and or 
warehouse. For class PL items only the regrind quantities will also display.  

▪ By EPlant - Check this option to see the On Hand for the current item. The EPlant listed is 
based on the EPlant associated to the current item. 

▪ By Warehouse/Division - Check this box to see the on hand inventory per 
Warehouse/Division. 

▪ Include same Inventory Items - When checked the on hand inventory will display for the 
same item in other EPlants. 

  

The check box settings are remembered in the registry. 

Non Allocate This is the quantity of items that are marked Non Allocatable in inventory transactions. The 
amount in the on hand still includes the amount in non allocatable but this field shows how 
many of the on hand inventory is non allocatable.  

Setting an item to non-allocated indicates to EnterpriseIQ that the quantity IS part of the On 
Hand inventory amount, but is NOT considered during the MRP evaluation. This situation is 
typically used when an item has been received or is in stock, but is on hold for some reason. 
Setting an item to non-allocated is a temporary way to tell EnterpriseIQ to ignore the 
quantity during the system evaluation, but maintain it in the On Hand inventory. 

Non-Conform The on hand quantity of non-conforming material. EnterpriseIQ will not include non-
conforming materials in any on hand balance and will not use non-conforming materials 
when calculating MRP requirements. In the case of raw materials, this has a direct impact 
when EnterpriseIQ generates raw material requirements. This value cannot be edited 
directly from this screen. Go to the Locations and Transactions screen. 
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Non Committed This displays how many un-allocated items are in inventory since the last time update 
schedule ran. This field is also in the inventory pick list. 

The formula for Manufactured items is:  

On Hand - MFG Quantity - VMI Location quantities -  MTO - MFG Safety Stock. 

The formula for Purchased items is: 

On Hand - Total Material Used (day_use_total.cum_mat_qty) - Total hard allocated for this 
item 

Note: For purchased items - When hard allocations are made to a work order for 
purchased components, the Non-Committed value in Inventory will be updated correctly 
after running update schedule. 

Note: If the calculation is negative the system will display zero. 

Note: When dispositioning MTO Items into inventory or allocating MTO inventory from 
SOs, the quantity is immediately not included in the Non-Committed value (before 
running update schedule).  Releasing the MTO allocation adds the released quantity to 
Non-Committed. 

By clicking on the icon to the right of this field you can jump to the Daily Projected Material 
Requirements screen. 

In-Transit Displays the quantity in In-Transit locations. 

No Ship Displays the quantity in No Ship locations. 

By Product Used for materials associated to a Thermoform or TFORM2 BOM. If the user creates a By 
Product inventory item from one of these types of BOMs, this box will automatically be 
checked. The user can also check and un-check the box manually. 

Not for sale By checking this box it will keep the item from showing up on the Sales Order inventory pick 
list so it cannot be selected to be put on a Sales Order. 

It will be available to add to manual packing slips.  

An item marked Not for Sale will also be excluded from automatic matching in EDI. 
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Inactive Items can be made inactive which will 'hide' the item from all pick lists. In pick lists there is a 
button to 'view inactive' if users need to see items that have been marked inactive. 

If an item in Master Inventory is marked inactive a confirm message will appear asking if the 
user would like to inactivate the Quote Inventory item as well. If Yes is selected the quote 
inventory item will be marked inactive as well as the master inventory item. If a master 
inventory item is toggled back to active, the quote item is not automatically marked active. 
If the quote item should be active again users must uncheck the box from the Modify Quote 
Inventory Item form.  

Note: If a location still exists on an Inactive item, the inactive item will be included in the 
pick list for Physical Inventory and a tag will automatically be created by the system.  To 
prevent this from occurring, remove any existing inventory and locations when marking an 
item ‘Inactive’. 

After marking an Auto-MRP item inactive, work orders and material requirements are not 
generated when running update schedule, and the existing item on the internal stock sales 
order will not have releases.   

Do not backflush 
this item 

With the ‘Do Not Backflush’ option selected in Inventory, items (both manufactured and 
purchased) that are attached to a BOM will be excluded from backflushing during the 
disposition process.  The item will also be excluded from standard cost calculations of the 
parent BOM, but does allow a standard cost rollup of the item itself.  This feature is a 
global setting that overrides the ‘Do Not Backflush’ option on the BOM, and likewise is not 
intended for use (and has no effect on) an item when used as the main material on a BOM.   

Make To Order When this box is checked and a sales order is added the system will automatically mark the 
SO line item Make to Order. For more information see the Make To Order 
https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf 
TechNote. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
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Serialized 
Inventory Control 
(SIC) 

Inventory with this box checked will be tracked by serial number during adds, deletes and 
moves within EIQ and RF/WMS.  

In Locations and Transactions the user can quickly see the labels associated to each location 
(FGMULTI record) by clicking on the Linked Labels button or right clicking on each location. 
The user can also see all labels printed for the item by right clicking and selecting 'Show All 
Locations Linked Labels'. Once a label is shipped it will no longer be visible here. 

During any transaction within Locations and Transactions the user will be prompted to pick 
from available serial numbers. 

Notes: 

An item cannot be marked serialized if the on hand does not equal zero. A warning 
message will appear if this is attempted. The user should complete a physical inventory 
to match the on hand with serial numbers. 

IQMS does not recommend using Serialized Inventory Control for material and 
components due to strict backflush location requirements in comparison to non-
serialized items. 

In order to alleviate decimal precision rounding issues for Serialized Inventory Control, 
two-decimal precision may be required in System Parameters on the Inventory Setup 
tab.  This is particularly important if choosing (against our recommendation) to use 
Serialized Inventory Control for material and components. 
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Dimensional 
Inventory/ 
Characteristics 

For SIC items only. Select the button next to the Serialized Inventory check box to define the 
Caption of the Dimension or Characteristic, and the UOM (if a Dimension). This can be set up 
for specific Inventory Classes and will automatically populate this form for new items. For 
existing items select the 'Load Default...' (green arrow) button to load the default 
characteristics associated to the inventory class.  

 

This information is accessible in the Print Labels>Dimensional Inv tab and Show Linked 
Labels in transactions. If the Mandatory check box is checked, labels cannot be printed until 
values are entered for the Dimensional Inventory/Characteristics. Users can enter a 0 value 
for a mandatory field. 

This information can be used for shipping and invoicing based on the Actual Inventory Unit 
of Measure (UOM) entered when a label is created. When printing a label from anywhere in 
the system for the item, users are required to enter a value for the mandatory dimension. 
Once labels are printed, the dimensional value for each serial is stored in 
MASTER_LABEL_DIM.NVALUE. During scanning of a pick ticket, if there is a match on the 
inventory item custom UOM and the mandatory label custom UOM the system will use the 
actual UOM value from the label instead of the calculated UOM conversion for the item. 
This will carry over to packing slip and AR invoice.   

Users can create calculated UOM fields through user-defined calculations that can be used 
in this process. UOMs included in the calculation must already exist on the Dimensional 
Inventory. To create a calculated dimension, select the 'Insert a new calculated UOM record' 

button  on the Dimensional Inventory/Characteristics form. A Formula Editor form will 
appear to enter the calculation. 
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The formula is entered in the blank space on the right (up to 2000 characters). Only the 
other UOM (characteristics) associated to the item will be listed on the left. These 
parameters can be added to the formula by dragging and dropping them with the mouse. 

Operators are found in the lower section. Just click on the operator to add it to the formula. 
(Note: Only the listed operators can be used). The calculated dimension will be highlighted 
in light blue. There are also an Edit Formula button that will open the Formula Editor to 
make changes, and a check formula for errors button. 

Users can enter an optional Default value for any UOM in the Default Value column on the 
Dimensional Inventory/Characteristics form. When the labels are printed the default values 
will fill in but are editable. When users post the actual values, if there is a calculated field it 
will populate based on the formula. 
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Note: Inventory transactions take place as always in native UOM. 

EPlant If you are using EnterpriseIQ’s EPlant module the EPlant you are logged into will populate 
the EPlant field automatically. It is not a required field if EPlant is not being used. 

To manually select the EPlant associated with the inventory item click on the ‘Assign Plant’ 
button near the field. Select the EPlant from the drop down list in the One Plant field. Select 
the ‘Apply' button to update the field and automatically post it. If the 'OK’ button is selected 
the change is made, but requires a manual post by the user. 

 

Right Click Options 

▪ Costed BOM - Displays the costs associated to the item based on the default BOM. Please see Costed 
BOM in the Costing section for more information. 

▪ Jump to BOM - This option will be available if the item has a default BOM attached to it. 

▪ Jump to Inspection Setup - Users with a license for the SPC module can jump to the Inspection Setup 
module. 

▪ Jump to Availability - This will take the user to the Inventory Availability module for the item. 

▪ Trace - Brings up the Trace function. See the Trace section for more information. 

▪ Copy Standard Cost to Clipboard - This will copy the standard cost elements and costs to the 
clipboard for pasting elsewhere. 

▪ Jump to Tier Table - This option will jump the user to the Tier Table and display tier discounts that 
are associated to the item. For more information on Tier Discounts please see Tier Pricing in this 
section. 

General Tab 
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Lead Days The number of calendar days it normally takes to receive this item once a purchase order 
is created. Primarily used for purchased items. Used in the Material Exception List to 
generate a Must Order By date.  It is the days between the must order by and the 
should arrive by fields. For example if the lead days = 14 and the Should Arrive By = 
11/26/07, the Must Order By will be 11/12/07. 

Note: This field is also used if the 'Auto Populate Request & Promise Date based on Lead 
Time’ option is checked in System Parameters on the Purchase Order and Sales Order 
setup tab, when adding a PO release using the ‘+’ sign, dragging and dropping, or the 
Generate Releases option, the release dates populate using the item’s Lead Days added 
to 'today’s' date, taking into account the first receiving day found from Vendor 
Maintenance. The system looks first at AKA lead days when applicable, and if none it 
checks for warehouse/division lead days, and if none it uses the main item’s lead days.  
If no applicable Lead Days exist for the item, the release dates are not automatically 
populated. 

Note: This value may be used in Sales Order Releases to evaluate the Lead Days+Must 
Ship Date. If it is equal to or greater than Promise Date a pop up warning will appear. The 
system will first look at the lead days in AKA Selling, if none it will use this value. 

Lead Time Optional. A text field used to write out the lead days (10 characters). 

Example: 
Lead Days is 7, then the Lead Time field might be ONE WEEK or 7 DAYS. 

Inspection Lead 
Days 

The number of inspection lead days for the item. If a value is entered in this field, during 
material planning the system will subtract the inspection lead days from the must arrive 
date.  
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Multiples Of The values entered in these two fields will display in the appropriate section on the 
Buy/Sell Pricing tab. 

Buying Multiples Of: Optional. The most commonly purchased amount of material. The 
purchase order requirements on the Material Exception List will then be created with the 
amounts rounded off to this number. 

Example: 
Item is normally purchased in 50 LBS bags, fill in 50 here. 
Exact MRP engine requirement is 423 pounds. 
Material Exception List generates PO requirement for 450 pounds. 

If purchased items are purchased or sold, when adding the release information on a 
purchase order or a sales order, the system will warn the user if the quantity does not 
conform to the multiples of. 

Selling Multiples Of: Optional.  This field is used in conjunction with Sales Order releases 
and Sales Quotation quantities.  Fill in 'multiples of' with the full box quantity.  During 
order entry the user will be asked if they want to keep the original quantity entered or 
use the full box quantity. If custom unit of measures are used the system will convert 
those as well when performing this check. 

This is also used to determine tier pricing when the 'Less Than Min. Upcharge %' option in 
AR Discount Tiers is populated. If the Selling Multiples Of is populated, and the Minimum 
Sell Qty is less than Selling Multiples Of, when the blanket quantity is less than the Selling 
Multiple Of the upcharge will apply. If they are equal, then standard waterfall pricing 
applies. 

Note: This can also be entered on the AKA Buying and AKA Selling tabs. The 
information populated in the AKA sections will override the master inventory values 
when applicable. 

Minimum Sell Qty A minimum sell quantity value can be entered in this field, then if a release is less than 
the Minimum Selling Qty, a confirmation message will pop up stating, ‘The release 
quantity, <qty>, is less than the Minimum Selling quantity, <qty>, for Inventory Item, 
<itemno>.  Would you like to change it to the Minimum Selling quantity of, <qty>?’  
This pop up has a ‘Do not show next time’ option and Yes/No buttons. Security can be 
added to this confirmation message. 

This field is also used in conjunction with the 'Less Than Min. Upcharge %' option in AR 
Discount Tiers. If a value is entered in this field and it is less than the Selling Multiples Of, 
and the blanket quantity on a sales order is less than Selling Multiples Of quantity the 
system will calculate the price break or Std price (based on the on 'Tier Price based on' 
setting) * Upcharge %.  ( Price + (Price *Upcharge %)). For example: With a tier price of 
$10.00 and an Upcharge of 20%, the Selling price = $12.00   

Note: This can also be entered on the AKA Selling tab. The information populated in 
AKA will override the master inventory values when applicable. 
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Min Order Optional. This is the minimum order quantity for the item, If a purchase order is created 
for less than this amount a warning message will appear requiring a security bypass. 

Note: If a zero is entered here the user will receive an error when creating a PO from the 
Raw Material Below Min material exception report stating 'Release qty must be greater 
than 0.' 

Note: This can also be entered on the AKA Buying tab. The information populated in 
AKA will override the master inventory values when applicable. 

Max Order Optional. This is the maximum order quantity for the item, If a purchase order is created 
for more than this amount a warning message will appear requiring a security bypass. 

Reorder Point Optional. This is the reorder point for the item. If the item is set up with a Reorder Point 
and the amount in inventory drops below the Reorder Point, the item will show up in the 
Material Exception List->Raw Material Below Minimum. 

Safety Stock Optional. A Safety Stock value can be entered for purchased items to create a false 
bottom. During the creation of material exceptions, the system will calculate the Total 
Exception as the total demand from the work orders plus the 'Reorder Point' amount for 
the inventory item less any on hand inventory plus the Safety Stock if applicable. Then 
this amount is rounded up to accommodate the ‘Multiples Of’ (standard packaging 
quantity) field found in inventory. 

For example: The  work order demand is 165.35, on hand is 15, reorder point is 30 and 
the safety stock is 25 with no buying multiples of, the left to order is 205.35 (165.35 + 30 
- 15 + 25). 

If the Buying Multiples Of is 100 then the Left to Order is 300 (rounded up to nearest 
100). 

PO Safety Adds additional days to the lead days of the material when calculating the Must Order By 
date in the Material Exception List. It is the days between the should arrive by and the 
must arrive by fields. For example, if the PO Safety equals 2 and the Should Arrive By is 
11/26/07, the Must Arrive By will be 11/27/07. (The system counts each day). 

PO Scope Used to determine the number of days of material requirements that should be entered 
as a single PO line item in the Material Exception List. Controls how much material to 
receive in against blanket order (i.e. only want to order enough material to complete 
production requirements over the next 7, 14, 21 days, etc.) 

PO Range Used in conjunction with the Ideal vs. Existing PO evaluation tool in the Material 
Exception List. This tool makes recommendations on how your current purchase orders 
might be re-arranged to acquire materials more efficiently. The Range value provides a 
baseline for making some of these assumptions. The suggested actions are based on 
comparing the ‘Should Arrive’ date with the ‘Promise Date’ on the purchase order. If the 
promise date falls within the PO Range the system recognizes it as meeting the demand. 
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SO Item 
Information 

Information can be added in this field that will be displayed when the item is added to a 
sales order or CRM Quote. To add information in this field click on the ellipsis button and 
type the information in the pop up form. This field can hold up to 2000 characters. 

This information can also be added at the AKA level. 

PO Item 
Information 

Information can be added in this field that will be displayed when the item is added to a 
purchase order. To add information in this field click on the ellipsis button and type the 
information in the pop up form. This field can hold up to 2000 characters. 

This information can also be added at the AKA level. 

Receiving 
Information 

Information can be added in this field that will be displayed when the item is being 
received. To add information in this field click on the ellipsis button and type the 
information in the pop up form. This field can hold up to 2000 characters. 

This information can also be added at the AKA level. 

Note: This note does not display when processing the receipt using Receive ASN 
functionality through the scanners. The receiving note does display when processing the 
receipt through the Pending ASN Receipts Maintenance module in EIQ. 

Packing Slip Note This note will pop up right after a pick ticket is converted to a packing slip in EIQ as well 
as IQRF. When not using pick tickets, this note will pop up when a packing slip is posted. 
To add information in this field click on the ellipsis button and type the information in the 
pop up form. This field can hold up to 2000 characters. 

Security can be placed on this field so users cannot change but view in read only mode. 

Note: A Packing Slip note can be associated to a customer (Customer Maintenance-
>Miscellaneous tab). If both the customer and item associated to a packing slip have a 
note, both notes will display in separate pop up windows. 

Inventory PO Parameters by Division 

For purchased items only users can set up the PO Inventory Parameters per Warehouse/Division. This 
functionality allows users to enter specific settings for situations where different Warehouses/Divisions 
have different needs. For example, you may need to carry 100000 of item A in in your main 
manufacturing facility because you are producing items that use this item in a large quantity. However, 
in another division you may only want to have 200 on hand to cover repairs.  

Note: When information is set up by division the PO parameters section on the main Inventory form will 
be grayed out and the system will use the division parameters or global parameters only. The system will 
default to the global parameters for PO Safety, PO Scope and/or PO Range if the Division settings are null 
or 0. It will allow for mix and match, for instance you could have PO Safety and PO Scope specified for a 
division while PO Range = 0, which would then default to global PO Range.  
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To enter this information select the button above the Min Order field . A form will appear to enter 
the parameters per Warehouse/Division. Select the Warehouse/Division from the pick list accessed by 
clicking the ellipsis button in the Warehouse/Division field. (Note: The name of this field will either be 
Warehouse or Division based on the Division setting on the Company File Information->Application tab 
in System Parameters). Enter the values in the Min Order, Max Order, Reorder Point, PO Safety, PO 
Scope, PO Range, Lead Days, and Safety Stock that pertain to this item for the specific 
Warehouse/Division. The system will use these values in material exceptions. 

Note: When the option to ‘Auto Populate Request & Promise Dates based on Lead Time’ is selected in 
System Parameters->PO and SO Setup tab, the Lead Days hierarchy for adding PO releases in the PO 
module is: 1) Buying AKA Lead Days, 2) Warehouse/Division Lead Days, 3) Inventory Master Lead Days. 

Note: The system will separate the requirements based on the division associated to the MFG Cell on the 
BOM or the work center. If the BOM has a MFG Cell with a division the material requirements will be 
separated for the specific division if the work order is not scheduled or scheduled on a work center with 
a division associated to the MFG Cell. If it is scheduled on a work center without a division linked to a 
MFG Cell, the requirements will be included in the non division requirements. If the BOM does not have 
a MFG Cell with a division the material requirements will only be separated for a division if the work 
order is scheduled on a work center with a MFG Cell with a division.   

 

NOTE: The PO fields on the General tab are for the specific inventory item only. Defaults for the PO 
Safety, PO Scope, and PO Range can be set up by going to Misc/Parameters. The system will use what is 
set on the individual inventory item if it is blank then it will look to the system defaults set in Parameters. 
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AKA Buying 

AKA (Also Known As) Buying 

Click on the AKA Buying tab to access this information. The following screen will appear. 

 

➢ The AKA buying system provides a cross reference of the vendor part numbers to internal 

part numbers. The primary focus is on providing an effective way to show different pricing 
schemes related to different vendors. The system allows the input of multiple vendors along 
with their different pricing. The system will then use the pricing entered under the AKA tab 

when purchasing to the vendor listed. 

NOTES: If no vendors are set up under AKA, then the system will use the pricing set up under the Pricing 
tab. 

AKA Description 

AKA Ext 
Description 

The description of the AKA item. 

The AKA Ext Description field provides another field to enter additional information on the AKA 
item. This field is also in the select by AKA pick list in purchase orders and on the PO. 

AKA Item # The AKA item number that this particular vendor recognizes the internal item number as.This 
item number may be entirely different than the original internal item number. 
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Buying Multiples 
Of 

The most commonly purchased amount of material. The purchase order requirements on the 
Material Exception List will then be created with the amounts rounded off to this number. 
Example: Item is normally purchased in 50 LBS bags, fill in 50 here. Exact MRP engine 
requirement is 423 pounds. Material Exception List generates PO requirement for 450 pounds. 

If purchased items are purchased or sold, when adding the release information on a purchase 
order or a sales order, the system will warn the user if the quantity does not conform to the 
multiples of. 

Note: A Buying Multiples Of can be entered for the master inventory item on the 
General tab. The system will first look to see of the AKA item has a value, if not it will 
use the value for the master inventory item. 

Cost Element For items that are purchased and manufactured (have a BOM associated to it), this field will be 
visible to associate a cost element that will be used in translog when receiving the item. When 
receiving the item in, if the Cost Element and Std Cost in AKA Buying is populated for that 
Vendor, the system will use the values entered in AKA Buying instead of the standard cost on 
the Standard Costing tab in inventory. 

Note: The inventory account the system uses will be based on the hierarchy used for 
manufactured items even when a cost element is assigned to the AKA and the item is 
purchased from a vendor.  It will check the inventory account at the inventory item level and 
then the inventory group.  If neither are populated then it will use the default inventory GL 
account.  It will not use the recv/dispo account on the cost element. 

Currency If Multi-Currency is enabled, this field can be used to select the currency code (i.e. USD, CAD, 
etc.) to associate to the price breaks. If the currency is not filled in the system uses the default 
currency. For example, if you have a CAD vendor and the price breaks are in CAD, choose CAD 
for the vendor in AKA selling. If you do not put CAD the system assumes the price breaks are 
the default. 

Default Check this box for the default vendor to be used when creating a new PO from material 
requirements. 

If there is not a vendor marked default and there are multiple lines in AKA buying, the system 
will display a pick list of the AKA vendors/items when making a new PO from material 
requirements. 

Note: The system will always display the Seq. 1 vendor in material requirements and not the 
one marked as the default. 

Documents Internal and/or External documents may be associated to a specific AKA record. The Print With 
options are: None, PO, or All. There is also a tab for Email Correspondence. 

Lead Days Enter the Lead Days for this AKA item. This is informational only unless the option to ‘Auto 
Populate Request & Promise Dates based on Lead Time’ is selected in System Parameters->PO 
and SO Setup tab. If that is checked the Lead Days hierarchy for adding PO releases in the PO 
module is: 1) Buying AKA Lead Days, 2) Warehouse/Division Lead Days, 3) Inventory Master 
Lead Days. 

Note: This value is not used for material exception calculations. 
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Min Order This is the minimum order quantity for the item, If a purchase order is created for less than this 
amount a warning message will appear requiring a security bypass. 

Note: If a zero is entered here the user will receive an error when creating a PO from the Raw 
Material Below Min material exception report stating 'Release qty must be greater than 0.' 

Note: A Min Order can be entered for the master inventory item on the General tab. 
The system will first look to see of the AKA item has a value, if not it will use the value 
for the master inventory item. 

OEM If the OEM check box in Vendor Maintenance is checked this box will be checked. This box 
cannot be edited from this screen. A list of OEM vendors and their distributors can be accessed 
in Vendor RFQ's. Then an OEM vendor can be selected which will add their distributors to the 
list of vendors to send the RFQ to. 

PO Item Info Information can be added in this field that will be displayed when the item is added to a 
purchase order. To add information in this field click on the ellipse button and type the 
information in the pop up form. This field can hold up to 255 characters. 

Price/1000 If this box is set to "Yes", the pricing will be based on 1000 units rather than Each. 

Quantity Price 
Breaks 

Enter Quantities and Price Breaks for each AKA item. To do so, select the vendor AKA item and 
begin entering in all quantities and price breaks for that item. (Quantities go out to two 
decimal places). Optionally enter an Effective Date, Price Date and an Inactive Date. If the 
effective date is in the future or the inactive date has passed, the line item will display in gray. 
(Note: If only the effective date is entered without an inactive date the line item will always be 
white). To hide inactive pricing select the Hide Inactive toggle button. 

A comment (up to 255 characters) may also be entered. 

This section can be sorted on any column, by selecting the column header. 

Rec Insp 
Threshold and 
Count 

Inventory items can be marked for receiving inspection. The Threshold is the number of posted 
receipts after which the user is notified of a needed inspection. 

The Count is the number of receipts posted since the last inspection. The line item in receiving 
will change color when an inspection is required. 

Receiving Item 
Info 

Information can be added in this field that will be displayed when the item is being received. 
To add information in this field click on the ellipsis button and type the information in the pop 
up form. This field can hold up to 2000 characters. 

Rev The revision of the AKA item. 

Seq. This is the sequence number for the attached vendors. This will default to the next number as 
vendors are added. The first will be Seq 1, the second will be 2, and so on. This field can be 
manually changed.  

If the Default feature mentioned above is not being used, when creating a new PO from 
material requirements, the system will  use the vendor with the lowest sequence number. 
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Std Cost For items that are purchased and manufactured (have a BOM associated to it), this field will be 
visible to enter a standard cost that will be used in translog when receiving the item. When 
receiving the item in, if the Cost Element and Std Cost in AKA Buying is populated for that 
Vendor, the system will use the values entered in AKA Buying instead of the standard cost on 
the Standard Costing tab in inventory. 

Note: The inventory account the system uses will be based on the hierarchy used for 
manufactured items even when a cost element is assigned to the AKA and the item is 
purchased from a vendor.  It will check the inventory account at the inventory item level and 
then the inventory group.  If neither are populated then it will use the default inventory GL 
account.  It will not use the recv/dispo account on the cost element. 

Unit A specific unit of measure (UOM) can be assigned to an AKA record by selecting one from the 
drop down list. If the AKA UOM is populated, when adding the AKA item to a purchase order 
the UOM on the line item will  default to the UOM listed on the AKA. 

The hierarchy for assigning a UOM to the purchase order line item is as follows: 

▪ AKA UOM 

▪ Master Inventory UD UOM marked 'PO Default' 

▪ Master Inventory Native UOM 

Note: The quantity in the AKA Quantity Price Breaks will still be in the Native UOM and prices 
should reflect the cost of one unit in the Native UOM so that if there is a PO UOM conversion, 
the price conversion will be accurate when applied to a Purchase Order. 

User Fields Two additional tabs are available in this section; User Fields 1 and 2. The User Fields 1 tab 
contains ten alphanumeric user fields. User Fields 2 tab has ten numeric user field. The user-
defined label text is dependent on item classes. These user fields are for informational 
purposes or can be added to reports. 

Vendor # The vendor's number. This will populate automatically based on the Vendor selected. 

Vendor Name The vendor's name. To select a vendor, click twice in the field and then click on the ellipse 
button to access the pick list. 

Vendor Type Select Distributor or OEM from the drop down list to indicate the vendor type. This is 
informational only. 

VMI Locations VMI locations can be assigned to the AKA item by selecting a VMI location from the pick list 
accessed by clicking on the ellipsis button in the Locations field on the VMI Locations tab. Only 
locations marked VMI that are not used by another AKA Buying row can be added. Once a 
location has been assigned the AKA Buying record will be highlighted in yellow indicating it is a 
Vendor VMI . 

When receiving is done the item will be placed in a VMI location (which is marked non 
allocate). Performing a move out of the VMI location into a normal location will trigger the 
creation of another PO receipt and post it. The Receipt is then available in AP Invoices. See 
Vendor Managed Inventory for Suppliers - Consignment for details. 
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➢ Vendor RFQ - The user can create a Vendor RFQ for items by selecting the Vendor RFQ speed 

button. Please see Vendor RFQ for details. 

➢ Hide Inactive Vendors - Click the Vendor button to hide inactive vendors. If the Vendors are 

not hidden they will display with a gray background. 

➢ Right Click Options: From the AKA Buying tab the user can right click to: Jump to the Vendor, 

Trace changes, access the User Defined Form. 

➢ User Defined Form -  Select the User Defined Form speed button or right click and select 

'User-Defined Form' to create/access the user defined form associated to the AKA Buying 

tab. User defined forms allow the user to create a unique form to store information beyond 
the scope of the original form. The form can contain an unlimited number of fields. For more 
information see User Defined Forms. 

 
 

AKA Selling 

Click on the AKA Selling tab to access this information. The following screen will appear. 
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➢ The AKA selling system provides a cross reference of the customer part numbers to internal 

part numbers. The primary focus is on providing an effective way to show different pricing 
schemes related to different customers. The system allows the input of multiple customers 
along with their different pricing. The system will then use the pricing entered under the 

AKA tab when selling to the customer listed. 

Note:  Before making any changes to AKA Information, post all invoices.  This will ensure that the 
correct AKA information is retained with the Sales Order detail, Shipment detail, and AR Invoice detail.  
Any changes made to the AKA Information prior to invoicing will lose Customer Item Number 
(custo_itemno) and Customer Description (custo_descrip) AKA information once invoiced, see AKA Kind 
and Ship To Attn. 

AKA Description 

AKA Ext 
Description 

The description of the AKA item. 

The AKA Ext Description field provides another field to enter additional information on the 
AKA item. This field is also in the select by AKA pick list in sales orders and on the pick ticket. 

AKA Item # The AKA item number that this particular customer recognizes the internal item number as. 
This item number may be entirely different than the original internal item number. 

AKA Kind This field can be populated to describe the specific AKA Kind related to the AKA. This field 
enables users to create multiple AKA records for the same customer, item number, and ship to 
address. The records are unique based on the combination of Customer+Item#+Ship To 
Address+AKA Kind.  

The 'AKA Kind' column is visible in the Sales Order AKA pick list so users will be able to pick the 
correct AKA item #.  

On the Sales Order, a second pick list will populate when you enter your inventory item that 
has multiple AKA records with different AKA Kind with the same AKA Ship To, allowing user to 
select the correct AKA Kind. 

Note:  Before making any changes to AKA Kind, post all invoices.  This will ensure 
that the correct AKA information is retained with the Sales Order detail, Shipment 
detail, and AR Invoice detail.  Any changes made to the AKA Kind prior to invoicing 
will lose Customer Item Number (custo_itemno) and Customer Description 
(custo_descrip) AKA information once invoiced.    

Note:  Items with an ‘AKA Kind’ will populate AKA information and pricing on the 
Sales Order line item only when the item is added by AKA to the Sales Order. 

Commiss % This is the commission percent that will be used when the item is sold to the AKA customer 
(up to six decimals). This allows the user to pay a different commission percent when selling 
the same product to different customers. 

The system will use the commission hierarchy to establish the salesperson(s) and commission 
percentage when a sales order is entered.  

Note: When changing the salesperson via the Commission field in AKA Selling, the 
Commiss % field will only be updated if the field was blank. If the Commission % 
should be different it must be changed manually. 

Commissions Salesperson(s) can be associated to the AKA item by selecting them from the drop down list in 
this field. 
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Currency If Multi-Currency is enabled, this field can be used to select the currency code (i.e. USD, CAD, 
etc.) to associate to the price breaks. If the currency is not filled in the system uses the default 
currency. For example, if you have a CAD customer and the price breaks are in CAD, choose 
CAD for the customer in AKA selling. If you do not put CAD the system assumes the price 
breaks are the default. 

Customer # The customer's number. This will populate automatically based on the Customer Name 
selected. 

Customer Name The customer's name. To select a customer, click twice in the field and then click on the ellipse 
button to access the pick list. 

A customer can only be added once to the AKA unless they have different Ship To addresses. 

Documents Internal and/or External documents may be associated to a specific AKA record.  The Print 
With options are: None, Sales Order, Sales Order Acknowledgment, Work Order, Certificate of 
Conformance, or All. This enables users to print documents specific to an AKA record when 
printing a report such as work order. 

There is also a tab for Email Correspondence. 

Drop Ship Check this box to designate the AKA item as drop shipped. This is an item that is shipped 
directly to the customer from a vendor. (In other words, it is used to bypass bringing product 
in-house and then re-shipping to customer). When a sales order for a drop shipped item is 
created the system will prompt the user to create a purchase order for the default vendor. 

Flexibility Rules Flexibility Rules are used in conjunction with EDI for FG items. The system determines the 
maximum allowed quantity increase or decrease based on the selected day range. Orders that 
comply with the Flex rules are passed through to the Sales module. Orders that do not 
comply, get flagged. Flexibility Rules can be setup for each AKA number for each Customer. 

When flexibility rules are set up on an AKA item and a new EDI order is converted outside of 
these flexibility rules, the system generates an error like the following: "Proc. 
[CheckFlexibilityRules] Order# %s, Item# %s, Del. Date %s: The percentage (%s) is over the 
lower limit of %s". 

Labels Menu Title This is the name of the shipping label to be used for the AKA item. 

Lead Days This is the number of lead days required for the AKA item. If the Lead Days + the Must Ship 
Date is equal to or greater than Promise Date a warning will appear stating, "The Must Ship 
Date + Std Lead Days is equal to or greater than the Promise Date". This will enable users to 
determine if an order is being placed within the agreed to lead time. 

Mfg # Select the MFG # that produces the Item from the drop down list.   

Mfg Division This  displays the division of the cell associated to the BOM. 
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Minimum Sell Qty A minimum sell quantity value can be entered in this field, then if a release is less than the 
Minimum Selling Qty, a confirmation message will pop up stating, ‘The release quantity, 
<qty>, is less than the Minimum Selling quantity, <qty>, for Inventory Item, <itemno>. Would 
you like to change it to the Minimum Selling quantity of, <qty>?’ This pop up has a ‘Do not 
show next time’ option and Yes/No buttons. Security can be added to this confirmation 
message. 

This field is also used in conjunction with the 'Less Than Min. Upcharge %' option in AR 
Discount Tiers. If a value is entered in this field and it is less than the Selling Multiples Of, and 
the blanket quantity on a sales order is less than Selling Multiples Of quantity the system will 
calculate the price break or Std price (based on the on 'Tier Price based on' setting) * 
Upcharge %. ( Price + (Price *Upcharge %)). For example: With a tier price of $10.00 and an 
Upcharge of 20%, the Selling price = $12.00 

Note: A Minimum Sell Qty can be entered for the master inventory item on the 
General tab. The system will first look to see of the AKA item has a value, if not it will 
use the value for the master inventory item. 

Price/1000 If this box is set to "Yes", the pricing will be based on 1000 units rather than Each. 

Quantity Price 
Breaks 

Enter Quantities and Price Breaks for each AKA item. To do so, select the vendor AKA item and 
begin entering in all quantities and price breaks for that item. (Quantities go out to two 
decimal places). Optionally enter an Effective Date, Price Date and an Inactive Date. If the 
effective date is in the future or the inactive date has passed, the line item will display in gray. 
(Note: If only the effective date is entered without an inactive date the line item will always be 
white). To hide inactive pricing select the Hide Inactive toggle button. 

A comment (up to 255 characters) may also be entered. 

This section can be sorted on any column, by selecting the column header. 

There are five User text fields and five Numeric User fields in this section to add additional 
information to the price breaks. Click the header to customize the caption. 

Rebate 
Parameter 

A Rebate Parameter can be associated to the AKA Item by selecting one from the pick list 
accessed by clicking on the ellipsis button. When the AKA item is associated to a sales order, 
the Rebate Parameter field will populate with this parameter. When an AR Invoice for the 
sales order is paid in full the system will calculate the amount of the rebate in the Rebate 
Manager module. 

To remove the parameter from being associated to the customer, right click and select 'Clear 
Rebate Parameter'.  

Rev The revision of the AKA item. 
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Selling Multiples 
Of 

This field is used in conjunction with Sales Order releases and Sales Quotation quantities. Fill 
in 'multiples of' with the full box quantity. During order entry the user will be asked if they 
want to keep the original quantity entered or use the full box quantity. If custom unit of 
measures are used the system will convert those as well when performing this check. 

This is also used to determine tier pricing when the 'Less Than Min. Upcharge %' option in AR 
Discount Tiers is populated. If the Selling Multiples Of is populated, and the Minimum Sell Qty 
is less than Selling Multiples Of, when the blanket quantity is less than the Selling Multiple Of 
the upcharge will apply. If they are equal, then standard waterfall pricing applies. 

Note: A Selling Multiples Of value can be entered for the master inventory item on 
the General tab. The system will first look to see of the AKA item has a value, if not it 
will use the value for the master inventory item. 

Ship To Attn A specific Ship To address can be associated with the AKA item. This allows users to have 
different pricing based on the Ship To address. When a sales order is entered for an AKA item 
the system will match the sales order shipping address to the AKA item's ship to address for 
the customer to find the correct pricing. Only active Ship To addresses will appear in the pick 
list. 

To clear an associated ship to address, right click and select 'Clear Ship To'. 

Note: If the user chooses to use this ship to functionality it is mandatory that a 
second AKA record without ship to information be entered. In several areas of the 
software the system filters on this AKA ship to information and without the AKA 
record with no ship to the items will not show in the pick list. 

Note:  Before making any changes to AKA Ship To, post all invoices.  This will 
ensure that the correct AKA information is retained with the Sales Order detail, 
Shipment detail, and AR Invoice detail.  Any changes made to the AKA Ship To prior 
to invoicing will lose Customer Item Number (custo_itemno) and Customer 
Description (custo_descrip) AKA information once invoiced.   

Ship To City The city associated to the selected Ship To address. 

Ship Division This is the Division/Warehouse associated to the Ship To address if applicable. 

SO Item Info Information can be added in this field that will be displayed when the item is added to a sales 
order. To add information in this field click on the ellipse button and type the information in 
the pop up form. This field can hold up to 2000 characters. 

Supplier Code This field is set up in Customer Maintenance->Ship To->EDI tab. 
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Unit A specific unit of measure (UOM) can be assigned to an AKA record by selecting one from the 
drop down list. If the AKA UOM is populated, when adding the AKA item to a sales order the 
UOM on the line item will  default to the UOM listed on the AKA. 

The hierarchy for assigning a UOM to the sales order line item is as follows: 

▪ AKA UOM 

▪ Master Inventory UD UOM marked ' OE Default' 

▪ Master Inventory Native UOM 

Note: The quantity in the AKA Quantity Price Breaks will still be in the Native UOM and prices 
should reflect the cost of one unit in the Native UOM so that if there is an OE UOM 
conversion, the price conversion will be accurate when applied to a Sales Order. 

Use Lot Charge 

Lot Charge 

Select the 'Use Lot Charge' box if the pricing is based on a lot charge and not a quantity price, 
and optionally enter the lot charge amount in the Lot Charge field. When this is checked, 
when a sales order is created and the item is added, the system will pop up a field to allow the 
user to edit or enter the lot charge.  Once the lot charge is entered, a separate line will be 
created automatically for a miscellaneous item, with an item description of Lot Charge, a 
blanket quantity of 1, and the lot charge populated in the price field.  

Note: If this box is checked price breaks cannot be entered. The pricing is based on 
quantity breaks or a lot charge, it cannot be both. 

User Fields Two additional tabs are available in this section; User Fields 1 and 2. The User Fields 1 tab 
contains five alphanumeric user fields. User Fields 2 tab has ten numeric user fields. These 
user fields are used for informational purposes or can be added to reports. 
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➢ Hide Inactive Customers - Click the Customer button to hide inactive customers. If the 

Customers are not hidden they will display with a gray background. 

➢ User Defined Form -  Select the User Defined Form speed button or right click and select 

'User-Defined Form' to create/access the user defined form associated to the AKA Selling 
tab. User defined forms allow the user to create a unique form to store information beyond 
the scope of the original form. The form can contain an unlimited number of fields. For more 

information see User Defined Forms. 

➢ Right Click Options: From the AKA Selling tab the user can right click to:  

▪ Jump to the Customer 

▪ Trace changes 

▪ Clear the Ship To 

▪ Jump to Ship To - opens Customer Maintenance at the Ship To tab 

▪ Attached Commodities (see AKA Commodities section below) 

▪ Clone AKA 

➢ When the Clone AKA option is selected a multi-select pick list will appear displaying all of the 

ship to address for the AKA customer for the EPlant associated to the item.  
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➢ Select the ship to addresses that this item should be associated to using the toggle buttons. 

Once the selections are made, select the Clone button, select Yes to confirm, and the system 
will clone the highlighted AKA for each selected ship to. The cloned records will be identical 
to the original AKA (including AKA breaks, Flex rules, User fields, SO Item Information, 

Commissions, and Documents). If an AKA already exists for the ship to that was selected, 
the system will skip that ship to and continue creating the AKA records for the other ones. 

 

AKA Selling Commodities 

From the AKA Selling tab, right click and select Attached Commodities. This allows the user to associate a 
commodities charge with an AKA item. The commodities charge will automatically be added to the AR 
Invoice as a separate miscellaneous line item with a quantity of one and a unit price calculated based on 
the selected procedure (AMOUNT_SUR_RATE or JUST_AMOUNT). The amount will post to the GL 
account associated to the commodity. 

Commodities are set up by selecting Commodities from the Options menu. Please see Commodities for 
details. 

NOTE: Commodity charges will be applied on a AKA Item/Ship To basis. Commodity charges will be 
applied from the non-ship to AKA if there are no AKAs with Ship To's assigned. 

▪ AMOUNT_SUR_RATE will calculate as follows: Unit price = invoice quantity (from item row just added 
to invoice) * AKA Commodities Amount * Commodities Surcharge Rate 

▪ JUST_AMOUNT will not use the sur charge rate and will calculate as follows: Unit price = AKA 
Commodities Amount 

▪ PRCENT_SUR_RATE This Procedure allows a percentage of the extended line item price to be added 
as a commodity. During AR Prepost, an attached Commodity with Percent_Sur_Rate procedure will 
calculate as follows: unit price = (Invoice Quantity * unit_price) * (Commodities Surcharge Rate /100) 

▪ SAC_DISCOUNT - This stored procedure is for use with recorded SAC EDI segments -   If this 
commodity is configured, and the order has recorded SAC segments, the following rules apply when 
creating the invoice: 

1)    If SAC01 = A and SAC07 is populated, the commodity amount =  (ABS(SAC07)* .01 * Qty 
Shipped * Unit Price) * -1. 

2)    If SAC01 = A and SAC07 is null, the commodity amount = (ABS(SAC08) * Qty Shipped) * -1. 

3)    If SAC07 and SAC08 are both null, or SAC01 <> A, do not apply a commodity. 

4)    A separate commodity line should be added for each SAC segment (there can be more than 
one SAC). 
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Note: If no procedure is selected the system will default to Amount_Sur_Rate. 

To access this option right click in the AKA Selling section and select 'Attached Commodities.' From the 
Options menu select 'Commodities' to first set up the various commodities. Enter the commodity 
description, surcharge rate, actual rate (informational only), and the GL account associated to the 
commodity. Select a Procedure for the calculation by clicking on the ellipsis button in the field to access 
the pick list. 

If the Propagate Commission option is checked when the commodity is added to the AR invoice, along 
with the inventory item, the commodity will have the same commission as the inventory item. 

Once the commodities are created they are associated to the AKA item by selecting the ellipsis button in 
the Commodity field on the AKA Commodities form. 

 
 

Additional Tab in Inventory 

The Additional page maintains some inventory class specific information, as described below. For 
example, in the case of FG items, it maintains the default customer and the bill of lading shipping 
information (NMFC#). The PL class uses this tab to store additional information related to the raw 
material. See below for a full discussion. 

The following information is stored on the Additional tab. All possible fields are listed below in 
alphabetical order. The fields actually displayed on the additional tab is based on the inventory class of 
the selected item. 

Auto Populate Service 
Central at Shipment 

If this option is checked, when posting a packing slip the system will automatically 
create a CRM  Service Central record.  The Serial # field will populate with the Lot # 
associated to the location the items were shipped from (FGMULTI.LOTNO), if there is no 
lot number the field will be blank. The Sold To field is the Customer from the packing 
slip, the Inventory item is the item from packing slip, and the Date Active will be the 
packing slip date. The system will populate the Packing Slip # field on the Service 
Central record.  

If a second packing slip is created for the same item with the same lot # a second 
Service Central record will not be created as one exists for the lot already.  

Automate Directed Task 
Generation 

This option, if enabled, activates automated directed task generation at the inventory 
item level. Tasks will be generated automatically for all items with this setting enabled.  

If the system-wide 'Automated Directed Task Generation' has been enabled within the 
Directed Task Monitoring module, this setting does not matter - tasks will be generated 
automatically for all items and all work centers.  

If the system-wide setting has not been enabled, however, this setting confines the 
automated directed task generation functionality to only these items with the setting 
enabled. 
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Blend - Oper # If this raw material is made up of a blend, an Operation # will be present in this field or 
the user may define a new blend. To define a new blend, click on the pick list near this 
field. Defining a new blend is discussed below. To delete a blend associated with the 
inventory item, click on the red minus button. The item will still be in inventory but not 
as a blend. 

Color Group Inventory items can be associated to a color group to be used on the GVS schedule to 
display the work orders in the color associated to the main material of the BOM. This 
allows users to quickly identify like materials for grouping on the schedule. 

Select the Color Group code from the drop down list. The Color Group Codes list is 
accessed from the Miscellaneous menu in inventory. 

Count The Count is the number of receipts posted since the last inspection. The line item in 
receiving will change color when an inspection is required. 

Cycle Count Code The Cycle Count Code is used in the Physical Inventory module. It allows a material to 
be assigned a pre-defined code and then physical inventory work sheets can be 
generated for specific Cycle Count Codes. Items can be automatically assigned a Cycle 
Count Code based on Sales % Rank, Transaction velocity, or manually assigned a code. 
See Cycle Count Codes for details. 

Last Cycle Count - The last date the item was counted when doing a Physical Inventory 
using the work sheet method and choosing the cycle count code. This date is used to 
determine if an item needs to be cycle counted based on the Counted Per Year value 
associated to the item’s Cycle Count Code. The date used depends on the 'Cycle Count 
Code Based On' option that is selected for the code associated to the item (in the Cycle 
Count Codes list->Miscellaneous menu).  

This field is also used when creating physical inventories for Location(s). On the Cycle 
Count Code tab, by default, the Tags will be created for each location found for the 
selected cycle count codes. Users can select the 'Requiring Count Only' toggle button 
on this tab to have the system only create tags for those items that require counting 
based on the Counted Per Year field and the Cycle Count Date 
(FGMULTI.CYCLE_COUNT_DATE) for the selected location(s)/cycle count codes. 

In Physical inventory when Recording Inventory Adjustments the system will update the 
'Last Cycle Count' date (Arinvt.cycle_count_code_date) with either the current Record 
Adjustment Date (default) or the Transaction Date. 

Refer to Physical Inventory for more detail. 
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Default Customer A default customer can be associated with manufactured items or purchased items if 
they are resold. This field will automatically populate with the customer associated to 
the BOM associated to the item if applicable. The Default Customer is only 
automatically populated when the item is first created from the BOM. To add or edit, 
select the Customer using the pick list accessed by selecting the search button near this 
field. Right click and select 'Clear Default Customer' to remove the associated customer. 

(This field is not a drop down selection in order to avoid opening a large lookup table). 

Proprietary - Select the button next to this field to set the default customer as the 
Proprietary customer. A pop up form will appear listing the current default customer. 
This can be changed by clicking the ellipsis button in the field and selecting a different 
customer from the pick list. This will also update the Default Customer field on the 
Additional tab. Enter an Effective Date and Inactive Date from the drop down calendars 
in the fields. If 'today' is in the Effective Date range, the Default Customer field will be 
displayed with a green background to indicate it is in a Proprietary state.  Items in a 
Proprietary state may only be added to Sales Orders for the Default Customer. If a user 
attempts to add it to a sales order for a non default customer the user will receive and 
error stating, 'Inventory item # xxx is proprietary to customer xxx - operation aborted.' 
If the effective and inactive dates are not populated, or are in the past or the future, 
the field will not be green and the item can be sold to any customer. Note this check is 
only on adding the item to the order.  If the customer is then changed it will not be 
enforced.   

Default FIFO method This is the default FIFO method used in Pick Ticket and WMS processing for this item. 
This will override the default selection in System Parameters->Inventory Setup. Select 
from the drop down list: 

▪ System Default - This will use the FIFO Method selected in System Parameters-
>Inventory tab 

▪ In-Date - This will use the In-Date to determine FIFO 

▪ Lot Date - This will use the Lot Date to determine FIFO 

▪ Expiry Date - This will use the Expiry Date to determine FIFO 

▪ Lot # Based FIFO - This will use the Lot # to determine FIFO 

To clear the field, select it and hit the 'delete' key. 

Note: VMI, IN Transit, MTO, Hard Allocated, Non Conform, and No Ship 
locations are excluded from Lot # Based FIFO. 

Discount Group This is used with SAC Discounts. An inventory item can be associated to a Discount 
Group by selecting one from the pick list accessed from the ellipsis button. When the 
item is added to a sales order for a customer that has the 'Use Discount Parameters' 
option checked, the SAC Discounts associated to the Discount Group will be applied to 
the line item and carry over to the AR Invoice. 

Drop Ship Only Check this box if the inventory item is always drop shipped. When an inventory item is 
added to a sales order, the inventory level drop ship option will override the AKA level 
drop ship option.  For example, if inventory level drop ship only is checked, but AKA 
level drop ship is unchecked, the order detail line will be marked Drop Ship. Default is 
Inventory level unchecked. 

Dry Time (PL Class only). The number of hours required to dry the material. Used in the quote to 
calculate production hours. 
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Dry Temp (PL Class only) The recommended temperature for drying the material. 

Exclude from CoC When checked the item will not be included in the calculations of the Certificate of 
Conformance. It can be added manually to the CoC. 

Exclude from CTP Visual 
Material Exception 

If this is checked the system will exclude the material exception flag for the item in 
(Capable to Promise) CTP. 

Exclude from Finite 
Schedule Visual Material 
Exception 

When this box is checked, if a material exception exists for the item, it will not cause 
the work order # to turn red/white on the Finite Schedule.  

Exclude from Work Order 
Materials and 
Components 

This option is only available if licensed for 'Advanced WMS'. 

When this box is checked ShopData/AssyData will not include this material in the Work 
Order Materials and Components screen. 

Floor Disposition This feature is used to establish the floor dispositioning rules for the item. The user can 
select from three options: 

Use Production Report Switch - This is the default option. The system will use what is 
selected in the production report parameters screen to determine whether to 
disposition partials or not. 

Do not disposition partials - With this selected only the quantity floor dispositioned will 
be dispositioned into inventory. The difference between good parts and floor 
dispositions will be ignored during Production Reporting. (No additional parts will be 
available for dispositioning into inventory other than the amount that was Floor 
Dispositioned 

Disposition partials - The system will Floor Disposition all Good parts not just those that 
were floor dispositioned. 

Forecast WO Time Fence The work order time fence option designates a time in days that you do not want the 
system to generate a forecast work order for releases that are within that time fence. 
This value can be set as a default system value from within Forecast parameters or per 
inventory item which will override the default. 

Gauge This is for class PL items only. This is the gauge of the material. This is used in 
Thermoform type BOMs. 

If the gauge of the attached material is changed in master inventory, the system will ask 
the user if the change should be propagated to all of the BOMs that use the material. 
Security can be placed on the pop up message. The pop up message also includes a 'Do 
not show next time' check box. 

The Gauge field can be changed from a specific BOM without affecting the default 
gauge value associated to the raw material in inventory 
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Group Code This is a user defined list used to designate which group an item belongs to. This is 
visible in several areas of the system to enable users to sort and filter on the Inventory 
Group Code. It is currently in the areas listed below: 

▪ Grouping ID Assignment and Assembly Track Sandbox modules which are used with 
the licensed Assembly Track By Group module 

▪ Work Centers within RealTime™ Production Monitoring can be sorted by Group Code 

▪ Where Used - Can be sorted by Group Code on the Attached To, Main Material, and 
Sales Config tabs 

▪ Inventory Group module - sorting is available 

▪ Scheduling - Add/Insert Work Order (sorting is available) 

▪ Scheduling - Text Mode Lower Grid (sorting is not available but users can move the 
Group Code column) 

▪ Update Schedule - Regenerate Schedule grid view (sorting is available) 

▪ Scheduling Graphical View - GVS WO Caption 

▪ Scheduling Window - Accessed from Sales Orders in the header and Releases->Work 
Order Information 

▪ Sales Order pick list 

▪ Archived Sales Orders pick list 

▪ Work Order pick list 

▪ Archived Work Order pick list 

▪ ICT  

▪ Step three in the Transaction Wizard 

▪ View Inventory form and pick list 

▪ eKanban Triggers form 

▪ MRO Parts tab 

▪ Engineering Quotes 

▪ In all pick lists and tables if the displayed item is linked to a master 
inventory record. This includes areas such as: RFQ pick list, Quote Inventory 
Maintenance, Current Materials, Attached Packaging, and Operations. 

▪ BOMs 

▪ In all BOM module pick lists such as: BOM pick list, Add Material, Change 
Material, Add Packaging, Add Component, and View/Edit Processes and 
Operations. 

▪ Process Cost - In all Item # pick lists on all four tabs, and in the Advanced Filter pick list 
feature. 

▪ IACJ screen (sorting is available)  
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Hard Allocation Decimal 
Rounding 

If the field is 0 or greater, in the Qty field in the upper section of the Allocated Materials 
form and the Qty to Allocate field on the Allocate Material form, the quantity for the 
inventory will be rounded to the nearest number based on this value. If this field is null 
it will round out up to six decimals depending on the actual quantity required. 

Note: This is not applicable for Serialized Inventory Control items (SIC). The full 
quantity of serial(s) selected are hard-allocated regardless of this setting. 

Include in Forecast (Purchased items only) If this option is checked the item will be listed in the Forecast 
module. If forecasts are added to the item and the 'Generate Work orders' option is 
checked in Forecast parameters, it will appear in the material exception list. The text in 
the middle section of the Projected Exception screen will be blue indicating it is forecast 
DRP demand. (Note: a work order will not be generated. 

Intrastat Code Intrastat stands for Intra EC Trade Statistics. Intrastat is the method of collecting 
information on the movement of goods between countries of the European 
Community. 

This field is used to designate the specific Intrastat Code for the inventory item. 

Inventory Group This is the Inventory Group associated to the item. A group can be assigned to the item 
from here by selecting the ellipsis button in this field and selecting the group from the 
pick list. Only groups with the same class as the item will be available to choose from. 

For more information see Inventory Item Group. 

Is Pallet (PK Class Only) Check this box if the packaging item is a pallet. It is used to determine 
pallet count in conjunction with parts per on the BOM. In the RF module it is used for 
the print label function 'Print on Complete Pallet.' Based on the part per field the 
system will recognize when a full pallet has been reached and prompt to print a label. 

Also, if this box is checked when a pick ticket is converted to a packing slip the Pallet 
Count field on the Packing Slip will populate automatically with the pallet count. 

Label Image Allows an image (*.jpg or *.bmp) to be linked to an inventory item and then printed on 
the label when labels are printed. To link an image to the item, click on the button to 
the right of this field and locate the image on the network or computer and click on 
Open. The file name and path will then be displayed in this field. Refer to the Label 
chapter (Attaching an Image to a Label) for more information on setting up the label. 

Label Menu Title This is the name of the primary label you want associated with the inventory item. 
Select the label from the drop down list. 

Label Printing Interval For 'Label Printing Assistant' module users only. Enter the value in seconds that the 
user must wait to print another label for the same item. The program will look at this 
field first and use its value to determine how often a label can be printed, if there is no 
value for this item the program will use the default interval within the Label Printing 
Assistant parameters. See the Label Printing Assistant https://my.iqms.com/cfs-
file.ashx/__key/Technote/LabelPrintAssist.pdf TechNote for more information. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/LabelPrintAssist.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/LabelPrintAssist.pdf
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Loose Weight The individual weight of one single item and does not include packaging items. The 
UOM comes from the Weight UOM in Inventory Parameters. For manufactured items 
this is the same field as the Loose weight field in BOL Data. When it is updated on one 
of the fields it will also update the other one.  

This is used with the option to calculate the BOL using weight for each item on the 
BOM. Please Calculate BOL based on individual component weights for more 
information. 

Note for items associated to a Thermoform/TForm2 BOM: For users installed before 
version 2011, updating the Item Weight on the BOM modifies this Weight field in 
Inventory. For users installed after version 2011 this field will not  automatically 
populate from the BOM, but if for some reason this is a requirement please contact 
IQMS support and the required trigger can be provided.  

Lot # is mandatory  

 

Expiration Date is 
Mandatory 

 

Lot Date is mandatory 
during receiving 

With this box checked the system will require a lot number for transactions such as ins, 
outs, and moves. If the user tries to do a transaction to a location without a lot number 
an error message will appear: 'Unable to continue - missing mandatory field Lot #'. 

Lot Date is mandatory during receiving - If the 'Lot # is mandatory’ option is checked the 
user can also select the ‘Lot Date is mandatory during receiving’ option to force users to 
enter a lot date during receiving. 

Expiration Date is Mandatory - If the 'Lot # is mandatory' option is checked the user can 
also select the 'Expiration Date is Mandatory' option. If this is checked for an item, the 
user will be prompted to enter an Expiration Date when doing a Change FG Lot # in RT 
Monitor or Assembly Track, when processing a transaction for an inventory item in 
IQRF and WMS such as receiving or Add by Item, and when dispositioning in Production 
Reporting by Work Order and Report Final Assembly in Assembly Track. If the 
transaction is called while auto dispositioning from a Production Report by Shift, the 
MFG # on the production report will be marked in red indicating there is a Disposition 
Error, which is, "Missing mandatory lot expiration date - operation aborted". 

Note: An item cannot be marked mandatory lot number if it has locations 
associated to it that do not have lot numbers. A warning will appear if this is 
attempted. 

Note: If an item has ‘Lot# is Mandatory‘ in conjunction with a Receive 
Designator location, the default Receiving location must have a Lot# or users 
will not be able to receive that item using IQRF/WMS. 

When printing labels, if a lot number is not entered on the label, a warning will 
appear stating, 'Lot # is Mandatory for 'Item #'. Continue?' Select No to return 
to the label form to enter the Lot#. If the user selects Yes, the label will be 
printed without a Lot#. Security can be added to this button. The pop up also 
includes a 'Do not show next time' check box. 

Note:  For manufactured items, a FG Lot # on the BOM may be required for 
disposition transactions. 
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Maintain BOM Label Info 
during EPlant 
Transaction 

When an inventory move results in an intercompany transaction, if this option is 
checked the system will not update the source item MASTER_LABEL.STANDARD_ID or 
MFGNO. The purpose is so that a user can determine the original BOM used even after 
an intercompany transfer has been done on the item. 

Note: This switch is setup on the target item number not the source. 

MSDS Authorable The MSDS Authorable setting can be specified for an entire class of material or for an 
individual item. To mark a class as MSDS Authorable select 'Inventory Class MSDS 
Setup' from the Options menu in the Chemical Abstract Service form (Inventory -
>Miscellaneous menu). 

NMFC # National Motor Freight Carrier shipping code used to describe the type and class of the 
item to be shipped. This is used for a Bill of Lading. 

Non-Taxable - Sales 
Orders 

If this option is checked, when adding the item to a sales order the system will not 
populate the Tax Code column. This will override the Tax Code associated to the Ship To 
address for the customer. 

Non-Taxable - Purchase 
Orders 

If checked when a purchased item is added to a purchase order, regardless of the tax in 
the header section of the purchase order, the item will not be taxed.  If unchecked the 
item will be marked 'Taxable' in the PO Detail if there is a tax code entered on the PO. 

OK for Sale on Web Check this box to make the inventory item available for sale to all WebDirect B2B and 
WebDirect B2C customers without requiring an AKA for each. Note: This checkbox is 
only available if licensed for either WebDirect B2B (WEB) or WebDirect B2C. 

Plug Value This is used for informational purposes only. 

Product Code Select the product code type for the item from the drop down list. Product codes are 
used to group like products together for volume price discounts and for the Repair 
module to establish items with similar replacement part lists. Product Codes can also be 
used to establish pricing for items stored in one unit of measure and sold in another. 
Please see Using Product Codes for converting prices for UOM Conversions. 

The list of Product Codes can be accessed from the Miscellaneous menu in Inventory. 

Note: If an item has a Product Code assigned and that product code has a 
decimal precision set, the decimal precision will be applied to that item’s unit 
price throughout WebDirect B2B. 

Rebate Parameter A Rebate Parameter can be associated to the inventory item by selecting one from the 
pick list accessed by clicking on the search button. When the item is associated to a 
sales order, the Rebate Parameter field will populate with this parameter. When an AR 
Invoice for the sales order is paid in full the system will calculate the amount of the 
rebate in the Rebate Manager module. 

To remove the parameter from being associated to the customer, right click and select 
'Clear Rebate Parameter'.  
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Rec Insp Threshold Inventory items can be marked for receiving inspection. The Threshold is the number of 
posted receipts after which the user is notified of a needed inspection. 

If licensed for SPC, there will be a button next to this field to setup Receiving SPC 
Information. 

 

▪ Receive to Non-Conform Location - This is the non-conform location the item will be 
received into during receiving when the threshold has been met. When posting the 
receipt, the system will populate the 'Assign New Receiving Location' form with this 
location, and the user cannot edit the location. To setup a location, select the ellipsis 
button to access the pick list of non-conform locations. Choose from the list or select 
the new button to create a new non-conform location. 

▪ Use SPC Inspection - This is the SPC Inspection Group to be used for the inspection. 
Select the ellipsis button to access the pick list of inspection groups associated to the 
item. When an item that requires inspection is received it will be listed in Quick 
Inspection for the Non-Conform Inventory Type. 

To clear the field select the eraser button. 

Regrind On Hand (PL Class only) The amount of regrind that is on hand. EnterpriseIQ stores regrind 
material separately within the same record as the virgin material. This value cannot be 
edited directly from this screen. Go to the Locations and Transactions screen. 

Note: If regrind is to be valued, then regrind will need its own inventory master 
record. The regrind column is not used in actual or standard costing. 

RF/ShopData Backflush 
by Serial 

This can be checked for materials that are attached to BOMs. With this checked along 
with ‘Auto-Backflush on RT scan to inventory’ in Production Reporting parameters, 
when users are performing RT Scan to Inventory, Floor Dispositions, and Disposition 
Label(s) Current Shift or Multiple Shifts from Print RealTime Labels, users will be 
prompted to scan serial numbers for the materials that will be backflushed. 

RG Value % (PL Class only) The percent of the cost of the virgin material that should be applied to 
the regrind. This is informational only, and can be used for reports. 
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Serialized Inventory 
Control 

Inventory with this box checked will be tracked by serial number during adds, deletes 
and moves within EIQ and RF/WMS. (This box is also on the Main Inventory screen). 

In Locations and Transactions the user can quickly see the labels associated to each 
location (FGMULTI record) by clicking on the Linked Labels button or right clicking on 
each location. The user can also see all labels printed for the item by right clicking and 
selecting 'Show All Locations Linked Labels'. Once a label is shipped it will no longer be 
visible here. 

During any transaction within Locations and Transactions the user will be prompted to 
pick from available serial numbers. 

Notes: 

An item cannot be marked serialized if the on hand does not equal zero. A 
warning message will appear if this is attempted. The user should complete a 
physical inventory to match the on hand with serial numbers. 

IQMS does not recommend using Serialized Inventory Control for material and 
components because the only way labels are backflushed automatically is in 
FIFO order. 

For Serialized Inventory Control it is recommended to use two-decimal 
precision in System Parameters on the Inventory Setup tab. 

Shelf Life The shelf life of the item in days. This is used in conjunction with Lot Dates to 
determine if a lot is expired. Once the lot is expired the system will automatically mark 
the location in red as expired.  
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Shelf Life 2 This can be used to track multiple shelf lives for raw materials. This is used primarily for 
items that require refrigeration. While in refrigeration the system will apply the Shelf 
Life.  When the items are removed from a refrigerated location then the Shelf Life 2 
value (in days) will kick in. If the Inventory Item's Shelf Life2 is populated, the system 
will mark locations in red if the System Date - locations in date is greater then the 
item's Shelf Life 2.  

When adding inventory in Transactions and Locations (or IQRF/WMS) to an existing 
location (fgmulti) with In Date other than 'today's' date, a message surfaces and the 
user must add a new location to populate the In Date of today. This is the same as 
when Unique Date-In is selected on an item.   

Locations can be set to 'Do Not Process Shelf Life 2' to establish rules for if/when the 
shelf life 2 will kick in. 

Location Shelf Life 2 examples: 

Type A = Process Shelf Life 2 

Type B = Do Not Process Shelf Life 2 

Moving from Type B to Type A 

▪ Maintains Unique Date In – assigns System Date as In Date 

Moving from Type A to Type A  

▪ Maintains Unique Date In – current In Date stays the same  

Moving from Type B to Type B 

▪ Uses standard Unique Date In rules (see 'Unique Date In' below) 

Moving from Type A to Type B 

▪ Uses standard Unique Date In rules (see 'Unique Date In' below) 

Receiving New Inventory to Type A 

▪ Maintains Unique Date In – assigns System Date as In Date      

Receiving New Inventory to Type B 

▪ Uses standard Unique Date In rules (see 'Unique Date In' below) 

Inventory Out either Type A or B 

▪ Uses standard Unique Date In rules (see 'Unique Date In' below) 

The two Shelf life fields work independently of each other in determining a 
location (fgmulti) expired status. 

SPG The Specific Gravity of the item. This value is used in several areas of the system: 

▪ It is used during quoting, along with the part volume to determine the part 
weight.  

▪ It is used in the calculation of the SPG for a blend based on the SPG values for 
each attached material. 

▪ Used in Thermoform and TForm2 BOMs to calculate the sheet weight. 
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Tariff Code Select the Tariff Code to be associated to this item from the pick list accessed by 
clicking on the search button. 

A tariff code is a number assigned to each type of product sold internationally. Each 
tariff code is issued by the World Customs Organization (WCO) through a database 
called the Harmonized System. This information can be added to official shipping 
documents such as Commercial Invoices and Shippers Export Declaration. 

The list of tariff codes is created from the Miscellaneous menu in inventory, or it can 
also be accessed from Lists menu in System Parameters.  

The Tariff Code can be changed by selecting a different one from the pick list. When it is 
changed the system will pop up a box for the user to enter the reason and the review 
date. The 'Reason for the Tariff Change' field is a user defined drop down list.  

The history of the Tariff Codes assigned to the item can be accessed by clicking the 

'Tariff History' button . A form will display showing the Review date, Reason, 
Change date/time, User ID, and Old and New Tariff Codes and descriptions. 

 

Tax Class This is used with the Avalara Tax Web Service to get the correct tax amount for the get 
taxes request. A Tax Class can also be associated to an Inventory Group. If an existing 
item is added to a group the tax code from the Group populates on the item when the 
Propagate button is used. This will override the Tax Class if one was already associated 
to the item. 

The Tax Class list is created from the 'Tax Web Service Setting' module accessed from 
the Tax Code Maintenance form (System Parameters->Lists menu). Please see the 
Avalara Tax Web Service TechNote for more information. 
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Unique Date-In Setting this flag forces the system to maintain a unique date per location. The location 
stores an “In Date” - the date the transaction to that location occurred. This field is 
assigned with each transaction. Once the date of receipt is established, future 
movements of the item include the original location date. The date can be changed by 
right clicking on the location from within the Locations and transactions screen and 
selecting 'Change In-Date'. Note, when the In Date is changed it will no longer have a 
time associated to it.  

Setting this switch is accomplished on an item by item basis. The check box can be 
found on all inventory items, on the Additional tab. By default, it is not active. 

Rules for Unique Date In function: 

When the 'Unique Date In' option is checked, the following transaction logic is invoked: 

When ADDING to a location - if the On Hand amount of that location is zero, update the 
location date with the current system date. If the On Hand amount of that location is 
greater than zero, then make a NEW location with the current system date and time 
and the ORIGINAL location description. Noted Exception: If the Add is done in a manual 
disposition in Production Reporting by Shift, when the user selects an existing location 
with on hand, only the date is looked at, not date and time. If it is a different date than 
today, the user must create or select a location with today’s date. 

When MOVING from one location to another - If the On Hand amount is greater than 
zero, make a NEW location with the Original location date and time and location 
description. The idea is that you have merely moved the SAME item to a new location, 
but the original date the material was received will still be a part of the record. 

In Receiving, the system only looks at the Date and does not consider a difference in 
Time.  So, if the location selected has the same In Date as current date, then the 
quantity is added to the existing location.  If the location selected has a different date, 
the user gets a message and needs to add a new location to receive into. 

When the 'Unique Date In' option is NOT checked, the following logic occurs: 

When ADDING to a location - If the On Hand amount of that location is zero, update the 
location date with the system date. If the On Hand amount of that location is greater 
than zero, simply update the quantity but DO NOT change the location date. In other 
words, use the original date of the location, do not change it to match the current date. 

When MOVING from one location to another - If the On Hand amount is greater than 
zero, maintain the original date of the location as the date of the TO transaction. This 
means the original date of location will be maintained at the new location as well. 

Whether or not the Unique Date In box is checked, the system date is used with the 
OUT (from) transaction when the location On Hand quantity is greater than zero. 
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Unique Disposition 
Locations on Move 

With this option checked all IN move transactions to any location marked as a default 
disposition ‘Dispo Designator’ in Inventory Transactions and Locations will create a 
unique FGMULTI row even if it is the same lot number. This includes moves made from 
IQRF and WMSIQ. This is designed for manufactured components and raw materials in 
order to consume them based on FGMULTI_ID order instead of FIFO by In Date order. 
Auto dispositioning during backflushing or production reporting will relieve based on 
the FGMULTI_ID sequentially. The system will maintain the hierarchy consideration of 
default locations with Mfg# associated (for example: unique FGMULTI_ID’s created 
using Direct Move WO will backflush before default locations without a Mfg# 
associated).  

It is important that the move transactions are done in order of how you want to 
consume them. For example, you have a partial box of 250 lbs and a full box of 1000 lbs 
of material. It is desired that the system consume the partial box first, so the user will 
first move the 250 lbs to the disposition location, and then the 1000 lbs to the same 
location. With this option checked the system will create two rows in FGMULTI and the 
system will consume based on the one that was moved into the disposition location 
first using the FGMULTI_ID. 

Note: This feature does not create unique FGMULTI_ID’s with IN Disposition 
transactions (for this use the Unique Date-In check box in Inventory). 

Note: When moving material through scanners and by serial  number, if the 
item has multiple locations existing of the same name, unless the item is 
marked ‘Serialized Inventory Control’ there is no guarantee that the material 
will be moved from a specific fgmulti of that location. 

Use Std Cost in 
Engineering Quote 

With this option checked the system will use the standard cost when assigning the 
material to an engineering quote instead of the price breaks.  

Volume The volume of the item. The UOM comes from the Case Dim UOM in Inventory 
Parameters. The volume for packaging items is used in the Bill of Lading calculation in 
the Packing Slip module. This information is also used in conjunction with the Pick 
Ticket parameter, 'Enable volume\weight calculations'. This is the same field that is in 
BOL Data->Case Volume. When it is updated on one of the fields it will also update the 
other one.  
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WebDirect Lead Days This is the lead days that will be used in WebDirect. If the item has a WebDirect Lead 
Days value the release calendar in WebDirect will highlight the earliest release date 
that can be selected. If an earlier date is selected the user will receive an error stating, 
"Release date cannot proceed highlighted date! Please select a later date." This date is 
based on today’s date plus Lead Days (skipping the weekend days in between). For 
example, if the lead days is 12 and the customer is entering a release on 07/21/11, the 
earliest release date will be 8/8/11. 

  

WMS Inventory Group For Advanced WMS: WMS Inventory groups can be created and then assigned to 
inventory items. If an inventory item is assigned to a WMS Inventory Group the 
Transaction Rules will be filtered on that group. 

The group can be assigned from the WMS Inventory Group module (accessed from 
WMS Setup) or from inventory. To assign a group from this field in inventory, select the 
ellipsis button in this field and select the group from the pick list. 
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Blend Operations in EnterpriseIQ 

The inventory module supports the concept of blends which can be added as the primary material on a 
BOM (not as a component). A blend is an operation stored internally in EnterpriseIQ and the operation 
dictates whether the final item is made up of two or more other items. Each item represents a 
percentage of the whole and the total percentages must add up to 100%. A blend can be “blended at the 
work center” or away from the work center. During Production Reporting and Dispositions, this field 
dictates how materials are consumed. 

Creating a Blend 

To create a blend, first create and save a new item of class PL. The item number and description should 
describe the final blend. 

➢ Select the Additional Tab and click the blend icon located on the right side of the Additional 

Tab. The following screen will appear: 
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The system will automatically fill in the Class, Oper # and Description. These may be changed if 
necessary. The Inventory Item #, Revision, Description and Unit of Measure will also fill in automatically. 

➢ Select whether the material is Blended at Work Center. This feature determines how product 

will be handled for material planning and dispositioning. 

If Blended at Work Center is checked: 

▪ Material Planning - The system will not look at any blend on-hand, only the components. Only the 
components will show up in material exceptions. 

▪ Dispositions - Only the blend components will be dispositioned. The blend itself will not ever be 
removed during dispositioning. 

If Blended at Work Center is not checked: 

▪ Material Planning - Material planning will first look at how much blend is on-hand and if there is not 
enough, the blend components will show on the material exceptions. 

▪ Dispositions - Only the blend will be removed during dispositioning, never the components. 

Define Blend by LD Ratio: 

A blend can be defined by Let Down Ratio instead of using percentages. To use LD Ratio, check the box 
'Define Blend by LD Ratio' and enter in the ratio instead of a percentage. For example, if the ratio for 
resin to color is 17/1, enter 17 in the LD Ratio field for the resin and enter a 1 in the LD Ratio field for the 
colorant. The percentages will calculate automatically. When using LD Ratio first select the main plastic, 
then the additive, and then the let down ratios. 

Materials Tab: 

The next step is to define the materials which compose the blend. Click on the Materials tab to display 
the materials grid, as shown below. 
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➢ Click [+] to add a new record, then click in the Item # field and use the ellipsis button to add 

the first material by selecting the material from the pick list. Once the material is selected, 
the pricing from the inventory Buy/Sell Pricing tab will be displayed in the right side grid. 

The pricing can be modified for the blend item. Any price changes made here will also 
change the value on the Buy/Sell Pricing tab for the inventory item. By default both active 

and inactive pricing will display. Select the button above the pricing section  to hide 
inactive pricing. 

Note: The materials added to a blend must all have the same unit of measure as the raw material 
inventory item. If a blend has a unit of measure in LBS the components must be in LBS also.  

Note: Manufactured items should not be added as components of a blend operation as a work order will 
not be created for the component since a work order is not created for the blend. In situations where a 
manufactured item is part of a blend users should create a BOM for the blend rather than use the blend 
operation functionality. See Creating BOM's for Blends and Regrind using Phantoms Items for details. 

➢ Enter the Blend% or LD Ratio as a whole number, not a decimal (unless your percentage is 
less than 1%). For example, to enter 95%, simply enter 95. To enter 4.2%, enter 4.2. 

➢ Continue adding materials until all have been accounted for. The total of all material blend 

percentages MUST equal 100. If it does not, an error stating, 'Either no materials have been 
assigned to the blend operation, or the total blend percentage does not equal 100.' will 
appear. 

➢ Calculating the buying price breaks for the blend is done by clicking on the calculator icon 
next to the price breaks section on the inventory item tab. Select which items price breaks to 
use then the system will calculate the blends price breaks from the prices and percentage 

information from all of the items that make up the blend. First, the system determines the 
'quantity for the calculation' consideration (QFC), which is equal to the Blend Ratio for the 
component * the blend quantity. Using this QFC, the system then calculates the blend’s price 

breaks using the following calculation: 

▪ Blend price breaks = [(Component A’s QFC * Component A’s Price Break for QFC Amount) + 
(Component B’s QFC * Component B’s Price Break for QFC Amount)] / Qty of Blend. Note: If three 
components are used to populate the blend, then Component C would be taken into consideration, 
and so on. 

For example: When calculating 1000 lbs. of blend made up of two components (A & B) that are set to 
95% and 5%, where both components have two price breaks of $0.50 for 1 qty and $0.25 for 900 qty. 
The system first determines the QFC per component. 

▪ Component A’s QFC = .95 * 1000 = 950 lbs 

▪ Component B’s QFC = .05 * 1000 = 50 lbs  

Then, the system will use component A’s price break that corresponds to the 950 lbs ($0.25), and it will 
use the price break that corresponds to the 50 lbs for component B ($0.50). The blend price for the 1000 
quantity, therefore will equal [(950 * $0.25) + (50 * $.50)] / 1000 = .2625. 
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➢ The user can also calculate pricing for ALL blends by clicking on the calculator at the top of 

the blend form. The breaks will use the same quantity price bracket used during the first 
calculation or if this is the first time calculated, the program will use the item with the largest 
percentage. 

Note: The Seq # field in the Materials section is used in RealTime Process Monitoring to tie data collected 
to attached components of the BOM running in first position. 

From the Material tab users can right click on an attached item and jump to inventory. 

SPG - The Specific Gravity (SPG) for all items can be entered on the Additional tab in inventory. This 
information will display in the lower section for each item. The SPG for the blend can be calculated based 
on the SPG values for each attached material. To calculate the SPG for the blend select the ellipsis button 
in the SPG field and select Yes to confirm. The system will use the component’s SPG and the percent of 
the blends content to determine the SPG for the blend. It is the sum of (SPG * Blend %) for all attached 
materials. For example: (1.1 * 0.95) + (0.8 * 0.05) = 1.045 + 0.04 = 1.085 

Note: For costing purposes an item with a blend operation attached is considered a purchased 
component.  

Note - Costing for inventory blends if there are two or more items attached with different cost elements: 

▪ Blended at work center:  When blended at work center is checked dispositioning will take the 
components of the blend out of inventory. PIT will process this as if it were a substitution since the 
blend components are not on the BOM.  PIT will take out the full amount from each components GL 
and then adjust when it calculates how much was actually used. If exclude substitutions in system 
parameters is checked, the cost elements GL accounts are used and no substitution calculation is 
made. 

▪ Not blended at work center:  The main blend will be taken out of inventory.  PIT will find the main 
blend, use its default cost element for processing. There is only one row in translog for the material 
used. PIT cannot match the second cost element. The other cost elements will be treated as variance 
since there is no 'match' found in the translog for that component cost element.  This is the same if 
you had a purchased item with multiple cost elements. 

If users want to have multiple cost elements on a blend it is recommended to use 'Blended at work 
center' to achieve correct costs on consumed components. The other option is to make the blend a 
Generic MFG item with a BOM. The system is not designed to have non manufactured items with 
multiple cost elements except when Landed cost type is involved. 

Documents Tab: 

You can also add Internal or External documents to the blend from the Documents tab. 

➢ Once the blend has been created, save all changes and exit this screen. The material is now 
linked to the blend. 
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Standard Costing Tab in Inventory 

Standard Costing is the comparison of standard costs as defined by the Bill of Manufacture and the 
actual costs associated with the purchase and production of items. The STD Costing tab in inventory 
holds much of the information required to properly use Standard Costing.  For an in depth discussion 
please refer to the Standard Costing section in the Costing Manual. 

Security Note: Companies may wish to hide cost and price information for inventory items. In security 
inspector look for SHCOST and SHPRICING in the inventory Invt_Shell form.  Remove visible and 
enabled and the tab(s) will disappear. Note that if the SHCOST is not enabled users will not be able to 
scroll through items on the Standard Cost tab or resize the fields on that page. 
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Buy/Sell Pricing Tab 

DELMIAworks supports an unlimited list of price breaks for each inventory item. The screen is split to 
include pricing for Buying and Selling. The purchasing part of the system will look at the price breaks in 
the buying section and the sales order will look in the selling section. Access to the list of price breaks is 
under the Buy/Sell Pricing tab within the inventory module. 

Each price break can support a quantity, price, price date, effective date and inactive date for multiple 
currencies. The system automatically uses pricing information entered on the Pricing tab when purchase 
orders or sales orders are created. 

You can maintain a running history of price breaks by setting the inactive date to an old date. The pricing 
record will change colors showing an obsolete price. Prices with an inactive date will not be considered 
during the purchase order or sales order entry process. 

Use Lot Charge - In the Selling section a lot charge can be used instead of price breaks. Select the 'Use Lot 
Charge' box if the pricing is based on a lot charge and not a quantity price, and optionally enter the lot 
charge amount in the Lot Charge field. When this is checked, when a sales order is created and the item 
is added, the system will pop up a field to allow the user to edit or enter the lot charge.  Once the lot 
charge is entered, a separate line will be created automatically for a miscellaneous item, with an item 
description of Lot Charge, a blanket quantity of 1, and the lot charge populated in the price field. Note: If 
the Use Lot Charge box is checked price breaks cannot be entered. The pricing is based on quantity 
breaks or a lot charge, it cannot be both. 
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Select the desired 'Currency' from the drop down list above the price section. Pricing may be entered 
and stored for multiple currencies. If Multi-Currency is being used, price breaks cannot be entered 
without a currency. If attempted an error will appear stating, 'Please select a currency when adding Price 
Breaks'. 

Note: There must be prices in all currencies, or when creating a sales order or CRM Quote the price will 
be blank for currencies without a price break.  

Enter a specific 'Multiples Of' value for Buying and/or Selling if desired. Both fields will default to the 
'Multiples Of' value entered on the Main Inventory->General tab. 

Vendor RFQ - From the Buying section the user can create a Vendor RFQ for items by selecting the 
Vendor RFQ speed button . Please see Vendor RFQ for details. 

Pricing may be entered and stored for multiple currencies. Enter the price break information using the 
field description below as a reference. The user can enter in as many quantities and price breaks as they 
like. The maximum decimal places is six. If you use the Quoting module, price information is imported 
automatically during the conversion process.  
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Price Breaks (Buying and Selling) - Left side of Pricing Tab. 

Quantity The quantity associated with the price. To enter a quantity: 

▪ Click on the ADD [+] key. 

▪ Place the cursor in the Qty field and enter a quantity. 

Price The price of the item at that quantity. 

Price Date Optional. The date the price was created or revised. 

Effective Date Optional. The date that this price will be in effect. If the date is in the future the line item 
will be gray until the effective date. 

Inactive Date Optional. The date when this price will no longer be in effect. The system recognizes the 
inactive date as the date entered however the line item will not turn gray until after that 
date has passed. To show/hide inactive price breaks select the Inactive toggle button. 

Comment A price break comment (up to 255 characters) can be entered in this field. 

Right Side of Pricing Tab. 

Standard Item 
Price 

Optional. The default price of the item. If all fields are blank in the price break section (AKA 
Selling and Selling section on Buy/Sell Pricing tab), then the program will use the default 
value entered in this field. Also, some inventory value reports use the amount entered 
here to value the inventory item. 

If this field is used for pricing on sales orders the user can update the price in this field then 
select the 'Update current sales orders price' button to update the price on selected sales 

orders.   

A form will appear from which the user can select all or specific sales orders to update 
pricing on. 

If a standard item price is entered for purchased items, a warning message will appear if 
the unit price on the requisition is greater than the standard item price. The warning box 
also has the 'Do not show next time' check box, if the standard item price is not entered 
for items. 
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Commission% If applying commissions to the inventory item, fill in the amount of the commission. This 
field can only be edited if the commission field is associated to an individual not a 
commission group. 

Note: If a Commission Group is selected for the Commission field the Commission % field 
cannot be edited. For example, the group is John 5% and Tim 2% if you put in 10% in the 
commissions field, the system cannot determine how much of the 10% would go to each 
salesperson in the group. 

Commission Select the salesperson associated with the commission from the arrow down list. This list 
includes the salesperson/group name and commission percent. 

Tier Type Select a Tier Type from the arrow down list. Tier Types and Pricing are discussed in detail 
later in this section. 

Waterfall Select the Waterfall option from the drop down list to associate to the item if Waterfall 
Tier Discount pricing should be used. See Waterfall Pricing for details. 

Setup Charge If the setup charge is greater than zero, users entering a sales order for that item will get a 
notice that there is a setup charge associated with that item. 

Buyer Code Enter the Buyer Code from the drop down list. The list is a user created list which can be 
accessed in Inventory from the Options menu or from System Parameters->Lists->Buyer 
Code. 

This field flows through to material exceptions and daily project material requirements. 

Exclude from 
Commissions  

If this is checked commissions will be excluded from the sales order even if a salesperson is 
assigned to the item or an AKA item associated to the item. 

Price Breaks are 
per 1000 

If this box is checked, the system will base the pricing per every 1,000 pieces. 
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Sales GL Account The General Ledger sales account for this item. If this field is blank, the system will use the 
default account number defined under System Setup|System Parameters|GL Setup. 

Each manufactured item in inventory can have multiple GL sales accounts, broken down by 
percentage. Click on the modify GL accounts button then right click on the Sales GL 
account and a form will appear for 'Sales Account Split'. From here you can specify multiple 
sales accounts and the percentage that you want to go to each account by clicking on the 
ADD (+) button on the form. When the Sales GL Account is a split this field will display in 
blue. 

During A/R invoice posting, the sales amount of the invoice will be divided up between the 
multiple accounts. In the A/R invoicing module, if the sales account for the item is found in 
the split sales account table, the account will appear in blue. This way users can easily tell 
that this item on this invoice has a split sales account. If the sales account is then un-split, 
user should delete the multiple sales accounts from the right-click screen. This will take the 
item out of the multi-sales account table and the items sales account will no longer appear 
in blue. The sale account will revert back to the one found on the buy/selling tab in 
inventory. 

Note: For EPlant users - The sales accounts associated to items MUST have the EPlant 
suffix added to them. 

Intransit 
Account 

This is the Intransit Account used for interplant transfers. This applies to manufactured and 
purchased inventory items. 

An Intransit Account can be assigned in in Inventory Groups and in System Parameters->GL 
Setup tab. 

Note: Accounts must be assigned for items that may undergo an Interplant transfer. 

Interplant 
Transfer 
Account 

This is the default GL  account used for interplant transfers. This applies to manufactured and 
purchased inventory items.  

An account can be assigned in Inventory Groups and in Inventory on the 'Buy/Sell Pricing' tab 
and in System Parameters -> GL Setup tab. 

Note: Accounts must be assigned for items that may undergo an interplant transfer. 

Interplant 
Transfer Var. 
Account 

This is the default variance account used for interplant transfers. This applies to manufactured 
and purchased inventory items. 

A variance account can be assigned in in Inventory Groups and in Inventory on the 'Buy/Sell 
Pricing' tab, and in System Parameters->GL Setup tab. 

Note: Accounts must be assigned for items that may undergo an interplant transfer. 

Inventory 
Rounding Offset 

This account will be used to capture out of balance amounts due to large quantities reported 
and decimal precision used in the parts per calculation. 
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Inventory Cost 
Revalue 

This account will be used when rolling a new standard cost for both purchased and 
manufactured items. 

Production 
Variance Acct 

Manufactured Items Only. This account will be used when the manufactured item is 
consumed into a generic and there is a difference between the parts per and the actual 
usage. If the account is empty, the system defaults to the MFG Production Variance 
account when actual usage is different and the Production variance account for standard 
cost changes. Both default accounts are set up in System Setup|System Parameters|GL 
Setup. 

PPV Account Purchased Items Only. This is the purchased price variance account used for this item. The 
PPV Account is used when posting Purchase Price Variances during AP invoicing. PPV is the 
difference between the PO price and the Standard Cost.  If this field is blank, the system 
will use the default account number defined under System Setup|System Parameters|GL 
Setup. 

WIP Process 
Account 

Manufactured Items Only. This account is used only for ASSY MFG Type items. As items are 
reported complete for a certain process they will go into inventory and post to this WIP 
Process account. Once the item is done with its processes it will change from a WIP item to 
a FG item. This account is also accessible from Options->Inventory Accounts. 

When using non-ASSY manufacturing types the 'WIP Inventory' account will use the 
Inventory GL Acct# field referenced above. 

Please Note: In order to have this account affected by ASSY3 items, the ‘Backflush Each 
Process’ option must be checked within the Manufacturing Type. 

Interplant Sales 
Account 

Manufactured Items Only. This is used only for interplant transfers. 

Physical 
Inventory 
Variance 

Manufactured Items Only. This account will be used in post inventory transactions for 
physical inventory variances. 

If this is not populated at the item level the system will use the physical inventory variance 
account number defined under System Setup|System Parameters|GL Setup. If that 
account is also not populated the production variance account  number defined under 
System Setup|System Parameters|GL Setup will be used. 

Inventory GL 
Account 

Manufactured Items and Non-Material items Only. The General Ledger inventory account for 
this item. If this field is blank, the system will use the default account number defined 
under System Setup|System Parameters|GL Setup. 

Note: For EPlant users - The inventory accounts associated to items MUST have the 
EPlant suffix added to them. 
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Shipments GL 
Account 

Manufactured Items and Non-Material items Only. This account will be used when posting the 
Shipments transaction type in Post Inventory Transactions. If the item does not have a 
specific account associated to it, the system will use the Shipments Pending Invoicing 
default account  number defined under System Setup|System Parameters|GL Setup. 

Note: This is only used when the 'Post Shipments awaiting invoicing/PIT' parameter is 
turned on in System Parameters->Inventory Setup. 

Pallet Charge 
Account 

This account is used at the time of AR Invoice when 'Use Pallet Charge' is enabled on the 
Sales Order and pallet charges are captured on a customer packing slip.   

If the item does not have a specific account associated to it and the 'Use Pallet Charge' 
option is enabled on a sales order, the system will use the Pallet Charge default account 
number defined under System Setup|System Parameters|GL Setup. 

Modify GL Acct's Use this button to modify the default GL accounts for this item only, as defined under 
System Setup|System Parameters|GL Setup.  

To modify the GL accounts for more that one item, select Options|Inventory Accounts 
from the menu. 

 
 



Inventory Management Page 83 of 478 

 

Inventory User Fields 

These fields are informational only and are provided so that you may enter other information about the 
inventory item. EnterpriseIQ provides ten text based fields, each 60 characters in length, and ten 
numeric fields, each supporting up to 15 digits and up to 6 decimal places (nine digits before the decimal 
and 6 after). Note: If the ‘Use 1000 separator for numeric fields’ option is selected (System Parameters-
>Company File Informations->Application tab) the user has to retype the entire number when editing the 
value or an error will appear. 

The label text and drop down lists are based on inventory class. 
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EnterpriseIQ does not use these fields in any reports or forms (including Pick Lists), but they may be used 
in any user defined reports. 

Defining Label Text 

Change the text for each field to closely match your environment. For example, the first field, by default 
listed as User 1, can be changed to store additional inventory information. The label text created is based 
on inventory class. For example, if you change the label text for the User Text 1 field on a class PL item it 
will be that name for all class PL items, but it will still be User Text 1 for other classes until changed. 

➢ Place the cursor over the text and right click, then select “Define Label Text” from the drop 

down menu. 

➢ Enter a new label and press [OK]. All records will now reflect this change. 

User Defined Lists 

For the User Text Fields the user can define a list that can be used to populate the user field rather than 
manual data entry. The lists are based on inventory class. To edit the list for a user field, right click on the 
blue arrow and select ‘Edit User Defined List’. A list form will appear to enter the Text selections that will 
be available when selecting the blue drop down arrow in the field. 

NOTE: The information in these fields will populate the HIST_UD_ARINVT table when the item is shipped 
or received. This is useful for report queries. 

Fore more information refer to the User Fields section. 
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Manufacturing 

The information on this tab is relevant to items that are manufactured. Many of the fields are not 
enabled for editing for non-manufactured items. The link between an inventory item and a BOM is what 
tells EnterpriseIQ whether an item is manufactured or whether the item is purchased. Items that have no 
link to a BOM (no BOM listed on the Manufacturing tab) are considered by EnterpriseIQ to be purchased 
items and will not have work orders generated for them as the system will not be able to assign a BOM 
to the work order. 

Note: If a Manufacturing number associated to an inventory item has been marked inactive, the system 
will consider the item to be a purchased item. 

EnterpriseIQ also supports the capability to have several BOMs that make the same item and to have the 
system generate work orders using just one default BOM, to split the work orders among several BOMs 
based on a pre-defined percentage, or to create work orders using a threshold method. Each of these 
methods are described in more detail below. 

Click on the Manufacturing tab under Inventory to access the following screen: 
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Additional Fields on Manufacturing Tab 

Move Time 
(days) 

This will add extra lead time to the must start date of the work order for manufacturing the 
item. This is intended for work in process items to create more time between operations if they 
do not run back to back. Move time from all levels of the BOM will be used when calculating 
must start dates. Must Start Date - Move Time (always excluding weekends regardless of the 
Shop Calendar). The system will then look at the Shop Calendar to see if the result of that 
calculation falls on a non working day and will back up more until the first working day is found.  

Notes: 

Move Time was designed for lower level items and not the finished good. Adding 
Move Time to a finished good will result in moving up the customer ship date. 

If Move Time is associated to a FG on a sales order with a promise date that is a ‘Dock’ 
Date Type, the system will move up the ship date. If the Promise date is a ‘Ship’ Date 
Type, then the move days are ignored since the promise date is the ship date.  

Wait Time (days) This value will be subtracted from the Must Ship Date and used to calculate the Must Start 
Date. Wait Time (days) looks at calendar days (not the shop calendar). For family BOMs the 
system uses the longest wait time of item(s) ordered; the wait time of a family item that is not 
actually being ordered is not considered.   

Wait Time was designed for top level items, but can be used on components.  

Note: The Must Ship Date will not reflect the Wait Time in days (this is just used for 
calculating the Must Start Date). 

Note: Wait time will be applied only once within a Run Size when Max WO Batch is 
used. 

Rework 
Manufacturing # 

This section will display any Rework Manufacturing BOMs created for the inventory item. The 
user can right click and select Jump To BOM to access the Rework BOM. 

Rework BOMS are used in the RMA and MRB modules to create Rework work orders. Please see 
Rework Work Orders for more information. 

Config Code The information displayed in this field is the Config Code (Sales Configuration Item description + 
non-default choice codes) for items created using the Sales Configuration templates in CRM-
>Sales Quotations. When creating a Sales Quotation for the Sale Configuration Template and 
converting it to a sales order, a 'Config Code' is created from the Sales Configuration Item 
description and any non-default Choice codes. The information displayed in the pop up form 
accessed by clicking on the ellipsis button is the description of the choices in a list. For example, 
if the Item is 'Vehicle', and the non default choices are color and size, the config code would be 
'VehicleColorSize', the memo in the pop up would be Color and Size in a list. Additional 
information can be added by entering text in the form.  

This actual Config Code field will also be in the pick list enabling users to search for specific 
Config Codes. 

Note: For VIN Generator users - The VIN History table in Serial Number Tracking will 
not populate the VIN # unless this Config Code is populated.  
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Backflush 
Materials 

With this checked, every time a transaction is done for the item the user will be forced to 
backflush the raw materials. This is also used for floor dispositioning. When this is checked it 
will alert the Warehouse Management module that when you floor disposition you need to also 
calculate and remove the items components from inventory. 

Note: This option will automatically be checked upon creation of a new manufactured 
item. 

Exclude 
Forecast Work 
Orders from 
Schedule 

With this checked, forecast work orders will not display on the Insert Work order Grid within 
Scheduling. 

Auto-load will not load these work orders. 

Finite Schedule 
Forecast WO Cut 
Off Scope 

This is a value in days that is used to filter the forecast work orders based on the Must Start 
Date. Only forecast work orders that have a must start date that falls between the current date 
and the Forecast WO Cut Off Scope will be available to load in the finite schedule either 
manually or via Auto Load. This field cannot be populated if the 'Exclude Forecast Work orders 
from Schedule' option is checked. 

A Forecast WO Cut Off Scope can also be set as a global value in Scheduling Parameters 
(accessed from the Options menu in the Finite Scheduling module). The system will look at the 
value associated to the inventory item first followed by the global setting.   

The global setting only applies if the inventory item does not have the 'Exclude Forecast Work 
Orders from Schedule' option checked, or the Cut Off scope is not populated. 

Exclude 
Forecast Work 
Orders from 
Assembly Track 

This only applies to ASSY1/2/3 work orders. If this is checked the system will hide work orders 
with forecast releases for the inventory item from the pick list when adding work orders to 
Assembly Track (from either the New button on the pick list or when using the + button within 
Assembly Track). 

Note: If the Scheduling Parameter 'Combine SO &  Forecast Demand on WO' is 
checked work orders can have both forecast and sales order demand. If a work order 
has both it will be hidden from the pick list. 

Auto Print 
RealTime Labels 

Check this option for this item to be monitored for automatic printing of RT labels through RT 
Label Monitor. With this box checked, the user can also select which packaging sequence will be 
used when printing the labels. The selection will always default to sequence #1, however if 
labels need to be printed for a different packaging sequence on the BOM, use the ellipsis to 
select the sequence from the pick list. If the packaging on the BOM is changed at a later date, 
the program will still use the selected sequence, regardless of what packaging item is in the 
sequence. If the job is already running, it must be setup in Realtime again for RTLabel Monitor 
to recognize the change and print the labels. 

Note: RT Labels Monitor will automatically print labels for manufactured items based on the 
parts produced captured in RealTime. As a package is completed (based on the parts per 
packaging item in the BOM) a label will automatically print. (Please refer to the RT Labels 
Monitor https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-
Monitor.pdf TechNote for more information). 

Note: The ‘Process Monitoring Triggered’ checkbox tells the system to print a label 
every time there is a cycle within RealTime Process Monitoring. (It is just like “Auto 
Print RealTime labels”, but with RealTime Process Monitoring instead). 

https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-Monitor.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-Monitor.pdf
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Cascade Parent 
MTO 
Designation 

This option is available for manufactured items that are used in higher level BOMs (dependant 
demand). It cannot be checked for top level items. During the update schedule when the 
system processes the dependent demand of a Make To Order (MTO) top level item it will 
designate the dependent demand items that have this box checked as MTO as well. When 
backflushing a parent item that is set to MTO, the dependent demand backflush quantity will 
come out of the MTO inventory location. 

Note:  If the 'Exclude from KIT MTO' option (BOM module) is selected on a 
manufactured component of a phantom item that also has this option selected in 
Inventory, the ‘Exclude from Kit MTO’ option in the BOM module overrides this and 
the component will NOT be marked MTO on the sales order.  
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MFG Min Qty This field is used to establish a minimum quantity to manufacture. At the time update schedule 
is run the system will evaluate the MFG Min Qty and MFG Multiples Of fields to determine the 
quantity of the work order. When these values are filled in, by default each release will be a 
work order, bucketing will not take place. These values will also display in MPS. 

If a MFG Min is set on an item that is part of a family tool separate work orders will be created if 
the Promise Date is the same on all items. For example, if a tool makes a Part A & Part B a work 
order will be created with requirements for part A and another work order with requirements 
for Part B. Both items are listed on each work order but only one item has a delivery quantity. 

 

If the release is less than the MFG Min Quantity, the work order will be increased to that 
quantity. If it is greater than the Minimum value it will be increased to the next MFG Multiples 
Of value. The quantity of parts over the release quantity will be allocated to later releases. 

If the system changes the quantity on the work order based on the Mfg Min Qty/Mfg Multiples 
Of the work order will be marked firm when it is scheduled in the first position. There are two 
cases where this will happen: 

If the Mfg Min Qty is greater than the sales order release. For example the sales order release is 
for 200 but the Mfg Min Quantity is for 300. 

If the sales order release is not divisible by the Mfg Multiples Of field. For example if the sales 
order release is for 1100 but the Mfg Multiples Of is 300. 

Since users can report via Production Reporting by Work Order without finite scheduling in the 
first position, for work orders that were system modified based on the MFG Min Quantity, they 
will be marked firm when PRW is used to report production. 

NOTES: 

The Must start date will NOT be based on the MFG Min Qty but the quantity of the 
original sales order amount. If you have a sales order for 1000 pieces and the MFG Min 
Qty is set for 5000, the Must Start Date will be based on the 1000 pieces, not 5000. 

If the work order was generated from the Forecast module it will not automatically be 
marked Firm. 

If the 'Force Bucketing for Mfg Min/Max Quantity' Scheduling Parameter is checked 
update schedule will force multiple sales releases into a single bucket even if they 
have min or max quantities.  This also works with 'multiples of'. The work order will 
still be marked firm when it is scheduled in the first position. In the work order 
module, if additional demand was added by the system due to Mfg Min Qty or 
Multiples Of values the line will be colored orange in the Delivery Quantities section. 
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MFG Min Qty 
Example 

 

For example: MFG Min Qty = 10000 and MFG Multiples Of = 10000 

Ex #1 - Sales Order Blanket Qty = 40000 with four releases of 10000 pieces each within the run 
size scope. The system will generate four work orders for 10000 pieces each. Each release 
becomes a separate work order due to a value being entered in the MFG Multiples Of field. If no 
value was entered as a MFG multiple of the system would generate one work order for 40000 
pieces. 

Ex #2 - Sales Order Blanket Qty = 35000 with four releases of 8750 pieces each. The system will 
generate four work orders for 10000 pieces each due to the multiples of value of 10000. 

Ex #3 - Sales Order Blanket Qty = 35000 with one release of 35000 pieces. The system will 
generate one work order for 40000 pieces due to the multiples of value of 10000. 

MFG Multiples 
Of 

This is the quantity the item will be manufactured in. By default the delivery quantities on the 
work order will be forced to be divisible by this multiples of quantity as well as the total 
manufactured. 

For example: If this field is 150 pieces and the sales order is for 1000 pieces total with 10 
releases of 100 each, the work order will be generated for a total of 1050 pieces with seven 150 
piece deliveries. 

If the system changes the quantity on the work order based on the Mfg Min Qty/Mfg Multiples 
Of the work order will be marked firm when it is scheduled in the first position. There are two 
cases where this will happen: 

▪ If the Mfg Min Qty is greater than the sales order release. For example the sales order release 
is for 200 but the Mfg Min Quantity is for 300. 

▪ If the sales order release is not divisible by the Mfg Multiples Of field. For example if the sales 
order release is for 1100 but the Mfg Multiples Of is 300. 

MFG Safety 
Stock 

This allows for a false bottom on inventory allocation. The MRP engine will not recognize the 
amount entered here to be used for allocation against sales order demand. It does not consider 
this as usable product. 

Note: If inventory falls below this level it will not automatically generate a work order, 
you must use Auto MRP. 

Note: This does not apply to Auto MRP demand. The system will consider all on hand 
as usable inventory to meet the Auto MRP requirements. 

For example:  

▪ The MFG Safety Stock is 1000, on-hand inventory = 2000, there is a sales order for 5000 pieces. 
The work order will be created for 4000 pieces because 1000 of the on-hand is considered 
safety stock. Without a value in this field the work order would be for 3000 (5000 - 2000). 

▪ If the demand came from Auto MRP, the work order would be created for 3000, because it will 
use all of the on hand to meet the demand. 

If the on-hand = 500 and there is not a sales order, no work order would be created just 
because the on-hand is below the MFG safety stock. Only auto-mrp will do that. 

For Auto-MRP users: If the safety stock box was previously checked on the Auto MRP and then 
this box is filled in, the box in Auto MRP will automatically un-check. 
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Master Production Scheduling (MPS) 

MPS information is for the Master Production Scheduling module. See MPS Time Phase for additional 
information. 

MPS Item Check this box if you want this item to be in the MPS (Master Production Schedule). 

No Planned 
Work Order 

For MPS items only, this option may be checked to prevent the system from generating a 
planned work order when sales order or dependent demand is present. A message stating, 
'arinvt_id = xxxxx demand is negated by no_plan_wo switch', will display in the EnterpriseIQ 
MRP Engine in the Note field informing the user that a work order was not generated because 
the MPS item has this box checked. 

Keep in mind that NO work order will be created for an item with this option checked even if 
Sales Orders or dependent demand is present. If the item has Auto MRP setup, the system will 
create a work order for the Auto MRP demand. If this option is checked and the item does not 
have Auto MRP setup, users will have to create a manual work order, and then once update 
schedule is run the system will generate planned work orders for any dependent demand. 

Note: This will also prevent the system from generating Forecast Work Orders for the item. 
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Phantom Item Check this box if you want this item to be a Phantom Item. A phantom item is a product that is 
consumed in a higher Bill of Manufacture. (A top level item that is sold should not be marked as 
a phantom item with the exception of a Kitting item). If this is checked the inventory level will 
never go negative when being consumed unless the Drive Phantom Negative check box is 
selected. Instead the components of the phantom item will be removed. This particular part 
number is typically considered a non-stocked item. 

When an item is made phantom on the manufacturing tab in inventory, additional check boxes 
will appear. 

▪ Drive Phantom Negative -  If this is checked, dispositioning will take from the phantom item 
and take inventory negative rather than pulling from the phantom's components. Note: A 
phantom Kit item is a top-level item, and when selected to ship (instead of components), this 
will drive the phantom Kit item negative regardless of ‘Drive Phantom Negative’ check box 
selection. Note: This should not be checked for Serialized Inventory Control items (SIC), as they 
should never go negative. 

▪ Include Kitting Components on SO - If this option is checked the components of a phantom kit 
item will be included on sales orders. If is not checked, then only the phantom item will be on 
the sales order. (See Kitting for details on this manufacturing type option). Note: A message will 
appear stating, 'A Kit cannot be a component on a BOM that makes a Kit – operation cancelled' 
if the item is currently a component on a BOM that makes a Kit, or is a manufactured item that 
includes a component that is a Kit. 

▪ Price Based on Components/Modify Components - This check box is only visible if the ‘Include 
Kitting Components on SO’ is checked. If this is checked, when a KIT is added to a Sales Order, 
the unit price of the phantom item will be null. The unit prices of the components will populate 
instead. The component pricing will follow normal pricing rules (e.g. pricing hierarchy, 
discounts/markups, etc). When the kit is added to a sales order or AR invoice, users are not 
allowed to delete kit components from the kit, and are prevented from modifying the kit 
components' quantity. When a packing slip is invoiced in the AR module, the components listed 
on the packing slip will appear on the Invoice. The price of the phantom will remain suppressed 
and the prices of the components will remain populated. 

If the Phantom Item check box is un-checked, the system will automatically un-check these 
options if they were checked. 

Cum LeadTime Informational only. This is how long it will take to produce this item if there is zero on hand. The 
total of the longest lead times per operation. This is a free form field, not currently used by 
EnterpriseIQ. It should be noted that EnterpriseIQ calculates a similar value when generating 
the must start dates for work orders, and does not use the value stored here. 

Critical Fence This is an informational only field, used by planners to recognize when they might transform a 
planned work order into a firm work in the MPS module. The MRP engine does not use this 
value. This is a value in days when the status of the MPS item becomes critical. Exception 
messages will appear to alert user to address the order for this item. 

MPS User Name This free form field simply identifies the person interested in this data, and is used only for 
grouping purposes when viewing the results of the MPS evaluation. 
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Manufacturing Load 

In the example above, the same item is made by two different manufacturing configurations, with each 
one being listed under the section Split Manufacturing Load By. There are also three buttons on this 
screen which are used to tell the system how to create the work orders. You may specify the proportion 
to be made from each configuration whenever this item is ordered. Select the configuration and indicate 
the percentage of each order to be made from each configuration. 

Create Work Orders Using Default Manufacturing # 

To create a work order for an item using a single configuration, click on the Default Manufacturing# 
button and then select the configuration to be used in the work order from the arrow down list next to 
the Default Manufacturing# field at the top of the screen. 

Create Work Orders Using Multiple MFG#s Split by Percent 

To create work orders using a multiple configurations split by percent, click on the Percent button. The 
next step is to tell the system how to split the work orders between the configurations. This is done by 
filling in the percentages to be used in the Percent fields associated with each of the configurations. Note 
that the total of the percentages must equal 100 or the system will not create the correct amounts for 
the work orders. 

In the example below, for an order of 10,000 pieces, the system will create one work order for 4,500 
pieces (45 percent of 10,000) using MFG# 103C00B and one work order for 5,500 pieces (55 percent of 
10,000) using MFG# 103-A00B. 
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Create Work Orders Using Multiple MFG#s Split by Threshold 

The use of thresholds for configurations in EnterpriseIQ is based on the premise that there are primary 
and secondary configurations, but that there are limits on the capacity of a configuration. When the 
capacity of a primary configuration is exceeded, then the system will then automatically shift the 
overflow capacity to secondary or even tertiary configurations. As many configurations as necessary can 
be used to handle the capacity. 

The thresholds are based on each sales order and by bucket. For example, you have two BOM's, BOM A 
and BOM B where BOM A is the BOM you can manufacture a limited amount of parts with. For example, 
you can only manufacture 1000 parts on BOM A and the rest need to be manufactured using BOM B. List 
BOM A as the first sequence with a Threshold of 1000 and list BOM B as sequence number 2 with a large 
threshold. 

With a sales order for 5000 parts and one release of 5000 parts. A work order will be created for BOM A 
for 1000 parts and another work order will be created for BOM B for 4000 parts. 

Since this is per sales order then if you had another sales order with the same quantities and release 
date then you would see another 1000 parts added to the BOM A work order and another 4000 parts 
added to the BOM B work order. 

The use of Thresholds also takes into account the bucket size. If the releases are split such that each 
release is for 1000 parts and they are 10 days apart where the manufacturing run size is set to 10 days, 
then all work orders would be created for BOM A 

NOTE: If multiple BOM's make the same item the system can hold a different center cost override for 
each MFG configuration. To adjust the center cost for a specific BOM, select the BOM from the Default 
Manufacturing # list and then go to the Standard Costing tab and enter a value in the Center Cost field. 
Do this for all of the BOM's that have a different center cost. The system will use the correct center cost 
override based on the BOM used. 

Manufacturing Split Information for Child Items 

In situations where split loads are established for items with a "child/parent" relationship the system 
works as follows: 

If the Split Load by threshold for the child is set up you will not see the ‘split’ occur unless the parent WO 
quantity is greater than the child’s threshold quantity.  The system allocates child demand for each 
separate bucket of parent demand. For example, if the parent threshold = 1000 and child threshold = 
500, then for each parent WO of 1000 (BOM 1) you will get two child WOs (Boms A and B) for 500 each. 

Split Load by threshold for the child performs in a straightforward manner when the parent is using one 
default BOM only. 

If the Split Load by percent option is used for the child you will see a work order created for each of the 
alternate child BOMs.  
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Inventory Documents 

The Document option allows an unlimited number of documents to be attached to the inventory item. 
Each inventory item may have its own set of documents.The documents can be associated to the item as 
an Internal or External document. Internal documents use a basic word processor to create these 
documents (notes) or the user can import existing text or graphics. External are documents that reside 
externally to EnterpriseIQ. 

Regardless of whether a document is Internal or External the user can set up a 'Print with' option for it. 
The document will print automatically when the selected form prints. Below is a listing of the 'Print with' 
options in Inventory: 

▪ None 

▪ Packing Slip 

▪ PO 

▪ Sales Order 

▪ Sales Order Acknowledgement 

▪ Invoice 

▪ Inspection Receipt - A document with this option selected will print with the PO Receipt. 

▪ Web - This option will display in WebDirect -> Products -> Search -> list of products -> click on one of 
the item numbers. This is for External documents only. 

▪ Vendor RFQ 

▪ Certificate of Conformance 

▪ Sales Quotation 

▪ All 

Note: If you do not want the document to print with any 'print with' option be sure to select 'None' from 
the drop down list. If left blank the system assumes 'All'. 

Email Correspondence 

In addition to documents there is an Email Correspondence tab. From this tab users can to attach Email 
correspondence related to the item. To add an Email simply drag and drop it from Outlook or other email 
programs into the form. The Received Date will fill in based on the email's received date and time. A 
Received Date box surfaces if the system is unable to determine the date (such as: the Received and Sent 
dates differ, unclear binary data, or older data, etc.). Users are asked to provide the Received Date by 
selecting the correct date from the calendar.  The From and Subject fields will also automatically 
populate with the information from the email. The date, from, and subject fields cannot be edited. A 
comment can be entered by double clicking the field. Enter the comment in the pop up box to further 
describe the email correspondence.  

There are three ways to access the Email once associated to the inventory item:  

▪ Double click on either the Received, From, or Subject fields.  

▪ Right click and select View email.  

▪ Or select the View email button.  
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Note: If the email has attachments, or multiple attachments, the total attachment size cannot be more 
than 4GB. The size allowance might further be limited by the chosen email program used. In order to 
view emails that have attachments, special formatting (e.g. stationary), or images embedded in the body 
of the email, the user must go into BDE Administrator and set the BLOB SIZE to 1000 for the database 
they are using (i.e. IQORA). 

Note: Dragging and dropping from a local workstation to an RDS desktop does not work. Users in this 
environment can drag and drop an email .msg file from a network folder within RDS. 

For information on adding documents see Documents in the Set Up manual. 
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Editing or Deleting Inventory Items 

Editing Inventory Items 

The Item number and Rev can be edited from the main inventory screen. To do this click on the Edit 

button next to the Item # field. A form will appear to enter the new item number and revision. If the 
item is manufactured the BOM will automatically be updated with the new information as well as any 
sales orders and work orders. 

Note: the information in the Rev field can be typed manually or selected from a user defined list. To 
create the list right click on the Rev field and select 'Edit User Defined List'. Select the + button and enter 
the text. (This field is only 15 characters - any additional characters entered will be ignored). 

Deleting Inventory Items 

To delete an inventory item click on the Delete (-) button on the navigator bar. A confirm message will 
appear stating, 'Are you sure you want to delete Inventory Item xxx'. If yes is selected, Inventory items 
can only be deleted if they have zero in inventory, are not attached to a BOM or an operation. The 
system will also check if the item is in the Forecast module. If it exists in the forecast but does not have 
any quantities forecasted it can be deleted. 

Warning messages will appear stating why the item cannot be deleted. For example if the item is 
attached to an operation the warning will state: "This item is associated with a process/operation. 
Remove the item from the process/operation and try again: Process/Operation #: #### Description: 
XXXX Class: OP." 

If the item has inventory the message will state: "There are locations with non-zero quantities for this 
inventory item." 

If Standard Costing is being used, if a user tries to delete an inventory item that is associated to an 
unposted Process WIP PIT transaction a warning message will surface and not allow the user to proceed. 
The user must ensure all PIT transactions for the item being deleted are posted first. 

Note: When deleting an inventory item from the inventory module that is in multiple EPlants, the Price 
Book item and the Price Book price break records will not be deleted until all of the inventory item 
records with the same item number in all EPlants are deleted. 

 
 

Trace in Inventory 

Trace can be set up for inventory items for four areas: Main Inv, AKA, Costing, and Pricing. By right 
clicking anywhere in the inventory module the user can access the trace tables for these areas to 
determine any changes made, what the changes were, who made the change, and when. Security can be 
placed on the trace form. 
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Inventory Speed Buttons 

At the top of the Inventory screen the following speed buttons are available: 

Search - By selecting the drop down arrow next to the Search button the user can access various 
pick lists to quickly find the desired item.  

▪ Search - This brings up the default master inventory pick list. This list has several columns describing 
the items as well as on hand, non-conform, and non-allocate quantities, and native UOM. 

▪ Search User Defined Fields - This brings up a pick list that includes the fields from the User Fields tab. 
Note: Each class of inventory can have it's own UD field labels, depending on what class you are on at 
the time you use this drop down determines what the labels say in the pick list. 

▪ Search AKA Selling - This brings up a pick list that includes these fields: AKA Item#, AKA Description, 
AKA Rev, Customer #, and Customer Name. 

▪ Search AKA Buying - This brings up a pick list that includes these fields: AKA Item#, AKA Description, 
AKA Rev, Vendor #, and Vendor Name. 

▪ User Defined Form - This will access a pick list with the fields from the user defined form associated 
to the inventory class of the item currently open. User Defined form columns with the field kind 
‘query’ and ‘picklist’ will not appear in the user defined form picklist. The name in the search drop 
down list will be the user defined name of the form. For example, if the user defined for for class FG 
is called Inventory Information, when on a FG item and going to pick list the selection will display 
'Inventory Information'. 

▪ The pick list includes a New button to add a new inventory item. If a user with the IQINVENTORY_RO 
role selects the New button they will receive a blank screen. Users should use the ‘Select’ button in 
the pick list and will receive a read-only version of the form. 

▪ The inventory pick list includes the feature 'Component Where Used Search'. This allows users to 
create a query to display parent items that involve all of the listed components. For details refer to 
the Pick Lists section. 

Form/Table toggle - This toggles the module from form to table view. When toggling this form to the 
table view the user will just see one record by default. In order to see more than one item at a time, 
enter a value in the pick list, click scope, click search and select a record.  The items in the scope will 
display in the grid.  If the records in the pick list span more than one class of inventory, when navigating 
to a different class of item, the form view will pop back up. 

Locations and Transactions - This opens the Locations and Transactions form for this inventory item. 

Transaction Log - Opens the transaction log for this inventory item. 

Labels - Opens the Print Label form for this item. See Labels for more information. 

Kanban Control - See Kanban Control for information. 
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On PO / Receive - Shows the Open PO Items form for this item, with jumps to PO and Receiving. 
Select the drop down arrow on this button and select Vendor RMAs. This opens a form listing Vendor 
RMAs associated to the item. From the list users can jump to a Vendor RMA or Vendor Maintenance. 

Sales Order Activity - Select this button to view the item’s sales order activity. From the drop down 
next to this button users can access Work Orders and Customer RMAs. Note: When the Work Order 
Information form is viewed from the Master Inventory Record, only work orders for the default BOM will 
appear on the list. See Sales Order Activity for details. 

PO History - Select this option to view the purchase order history for this item. The PO History form 
will appear displaying the PO details such as: PO #, Price, and Received Date information. 

Alternate Items - This table is used to store a list of other items that can be used instead of the 
parent item. Please see Alternate Items for more information. 

RealTime Work Order History - For Manufactured Items only the user can view the RealTime™ work 
order history for the item. The form displays information regarding work orders for the specified item 
that includes: total up hours, total cycles, total down hours, average cycle, work order quantity, total 
floor dispositioned quantity, FG lot number, and many more. 

User Defined Form - To set up the form see User Defined Forms in the Common Form Functions 
section of the Using EnterpriseIQ manual. 

Process Cost - This applies to manufactured inventory. This will display Process Cost information by 
work order for the item. See Introduction to Process Costing for details on this module. 

Edit WebDirect B2C - For users licensed for the WebDirect B2C module, on items with the 'Ok for Sale 
on Web' option checked, this button will be visible. This will provide users the ability to access the 'Edit 
Product Detail' page within an embedded web browser. 

Edit Physical Characteristics - For users with the Slitting MFG Type set up, this speed button will be 
available to enter the physical characteristics, including Outside Diameter, Core size, Width, SPG, 
Volume, and Gauge of the item. (See Slitting for details). 

 Add/Edit Bulletin(s) - Select this button to create messages relevant to a inventory item (as well as 
EPlant, Work Center, Customer, and BOM) that can be seen in Scheduling, RealTime™ (Individual Center 
Info), and ShopData (RT Work Center). See Bulletin Board Editor for details. 

EIQ Bookmark - This option allows the user to drag and drop the icon onto the desktop or a folder in 
order to open the exact Inventory item up again with one click. Select the EIQ Bookmark button then 
drag it to the desktop or folder and drop it. The shortcut will be named INVENTORY_id#.eiq by default. 
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Sales Order Activity 

Sales Order Activity - Select this button to view the item’s sales order activity. 
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This form will display the open and archived sales orders associated to the inventory item. Right click 
jumps are available to the Customer, Inventory, and Sales Order. Users can also right click and select 
Shipments and Work Order Info. The table is color codes as follows:  

▪ Gray -  Archived Sales Orders. 

▪ Green - Shipped Sales Orders. When a release is shipped, the system will populate the date in the 
Ship Date field visible on this form. 

▪ Purple - Not Shipped Sales Orders 

▪ Yellow - Partially shipped Sales Orders. 

Sales Orders can be sorted by any column by clicking on the column or by right clicking in the 
information grid. The filter button can be used to filter the results of the form based on: Class, Company 
Name, Cust #, Item #, Item Description, Order #, PO #, Rev, and Status. 

Security can be placed on this form. There is also security just for the Unit Price column. 

Work Orders 

From the drop down list on the Sales Order Activity button select Work Order to access the Work Orders 
Information form for the item. This is the same option available from the bottom section of a sales order. 
See Sales Order Release Section - Right Click Options for more details. 
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Customer RMA 

Select this to access Customer RMAs associated to the item. A list of RMAs will appear. Users can right 
click and jump to the RMA or Customer Maintenance. 
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Bulletin Board Editor 

Select the Add/Edit Bulletin(s) button  to create messages relevant to a inventory item (as well as 
EPlant, Work Center, Customer, and BOM) that can be seen in Scheduling, RealTime™ (Individual Center 
Info), and ShopData (RT Work Center).  

The Bulletin Board Editor will display. 
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Select the Source from the drop down list. Then select the ellipsis button to access the corresponding 
pick list, i.e. BOMs, Work Centers, etc. Select the ellipsis button in the Message field to enter a message. 
The Date and User fields will populate automatically with the date/time the message was created and 
the logged in user name. These fields cannot be manually changed. 

A Bulletin Board can be accessed by selecting the Show/Hide Bulletin Board button  in the modules 
that have this feature (i.e. Scheduling). The bulletin board will display messages associated to the EPlant, 
Work Center, BOM, Inventory Item, and Customer if relevant to the current work center. The number of 
Bulletins will display at the top. The messages will be bold until marked read. Select the blue source 
header or the text to mark it as read. Select the 'Read All' button to mark all the messages as read. 
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Note: This requires the IIS Server to be setup and the information populated in System Parameters-
>Company File Information tab->Web tab for the Bulletin Board to be available. Please see the IIS 
Installation TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf for more 
information. 

The Add/Edit Bulletin(s) button is also available in Customer Maintenance, Inventory, ShopData, and 
RealTime™. 

 

 
 

Kanban Control 

  

Kanban is a scheduling system that helps determine what to produce, when to produce it, and how much 
to produce.  Kanban cards are a key component of Kanban that uses cards to signal the need to move 
materials within a production facility or move materials from an outside supplier to the production 
facility.  The Kanban card is, in effect, a message that signals depletion of inventory that when received 
will trigger the replenishment of that inventory. Consumption drives demand for more. Demand for 
more is signaled by Kanban card. 

Note: This is different than EnterpriseIQ eKanban which is an automated system that does not use 
physical Kanban cards.  eKanban (Auto MRP) is a triggered pull system but not a physical system like 
Kanban. 

 
 

https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf
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Kanban for Purchased Items 

 

Kanban Control Top Section Field Listing for Purchased Items:  

Card Count This field is the default card count. This is calculated by the system as follows:  

Default Card Count calculation for Purchased Items: 

[Average Daily Demand * (Lead Days + Collection Wait Time) (1 + Safety Stock Percent)] / Std 
Container Capacity 

Collection Wait 
Time 

The number of days for collection wait time. This is added to the Lead Days in the 
Recommended Card Count calculation. 

Daily Demand This is calculated as follows: 

Purchased Items = (Total amount of projected material requirements / Schedule Scope in days) 

This field is editable to allow the user to override the calculated daily demand. 

Division If desired, select the division to be associated with the Kanban Control record from the drop 
down list. 

Firm Demand If this option is unchecked, the daily demand will be overwritten with the Planned Daily 
Demand each time the Kanban is calculated. 

Formula Name The Kanban card formula assigned to the Kanban Control record. 

ID ID of the Kanban Control record. 
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Lead Time The number of lead days associated to the item. This defaults to the lead days associated to 
the item (Inventory->General tab). If the Lead Time is not populated the user will receive a 
warning when attempting to calculate. 

Planned Daily 
Demand 

The calculated daily demand. 

PO # The purchase order number associated to the Kanban Control record. The system will 
automatically add releases to this PO when a Kanban card is scanned and marked as ‘On 
Order’.  

To associate a PO, select the ellipsis button or right click and select ‘Assign PO’. The pick list of 
PO’s will appear. Select an existing PO from the list or select the New button to create a new 
PO. 

Once assigned the user can jump to the PO by right clicking and selecting ‘Jump to PO’. 

The PO pick list only displays POs in the logged in EPlant.  In order to do centralized 
purchasing, the user must be logged in as View All.    

Note: The line item on the PO is not automatically marked closed by the system during 
receiving. Also, a PO linked to a Kanban Control record cannot be archived or deleted. If 
attempted the user will receive an error stating:  

Master has detail records. Cannot delete or modify. ORA-02292: integrity constraint 
(IQMS.FK_KB_CONTR_REF_19436_PO_DETAI) violated - child record found Master table: 
PO_DETAIL Child table: KB_CONTROL Cannot archive or delete PO linked to Kanban Control. 
Update Kanban Control by removing link to PO and try again. 

Replenishment 
Signal 

The number of Kanban cards ‘Pending Accumulation’ before creating the PO release or Manual 
WO (depending on the type of inventory – purchased or manufactured). For example, if the 
Replenishment signal is 3 the system will wait until there are 3 Kanban cards that are status 
"Pending Accumulation" before placing the PO release or Manual WO (depending on the type 
of inventory (purchased or manufactured). 

Safety % The percentage increase in the number of Kanbans used as a precautionary measure for buffer 
inventories. 

Standard 
Container 
Capacity 

This value will defaults to the ‘Multiples Of’ value associated to the item (Inventory->General 
tab) but can be overridden. If this field is not populated the user will receive a warning when 
attempting to calculate. 
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Top right grid Fields 

▪ Demand Period - Run scope of the Heijunka family.  The user can change the demand period by 
selecting the ellipsis button in this field. 

▪ Source – The source of the Demand Period – either Kanban or Heijunka 

▪ Recalc on Update Sched - If this option is checked, the system will recalculate the average daily 
demand and recommended card count during update schedule. 

▪ Formula Name - The Kanban card formula assigned to the Kanban Control record.  If left blank, the 
system uses the default Kanban card formula. 

 Other options 

▪ Calculate Average Demand, Assign Standard Container Capacity and Lead Days button –  Calculates 
the Card Count and Average Demand, assigns the Standard Container Capacity and Lead Days 

To calculate the recommended cards select the Insert (+) button in the top section. Enter the Safety % 
and Collection Wait Time if desired. Save the entry and then select the Calculator speed button. The 
system will then calculate the average daily demand and the recommended card count. 

Purchased Item Example using default calculation and the information below: 

Lead Days = 5 

Standard Container = 100 

Safety % = 20 

Collection Wait Time = 3 

Schedule Scope - 140 days 

Total projected material requirements = 6861.93 
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Average Daily Demand is calculated as follows: 

(Total amount of projected material requirements / Schedule Scope in days) 

6861.93 / 140 = 49.01 

Recommended Card Count is calculated as follows: 

[Average Daily Demand * (Lead Days + Collection Wait Time) (1 + Safety Stock Percent)] / Std Container 
Capacity 

[49.01 x (5 + 3) x (1 + 0.2)] / 100 = 4.70 (rounds up to 5) 

To access these options select the drop down next to the calculator button: 

▪ Assign Kanban Card Formula – allows the user to assign a defined Kanban card count formula. 

▪ Define Kanban Formula – This option allows Power Users or DBAs to create a user defined Kanban 
card formula.  (Important! -  :ID and :RESULT MUST be included in the formula.  These are 
mandatory parameters). 

Example defined Kanban formula: 

declare 

  v_kb_control_id number:= :id; 

  v_kb         kb_control%rowtype; 

  v_days       number; 

  v_card_count number; 

begin 

  select * into v_kb from kb_control where id = v_kb_control_id; 

  if v_kb.container_qty = 0 then 

    v_kb.card_count:= 0; 

  else 

    v_days:= nvl(v_kb.replenishment_time,0) / 60 / v_kb.daily_prod_hrs  + nvl(v_kb.wait_days,0); 

    v_card_count:= (v_kb.daily_demand * v_days * ( 1 + nvl(v_kb.safety_percent,0)/100 )) /  
v_kb.container_qty; 

    v_kb.card_count:= trunc(v_card_count + 0.999999); 

  end if; 
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  :result:= v_kb.card_count;  

end; 

▪ Recalc Kanban Card - Calculates the Average Demand, assigns the Standard Container Capacity and 
Lead Days 

Create Kanban Cards 

To create KanBan cards select the Insert (+) button in the lower portion of the screen. Continue this 
process to create the recommended card count quantity. Each KanBan card will be assigned a unique 
card number which is used in RF Scanning. Select the Print button to print each card. (The report used is 
assigned in System Parameters->Reports and Forms). These cards are attached to the container of 
material. 

Kanban Cards Grid 

▪ Cards – Displays whether the card is in the Kanban Rack or Inventory. 

▪ Status – When Kanban cards are first created, the status of the cards are inactive.  The status of the 
cards can be changed either manually or through IQRF/WMSIQ.  The status can be either On Hand, 
On Order, or Pending Accumulation.  As the status is changed the color code is changed and the 
card moves back and forth between the Kanban rack and Inventory. Green indicates on hand status, 
yellow indicates on order status, and blue indicates pending accumulation. 

Note: The status can be changed manually within this form but when done this way it will not update 
the PO releases, therefore it is not recommended. Use IQRF or double click the card.   
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▪ Last User ID – the last user ID when the Kanban card’s status is changed. 

▪ Card # - The card number. 

▪ Additional fields for Serialized items:  Serial #, Location, Qty, Lot #, and Inventory Status. 

Using Kanban Control 

For purchased items, scanning a Kanban card tells the system to place a release on the associated 
purchase order (PO). The PO can be sent to the vendor manually or eServer can be used to send the 
information as an outgoing EDI. The receiving process for Kanban controlled items is identical to that of 
all purchased items except an additional step must be performed. During receiving of a Kanban release 
an ‘On Order’ Kanban card must be scanned or double clicked on to convert it to an ‘On Hand’ Kanban 
card and then the card is manually affixed to the container. 

Example:  

The initial ‘On Hand’ quantity is equal to 5 gaylords. As soon as a gaylord is opened the Kanban card is 
removed and scanned. The status is changed to ‘On Order’. This adds a release to the PO and the 
supplier is notified to ship another gaylord of material. When the gaylord is received a PO receipt is 
created adding the gaylord to the on hand inventory and then the Kanban card is scanned marking the 
status to ‘On Hand’. Assuming that supplier lead times and average daily demand remain constant over 
time the pattern of having 4-5 gaylords on order, 1-2 gaylords on hand with one gaylord being consumed 
starts to repeat itself. If average daily demand were to decrease the frequency of signals to the supplier 
would also decrease causing a higher amount of material on order to move to on hand. To correct this 
situation the user will need to recalculate the number of Kanban cards needed and remove cards to 
reduce your total inventory of material on order and on hand. If the average daily demand were to 
increase the frequency of signals to the supplier would increase causing a higher amount of material on 
order and less to be available on hand. To correct this situation the user should recalculate the number 
of Kanban cards needed and add cards to increase the total inventory of material on order and on hand. 

Non Serialized Inventory Control (SIC) Items: 

When a Kanban card is created for a non-SIC item, the card is inactive and displayed in white.   

➢ Changing the status manually - Manual status changes are not recommended. When the status 

of the card is manually changed to ‘On Order’, the card turns yellow and no release is added 
to the PO.  When the status of the card is manually changed to ‘On Hand’, the card turns 
green, moves to the Inventory column, and the item is not received into inventory.   

➢ Using RF - When the card is scanned through RF to ‘On Order’, the card turns yellow and the 

system adds a release to the associated PO.  The receiving process for Kanban controlled 
items is identical to that of all purchased items except an additional step must be performed.  

The card is scanned through RF to ‘On Hand’, the card turns green, moves to the Inventory 
column, and the item is not received into inventory (Item was already received through the 
receiving process).   
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➢ Double clicking on the card - When double clicking on a card in the Kanban rack, the user can 

receive into inventory by reporting good parts.  The card turns green, moves to the 
Inventory column, and the item is received into inventory.  When double clicking on a green 

card, the confirmation ‘Relieve Inventory and return Kanban Card to Rack? appears.  When 
choosing Yes, the card turns yellow, moves to the Kanban Rack, and the status of the card 
changes to ‘On Order’.  A release is added to the PO. 

Serialized Inventory Control (SIC) Items: 

When a Kanban card is created for a SIC item, the card is inactive and displayed in yellow. 

➢ Manual - The status cannot be changed manually. 

➢ Using RF - When the card is scanned through RF to ‘On Order’, the card turns yellow and the 

system adds a release to the associated PO.  The receiving process for Kanban controlled 
items is identical to that of all purchased items except an additional step must be performed.  

The card is scanned through RF to ‘On Hand’, the card turns green, moves to the Inventory 
column, and the item is not received into inventory (Item was already received through the 
receiving process).   

➢ Double clicking on the card - When double clicking on a card in the Kanban rack, the user can 

select an existing serial # to receive into inventory.  The card turns green, moves to the 

Inventory column, and the item is received into inventory.  When double clicking on a green 
card, the confirmation ‘Relieve Inventory and return Kanban Card to Rack? appears.  When 
choosing Yes, the card turns yellow, moves to the Kanban Rack, and the item is relieved 
from inventory.  A release is added to the PO. 

Kanban Card Speed buttons 

▪ Print Card(s) – Allows the user to print the cards. 

▪ Assign label to the kanban card – For SIC items, if a kanban card is yellow users can assign a serial 
number that is already in inventory but not assigned to a Kanban card by selecting the 'Assign 

Label...' button . This will bring up a pick list of un-assigned serial numbers associated to the 
item. After selecting a serial, the card will turn green (status will be on hand). 

Report Production 

Top Section Fields: 

▪ Pacemaker – only applicable for MFG items 

▪ Item # - Displays the Item #, Description, Ext. Description, Class, Rev, and UOM of the item. 

▪ Backflush – only applicable for MFG items 
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▪ Enter Quantity tab – only appears for non-SIC items.  Enter the Good Parts to receive into inventory 
and the lot # 

▪ Scan Serial – Allows the user to select an existing serial # to receive into inventory. 

▪ Print Labels – only applicable for MFG items 

The Enter Quantity tab will only be visible for non-serialized items. To report production enter a quantity 
in the Good Parts field, and enter a lot number if applicable. A Manual/Backflush In transaction will occur 
for the quantity of good parts entered. The Backflush check box will be checked if the 'Scanner Print 
Label/Backflush' check box is checked for the item in Kanban Control in EIQ. It cannot be check or un-
checked from this form. 

Scan Serial  tab is available to both SIC and Non-SIC items.  When reporting from the Kanban form the 
user can select the search button to access the pick list of all SN#s for this item that have not been 
dispositioned.  A Manual/Backflush In transaction will occur for the quantity associated to the serial 
number. 
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Kanban for Manufactured Items 

 

Kanban Control Top Section Field Listing for Manufactured Items:  

Card Count This field is the default card count. This is calculated by the system as follows:  

Default Card Count calculation for Manufactured items: 

[Average Daily Demand * Replenishment Time (converted to days) + Collection Wait Time) 
(1+Safety Stock Percent)] / Std Container Capacity  

(Note: when the replenishment time is converted to days, the system uses production hours 
per day for that MFG Cell). 

Collection Wait 
Time 

The number of days for collection wait time. This is added to the Lead Days in the 
Recommended Card Count calculation. 

Daily Demand The average daily demand from the Daily Usage tables. This will be based on the division or 
manufacturing cell if applicable. This is calculated as follows: 

Manufactured Items = (Total of all WO qty in the scheduling scope / Scheduling Scope – non 
working days) 

This field is editable to allow the user to override the calculated daily demand. 

Division If desired, select the division to be associated with the Kanban Control record from the drop 
down list. 
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Firm Demand If this option is unchecked, the daily demand will be overwritten with the Planned Daily 
Demand each time the Kanban is calculated. 

Formula Name The Kanban card formula assigned to the Kanban Control record. 

ID ID of the Kanban Control record. 

 

Mfg Cell 

For Manufactured items this field cannot be edited. It will be populated with the Mfg Cell 
based on the Pacemaker information.  

Planned Daily 
Demand 

The calculated daily demand. 

Replenishment 
Signal 

The number of Kanban cards ‘Pending Accumulation’ before creating the PO release or Manual 
WO (depending on the type of inventory – purchased or manufactured). For example, if the 
Replenishment signal is 3 the system will wait until there are 3 Kanban cards that are status 
"Pending Accumulation" before placing the PO release or Manual WO (depending on the type 
of inventory (purchased or manufactured). 

Safety % The percentage increase in the number of kanbans used as a precautionary measure for buffer 
inventories. 

Standard 
Container 
Capacity 

This value will defaults to the ‘Multiples Of’ value associated to the item (Inventory->General 
tab) but can be overridden. 

For a manufactured item, this value is calculated using the ‘Selling Multiples Of’ field.   

Right Click Options in upper left grid: 

▪ Calculate Replenishment Time 

▪ Show Demand - This will how all the sales order details for all the work orders involved in the daily 
average demand. 

▪ Jump to Pacemaker Source - This will jump to the BOM or process depending on what the pacemaker 
source is. 

 

Top Right Grid Field Listing: 

Demand Period  Run scope of the Heijunka family.  The user can manually change the demand period. 

▪ Source – The source of the Demand Period – either Kanban or Heijunka 

Formula Name The Kanban card formula assigned to the Kanban Control record.  If left blank, the system 
uses the default Kanban card formula. 

Pacemaker  The process or Mfg# that you schedule. 

▪ Source – Source of the Pacemaker – either BOM or Process 

▪ Status - This may be populated during calculation and displays information if there is 
something wrong (missing data, cycle time greater than the calculated takt time, etc…) 

Pitch Time (min) The time to produce the Standard Container Capacity. (Takt Time * Standard Container 
Capacity). 
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Recalc On 
Update Sched 

If this option is checked, the system will recalculate the average daily demand and 
recommended card count during update schedule. 

Replenishment 
Time (min) 

This column is used as the "Lead Time" in the Kanban # or cards calculation. It is calculated or 
can be entered manually. To have the system calculate this value, right click and select 'Calc 
Replenishment Time'. 

Calculation of Replenishment Time: 

All MFG Types except ASSY 1,2 & 3: 

[Cycle time (in hours) * Std Container Size * Replenishment Signal + Setup time in hours] * 60 

For ASSY 1,2 & 3: 

[Sum(all processes hrs required for one item) * Std Container Size * Replenishment Signal + 
Setup time in hours] * 60 

Scanner Print 
Label/ Backflush 

If this option is unchecked, when scanning a card to ‘On Hand’, the card status will change to 
‘On Hand’ and be colored coded Green.  If this option is checked, when scanning a card to 
‘On Hand’, the system will print a label, disposition the parts into inventory, and backflush 
material/components.  The card status will change to ‘On Hand’ and be colored coded Green. 

Takt Time (min) The maximum allowable time needed to produce one unit in order to meet customer demand. 
(Daily Hours / Average Daily Demand)  * 60 
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 Other options 

▪ Calculate Average Demand, Assign Standard Container Capacity and Lead Days button – Calculates the 
Card Count and Average Demand, assigns the Standard Container Capacity and Lead Days 

Manufactured (ASSY) Item Example using the default calculation and the information below: 

Standard Container Capacity= 500 

Schedule Scope = 130 

Safety % = 98% 

Collection Wait Time = 2  

Replenishment Signal = 1  

Process Information = Process 1: Cycle time is 90 minutes, multiples of is 10, Yield is 100%, setup hrs of 1. 
Process 2: Cycle time is 75 minutes, multiples of is 50, Yield is 97%. 

Average Daily 
Demand 

Manufactured Items = (Total of all WO qty in the scheduling scope / Scheduling Scope – 
non working days) 

2000 / 130  

Replenishment 
Time (in minutes) 

Calculation of Replenishment Time For ASSY 1,2 & 3: 

[Sum(all processes hrs required for one item) * Std Container Size * Replenishment Signal 
+ Setup time in hours] * 60 

[((90/60) / 10) + (((75/60) / 50) / 0.97) * 500 * 1 + 1] * 60 

= [0.1757732 * 500* 1 + 1] * 60 

= 5333.2 

Converted to days = 5333.2 * 0.000694444444  = 3.7 

Card Count Default Card Count calculation for Manufactured items: 

[Average Daily Demand * Replenishment Time (converted to days) + Collection Wait 
Time) (1+Safety Stock Percent)] / Std Container Capacity  

(Note: when the replenishment time is converted to days, the system uses production 
hours per day for that mfg cell). 

 

▪ Assign Kanban Card Formula – allows the user to assign a defined Kanban card count formula. 
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▪ Define Kanban Formula – This option allows Power Users or DBAs to create a user defined Kanban 
card formula.  (Important! -  :ID and :RESULT MUST be included in the formula.  These are 
mandatory parameters). 

Example defined Kanban formula: 

declare 

  v_kb_control_id number:= :id; 

  v_kb         kb_control%rowtype; 

  v_days       number; 

  v_card_count number; 

begin 

  select * into v_kb from kb_control where id = v_kb_control_id; 

  if v_kb.container_qty = 0 then 

    v_kb.card_count:= 0; 

  else 

    v_days:= nvl(v_kb.replenishment_time,0) / 60 / v_kb.daily_prod_hrs  + nvl(v_kb.wait_days,0); 

    v_card_count:= (v_kb.daily_demand * v_days * ( 1 + nvl(v_kb.safety_percent,0)/100 )) /  
v_kb.container_qty; 

    v_kb.card_count:= trunc(v_card_count + 0.999999); 

  end if; 

  :result:= v_kb.card_count;  

end; 

▪ Recalc Kanban Card - Calculates the Average Demand, assigns the Standard Container Capacity and 
Lead Days. 

Kanban Cards 

The lower section of the Kanban form displays the Kanban cards. The screen shot below shows the fields 
when the item is marked as a serialized inventory control item. Non-serialized items will not have the 
Serial #, Location, Qty, Lot #, or Inventory Status fields. 
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To create Kanban cards select the Insert (+) button in the lower portion of the screen. Continue this 
process to create the recommended card count quantity. Each Kanban card will be assigned a unique 
card number which is used in RF Scanning. Select the Print button to print each card. (The report used is 
assigned in System Parameters->Reports and Forms). These cards are attached to the container of 
material. When first created the status of the cards are inactive. The status of the cards are changed 
using IQRF. The status can be either On Hand or On Order. As the status is changed the color code is 
changed on this form. Green indicates on hand status and yellow indicates on order status. The user 
name of the person who last changed the status will populate in the Last User ID field. 

Kanban Cards Grid 

▪ Cards – Displays whether the card is in the Kanban Rack or Inventory. 

▪ Status – When Kanban cards are first created, the status of the cards are inactive.  The status of the 
cards can be changed either manually or through IQRF/WMSIQ.  The status can be either On Hand, 
On Order, or Pending Accumulation.  As the status is changed the color code is changed and the 
card moves back and forth between the Kanban rack and Inventory. Green indicates on hand status, 
yellow indicates on order status, and blue indicates pending accumulation. 

Note: The status can be changed manually within this form but when done this way it will not update 
the PO releases, therefore it is not recommended. Only use IQRF.   



Inventory Management Page 120 of 478 

 

▪ Last User ID – the last user ID when the Kanban card’s status is changed. 

▪ Card # - The card number. 

▪ Additional fields for Serialized items:  Serial #, Location, Qty, Lot #, and Inventory Status. 

Kanban Card Speed buttons 

▪ Print Card(s) – Allows the user to print the cards. 

▪ Assign label to the kanban card – Allows the user to assign an existing label to a kanban card. 

Using Kanban Control 

For manufactured items the system works similar to that of purchased items. The lead days is required 
as it may be used in the user defined calculations for kanban cards, and optionally any of the other fields 
that are applicable such as Safety %. The main difference between purchased and manufactured items is 
when changing the status of a Kanban card to ‘on order’, instead of creating a release on a PO, the 
system will immediately create a FIRM Manual work order. 

As containers of manufactured items are completed the Kanban card must be scanned to convert it to an 
‘On Hand’ Kanban card and affixed to the container. Updating the actual on hand quantity in inventory is 
handled identically to that of any other manufactured item using production reporting or scanning. The 
manual work order is then deleted. 

Notes:  

Setup time must be configured for manufactured items in order for the system to determine the change 
up time between items. 

Lead days is not currently used in the default calculation for kanban cards, but it is required as it may be 
used in the user defined calculations. 

Non Serialized Inventory Control (SIC) Items: 

When a Kanban card is created for a non-SIC item, the card is inactive and displayed in white.   

➢ Changing the status manually - When the status of the card is manually changed to ‘On Order’, 

the card turns yellow and no firm manual work order is created.  When the status of the 
card is manually changed to ‘On Hand’, the card turns green, moves to the Inventory 
column, and the item is not dispositioned into inventory.   

➢ Using RF - When the card is scanned through RF to ‘On Order’, the card turns yellow and the 
system creates a FIRM manual work order.  As containers of manufactured items are 
completed, the Kanban card must be scanned to convert it to an ‘On Hand’ Kanban card and 

affixed to the container.  If the 'Scanner Print Label/ Backflush' option on the Kanban 
Control form is unchecked, when scanning a card to ‘On Hand’, the card status will change 
to ‘On Hand’ and be colored coded Green, moves to the Inventory column, and the item is 

not dispositioned into inventory (Item was already dispositioned through the production 
reporting or scanning). If this option is checked, when scanning a card to ‘On Hand’, the 
system will print a label, disposition the parts into inventory, and backflush 

material/components. The card status will change to ‘On Hand’ and be colored coded Green. 
The manual work order is then deleted.   
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➢ Double clicking on the card - When double clicking on a card in the Kanban rack, the user 

can disposition into inventory by reporting good parts, selecting an existing serial number, or 
printing a label.  The card turns green, moves to the Inventory column, and the item is 
dispositioned into inventory.  When double clicking on a green card, the confirmation 

‘Relieve Inventory and return Kanban Card to Rack? appears.  When choosing Yes, the card 
turns yellow, moves to the Kanban Rack, and the status of the card changes to ‘On Order’.  
No FIRM manual work order is created. 

➢ When a Kanban card is created for a SIC item, the card is inactive and displayed in yellow. 

▪ The status cannot be changed manually. 

▪ Using RF - When the card is scanned through RF to ‘On Order’, the card turns yellow and the system 
adds a release to the associated PO. The receiving process for Kanban controlled items is identical to 
that of all purchased items except an additional step must be performed. The card is scanned 
through RF to ‘On Hand’, the card turns green, moves to the Inventory column, and the item is not 
received into inventory (Item was already received through the receiving process). 

▪ Double clicking on the card - When double clicking on a card in the Kanban rack, the user can select 
an existing serial # to receive into inventory. The card turns green, moves to the Inventory column, 
and the item is received into inventory. When double clicking on a green card, the confirmation 
‘Relieve Inventory and return Kanban Card to Rack? appears. When choosing Yes, the card turns 
yellow, moves to the Kanban Rack, and the item is relieved from inventory. A release is added to the 
PO. 

Report Production 

Top Section Fields: 

▪ Pacemaker – only applicable for MFG items 

▪ Item # - Displays the Item #, Description, Ext. Description, Class, Rev, and UOM of the item. 

▪ Backflush – only applicable for MFG items 

Production can be reported from the Kanban form for manufactured items. If a card is yellow users can 
double click on the card to access the Report Production form.  

The Enter Quantity tab only appears for non-SIC items and ASSY1 manufactured SIC items.   To report 
production enter a quantity in the Good Parts field, and enter a lot number if applicable. A 
Manual/Backflush In transaction will occur for the quantity of good parts entered. The Backflush check 
box will be checked if the 'Scanner Print Label/Backflush' check box is checked for the item in Kanban 
Control in EIQ. It cannot be check or un-checked from this form. 

Scan Serial  tab is available to both SIC and Non-SIC items.  When reporting from the Kanban form the 
user can select the search button to access the pick list of all SN#s for this item that have not been 
dispositioned.  A Manual/Backflush In transaction will occur for the quantity associated to the serial 
number. This tab does not appear for ASSY1 manufactured SIC items. 
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Print Labels tab  

This allows the user to print a label to disposition into inventory.  This tab does not appear for ASSY1 
manufactured SIC items. The Box Quantity will default to the Standard Container Capacity but can be 
changed. The Labels quantity defaults to one and cannot be changed. The default information will 
populate in the other fields as with all labels. Make any necessary changes on the General tab or User-
Defined tab and select the OK button to print the label. A Manual/Backflush In transaction will occur for 
the quantity associated to the label. 

 

Additional Options for Serialized Items 

If a kanban card is yellow users can assign a serial number that is already in inventory but not assigned to 

a Kanban card by selecting the 'Assign Label...' button . This will bring up a pick list of un-assigned 
serial numbers associated to the item. After selecting a serial, the card will turn green (status will be on 
hand). 

Relieve Inventory - If the user double clicks on a green card for a Serialized Item a confirmation box will 
appear stating, " About to relieve inventory and return Kanban card to rack". After selecting OK, the 
system will relieve the inventory of that SN by the SN quantity. A Manual/Backflush Out transaction will 
occur, and the card will be changed to On Order (yellow) status. 
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Heijunka Box Load Leveling 

Heijunka is a Japanese term that refers to the overall leveling, in the production schedule, of the volume 
and variety of items produced in given time periods. Heijunka is what most lean companies are working 
towards as they try to be able to make just what the customer wants in the time or when the customer 
wants it. In Heijunka, the company is trying to do two things. One is to level production by volume and 
the other is to level the production by product type or mix of products. Heijunka takes the total volume 
of orders in a period and levels them out so the same amount and mix are being made each day. In 
short, what you are trying to do is to build a level schedule everyday by taking the actual customer 
demand, determine the pattern of volume and mix, and building your level schedule. 

A tool used to help level both the mix and volume of production is a Heijunka box. A Heijunka box is 
basically a Mfg Cell, so there can be only one Heijunka box per Mfg Cell. A Heijunka box has a column of 
kanban slots for each pitch interval, and a row of kanban slots for each product type.  Kanban are 
placed into the leveling box in the desired mix sequence by product type. 

Note: The Heijunka cards are based on manufacturing demand which is different than the Kanban cards 
which control how much inventory you have on hand for purchased and manufactured items. 

To enable Heijunka scheduling, check the ‘Heijunka/KanBan Scheduling’ option in System Parameters > 
Application tab.  Once this option is checked, the user will need to log out of EnterpriseIQ and log back 
in to see the Heijunka Box icon on the Manufacturing tab.  The Heijunka Box icon will also be available 
in ShopData and AssemblyData. 

Heijunka Box 

 

 

Field Information: 
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Name Enter a name of the Heijunka Box. 

Description Enter a description of the Heijunka Box 

Mfg Cell Select the Mfg Cell of the Heijunka Box. Note: There can be only one Heijunka box per 
Mfg Cell. 

Work Center Type Select the work center type of the Heijunka Box. 

Demand Period The Run scope of the Heijunka family.  The Mfg # run scope must be equal to the 
Heijunka run scope.  Once a BOM is part of a Heijunka family, the run scope on the BOM 
cannot be changed.  

EPEI Every Product Every Interval - The smallest possible lot size for a part in a process is a 
reflection of the “production interval” or “EPEI”. This interval defines the maximum 
frequency that you can produce each part without running out of capacity because of too 
many setups on all parts. It is an expression of how frequently each item produced in a 
process can actually be run without incurring a capacity penalty.  This value is calculated 
or a user defined EPEI formula can be created and assigned. 

Formula Name - The EPEI formula assigned to the Heijunka Box.  If left blank, the system 
uses the default EPEI formula 

Define EPEI Formula – This option (accessed from the File menu) allows Power Users or 
DBAs to create a user defined EPEI formula. Each Heijunka Cell can have it’s own EPEI 
calculations.  (Important!  :ID and :RESULT MUST be included in the formula.  These 
are mandatory parameters). 

EPEI Stats: 

▪ Last Recalc - Last date/time EPEI calculated 

▪ Daily Avail (min) - Minutes available in the productions 

▪ Daily Load (min) - Average daily demand in minutes. 

▪ Daily Setup (min) - Daily setup minutes 

▪ EPEI 

▪ # Change Over - How many times you change the item in the given period. (Calculated: Daily 
Avail - Daily Load / Daily Setup) 
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Fixed Pitch The frequency at which finished goods are withdrawn from a pacemaker process as well 
as the corresponding amount of schedule released to that process. 

The default formula for Fixed Pitch = (Std Container Capacity * longest cycle time of the 
items) * 3 

Formula Name – The Fixed Pitch formula assigned to the Heijunka Box.  If left blank, the 
system uses the default Fixed Pitch formula. 

A user defined calculation can be created to override the default. Select 'Define Fixed 
Pitch Formula' from the File menu to create a user defined formula. (:ID and :RESULT 
MUST be included in the formula.  These are mandatory parameters). 

Speed buttons 

▪ Start Monitor - This will start the monitor in order for users to see the progress of completed cards. 
As production is reported the completed intervals will be removed so users will be able to see what 
needs to be produced next. No edits can be made to the fields when the monitor is running. 

▪ Stop Monitor - This stops the monitor. 

▪ Recalculate Heijunka Box - This button will generate the EPEI and Pitch intervals in the Heijunka Box 

Details Tab 

The Details tab will display all of the Kanban items tied to the MFG Cell only.  If the MFG Cells are the 
same, then all items for that MFG Cell will be displayed (regardless of center type). It includes the item 
information and the details from Kanban Control. 

Item #  Item number  

Item Description Description of the item 

Item Ext 
Description 

Extended description of the item 

Pacemaker  How you control production at this point sets the pace for all the upstream processes. 

▪ Process #/Mfg # - The process # or Mfg # of the pacemaker 

▪ Description- Description of the process or Mfg # 

Cycle Time (sec)  Cycle time of the process/mfg # 

Setup Hrs  Setup hrs of the process/mfg # 

Scrap  Yield % from the process or Scrap % from the mfg # 

Takt Time (min)  The takt time from Kanban Control.  The maximum allowable time needed to produce one 
unit in order to meet customer demand. (Daily Hours / Average Daily Demand) * 60 

Pitch Time (min)  The pitch time from Kanban Control.  The time to produce the Standard Container Capacity. 
(Takt Time * Standard Container Capacity) 

Daily Demand  The daily demand from Kanban Control.  (Total of all WO qty in the scheduling scope / 
Scheduling Scope – non working days).  This field is editable to allow the user to override 
the daily demand. 
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Firm Demand  If this option is unchecked, the daily demand will be overwritten with the Planned Daily 
Demand each time the Kanban is calculated. 

Std Container 
Capacity 

The standard container capacity from Kanban Control.   

Replenishment 
Time (min)  

The replenishment time from Kanban Control. 

KanBan Formula 
Name  

The KanBan card formula assigned to the item.  If left blank, the system uses the default 
Kanban card formula. 

Ratio  The ratio of cards compared to the other items in the Heijunka Box. 

EPEI Run Size Quantity of parts to produce within the EPEI time. 

Recalc Kanban 
Card  

Calculates the Daily Demand, assigns the Standard Container Capacity and Lead Days of the 
Kanban. 

Assign Kanban 
Card Formula  

Allows the user to assign a defined Kanban card count formula. 

Define Kanban 
Formula  

This option allows Power Users or DBAs to create a user defined Kanban card formula.  
(Important!  :ID and :RESULT MUST be included in the formula.  These are mandatory 
parameters.)  See below for an example of a defined Kanban formula. 

Recalc Kanban 
Card  

Calculates the Average Demand, assigns the Standard Container Capacity and Lead Days of 
the Kanban. 

Right Click Options from the Details tab: 

▪ Show Demand - This will how all the sales order details for all the work orders involved in the daily 
average demand. 

▪ Calc Replenishment Time 

▪ Jump To: BOM, Process, Inventory, or Kanban  

Heijunka Tab 

Item # Item number 

Pitch Intervals  Displays the number of cards within each pitch interval 

Description  Description of the item 

Rev  Rev of the item 

Class  Class of the item 

Recalc Kanban 
Card 

Calculates the Daily Demand, assigns the Standard Container Capacity and Lead Days of 
the Kanban. 

Assign Kanban 
Card Formula  

Allows the user to assign a defined Kanban card count formula. 

Define Kanban 
Formula 

This option allows Power Users or DBAs to create a user defined Kanban card formula.  
(Important!   :ID and :RESULT MUST be included in the formula.  These are 
mandatory parameters.)  See below for an example of a defined Kanban formula. 
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Recalc Kanban 
Card 

Calculates the Average Demand, assigns the Standard Container Capacity and Lead 
Days of the Kanban. 

File menu options: 

▪ Define EPEI Formula - This option allows Power Users or DBAs to create a user defined EPEI formula.  
(Important! -  :ID and :RESULT MUST be included in the formula.  These are mandatory 
parameters.)  See below for an example of a defined EPEI formula. 

▪ Define Fixed Pitch Formula - This option allows Power Users or DBAs to create a user defined Fixed 
Pitch formula.  (Important! -  :ID and :RESULT MUST be included in the formula.  These are 
mandatory parameters.)  See below for an example of a defined Fixed Pitch formula. 

▪ Update Schedule - This function, highlighted in detail in the How to Generate Work Orders - Update 
Schedule section, will rebuild the work orders and re-evaluate material and capacity planning tables. 

Example Formulas 

Example defined Kanban formula: 

declare 

  v_kb_control_id number:= :id; 

  v_kb         kb_control%rowtype; 

  v_days       number; 

  v_card_count number; 

begin 

  select * into v_kb from kb_control where id = v_kb_control_id; 

 

  if v_kb.container_qty = 0 then 

    v_kb.card_count:= 0; 

  else 

    v_days:= nvl(v_kb.replenishment_time,0) / 60 / v_kb.daily_prod_hrs  + nvl(v_kb.wait_days,0); 

    v_card_count:= (v_kb.daily_demand * v_days * ( 1 + nvl(v_kb.safety_percent,0)/100 )) /  
v_kb.container_qty; 

    v_kb.card_count:= trunc(v_card_count + 0.999999); 

  end if; 

 

  :result:= v_kb.card_count;  

end; 

 

 

Example defined EPEI formula: 

declare 

  v_heijunka_id      number:= :ID;  /* mandatory IN param */ 
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  v_daily_avail_time number; 

  v_daily_run_time   number; 

  v_daily_setup_time number; 

  v_pftr             number; 

  v_epei             number; 

  v_work_center_count number; 

  v_heijunka         heijunka%rowtype; 

begin   

  select * into v_heijunka from heijunka where id = v_heijunka_id; 

 

  -- get daily avail time in min 

  v_daily_avail_time:= 480;  

   

  -- calc total daily required run time based on daily demand and daily total setup time 

  v_daily_run_time  := 360; 

  v_daily_setup_time:= 20; 

   

  -- if changeover time is 0 we dont know how long does it take to change over 

  if nvl(v_daily_setup_time,0) = 0 then 

     return; 

  end if; 

   

  if nvl(v_daily_avail_time,0) = nvl(v_daily_run_time,0) then 

     return; 

  end if; 

 

  -- PFTR - product family turnover rate. It is also how many cycles in a day we can go through 

  v_pftr:= (v_daily_avail_time - v_daily_run_time) / v_daily_setup_time; 

 

  -- EPE Interval   

  v_epei:= round( 1/v_pftr, 2); -- note in order to convert to minutes just multiply by DAILY_AVAIL_TIME 

 

  -- count how many work_centers we have  

  select count(*) into v_work_center_count  

    from work_center  
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   where mfgcell_id = v_heijunka.mfgcell_id  

     and rtrim(cntr_type) = (select rtrim(name) from cntr_type where id = v_heijunka.cntr_type_id); 

 

  -- update epei and stats in hejunka table. All times are in minutes. EPEI is a fraction of prod day in days. 

  update heijunka  

     set daily_avail_time = v_daily_avail_time, 

         daily_run_time = v_daily_run_time, 

         daily_setup_time = v_daily_setup_time, 

         epei = v_epei, 

         epei_time = trunc(v_epei * v_daily_avail_time / iqmisc.no_zero( v_work_center_count )) 

   where id = v_heijunka.id;  

 

:RESULT:= v_epei; 

end; 

 

 

Example defined Fixed Pitch formula: 

declare                                        

  v_id     number:= :ID;    /* mandatory IN param */ 

  v_result number;  

begin                                          

 

  select 3 * max( nvl(kb.container_qty, 1) *  

                  nvl(case kb.pacemaker_source 

                           when 'STANDARD' then (select cycletm from standard where id = 
kb.pacemaker_source_id) 

                           when 'PTOPER'   then (select cycletm from ptoper   where id = 
kb.pacemaker_source_id) 

                      end,0) / 60 ) 

    into v_result 

    from kb_control kb     

   where kb.mfgcell_id = (select mfgcell_id from heijunka where id = v_id ) 

     and nvl(ratio,0) > 0; 

                                               

  :RESULT:= v_result;        /* mandatory OUT param */ 

end;                                           
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Kanban Supermarket 

Users can directly access the Kanban Cards from the Kanban Supermarket icon on the Manufacturing 
tab. 

Note: To enable Heijunka scheduling, check the ‘Heijunka/KanBan Scheduling’ option in System 
Parameters > Application tab. Once this option is checked, the user will need to log out of EnterpriseIQ 
and log back in to see the Kanban Supermarket icon on the Manufacturing tab. 

Select an item from the pick list and the Kanban Supermarket form will appear. The form displays the 
Kanban cards. The screen shot below shows the fields when the item is marked as a serialized inventory 
control item. Non-serialized items will not have the Serial #, Location, Qty, Lot #, or Inventory Status 
fields. 
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To create Kanban cards select the Insert (+) button. Continue this process to create the recommended 
card count quantity. Each Kanban card will be assigned a unique card number which is used in RF 
Scanning. Select the Print button to print each card. (The report used is assigned in System Parameters-
>Reports and Forms). These cards are attached to the container of material. When first created the 
status of the cards are inactive. The status of the cards are changed using IQRF. The status can be either 
On Hand or On Order. As the status is changed the color code is changed on this form. Green indicates 
on hand status and yellow indicates on order status. The user name of the person who last changed the 
status will populate in the Last User ID field. 

Kanban Cards Grid 

▪ Cards – Displays whether the card is in the Kanban Rack or Inventory. 

▪ Status – When Kanban cards are first created, the status of the cards are inactive.  The status of the 
cards can be changed either manually or through IQRF/WMSIQ.  The status can be either On Hand, 
On Order, or Pending Accumulation.  As the status is changed the color code is changed and the 
card moves back and forth between the Kanban rack and Inventory. Green indicates on hand status, 
yellow indicates on order status, and blue indicates pending accumulation. 

Note: The status can be changed manually within this form but when done this way it will not update 
the PO releases, therefore it is not recommended. Only use IQRF.   

▪ Last User ID – the last user ID when the Kanban card’s status is changed. 

▪ Card # - The card number. 

▪ Additional fields for Serialized items:  Serial #, Location, Qty, Lot #, and Inventory Status. 

Kanban Card Speed buttons 

▪ Print Card(s) – Allows the user to print the cards. 

▪ Assign label to the kanban card – Allows the user to assign an existing label to a kanban card. 

Kanban Supermarket Options: 

The same functionality available from Kanban Control exists in Kanban Supermarket, such as reporting 
production and assigning serial numbers to cards. For a complete discussion of these options please 
refer to Kanban for Purchased Items or Kanban for Manufactured Items depending on the type of item. 
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Alternate Items 

Alternate items can be set up to provide options to substitute items for other items. There are two 
options available for Alternate Items. These options in System Parameters->Inventory tab are mutually 
exclusive: 

▪ Alternate Item# Applied to Substitute BOM - (Default method). If this option is selected alternate 
items can be substituted on sales orders or from material exceptions. When substituted in material 
exceptions, the system will attempt to create a substitute BOM.  

▪ Alternate Item# Applied to Work Order Allocation - If this option is selected users can substitute 
alternate items from material exceptions for specific work orders. The associated work order 
becomes firmed. A substitute BOM is not created, instead the alternate item shows on the Material 
Allocation screen. 

Alternate Item# Applied to Substitute BOM Method 

When the Alternate Item# Applied to Substitute BOM parameter is checked, alternate items can be set 
up to replace items requested on sales orders or to replace material exceptions. There is a right click 
feature from both areas to select an alternate item. 

To create Alternate Items 

➢ Select the speed button on the inventory form. A window will appear to enter the alternate 
item(s) for the current item. 
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➢ Select insert record (+) button or the ellipsis button in the Item # field and then select the 

alternate item(s) from the pick list. Multiple items can be selected from the pick list using the 
Ctrl keyboard button. The Sequence and Alternate item Code are not required when using 
the Alternate Item# Applied to Substitute BOM method. 

➢ Select the insert button to add additional alternate items. 

From this form users can right click and select Jump to Inventory and Jump to Inventory Transactions & 
Locations 

Alternate Items and Sales Orders 

Once alternate items have been set up the user can substitute these items for parent item on sales 
orders. From the sales order, highlight the line item to be substituted and select Alternate Item #. Select 
the alternate from the pop up list. The system will do the following: 

▪ If there have been no shipments against the sales order item the system will simply replace it. For 
Kitting items the default Kit's BOM components are removed, and the alternate Kit's BOM 
components are added. 

▪ If the sales order item has been shipped against but not in full, a new line item will be added to the 
sales order for the Alternate Item selected. All of the unshipped demand (remaining Blanket Quantity 
and unshipped Releases) will be moved to the Alternate Item detail. 

▪ If the sales order item has been shipped in full, a new line item will be added to the sales order for 
the Alternate Item selected (just like adding a new item from the pick list). 

Alternate Items and Material Exceptions 

Alternate items can be substituted for items in material exceptions. From within the Material Exception 
List, right click on the item to be replaced and select Alternate Item #. Select the alternate from the pop 
up list.  

A form will appear listing the work orders and Mfg #'s that require the original item.  
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Select the work orders where the original item should be replaced by the alternate item by highlighting 
them in the list using the toggle buttons. Once highlighted, press OK. 

The system will attempt to replace the item directly. However if the item is currently running the user 
will receive an error similar to the following: 

General SQL error. ORA-20500: WO# 147901 is currently running on work center 16. Mfg# substitution 
or change is not allowed. 

If the system is able to replace the item directly the selected work orders will automatically have a 
substitute BOM created for them. The substitute BOM is the same as the original BOM except the 
original exception item is replaced with the Alternate item. The parts per for this item remains the same 
as the original. 

        

Note: The design will not account for UOM conversions on either the original or alternate item since the 
system is unable to accommodate the correct conversion amount to order when the original, or 
alternate, or both items use their own unique conversion factor. 

Note: When a component in a blend operation is replaced with an alternate item it will permanently 
replace the original item in the blend operation. This will affect all BOMs where the blend operation is 
used in. 

Alternate Item# Applied to Work Order Allocation 

When the Alternate Item# Applied to Work Order Allocation parameter is checked users can substitute 
alternate items from material exceptions for specific work orders. The associated work order becomes 
firmed. A substitute BOM is not created, instead the alternate item shows on the Material Allocation 
screen. 

Alternate Item Codes 

Alternate Item Codes are used with the Alternate Item # option 'Alternate item is applied to work order 
allocation' to filter the Alternative Items. The Alternate Item Codes are assigned to the alternate items 
and to the BOM that consumes items that have alternates. 

The Alternate Item Code list is accessed from the Lists menu in System Parameters. To create codes 
select the New button on the pick list, insert a new record and enter the Code and Description. 
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BOM Parameters 

An 'Alternate Item Code' can be associated to a BOM in order for the system to know which alternate 
items can be used for substitutions. The system will only show blends that are setup as an Alternate Item 
of the original Blend with a matching Alternate Item Code. In the BOM Options menu select 
Miscellaneous Parameters. From the Scheduling tab select an Alternate Item Code from the pick list 
accessed by clicking on the ellipsis button in the field. 
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Create Alternate Items 

➢ Select the speed button on the inventory form. A window will appear to enter the alternate 
item(s) for the current item. 
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➢ Select insert record (+) button or the ellipsis button in the Item # field and then select the 

alternate item(s) from the pick list. Multiple items can be selected from the pick list using the 
Ctrl keyboard button. Enter the sequence # and choose an Alternate Item Code from the 
pick list accessed by clicking the ellipsis button in the field for each item. Select the insert 

button to add additional alternate items. 

From this form users can right click and select Jump to Inventory and Jump to Inventory Transactions & 
Locations. 

Copy and Replace - From the right click menu choose Copy Alternate Items or Replace Alternate Items to 
quickly make changes to the alternate items. 

▪ Copy Alternate Item - Alternate Items for one item can be copied to another item. Multi-select the 
item(s) in the Alternate Items list using the shift or ctrl keyboard buttons, select the target item to 
copy the alternate items to from the pick list and press the Select button. A confirm message will 
appear stating, 'About to assign alternate item(s) to 'Item #' [mode = COPY] - continue?'. Select Yes 
to continue, and the item(s) will be added to the target item(s) alternate item list. Select No to return 
to the screen with no changes. 

▪ Replace Alternate Item - Alternate Items for one item can replace a target item's alternate items 
based on Alternate Item Code. Multi-select the item(s) in the Alternate Items list using the shift or 
ctrl keyboard buttons, select the target item to replace the alternate items for from the pick list and 
press the Select button. A confirm message will appear stating, 'About to assign alternate item(s) to 
'Item #' [mode = REPLACE] - continue?'. Select Yes to continue. If the selected Alternate Items have 
Alternate Item Codes the system will replace only matching Alternate Item Codes in the Target.  If 
there is no Alternate Item code it will match the target without an Alternate Code. Select No to 
return to the screen with no changes.  

Material Exception List 

From the Material Exception List users can substitute alternate items on specific work orders. The work 
order becomes firm. Instead of a substitute BOM being created the alternate item shows on the Material 
Allocation screen and will be used in backflushing. 

From Material Exceptions, right click on the item in the upper section and select Alternate Item. The 
Alternate Work Order Allocation form will appear. To substitute an alternate component select the 
ellipsis button in the 'Alternate Component Item #' field and choose and item from the list of alternate 
items. The list includes the non committed and on hand quantities for the alternate item. 



Inventory Management Page 139 of 478 

 

 



Inventory Management Page 140 of 478 

 

Select the item and select Yes on the confirm message to proceed with the alternate item(s) 
replacement. The work order will be marked firm and the alternate item will show as a substitute in the 
Material Allocation screen. 
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When backflushing in production reporting or if the work order is selected when doing a manual 
transaction the system will remove the alternate item instead of the one associated to the BOM. 

Blends 

This same functionality also works for blends. If the base item is a component in a blend, the system will 
display other blends that have been added to the Alternate Item list for the base blend.  

For example, Blend 1 uses a component ALT1. Blend 2 uses a component ALT2. Blend 2 can be an 
alternate for Blend 1. So on the Blend 1 inventory item the Blend 2 would be set up as an Alternate Item. 
Then on the ALT1 item, the ALT2 item would be set up as an Alternate Item. All with the same Alternate 
Item Code. The Alternate Item Code for the BOM that uses Blend 1 is associated to the same code. 

To choose an alternate blend, select the ellipsis button in the 'Alternate Blend Item #' field to access the 
pick list. Only blends that are setup as an Alternate Item for the original blend with a matching Alternate 
Item Code show for selection. 
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The work order will be marked firm and the alternate item will show in the Material Allocation screen. 

➢ Alternate Items in Production Reporting 

➢ In Production Reporting by Shift and Production Report by Labor/Shift (PRLS) an Alternate 
Item can be chosen as a substitute for an item on a one time basis or for the work order. 

Select the Drop down arrow next to the Alternate item speed button  in the Materials 
Involved section. Select one of the options: 

▪ Replace with Alternate Item (One Time) - This replaces the item that was highlighted when the 
Alternate Item icon was clicked. 

▪ Replace with Alternate Item (This Work Order) -  This replaces the item that was highlighted when 
the Alternate Item icon was clicked. It marks the work order firm and creates a Substitute BOM or 
Work Order Allocation based on the System Parameter Alternate item switch. 

➢ The pick list of alternate items for the highlighted item will display. Choose an item from the 
list. 
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Process Cost by Work Order 

Select the Process Cost speed button  to access process cost information by work orders for 
manufactured item. When this option is selected a pick list of work orders associated to the item will 
display. (The system looks in the C_TRANSLOG_WORKORDER table that is populated by a trigger on 
insert for translog). Select a work order from the list and the Process Cost form will display the costing 
information for the work order. See Introduction to Process Costing for details on this module. 
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Auto MRP (eKanban) 

Auto-MRP is set up on individual inventory items and is used to specify minimum inventory stocking 
levels for these manufactured items. This functionality helps maintain a constant on hand supply of 
items. The system allows the stocking and manufacturing quantity levels to be set on an item by item 
basis for maximum flexibility. The manufacturing quantity concept uses the assumption that it is 
desirable to produce an economically sized run whenever a job is put on a machine. 

Auto-MRP is set up with the minimum on hand inventory level and an amount to be manufactured. The 
first time an item is set up with Auto-MRP, the system generates an Internal Stocking Sales Order which 
has the same functionality as a regular sales order. This sales order is then used for all items set up with 
Auto MRP. To distinguish the sales order from a manual sales order, the wording 'INTERNAL STOCK' is 
embedded in the PO field and the Taken By field is filled in with Auto MRP. 

Auto-MRP monitors the inventory levels of the items on this order and when the amount in inventory 
drops below the minimum level specified for the item, the system automatically enters a release and 
thus creates demand for the item. 

EnterpriseIQ's MRP engine looks at the demand for the item from the Internal Stocking Sales Order 
(along with other open orders for the item), the inventory level for the associated item, and creates a 
Work Order to ensure that the required amounts are produced. The Work Order is then handled in the 
same manner as other Work Orders. 

Auto-MRP can only be set up for those items that are manufactured and have a valid BOM associated 
with the item. To set up Auto-MRP for an inventory item, follow the steps outlined below: 

➢ From the EIQ Launcher Bar, click on the Inventory button or select File-> Manufacturing-
>Inventory from the menu. The inventory pick list will appear. 

➢ Select the item that is going to be set up for Auto-MRP from the pick list. The main inventory 
screen will appear. 

➢ Select File->Auto-MRP from the menu. The following screen will appear: 

Note: If the item does not have a BOM associated with it, the ability to select Auto-MRP will not be 
available. 
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Default Auto-MRP or Auto-MRP by Division/Warehouse 

Each manufactured inventory item can have the Auto-MRP set up as a default (not division/warehouse 
specific) or specifically for a division/warehouse. The difference is when set up under the Default the 
system looks at the total on-hand for all locations regardless of the division/warehouse designation. If 
Auto-MRP is set up for a specific division/warehouse, the system will only look at the on-hand quantity 
for locations associated to that division to determine when to put in the sales order release. Once the 
sales order is generated there is really no difference. 

Only set up Auto-MRP for one or the other per individual item, do not set it up for both default and by 
division/warehouse. Users can utilize both types within the system but not for a single item. If a user 
attempts to enter data for both sections an error will surface stating: "Auto-MRP has already been set up 
using the Default Auto-MRP method.  In order to set up using Auto-MRP By Division, data must be 
removed from Default Auto-MRP first as these modes are mutually exclusive." The data from a section 
can be removed by selecting the red X button in the section. 

Note: The system keeps Auto-MRP work orders separate. Therefore, it is possible that two work orders 
with a bucket 1 will be generated if Auto-MRP is set up on an item without the division/warehouse 
designated and there is also a sales order open for the item. 

Note: If one BOM makes multiple items and each item has Auto-MRP set up for a specific division, the 
first due item will have a work order. The other item(s) will be schedule allocated and will not show 
demand on that work order. If the 'Qty to Manufacture' is different for the items in the family tool an 
additional work order may be created depending on the 'lead days' value. Please see the Auto-MRP and 
Family Tools section for more information. 

Note: When an Auto-MRP work order is created, the current Non-Committed amount will be FG 
Allocated to the work order. This will cause the Non-Committed amount to drop on the inventory record 
based on the amount allocated. 

Auto MRP Field Listing 

Use the field listing below to assist in filling in each of the fields shown on the inventory screen. Enter the 
data in the top section to set the Auto-MRP as a default. Enter the information in the bottom section to 
set up the Auto-MRP for a specific division/warehouse. 
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Item #  This fills in automatically with the inventory item number.  

Order # Once the information requested is entered and the Create Order button is clicked, the 
Internal Stock Sales Order number will fill in.  

MFG Order Point The desired on hand quantity of the inventory item. When the actual on hand 
inventory drops below this value, a release will be added to the Internal Stock Sales 
Order for the number entered under 'Qty to Manufacture'. 

Qty to Manufacture The amount of items to be manufactured. This number is usually specified as an 
economically sized manufacturing run. Once the inventory level falls below the 'MFG 
Order Point' update schedule will issue a work order to manufacture this quantity or 
the balance to manufacture (less what is on hand).  

Note: If a value is entered in the 'MFG Min Qty' field on the Manufacturing tab in 
Inventory the quantity on the work order will be that value instead of the 'Qty to 
Manufacture' established in Auto-MRP. This is only applicable if the 'MFG Min Qty' 
is larger than the 'Qty to Manufacture' in Auto-MRP. 

Lead Days The number of manufacturing lead days required to reach the maximum stock level. 
For example, if the number entered here is 7, the Promise Date on the release on the 
Internal Stock Sales Order will be 7 days from the day the inventory dropped below the 
'MFG Order Point'. 

If a value is entered in the 'Auto-MRP Scope in Days' field, once the entry is posted the 
'Lead Days' and 'Exclude Hard Alloc' options will be cleared and be designated as read-
only, since they no longer apply. 

Multiples Of This is the same field that is on the General tab in the Inventory module. 

In Auto MRP if this field has a value it will force the 'Kanban Lot Size' to be divisible by 
this quantity. If it is not a warning will appear. 

This field is also used in conjunction with Sales Order releases. Fill in 'multiples of' with 
the full box quantity. During order entry the release quantities will be rounded up to 
this full box quantity and the user will be asked if they want to keep the original 
quantity entered or use the full box quantity. 

Kanban Lot Size The system will use the 'Kanban Lot Size' to determine the work order quantity for the 
Auto MRP demand less the on hand quantity. The system will force each Auto MRP 
sales order release into separate work order buckets. Also, the same demand release 
date will be used for all Kanban releases. 

For example, if the' Qty to Manufacture'  = 14000 and the 'Kanban Lot Size'  = 8000. 
The system would create two work orders for 8000 pieces each (assuming no on hand). 
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Auto-MRP Scope In 
Days 

This is the scope in days used to determine when inventory will fall below the 'MFG 
Order Point'. This option will allow users to anticipate when their inventory will fall 
below the desired safety stock levels, and have the system automatically create a work 
order based on the current sales order demand within the specified scope. Utilizing this 
feature will ensure the quantity to manufacture value will already be produced and on 
hand to replenish safety stock by the end of the scope and after sales orders are 
shipped. 

The system considers demand from sales orders, sales orders with hard allocated 
material, forecast demand, and dependent demand. The system will use the date that 
the inventory will fall below the 'MFG Order Point' as the promise date when adding 
releases to the internal stock order. Orders outside of the defined scope are not 
considered when determining when inventory will fall below 'MFG Order Point'.  

If the 'Allocate by Division' Scheduling parameter is unchecked the system will consider 
all available non-allocated on hand inventory when determining whether demand will 
cause inventory to fall below the 'MFG Order Point'.  

If the 'Allocate by Division' is checked the system will consider all available non-
allocated on hand inventory without a division assigned when determining whether 
demand will cause inventory to fall below the 'MFG Order Point'. 

Note:  When using the 'Scope in Days' feature for Auto-MRP items set up by 
division, the 'Allocate by Division' scheduling parameter must be checked. If it is not 
checked a confirm message will appear stating, "Allocate by division must be 
checked in scheduling parameters when using the Scope in Days functionality! 
Would you like to continue?".  When selecting 'No' the changes are not saved and 
users are returned to the screen to change the settings. Please note that if 'Yes' is 
selected items setup under divisions will never trigger an internal stock order for 
divisions when inventory falls below the 'MFG Order Point'. A mouse over hint 
stating, "Check this option when setting up Auto MRP by division with scope days", 
is on the 'Allocate by Division' scheduling parameter to inform users that this is a 
requirement. 

Note: If a user attempts to uncheck the Scheduling Parameter 'Allocate by Division' 
when an item has division Auto-MRP with 'Scope in Days' setup a warning will 
appear stating, "Scope in days functionality will not apply if Allocate by division 
checkbox is unchecked! Would you like to continue?". Selecting 'No' will return the 
user to the Scheduling Parameters form with no changes made. If 'Yes' is selected 
the 'Scope in Days' field in Auto-MRP division settings will be grayed out as an 
indicator that it no longer applies to the Auto-MRP calculations. If the 'Allocate by 
Division' parameter is re-checked, the 'Scope in Days' field will no longer be grayed 
out.  

If a value is entered in this field, once the entry is posted the 'Lead Days' and 'Exclude 
Hard Alloc' options will be cleared and be designated as read-only, since they no longer 
apply. 
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Safety Stock If this box is checked, the MRP engine will not take the 'Qty to Manufacture' amount 
into consideration as usable product to be allocated to customer demand (from sales 
orders). Safety Stock is ignored for internal (Auto MRP) demand, as the Auto MRP 
order is designed to get the inventory back to a certain level but not exceed it.  

When determining the work order quantity for customer  demand the MRP engine 
will not allocate up to the safety stock amount to a customer requirement (sales 
order). It does not consider this as usable product. The system uses the 'Qty to 
Manufacture' amount as the safety stock quantity unless a value is entered in the 
'Safety Stock' field on the Manufacturing tab in Inventory. In this scenario, the system 
will use that value instead of the 'Qty to Manufacture' to determine the work order 
quantity for customer demand. If a value is entered in the 'Safety Stock' field on the 
Manufacturing tab, this field will be disabled. 

For Example: Sales order for 10,00; safety stock set at 2,000; and on-hand = 2000 

Update schedule will create a work order for 10,000 since the on-hand is set aside for 
safety stock. If the sales order is an Auto-MRP sales order, the work order would only 
be for 8,000.  Update schedule will use the on-hand, ignoring the safety stock setting. 

Make FIRM WO When this is selected the work order generated for the internal stock item will be 
made firm automatically. The work order will then follow the firm work order rules 
(ignore inventory and only be reduced through dispositioning). 

This also applies to internal work orders created when the 'Auto-MRP Scope In Days' 
option is checked. If demand changes within the scope in days, the system will create 
new internal firm work orders as needed. The system will allocate Firm work orders 
that were previously created when determining if additional work orders need to be 
generated based on demand changes. However, if the Must Start dates do not line up, 
a new firm Auto MRP work order will be created and not consume the previously 
generated firm work order. 

Include VMI With the 'Include VMI' box unchecked, the system will not consider VMI inventory 
when considering the on hand inventory level. With the box checked the system will 
include the VMI inventory as on hand when determining if the item has fallen below 
the reorder point. Note that this may cause MRP to not see a need to create parts. The 
VMI inventory is not used to determine the work order quantity regardless of whether 
this option is checked or not. 

Example: 

On Hand is 10,000; Auto-MRP is set to 7,000;  4,000 parts are moved to a VMI 
location 

With the 'Include VMI' box checked, the system would take the VMI inventory into 
account and would not see a requirement to bring the stock level up. With the box 
unchecked, the system would not take the VMI inventory into account and would see a 
requirement to create 1,000 parts on an internal stocking sales order. 
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Include VMI in Mfg 
Qty Calc 

If the 'Include VMI' option is checked, this option will become available. If this option is 
checked, the VMI quantities are considered available. When the system calculates the 
Auto MRP work order quantity it will use “Onhand+VMI Qty” in the calculation.  
Otherwise it will only use the On Hand quantity. 

Exclude Hard Alloc If this option is checked the system will not take into account hard allocated quantities 
when calculating Auto MRP Work Orders. 

See the Hard Allocated example in the Auto-MRP Examples section below. 

If a value is entered in the 'Auto-MRP Scope in Days' field, once the entry is posted the 
'Lead Days' and 'Exclude Hard Alloc' options will be cleared and be designated as read-
only, since they no longer apply. 

Schedule Allocate to 
SO 

If this box is checked, any product produced from an Auto-MRP work order (including 
Firm Auto-MRO work orders) will be applied to a sales order through schedule allocate 
in update schedule. This will prevent the creation of a new planned work order for the 
sales order demand. When the Schedule Allocate to SO box is checked, the Auto-MRP 
records are evaluated first, and then the Sales Order demand will take them into 
account when being processed by update schedule.  

Note:  MTO work orders will not be "schedule allocated to" by Auto-MRP work 
orders, even when the ‘Schedule Allocate to SO’ option is checked. 

Once all the required information is entered, click on the 'Create Order' button to add the item to the 
Internal Stocking Sales Order. The internal order number will appear in the Order # field. To view the 
Internal Stocking Sales Order, right click on the Order # field and jump to the order. The following screen 
will appear: 
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All items that are set up for Auto-MRP will be listed on the Internal Stock Sales Order and those items 
with on hand inventory levels below their MFG Order Point will have releases for quantities associated 
with their 'Qty to Manufacture'. 

Note: Auto MRP orders are not EPlant specific in the header section. The user must be in View All to view 
the Internal Stock sales order. 

Note: After marking an Auto-MRP item inactive (inactive check box in Inventory->Main Inventory tab), 
work orders and material requirements are not generated when running update schedule, and the 
existing item on the internal stock sales order will not have releases.   

Note: Users will not see the system generated 'INTERNAL STOCK' Auto MRP sales order in the sales order 
pick list. Jumps to the Sales Order and navigation to the sales order within the module are still available. 

Delete/Archive Auto MRP Sales Order 

If a user tries to delete and/or archive the internal stock (Auto-MRP) sales order, a confirmation message 
is displayed stating: "Are you sure you want to delete and/or archive the Auto MRP Sales Order # 
<orderno>?", with Yes and No buttons. There is also a 'Do not show next time' check box. Security can be 
placed on the Yes button and the check box. 
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Auto-MRP Examples 

The following examples explain the basic methods of work order generation for various scenarios: 

Example 1:   

On Hand is greater than MFG Order Point 

On Hand Qty 700 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock Not checked 

Open Sales Orders 0 

MFG Safety Stock 0 

Results: 

Work Orders None On hand inventory is greater than the 
Manufacturing Order Point 

 

Example 2: 

On Hand is less than Mfg Order Point - no sales orders 

On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock Not checked 

Open Sales Orders 0 

MFG Safety Stock 0 

Results: 

Work Orders Internal Stock 
SO 

WO Qty = 4800, Qty to Manufacture 
less On-Hand Qty (5000 - 200). 
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Example 3: 

On Hand is less than MFG Order Point - open sales order 

On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock Not checked 

Schedule Allocate SO Not Checked 

Open Sales Orders 1000 pieces with promise date later than internal 
demand. 

MFG Safety Stock 0 

Results: 

Work Order(s) Internal Stock 
SO 

WO Qty = 4800 (5000 - 200). 

 Customer 
demand 

WO Qty = 1000 (Qty to Manufacture) 

Note: If the open sales order for the customer had a promise date sooner than the internal requirement, 
the on hand inventory would be allocated to the customer's demand instead. The total quantity remains 
at 5,800 but the results would be as follows: 

Work Order(s) Internal Stock 
SO 

WO Qty = 5000 

 Customer 
demand 

WO Qty = 800 (1000 - 200). 
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If the Schedule Allocate option is checked, the system will not create another work order for the Sales 
Order demand if it falls after the Mfg Run Size time period. So in the above example, only one work 
order would be created. 

Work Order(s) Internal Stock 
SO 

WO Qty = 4800 

Example 4: 

On Hand is less than MFG Order Point, no sales orders, safety stock is checked. 

On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock Checked 

Open Sales Orders 0 

MFG Safety Stock 0 

Results: 

Work Order(s) Internal Stock 
SO 

WO Qty = 4800 

 

Example 5: 

On Hand is less than MFG Order Point, open sales order, safety stock is checked. 

On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock Checked 

Open Sales Orders 1000 pieces with promise date later than internal 
demand. 

MFG Safety Stock 0 

Results: 
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Work Order(s) Internal Stock 
SO 

WO Qty = 4800 (on hand inventory is 
considered for internal (Auto MRP) 
orders). 

 Customer 
demand 

WO Qty = 1000. 
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Example 6: 

On Hand is greater than MFG Order Point, safety stock is checked, open sales order 

On Hand Qty 750 

MFG Order Point 500 

Qty to Manufacture 650 

Safety Stock Checked 

Open Sales Orders 1000 pieces 

MFG Safety Stock 0 

Results: 

Work Order(s) Customer 
Demand 

WO Qty = 900. Allocates 100 of on 
hand inventory towards SO. On Hand 
less Qty to Manufacture (Safety Stock) 
750 - 650. No Auto-MRP demand 
because On-Hand is greater than the 
MFG Order Pt. 

 

Example 7: 

On Hand is less than MFG Order Point, safety stock is entered on the Manufacturing tab in inventory, 
open sales order 

On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock N/A 

Open Sales Orders 1000 pieces with promise date later than 
internal demand. 

MFG Safety Stock 150 

Results: 
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Work Order(s) Internal Stock 
SO 

WO Qty = 4800 [Qty to Manufacture - 
On hand) = [5000 - 200]. 

The MFG Safety stock is not 
considered for Auto MRP demand. 

 Customer 
demand 

WO Qty = 1000. 

If the open sales order promise date is before the internal demand, the results are as follows: 

Work Order(s) Internal Stock 
SO 

WO Qty = 4850 [Qty to Manufacture - 
On Hand] = [5000 - 150]. 

After fulfilling customer demand the 
On Hand will be 200 + 950 - 1000 = 
150 

 Customer 
demand 

WO Qty = 950. 

(1000 - 200) + 150 safety stock  
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Firm Option: 

In any of the above examples if the 'Make Firm WO' is checked the work order created for the Auto-MRP 
demand will be marked firm. It will then follow the firm work order rules (ignoring on hand inventory 
and only be reduced through dispositioning). Keep in mind if the on hand inventory level becomes 
greater than the MFG Order Point the firm work order for the Auto-MRP demand will not be removed 
during update schedule. 

Auto-MRP Scope in Days Examples:  

▪ MFG Order Point = 50 (trigger point) 

▪ Qty To Mfg = 100 (build up to stock qty) 

▪ Auto-MRP Scope in days = 30 

▪ Make Firm Work Order is not enabled 

On hand = 150 

The system compares the sales order delivery dates (must ship date) to the Auto-MRP Scope in Days. If 
the order falls within the scope in days then the order is considered when projecting out when the 
quantity on hand will fall below the MFG Order Point. The system will add a release to the internal stock 
order for the quantity to manufacture which is 100 parts in this case.  The work order will be generated 
for the difference between the projected on hand quantity (below the MFG Order Point) and the Qty to 
MFG.  The date that the inventory will fall below the MFG Order Point will be used as the promise date 
when adding releases to the internal stock order. The system will include demand from sales orders, 
sales orders with hard allocated material, forecast demand, and dependent demand (all manufactured 
items will be evaluated).  

Sales order quantity examples: 

▪ Scenario 1: If the sales order quantity = 125 and the on hand is 150 then there is a balance in 
inventory of 25 when the sales order is to be shipped.  This is below the MFG Order Point of 50 so 
the system will generate a release on the internal stock order of 100, and the work order will be for 
75 parts to bring it up to the Qty to MFG of 100. 

▪ Scenario 2: If the sales order quantity = 150 then there is a balance in inventory of 0 so the system 
will generate the work order for 100 parts to bring it up to the Qty to MFG of 100. 

If there are several work orders within the scope, the system will accumulate them until it hits zero, and 
will generate the work order for the 100 stock parts (Qty to MFG). 

Allocate by Division (Scheduling Parameter) Examples: 

If 'Allocate by Division' Scheduling parameter is unchecked the system will consider all available non-
allocated on hand when determining whether demand will cause inventory to fall below the 'MFG Order 
Point'.  

If 'Allocate by Division' is checked the system will consider all available non-allocated on hand without a 
division assigned when determining whether demand will cause inventory to fall below the  'MFG 
Order Point'. 
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Using the data below, refer to the screenshots to show the results based on whether the 'Allocate by 
Division' parameter is checked or unchecked: 

▪ MFG Order Point = 500 

▪ Qty to Manufacture = 10,000 

▪ Scope = 15 

▪ On Hand - DIV 1 = 1750 

▪ On Hand - DIV 2 = 1000 

▪ On Hand - No DIV = 250 

▪ Hard Allocated = 4500 

▪ VMI = 1000 

Default Auto-MRP set up (not by Division) 

Allocate by Division is unchecked: 
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Allocate by Division is checked: 
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Auto-MRP set up for Division  

Note:  When using the 'Scope in Days' feature for Auto-MRP items set up by division, the 'Allocate by 
Division' scheduling parameter must be checked. If it is not checked the items setup under divisions will 
never trigger an internal stock order for divisions when inventory falls below the 'MFG Order Point'. A 
mouse over hint stating, "Check this option when setting up Auto MRP by division with scope days", is on 
the 'Allocate by Division' scheduling parameter to inform users that this is a requirement. 

Allocate by Division is checked: 
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Make Firm WO - If the 'Make Firm WO' is checked the work order created for the Auto-MRP demand will 
be marked firm. 

Firm Work Order Example with Auto MRP Scope in Days checked: 

▪ MFG Order Point = 500 

▪ Qty to MFG = 1000 

▪ On Hand = 1000 

Scenario: A new Sales Order for 600 is shipped. This drops the on hand to 400, which is below the MFG 
Order Point. When update schedule is run, a firm work order gets created for 600. If demand is added to 
the sales order for 100 and shipped; the on hand is now at 300. When update schedule is run, a second 
firm work order is created for 100. 

Note: The system will allocate Firm work orders that were previously created when determining if 
additional work orders need to be generated based on demand changes. However, if the Must Start 
dates do not line up, a new firm Auto MRP work order will be created and not consume the previously 
generated firm work order. 

VMI Options: 

If the 'Include VMI' option is checked the system will include inventory in a VMI location as part of the on 
hand when determining if inventory has fallen below the reorder point. (Work order generation never 
looks at VMI inventory).  

If the 'Include VMI on Mfg Qty Calc' option is checked, when the system calculates the Auto MRP work 
order quantity it will use “Onhand+VMI Qty” in the calculation. 

Hard Allocated Example: 

When the Exclude Hard Allocated box is checked the system will not consider items that have been hard 
allocated. 

On Hand Qty 500 

MFG Order Point 400 

Qty to Manufacture 1000 

Safety Stock Not checked 

Open MTO Sales Orders 200 with 200 hard allocated to the SO 

MFG Safety Stock 0 

Results: 
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Work Orders Internal Stock 
SO 

WO Qty = 700  

Qty to Manufacture less Qty On hand - 
Hard Allocated: (1000 - (500 - 200)) = 
700 

Using the same information, if the Exclude Hard Allocated box is not checked then no work order would 
be created as the on hand inventory of 500 is not below the MFG Order point of 400. 

Kanban Lot Size Example: 

The system will use the Kanban Lot Size to determine the work order quantity for the Auto MRP demand. 
The system will force each Auto MRP sales order release into separate work order buckets. Also the 
same demand release date will be used for all Kanban releases. 

On Hand is less than Mfg Order Point - no sales orders, Qty to Manufacture less than Kanban lot size. 

On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 5000 

Safety Stock Not checked 

Open Sales Orders 0 

MFG Safety Stock 0 

Multiples of 1000 

Kanban Lot Size 8000 

Results: 

Work Orders Internal Stock 
SO 

 

WO Qty = 7800, Qty to Manufacture 
rounded up to Kanban Lot Size of 8000 
less on hand of 200. 

On Hand is less than Mfg Order Point - no sales orders, Qty to Manufacture greater than Kanban lot size 
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On Hand Qty 200 

MFG Order Point 500 

Qty to Manufacture 14000 

Safety Stock Not checked 

Open Sales Orders 0 

MFG Safety Stock 0 

Multiples of 1000 

Kanban Lot Size 8000 

Results: 

Work Orders Internal Stock 
SO 

Two separate work orders: one for Qty 
= 7800, and one for 8000. Qty to 
Manufacture rounded up to Kanban 
Lot Size of 8000 x 2 = 16000 less on 
hand of 200. 
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Divisions/Warehouses 

The system will only look at the on-hand quantity for locations associated to that division to determine 
when to put in the sales order release. 

Division Example 

On Hand is less than MFG Order Point - no sales orders - On hand is in a different division than what the 
Auto-MRP is set up for. 

On Hand Qty 200 (Div 2) 

MFG Order Point 500 (Div 1) 

Qty to Manufacture 5000 

Safety Stock Not Checked 

Open Sales Orders 0 

MFG Safety Stock 0 

 

Results: 

Work Order(s) Internal Stock 
SO 

WO Qty = 5000. The on hand is in 
Division 2 but the Auto-MRP is set up 
for Division 1. 
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Auto-MRP and Family Tools 

Auto-MRP is set up on an individual item basis. It is possible to set up Auto-MRP for only one item in a 
family tool. Examples are provided below to illustrate how work orders are created for Auto-MRP 
requirements in family tools: 

Family Tool Examples: 

Example 1: The tool makes a part A and a part B. Auto-MRP is set up on part A only. On hand inventory 
of part A falls below the MFG Order Point. 

One work order will be created for part A only. Part B will also be listed on the work order but with zero 
parts required. The work order report will also list both parts with the correct quantity required. The raw 
material requirements will be for both parts because they are calculated based on the shot weight and 
number of cycles, not the individual cavity weight. Any attached components such as packaging or 
inserts will be included in the material requirements reports and staging reports. However, on the work 
order report the attached components for part B will be listed with zero quantity required. 

NOTE: The system will not create artificial demand for the other part(s). It is not necessary since the 
system knows the materials to be consumed based on the BOM. Also, work orders are always 
automatically generated based on actual demand (sales orders). If Auto-MRP is not set up for an item, 
sales order demand does not exist and therefore a work order is not created. Putting a requirement on 
the work order for items without demand would fall outside the logic of the system. 

If the other part(s) will not be produced (i.e. a cavity is shut off) be sure to change the 'Act Cav' field in 
the BOM to zero. This will then effect the raw material requirements to not include the material required 
for the part(s) with zero actual cavities. 

Example 2: The tool makes a part A and a part B. Auto-MRP is set up on both part A and B. On hand 
inventory of both parts falls below the MFG Order Point. 

One work order will be created for the Qty to Manufacture set for each part. For example, part A has a 
Qty to Manufacture = 15000 and part B = 10000, the work order will be created for 15000 A's and 10000 
B's. All raw materials will be based on the number of cycles required and shot weight. Note, the cycles 
required is the larger of the two requirements, in this example it would be 15000 assuming part A has 
one cavity. The work order will therefore be making an additional 5000 part B's that have no demand. 
(As mentioned above the system will not create artificial demand for those extra 5000 parts). The 
attached components will be based on the parts required for each. If part B requires one insert per item 
the material requirements reports will show 15000 inserts required. 

Family Tool Examples with Divisions: 

The examples below use the same family configuration as above; the tool produces a part A and part B: 

Example 1: On Hand is less than MFG Order Point for both parts - no sales orders - Auto-MRP is set up 
identically for both items, or only one item has Auto-MRP set up. The results are the same. 
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On Hand Qty 0, for each part 

MFG Order Point 500 

Qty to Manufacture 3500 

Safety Stock Not Checked 

Open Sales Orders 0 

MFG Safety Stock 0 

 

Results: 

Work Order(s) Internal Stock 
SO 

WO Qty = 3500 for one part, the other 
part will show 0 quantity but will be 
schedule allocated for 3500. 

 

Example 2: On Hand is less than MFG Order Point for both parts - no sales orders - the parts have a 
different Qty to Manufacture and different lead days. 

On Hand Qty 0, for each part 

MFG Order Point 500 

Qty to Manufacture 3500 for part A, lead days = 5 

3000 for part B, lead days = 10 

Safety Stock Not Checked 

Open Sales Orders 0 

MFG Safety Stock 0 

 

Results: 

Work Order(s) Internal Stock 
SO 

WO Qty = 3500 for part A, part B will 
show 0 quantity but will be schedule 
allocated for 3500. 

 



Inventory Management Page 169 of 478 

 

NOTE: Because the lead days for part A is less than the lead days for part B and the quantity for part A 
will meet the requirements for part B, only one work order is created for part A. 

Example 3: On Hand is less than MFG Order Point for both parts - no sales orders. 

On Hand Qty 0, for each part 

MFG Order Point 500 

Qty to Manufacture 3500 for part A, lead days = 10 

3000 for part B, lead days = 5 

Safety Stock Not Checked 

Open Sales Orders 0 

MFG Safety Stock 0 

 

Results: 

Work Order(s) Internal Stock 
SO 

WO Qty = 3000 for part B, part A will 
show 0 quantity but will be schedule 
allocated for 3000. 

 Internal Stock 
SO 

WO Qty = 500 for part A to meet 
additional 500 piece requirement that 
was not schedule allocated. 
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If part A and B have the Auto-MRP set up for different divisions the results are the same. The only 
relevance is what division the on-hand inventory is in to determine the ultimate work order quantity. 

A Note on Schedule Allocation 

The system takes into consideration if another work order will produce enough items to fulfill demand. 
The system knows we are making those parts to fulfill the work order, so if another order were to come 
in, we can see that this work order might already produce enough parts to satisfy the new demand. We 
look at that Schedule Allocate column to see if parts are already being made by an existing work order 
before creating another work order for same part(s). 

For example, assume that a sales order demands Part A from BOM 103. This BOM actually creates two 
parts, parts A and B. EnterpriseIQ understands that the production run will produce both parts. 

Both part numbers are taken into account when determining product availability. This system of 
allocation works in the same way on hand inventories are allocated. If a work order is already going to 
produce a part another sales order demands, then that demand is discounted by the number of parts the 
original work order will produce. 
 

Auto-MRP vs. Mfg. Safety Stock 

The section provides information on the different methods of creating a stocking program for a 
manufactured item in EIQ. Currently there are two methods to do this:  

1 Auto-MRP 

2 MFG Safety Stock.  
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Both methods have pros and cons that are explained below. 

Auto-MRP (eKanban)  

This is setup on the item level and is used to determine a Min/Max on hand situation. The system uses 
the Actual On-Hand to determine when an “Internal Sales Order” should be created or updated with 
releases to generate work orders for an Auto-MRP item. The system looks at the Current On Hand 
amount (Note: Not the Non-Allocated amount) to determine if a Re-Order point has been met. If the Re-
order point has been met the system will create a release on the Stocking sales order to drive the system 
to create the required work order. The work order quantity is based on the Qty to MFG value setup on 
the item minus the current actual On-Hand. (Note: If the item has MFG Min or MFG Multiples of setup 
this will affect the quantity on the work order). The quantity of the work order can float as the On-Hand 
amount changes; this is normal MRP logic in EIQ. Another feature that can help control the Auto-MRP 
creep is setting the item up to Schedule to SO Allocate. What this setting does is allow the supply being 
created by the Auto-MRP order to be allocated to Demand that is outside of the Mfg. Time Fence for the 
item or the system default. One key thing to remember is that the restock WO is not created until the 
actual On Hand is less than the Mfg. Order Point. See the sections above for more details. 

MFG Safety Stock (Inventory->Manufacturing Tab) 

This setup allows for a quasi-stocking program to be maintained, that is driven off a combination of the 
Non-Committed On-Hand and customer demand. In other words entering in an amount in the Safety 
Stock field tells the system to ignore the quantity in this field when looking at available product. This 
does not affect in anyway the ability to sell, ship, consume, or otherwise use the product that is in 
“Safety Stock” instead it hides the inventory from the MRP engine when it is determining if there are 
enough products available to meet demand.  

PROS and CONS for each option: 

Auto-MRP (eKanban) 

PROS: 

▪ The system will automatically create a Sales Order/ Work Order if the inventory amount is below the 
MFG Order Point. This is true when just setting up an item, even though there is no inventory on-
hand the system will create the supply to get the item back up to the MFG Qty. For an ongoing basis 
the system will only create a Supply Order when the actual On-Hand is less than the Reorder point. 

▪ For End users that are using Division a separate Auto-MRP setup can be created for each Division. 

▪ The system will automatically inactivate the Auto-MRP setup if the inventory item is marked inactive. 

▪ VMI can be included or excluded on the On Hand amount depending on how the user sets up the 
inventory item. 

▪ SO Allocate can be allowed as well to prevent multiple Work Orders for the same item being created 
if the Sales Order demand is outside of the Mfg. Run Size fence for the item. This means that if you 
have a Mfg. Run Size of seven days and the On hand drops below today and no sales orders have 
demand within those seven days the system will allocate the Supply from the Auto-MRP Work Order 
to the future demand. However, if you have a Sales Order that has requirements within seven days 
of the Stocking Order requirements and the current On hand is not enough to cover the Sales Order 
requirements you will get another Work Order that is separate from the Stocking Order. 
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CONS: 

▪ The system only takes into account the Actual On Hand of the Inventory; it does not take into 
account the Non-Committed inventory. This may lead to situations were multiple work orders will be 
created and a true level loaded approach to scheduling control will not be able to be maintained. 

Mfg. Safety Stock 

PROS: 

▪ The system looks at the Non-Committed value of the item to evaluate when a Work Order needs to 
be created. The trigger for this is based on when the Non-Committed is less than what is required for 
Demand in the future. The key concept here is the Demand is driving the stocking program. 

▪ There will only be one work order involved for the restock plan, unless Max WO Batch or MFG Min 
size is less than the required amount for the Demand. Typically the system will only create a single 
work order. 

▪ The user should create an appropriate Min Qty. to attain a stock level.   This means that the user 
should set the Min Quantity to what they typically would want to run on a single work order.  This is 
done to optimize the setup and reduce repetition of running the same item more than once. 

CONS: 

▪ When a part is first setup, the user must create a Manual Work Order to get the system back up to 
the Stocking Level that they want to maintain on this inventory item. 

▪ There is no automation in the creation of the Work Order. All this is driven from the Demand vs. 
Supply coming from Customer Orders. However, if this is properly setup and maintained the system 
will maintain the appropriate level of stock at all times. 

Notes: 

▪ The MRP Engine will always protect the system, in other words Customer Demand will always be 
met.  

▪ Both Auto-MRP and MFG Safety Stock settings must be evaluated on a regular basis. This holds true 
for the other settings related to Manufacturing. 

▪ Family Tools create a unique problem when setting up Auto-MRP or Safety Stock. The concept of 
schedule allocation must be understood by the user, which means that if I setup either method on 
one part of the family tool a work order could be generated with “Zero” requirements for the other 
item(s) of the family tool. For example, a work order could be created for side A showing 
requirements for A, but the system knows internally that B will also be made. Care and thought 
should be given to setting up Family Tool items. 

▪ MFG Safety Stock is the correct choice for customers that want the system to use the Non-
committed Amount to help drive the supply creation. 

▪ Auto-MRP is the correct choice for customers that want the actual On-hand Amount to drive the 
creation of supply. 
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Cloning an Inventory Item 

Inventory items may be cloned to facilitate the creation of like inventory items. To clone an item: 

➢ From the EIQ Launcher Bar, click on the Inventory button or select File| Manufacturing|Inventory 

from the menu. The inventory pick list will appear. 

➢ Select the item that is going to be cloned and the main inventory screen will appear. 

➢ Select File|Clone Item from the menu. The following screen will appear: 
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➢ Enter the new Class, Item number, Revision level. The EPlant will fill in automatically with 

the EPlant the user is logged into.  

Note: When cloning an item the system will populate the item number with the next sequential number 
if the ‘System-Generated Inventory#’ option is enabled in System Parameters->Sequential Numbering 
tab.  The value can be overwritten if desired. 

➢ Below lists additional options that can also be cloned. Check boxes can be manually 
checked, or use the 'Select al' and 'Unselect all' speed buttons to check or un-check all 
options at once. 

▪ Include AutoMRP information - Check this option to clone the Auto MRP information also. If it is not 
checked the Auto MRP data will not be cloned. Note: The Auto MRP information will not be available 
until a default manufacturing number is assigned to the cloned inventory item. 

▪ Include User Defined Form - Check this option to include the data in the fields in the user defined 
form. 

▪ Include AKA Selling Information - Check this box to include the AKA Selling information (including 
attached commodities). This will also clone the Internal and External AKA Documents. 

▪ Include AKA Buying Information -  Check this box to include the AKA Buying information. This will 
also clone the Internal and External AKA Documents. 

▪ Include Inspection Setup Parameters - For users with the SPC module this box can be checked to 
include the inspection setup parameters and attached gages when cloning the item. 

▪ Include Costing Information - This will clone the standard costing information, including the standard 
calculation quantity. If it is not checked none of the cost information will be cloned. 

▪ Include Internal Documents   

▪ Include External Documents  

▪ Include Email Correspondence  

▪ Include Forecast Group - If this is checked the item will be included in the forecast group that the 
source inventory item was assigned to. 

▪ Include Tier Discounts - If this option is checked the item will have the same Tier Discount assigned to 
it as the source inventory item. 

▪ Include Pricing Information - If checked the pricing from the source item will be assigned to the cloned 
item. This includes the active Buy/Sell Pricing and Standard Item Price. 

▪ Include General Information - If checked, when cloning the item, the information under the General 
tab will be copied to the new item. 

➢ Click [OK] to create the new item. All inventory item information is duplicated with the 

exception of the links to a BOM on the Manufacturing tab. 

Notes: 

The system will remember the state of each check box per user (checked or un-checked) from the last 
time it was used. 

For purchased items the average cost is also cloned. 
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If the item is cloned to another EPlant, the Inventory Group will not be cloned if the group is not 
associated to that EPlant. 

When cloning an Inventory item, the AKA Buying VMI locations will not carry over since each AKA Buying 
VMI location must be unique per Item/Vendor.   

Security can be placed on the clone feature, including all check boxes. 

When cloning an item that has an ICT eKanban trigger attached, the system does not clone the ICT 
eKanban information. 

 
 

Inventory Options Menu 

The options menu provides access to several key functions, as outlined below: 
 

Show Additional Main Picklist Fields 

The Inventory pick list potentially will open slowly when the Non-Committed field is present. This feature 
gives users an option to not include that field to increase the speed of opening the pick list. 

▪ If this option is checked, the Inventory pick list will display the Non-Committed field. 

▪ If it is unchecked, the Inventory pick list will not display the Non-Committed field. 
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Where Used 

Use this utility to quickly find where the item is used by manufacturing configurations, where it is used as 
a component in a blend, as an item or part in Maintenance, Repair and Overhaul, associated to a process 
or a sales configuration. This displays information such as: Config #, item information, Qty Per, Group 
Code, and on hand. This utility is particularly useful when replacing obsolete items with new versions. 
The relevant tabs for the item will have a green check mark, if not it will be a red x. To prevent this form 
from being hidden behind another open module, select the 'Stay on Top' feature from the options menu. 

If the user is logged in to 'View All' EPlants the top grid will display items with a matching class, item 
number, and revision across all EPlants. 
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Attached To Lists the BOMs that the item is attached to as a component or as a component of a 
process associated to a BOM. This is used primarily for manufactured items that are part 
of another assembly (usually via a Generic BOM) or for purchased components 
associated to processes. 

Main Material Lists the configurations where the item is the primary raw material being consumed. 

Blend Lists the blends that the item is used in. 

MRO Displays where the item is used in MRO Equipment as parts, or as attached inventory 
within a MRO Task. 

Process Lists processes of class 'AS' (i.e.  ASSY1), and operations without an association to a 
BOM (ex: GENERIC, INJECTION). 

Sales Config This lists the Sales Configuration Templates where the item is attached to the Choice 
Details. If the Sales Configuration Template is inactive the record will be marked with a Y 
in the Inactive column. 

Item Inactive - On the Attached To, Main Material, and Blend tabs this column will have a Y in it if the 
manufactured inventory item is marked inactive. 

BOM Inactive - On the Attached To and Main Material tabs, this This will have a Y if the BOM is marked 
inactive. 

Process Inactive - On the Process tab if the process is inactive this box will be checked. 

Sequential Where Used View 

Select the Sequential Where Used View button  to view the where used information for all items 
that contain the target component. This view includes the Max Level and a color scale for visual aid for 
each item.  
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This form includes the Filter Dataset (filter button) feature which allows users to filter the information 
based on the available columns. The information in the list can be exported to XML or Excel format from 
the right click menu. 

Right Click Options 

These options are available from the various relevant tabs. 

▪ Where Used (Drill Down) - The ability to drill down to the Where Used details for an item listed in the 
screen. 

▪ Where Used Work Order - This will show all work orders for the highlighted Config #. A form will 
appear listing all the work orders associated to that configuration as well as work order details such 
as bucket number and cycles required. 

▪ Where Used All work orders - This will show all work orders for all Config #s listed in the same format 
as above. This grid includes a 'Scheduled On' column that displays the work center and position if the 
work order is scheduled. 

▪ Jump to inventory - Jump to inventory for the highlighted item. 

▪ Jump to BOM - Jump to the BOM for the highlighted item. 

▪ Jump To MRO - This option is available in the MRO section and will take the user to the Equipment 
record. 

▪ Jump to Process - This will open the process where the item is attached. 

▪ Export Data - This will export the data to either XML or Excel format 

▪ Remove From - This option is available on the Attached To, MRO, or Process tabs. For 'Attached To' 
the item(s) will be removed as an attached component on the BOM. For Process, the item will be 
removed from the Processes Material tab. On the MRO tab the user can remove item(s) from the 
Parts tab in MRO and/or from a Task. 

Replace or Append Attached Item 

From each tab (except MRO) there is an option to replace or append the attached record such as 
attached components, processes, and main material. To replace or append an attached item first 
highlight all of the records that the change should be made for by using the Shift or Ctrl keys or the select 

buttons at the top of the form. Click on the replace speed button . and pick list will appear from 
which you can choose the new item to replace the existing one or click on the append button to add a 
new attached item. 
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Note: When appending or replacing, only items with the same default unit of measure can be selected. 
For example, if the original attached item had a UOM of eaches, an item with a UOM of LBS cannot be 
selected. The user will receive an error. 

When replacing Attached Components, users must fill in the quantity per field with the number of 
components per item required or select the 'Use Existing Qty Per' option. This option will use the 
quantity per associated to the original attached item for a specific BOM for the new item that is 
replacing it or being added. For example Insert B is replacing Insert A and Insert A was attached to a 
BOM X at a parts per of 2 and to BOM Z at a parts per of 4. With the Use Existing Qty Per selected Insert 
B will replace Insert A on BOM X with a parts per of 2, and on BOM Z with a parts per of 4. If the 'Use 
Existing Qty Per' is not checked the user must enter in the parts per and that value will be used for all 
highlighted BOM's. If nothing is entered a warning will appear stating, "A quantity and record(s) selection 
is required to continue; either select check box to 'Use Existing Qty Per' or enter value in 'Qty Per' 
column." 

Select Replace or Append and then select OK. A confirm message will appear stating the changes that 
will be made, select Yes to make the change. 

Note: For the multi-select option the parts per must be the same for all the BOM's or the user can check 
the 'Use Existing Qty Per' option. 

Once the OK button is selected a pop up confirmation form will appear: 

 



Inventory Management Page 182 of 478 

 

Select the 'Apply Now' button to make the changes. The Cancel button will return the user to the Where 
Used screen.  

Note: When an item on a Sales Configuration Template is replaced through the Where Used screen in 
Inventory, a prompt will appear, "Would you like to remove dependencies when inventory item is 
changed?"  The prompt will appear regardless if dependencies are attached to the item in the Sales 
Configuration Template. The prompt has a 'Yes', 'No', 'Yes to All' and 'No to All' options. If 'Yes' is 
selected the dependencies will be removed. If 'N'o is selected the dependencies will remain intact. If the 
user selects ‘Yes to All' then the system will remove dependencies on all selected Sales Configuration 
Templates that were selected prior to selecting the Replace speed button. If the user selects ‘No to All’ 
then the system will not remove dependencies on all selected Sales Configuration Templates that were 
selected prior to selecting the Replace speed button. When a 'to all' option is selected the system will 
not resurface the prompt during this replace procedure. The prompt also includes a 'Do not show next 
time' option. 

Create ECO 

For users with a license for the ECO module a 'Create ECO' button will be available. This will create a new 
ECO. After selecting the Create ECO button enter the Effective Date from the calendar, then select the 
Template from the pick list. A new ECO is created and new ECO BOM(s) with the substitution changes are 
associated to the ECO. The ECO Description field will be populated with "'Where Used' mass replace". 
 

BOM Tree 

The BOM tree shows all items required for the production of the item. It is calculated based on the 
Standard values entered on the BOM. The information includes the quantity of the dependent items 
required per item manufactured including scrap if applicable. The quantities are in the native unit of 
measure (UOM), and the native UOM is displayed. (Note: The scrap is calculated exponentially, for 
example if a component has 5% scrap it will display a requirement of 1.052632 = 
(1+0.05)+(0.05^2)+(0.05^3)+(0.05^4)+(0.05^5)). 
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Several tool bar functions are available in the BOM tree view. They are listed below for your reference. 

 Full Expand - Shows detail on all the items that compose the final item. 
 

 Collapse - Collapses the BOM tree to show detail on only the main item. 
 

 BOM Explosion - The BOM Explosion can be used to obtain a quick calculation as to whether the 
item can be manufactured from the non-committed material on hand. This function will show the user 
how much material in inventory is not allocated towards other work orders. It also displays the total On 
Hand inventory. 

To use the BOM function, click on the button, enter the amount of the item to be manufactured and click 
'OK'. The BOM Explosion will show the amount of each item required to manufacture the amount of 
items and indicate the amount available in inventory.  
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 Material Exception List - Select the Material Exception List button to open the BOM Tree Material 
Exceptions list. This list displays only the materials associated to the BOM that have a material exception. 

 Print - Prints the BOM Tree or the BOM Explosion. Note: The BOM tree prints directly to the printer.  
It does not require Microsoft Word be installed on the work station. 

Jump To Options 

Right click ‘Jump To’s’ available from the BOM Tree include: BOM, Inventory, Transactions/Locations, or 
Inventory Availability. 

BOM Tree Calculations 

This example is for an Injection BOM with the following information: 

▪ Runner/Sprue = 12 

▪ Scrap = 5  

▪ Part Weight = 100 grams 

▪ Std. Cav = 1 

▪ The Defined percentage of runner and sprue can be set up for Injection and Diecast MFG Types, and 
for Custom MFG Types that default to Injection and Diecast, from Mfg Types->File menu->Alter LBS/K 
Calculation. The default is 10%. 

Calculation for Pounds per Item for Primary Material 

If Regrind is >0% then one of the following formulas would apply depending on whether the process will 
produce enough regrind. The system does a comparison of shot weight less the shot weight times the 
regrind % to the cavity times part weight to determine which formula will be used. The first calculation 
checks to see if the Shot Weight less the Shot Weight times the Regrind Percentage is LESS than the 
Cavity weight total. If so, then the new Shot Weight (BB) will be equal to the total cavity weight plus the 
runner/sprue weight times defined percent of runner and sprue. 

If the process will produce enough regrind: 

Regrind = 10%,  

(Part Weight + (Sprue/Std Cav)) / (1 – (Scrap/100)) * (1 – (Regrind / 100)) 

(100 + (12/1))  / (1 – (5/100) * (1 – (10/100)) 

=  112  / 0.95 * 0.9 = 106.10526 

=  106.10526 / 453.59 = 0.233923 LBS 

If the process will not produce enough regrind: 

Regrind = 85% 

((Part Weight + (Sprue/Std Cav) * (mfgtype.lbsk_percent_runner/100) 
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(100 + (12/1 * 10/100)  

= 100 + 1.2 

= 101.2 / 453.59 = 0.223109 LBS 

No Regrind:  

((Part Weight + (Sprue/Std Cav) / (1 – (Scrap/100)) 

example: (100 + (12/1)) / (1 – (5/100) =  

= 112 / .95 

= 117.89473 / 453.59 = 0.259915 LBS 

Note: If the runner and sprue is zero and the allowable regrind is greater than the scrap % the system will 
simply take the Part Weight * Std Cavity / 453.59 to determine the LBS/Item value. 

Blends 

Blend Operation - If the primary material is a Blend Operation the components of the blend will be listed 
below the material. The requirement per item for the components of the blend will be the Blend % value 
from the 'Define Blend Operation' form.  

Example: 
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Phantom Blend - If the primary material is a Phantom Blend BOM,the components of the blend will be 
listed below the material. The requirement per item for the components of the phantom blend will be 
the Parts Per value from the Attached Materials section on the BOM.  

Example: 

 

 



Inventory Management Page 188 of 478 

 

Calculation for Requirements per Item for Class PK Items 

The information for calculating requirements for packaging items comes from the Attached Materials 
section. Parts per is on the Attached Materials tab and the Scrap is on the Details tab. 

For example: 

▪ Parts Per = 100 

▪ Scrap = 5% 

Parts Per for the attached packaging item * (1 - Scrap/100) 

100 * (1 - 5/100) 

=100 * 0.95 

= 95 

Calculation for Requirements per Item for Non PK Class attached Items (purchased or manufactured) 

The information for calculating requirements for packaging items comes from the Attached Materials 
section. For example: 

▪ Parts Per = 1 

▪ Scrap = 5% 

Parts Per for the attached packaging item / (1 - Scrap/100) 

1 / (1 - 5/100) 

=1 / 0.95 

= 1.052632 

Note: If the item is manufactured and has a primary material and/or components, they will be listed 
below the item and the calculations for the requirements are as described above. 

Total Required 

The calculation for the total required is the requirements per item multiplied by the 'BOM Quantity 
Explosion' the user entered. 

For example, if the Pounds per Item is 1.124251 for a BOM Quantity Explosion of 1000, the Total 
Required = 1,124.251 
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On PO / Receive 

On PO/Receive displays a summary list of open purchase orders that have not been fully received that 
the item is listed on. It displays the release information including Qty, Request and Promise dates, and 
the Acknowledged check box. The lower section displays line item notes. This information cannot be 
edited from this form. 

The ability to Jump to PO or Jump to Receiving is available by right clicking in the top section. A sample of 
this screen is shown below. 
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Labels 

The user has the ability to print labels created in Label Matrix or CRW for inventory items. This feature 
may also be accessed from the speed button. Labels may be printed for any class of item in inventory. 
EnterpriseIQ supports both manufactured and purchased materials labels with the label type being linked 
to whether the inventory item is manufactured (linked to a BOM) or purchased (no BOM link). The 
printing of each of these label types is discussed below. 

NOTE: Label Matrix must be properly installed and linked to EnterpriseIQ, the database files must be 
prepared, and the labels must be designed in Label Matrix or CRW before using this feature. This topic is 
covered in detail in the Label chapter, See Labels. 

Printing Purchased Component Labels 

➢ Select Options|Labels or click on the Print Labels button from the main inventory screen of the 

item that the labels are required for. If the selected item is purchased, the following screen 
will appear: 
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The date will fill in automatically with the system date. 

➢ Select the Label type by clicking on the arrow down list or if the label is new, click on the New 

Label button. Creating a new label is discussed above. 

➢ Enter the Lot # and Box Qty fields, if applicable.  

Note: If the item has the 'Lot # is Mandatory' option checked (Inventory->Additional tab) and a lot 
number is not entered on the label, a warning will appear when the user attempts to print the label 
stating, 'Lot # is Mandatory for 'Item #'. Continue?' Select No to return to the label form to enter the 
Lot#. If the user selects Yes, the label will be printed without a Lot#. Security can be added to this button. 
The pop up also includes a 'Do not show next time' check box. 

➢ Enter the Labels Quantity to tell the system how many labels to print or accept the default. 

➢ Optionally enter the Country of Origin using the user defined drop down list or manually type 

the information. 

➢ Printer - If the selected label is a Label Matrix label this field will be visible for the user to 

select a specific printer. The selected printer will be remembered.  

➢ Label Disposition - This allows users to override the label disposition setting. The drop down 

choices are: System, Dispositioned, Non-Dispositioned.  

▪ If the user does not touch the drop down it will be blank and the system will use the global 
parameter in System Parameters -> Label Setup -> Print all Labels (Purchased or Manufactured) 
based on whether the item is Purchased or Manufactured. 

▪ If the user selects System, the global parameter will be used. 

▪ If the user selects Dispositioned, the system will set all labels printed in this session as Master_label. 
Dispo_Scan = Y. 

▪ If the user selects Non-Dispositioned, it will set all labels printed in this session as Dispo_Scan=N 

▪ The system does not remember the previous drop down selection, it will always default the field to 
blank, which uses the global setting. 

AKA Item # -  If the selected customer has AKA information the AKA Item# will populate in the Print 
Label screen. 

User Fields for Labels 

EnterpriseIQ allows information entered in the User Fields within inventory to be printed on labels or the 
input of information onto the labels when printing the labels. These options are both supported using 
the User Fields, as described below: 

➢ From within the Print Labels screen, click on the User-Defined tab. The following screen will 

appear: 
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Information entered into the User Fields for the inventory item will automatically fill into the appropriate 
field, as shown above in the User Char 1 field. 

➢ To change the field labels, right click on the field heading and click on Define Label Text. 

The User Defined Captions box will appear. In the New Value field, enter the new field 
caption and click on [OK] to return to the User Defined screen. The new heading will now be 

in place of the system default heading. 

➢ Enter any information (or override existing information) in the comment fields that is to 
appear on the label. 

NOTE: The User Fields must be added to the label in order for the information to be printed on the label. 

➢ Click [OK] to print the labels. 
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Labels for Manufactured Items 

Printing Manufactured Item Labels 

➢ Select Options|Labels or click on the Print Labels button from the main inventory screen of the 

manufactured item. The following screen will appear: 

 

Date This will default to the current date but can be changed. 

Customer This will default to the customer associated with the manufactured item but can be changed 
if the item was shipped to a different customer by clicking on the drop down arrow list and 
selecting a different customer. 

Check the 'Exclude' box to print labels without a customer. 

Order # This is the order number associated with the shipped item. This field cannot be changed. 
This field is only visible on the form when printing from the print labels module on the 
Sales/Distribution tab of the Launcher Bar. 
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PO # This is the purchase order associated with the order # for the item shipped. This field is only 
visible on the form when printing from the print labels module on the Sales/Distribution tab 
of the Launcher Bar. 

AKA Item # This will display the AKA Item # when applicable, such as when printing labels from sales 
orders and inventory. For sales orders this will populate based on the AKA # from the sales 
order. When printing labels from inventory if the user prints the label within inventory and 
selects a customer with AKA information set up for the item, the AKA # will populate. If the 
customer has multiple ship to addresses, the AKA # will populate based on the selected ship 
to. 

Sales Order Qty When printing labels from the Sales/Distribution tab this field will be visible and will display 
the blanket quantity from the sales order. 

Bill To This is the bill to address associated with the order. This can be changed if additional bill to 
addresses exist for the customer by clicking on the drop down arrow and choosing from the 
list. 

Ship To This is the ship to address associated with the order. This can be changed if additional ship 
to addresses exist for the customer by clicking on the drop down arrow and choosing from 
the list. 

Label This is the label that will be printed. To change the label type click on the drop down arrow. 
This is a list of the label menu titles that have been created. 

The drop down list will also display a 'Label Origin' column. Both manufactured and 
purchased items show the default label associated to the item (when applicable) on the first 
line of the Print Label drop down with origin = inventory.  If a default label is specified for a 
manufactured item on the AKA Selling tab, then origin = AKA.  Non-specified labels for 
manufacturing have origin = customer; for purchasing, the origin = labels. 

Manufacturing # This is the manufacturing number associated with the order/part. If the Manufacturing # is 
inactive it will display in yellow.  Note: An inactive BOM is available for Mfg# selection only 
when a work order exists for the inactive BOM (even if an inactive BOM is the default Mfg# 
in Inventory). 

Lot # The user may type in a lot number to print on the label. 

When printing a label from a Packing Slip there will be a search button next to the Lot # 
field. The pick list will include values of Lot #s shipped within this packslip. The Lot # will 
populate in the labels form only when there is just one Lot# available for the item, 
otherwise a selection can be made if more than one Lot#. 

If the item has the 'Lot # is Mandatory' option checked (Inventory->Additional tab) and a lot 
number is not entered on the label, a warning will appear when the user attempts to print 
the label stating, 'Lot # is Mandatory for 'Item #'. Continue?' Select No to return to the label 
form to enter the Lot#. If the user selects Yes, the label will be printed without a Lot#. 
Security can be added to this button. The pop up also includes a 'Do not show next time' 
check box. 

Package The packaging item associated with the part. If more than one packaging item is associated 
with the item the user can select a different one from the drop down list. 
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Pk Unit Quantity This is the number of items per packaging item. For manufactured items, this information 
comes from the BOM unless the the 'Use Inventory BOL Data for Packaging Quantity' setting 
in System Parameters->Label Setup is checked the system will use the BOL Data instead of 
the BOM.  

When printing  labels from the Inventory module only, for purchased items this 
information comes from the Items Per Package field in BOL Data (Inventory->Options 
menu). 

Labels Qty This is the number of labels to be printed. This defaults to zero. The system will calculate 
this by clicking on the calculator icon (Qty/Box Qty = labels qty). The quantity used will 
depend on where the label is being printed from. For example, if printing from the 
Sales/Distribution tab the system uses the total quantity ordered. 

If a negative value is entered for an item marked as serialized control, a warning will appear 
stating, "SIC Inventory item - negative qty is not allowed. Operation aborted."   

1st Box # This is the number of the first box. The box # increments per part (not per packaging item). 
The user can edit this field by clicking on the icon next to the field and typing in the first box 
number. 

Volume This information populates with the volume data from the additional tab in inventory for 
the associated packaging item. 

Weight This information comes from the detail tab on the Items Details tab in BOM for the 
packaging item. 

Country of Origin This is the Country of Origin for the item. The user can select this from the user defined 
drop down list, or enter it manually.  This will populate in the Master Label table. 

Printer If the selected label is a Label Matrix label this field will be visible for the user to select a 
specific printer. The selected printer will be remembered.  

Label Disposition This allows users to override the label disposition setting. The drop down choices are: 
System, Dispositioned, Non-Dispositioned. 

▪ If the user does not touch the drop down it will be blank and the system will use the global 
parameter in System Parameters -> Label Setup -> Print all Labels (Purchased or 
Manufactured) based on whether the item is Purchased or Manufactured. 

▪ If the user selects System, the global parameter will be used. 

▪ If the user selects Dispositioned, the system will set all labels printed in this session as 
Master_label. Dispo_Scan = Y. 

▪ If the user selects Non-Dispositioned, it will set all labels printed in this session as 
Dispo_Scan=N 

The system does not remember the previous drop down selection, it will always default the 
field to blank, which uses the global setting. 
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➢ Edit the User Fields, as discussed above. 

➢ Click [OK] to print the labels. 

➢ Potential Label printing error: "Field, division, not found." - Although this error in general 

means the .dbf needs to be recreated and label re-analyzed in the file path specified  in 
System Parameters > Label Setup tab, the cause could be that the file path itself is not 
correct for the workstation where the label is being printed from.  If the folder specified in 

the file path does not exist at all, user will get a different error indicating the path is not 
valid.  However if the file path points to a folder that actually exists but without the .dbf in 
it, they will get the error: "Field, division, not found". 

Dimensional Inv 

➢ For Serialized Inventory Control items only there will be an additional tab on the Print Label 

form. 

 

The 'Dim/Characteristic' field populates with the information entered in the 'Dimensional Inventory/ 
Characteristics' form accessed by selecting the button next to the Serialized Inventory check box on the 
Main Inventory tab in Master Inventory. A 'Value' can be manually entered. Users can enter a 0 value for 
a mandatory field. This is informational only.  
 

Inventory User Defined Form 

User defined forms allow the user to add new fields for a specific module. These fields can then be used 

in customized reports. This option can also be accessed from the speed button . 

To set up the form see User Defined Forms in the Common Form Functions section of the Using 
EnterpriseIQ manual. 
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Item Specifications 

The Item Specifications screen allows the user to tie any specifications or special codes to an particular 
item. Item Specifications can be used in User defined reports. 

➢ The first step is to set up under the Master Specification table which can be accessed by 
selecting Misc|Master Specifications from the inventory menu or Sys Setup|System Parameters| 

Lists|Master Specifications. 

 

Enter the Codes, Descriptions and Revision level of each specification. (Note: The ‘Code’ field must be 
unique).   

➢ The next step is to assign the Master Specifications to an inventory item. Select Options| Item 

Specifications from the inventory menu to access the Item Specifications table. 

 

➢ Item Specifications can be added by clicking on the [+] key and selecting from the arrow 

down list. 
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MPS Time Phase 

From the inventory module, Options/MPS Time Phase you can jump to the Master Planning Schedule 
information for a particular item. If the item has not been set up as a MPS Item (the MPS Item option is 
not checked on the Manufacturing tab in Inventory) a pop up confirm message will appear asking, "Add 
Item 'xxxx' to MPS Time Phase Data?" If the user selects Yes, the system will automatically check the MPS 
item check box and open the MPS Time Phase Data form.  If the user answers No the Time Phase Data 
form will open blank and the MPS Item Check box will not be checked. If the user selects Cancel the MPS 
Time Phase form will not open and the user will be taken back to Inventory. 

Note: Only items with the MPS item check box will be visible in the MPS Time Phase Data form. 

MPS stands for Master Production Scheduling, a method of viewing time phased data pertaining to a 
part number. This can include demand (forecast, sales order and dependent), current work orders (firm, 
generated, manual) and projected on hand balances (availability). 

The system supports this information to be setup by part number. However, not all part numbers should 
be included in this system. Generally, only those items that are sold (final products) are normally 
associated with the MPS. This is because scheduling these items will also affect the manufacturing and 
purchasing of the lower level components, negating the need to directly include these in the MPS 
system. 
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This view illustrates, weekly, the supply, demand, available to promise and the running balance of the 
item. This information is completely based on the current sales order situation, the forecast, dependent 
demand (demand for this part based on another part consuming it) and availability. The number of 
weeks displayed is based on the scheduling scope in days set in the scheduling module under 
Options/Scheduling Parameters. 

NOTE:  To view the most current information the Time Phase Data must be calculated by clicking on the 
calculator speed button. When MPS reports are run a procedure called 'Populate Time Phase Data' is 
executed prior to printing that will recalculate the Time Phase Data to insure the reports contain up to 
date information. 

The upper left grid area shows the basic item information from inventory, including On Hand, On Hand 
less Non-Allocate, and On Hand less In-Transit. 

The upper right grid area shows the current status of the part, with information such as the safety stock 
level (ReOrd Point), the yield factor, on hand, MFG Min Qty, MFG Multiple Of, and MPS data, all taken 
from the Inventory record or the BOM. 

The bottom section of the form represents a summary of the production week. For specific information 
on each field refer to the MPS Time Phase section in the help files, see Time Phase Data. 
 

On  SO / PO 

This option has been removed. Please use the On PO/Receive or Sales Order Activity options. 
 

Buyer Code 

This option brings up the Buyer Code list. This list is used to assign a buyer code to an inventory item. 
The code associated with the inventory item is displayed in the Material Exceptions and Daily Projected 
Material requirements. 
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To add buyer codes, select the ADD (+) button and enter a Code and Description. Codes can only be 
deleted if they are not assigned to any inventory item. 
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BOL Data 

This options allows the user to set up case and pallet information for calculating the Bill of Lading when 
shipping a purchased item. The package information (not the pallet) will be used to calculate the Bill of 
Lading for the purchased item when selecting ‘Calculate BOL based on default system values’ option in 
Packing Slips and Multiple packing slip BOLs. (See Calculate BOL based on default system values for more 
information). 

It can also be used for manufactured items by checking the 'Override BOM information' box. If this is 
checked, the system will use the BOL Data to calculate the BOL shipping information and not the 
information from the BOM or label. 

BOL Data is also used in conjunction with the Pick Ticket parameter, 'Enable volume\weight calculations'. 
This parameter is a tool to determine how many boxes and pallets can fit into the container/trailer 
before starting a new container/trailer. As items are added or removed to the pick ticket the calculations 
will recalculate to determine the volume and weight. (Please see Shipment Volume / Weight Calculations 
for more information). 

The Movement Class portion is used to describe the relative frequency of transactions involving the 
UOM in the warehouse for the item.  

The Movement Class portion is only available if licensed for 'Advanced WMS'. 
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The data can be entered for loose, case, or pallet info or all: 

▪ Weight - The Loose weight is the individual weight of one single item and does not include packaging 
items.  For manufactured items this is the same field as the weight field on the Additional tab in 
Inventory. Case weight is the weight of one case, and Pallet weight is the weight of one pallet.  

▪ Items per (Case, Pallet) - The number of items per case, i.e. quantity of items in a box. The number of 
items per pallet. 

▪ Volume - the volume of the loose item, case or pallet. This value can be entered or calculated. To 
calculate the volume select the + to expand the field and enter the Length, Width, and Height. Next, 
select the double arrow button to calculate the volume. 

Note: For Advance WMS, if using Loose for the Default PK Unit all requests for Inventory movement must 
be in whole numbers. When using 'Loose' there is no Parts Per as it is always one. 

Location and Package UOM Setup - The UOMs for weight and volume can be setup in 'Location/Pkg 
UOMs' accessed from the File menu in the Location Type module. 
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Movement Class 

A movement class is used to describe the relative frequency of transactions involving the UOM (loose, 
case, pallet) in the warehouse for the item. Use the drop down list to select a movement class. The 
Movement Classes can be configured from System Parameters->Lists->Inventory Movement Class or 
from Inventory->Miscellaneous->Inventory Location Info->Movement Class Maintenance.  Enter the 
maximum Max Pallet Stack for the item (the maximum = 99). If a movement class is manually changed 
for an item check the 'Lock Move Class' check box under the specific movement class to prevent the 
system from reverting back to the calculated class when the movement ranking is recalculated. 

Select the 'Default PK Unit Type' for the item from the drop down list: E-Loose, C-Case, P-Pallet. This is 
used in Inventory Movement Ranking. This will populate in TRANSLOG.PK_UNIT_TYPE. 

Override Receiving Default  - This is used by the Inventory Transaction Planning engine to determine if 
the Receiving Designated Location should or should not be used. With the option selected, when 
receiving through IQRF the system ignores any default Receiving Designator locations and always 
prompts for a location. If this option is not selected, the system will add a location for  the default 
receiving location (matching the division/warehouse of the PO line item) if they do not already exist for 
the item. 

ICT Info 

This will only be visible for users licensed for ICT. 

Items Per Full Truck - Enter the quantity of items per full truck. This is used to calculate the freight cost in 
Intercompany Receiving. During Intercompany receiving the freight cost can be calculated which will add 
a landed cost to the actual cost for the location. There is a check box in Intercompany Receiving to 
calculate the Freight Cost when using the 'Receive All' button, or it can be calculated for an individual 
item by selecting the calculator button in the Freight Cost/Item field. This value can also be manually 
entered. On Posting ICT Receipts for an item with a freight cost the locations actual cost 
(FGMULTI.ACT_COST) is increased by the Freight Cost per Item amount. The system will add a second 
row to the main Translog table in Data Dictionary with the Item information (CLASS, ITEMNO, REV, 
DESCRIP, and UNIT) with a transaction type = 'LANDED COST'.  This row will allow tracing where the 
additional act cost came from. 

The calculation is: Full Truck Rate based on the EPlant/Division From and To in the Full Truck Table in ICT 
/ Items Per Full Truck from the ICT Info in BOL Data for the item being received.  
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Environmental Regulated Components 

This is a list of Environmental Regulated Components associated to the inventory item. This utilizes the 
information entered in the Chemical Abstract Service (CAS) list (Chemical Abstract Service) and the 
Environmental Regulations list (Environmental Regulations). 

Users will first enter Environmental Regulations, then enter the Chemical Abstract Services. The 
Environmental Regulations are then associated to Chemical Abstract Services. Once this information has 
been entered go to an item where a regulated component applies and enter the details in the 
Environmental Regulated Components form. 

 

Click the ellipsis button in the 'CAS Name' field to access the CAS pick list. Select the applicable item. The 
CAS list can be accessed for adding or editing items from this form by clicking on the CAS speed button. 

Next, enter the Percent and a comment if desired. 

Once this information is entered users can print reports of declarable substances to comply with 
regulations. 
 

Physical Inventory/Cycle Counting 

See the Physical Inventory section below. 
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Inventory Accounts 

The default Sales, Inventory and Purchase Price Variance (PPV) accounts can be manually overridden for 
each inventory item on a global basis by using the Inventory Accounts feature. 

➢ To access this feature, select Options|Inventory Accounts from the inventory menu. The 

following screen will appear 

NOTE: Some fields in the screen may be 'grayed out'. This indicates that the item is a purchased 
(inventory accounts are set up through the cost element screen) or a manufactured item that is not tied 
to a BOM. 

How the list is ordered will display in the top section (i.e. 'Sorted by Class'). To change the order, select 
the Order By menu option and select an option from the list. 

There is also a search button to access the pick list of items which allows users to sort on any column. 
The pick list includes the Advanced filtering option.  

 

➢ Select the item to be modified (or select multiple items by clicking on the first row and 
holding down the Ctrl or Shift keys and click on the ending row). 

➢ Select the Inv Account to be Assigned to from the arrow down list. 

➢ Select the GL Account to be Assigned from the arrow down list. 

➢ Click on 'Apply' when finished. The new GL accounts will fill in as in the screen above. 
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MTD/YTD 

The MTD/YTD function displays a summary of the quantity and cost information for a particular item for 
any specified time period. 

 

➢ Select the filter method to be used (MTD (month to date), YTD (year to date), or a date 

range) by clicking on the button adjacent to the label. For Date Range, select the range of 
dates by clicking on the arrow down and accessing the calendars. 

➢ Click on Calculate to view the information for the selected filter. 

The system will look at 6 decimals places for the calculation, but display the result rounded to 2 decimal 
places.The formulas used for the amount calculations are as follows: 

Purchased 
Components 

Dollar Value = Quantity from Translog * Actual Cost 

Actual Cost for In transactions comes from the PO. Actual Cost for the Out transactions is 
based on a weighted average and can be viewed either on the Location and Transaction 
Screen or the Translog. 

Manufactured 
Items 

Dollar Value = Quantity from Translog * Std. Item Price 

The Std. Item Price is entered on the Pricing Tab of the Inventory Screen. If the Std. Item 
Price is 0.00 or left blank, the In and Out amounts will be 0.00. 

The quantity excludes the following transaction types: MOVE_LOCATION, VMI MOVE_LOCATION, and 
VMI INTERPLANT XFER. If there is a Void PO transaction the original PO receipt and the Void PO 
quantities are excluded from the IN / OUT counts.    
 



Inventory Management Page 209 of 478 

 

Commodities 

The Commodities form is used for three distinct purposes: 

▪ AKA Commodities 

▪ Shipping Manifest Commodities 

▪ Purchased Item Commodities 
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AKA Commodities 

The AKA commodities functionality allows the user to associate a commodities charge with an AKA item. 
The commodities charge will automatically be added to the AR Invoice as a separate miscellaneous line 
item with a quantity of one and a unit price calculated based on the selected procedure. 

The following fields are used for AKA Commodities: 

Description The description of the AKA Commodity. 

Code Optionally enter a code. 

Surcharge Rate  The rate used in calculating the commodity when using the AMOUNT_SUR_RATE and 
PRCENT_SUR_RATE  procedures. 

Actual Rate Informational only field used to describe the actual rate. 

GL Account The GL account to be used when posting the AR Invoice. Select the GL account from the 
pick list which is accessed by clicking on the ellipsis button. 

Procedure Click the ellipsis button to access the list of procedures. See AKA Commodities for more 
information on the specific procedures. 

Propagate 
Commission 

If the Propagate Commission option is checked when the commodity is added to the 
AR invoice, along with the inventory item, the commodity will have the same 
commission as the inventory item. 

 

Shipment Manager Commodities 

The following fields are used for Shipping Manager Commodities. These commodities are used for 
international shipping manifests in the Shipping Manager module only. 
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Description Description of the Shipping Manager Commodity. 

Code Optionally enter a code. 

GL Account A GL account is required to save the entry but is not used for the shipping manager 
record. We recommend using the freight GL account. 

Unit Weight Weight of the commodity corresponding to the unit of measure. (this will always be 
LBS until further changes). 

Unit Value  Customs value for one unit of the commodity. This is the selling price, or cost if not 
sold, of the commodity. 

UOM The UOM field is the default unit to be used with quantity and unit value, when the 
commodity is listed on a shipment. Right click and select ‘ Edit User Defined List’ to 
create the UOM options then select the UOM from the created list, or manually type 
the UOM in the field. 

Country of 
Manufacture 

Where the commodity was originally manufactured or produced. 

Country Code The code associated to the Country of Manufacture. 

  

Purchased Item Commodities 

Commodities can be associated to purchased inventory items, then when creating the AP Invoice the 
actual cost on commodities can be entered which will allow for a comparison to the commodities 
standard cost. 

Description Description of the Purchased Item Commodity. 

Code Optionally enter a code. 

Surcharge Rate Enter the 'standard' commodity cost. this will then be used to compare to the actual 
cost entered from the AP Invoice. 

GL Account A GL account is required to save the entry but is not used for commodities associated 
to purchased items.  

Once purchased item commodities have been created they are associated to an item by selecting 
'Attached Commodities' from the right click menu in Master Inventory.  
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Select the insert record button then click in the Commodity field to access the pick list of commodities. 
Select the commodity to associate to the item from the list. The Commodity name and Surcharge Rate 
will populate. An Amount can be entered which is used to calculate the Calculated Cost (Surcharge Rate 
* Amount = Calculated Cost). 

To enter the actual cost, from the AP Invoice line item section, right click and select 'Add/Edit Commodity 

Price Information'. A pop up form will appear listing the items commodities with a field to enter the 
Actual Cost. 

 

After posting the AP Invoice the Standard Cost and Actual Cost information for the commodity will be 
linked in the view: V_AP_COMMODITIES. Reports can be written to show actual and standard cost 
comparisons. 
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Inventory Period Valuation 

This option allows the user to view inventory information for a specific moment in time. It middle section 
includes the item details such as standard cost, on hand and total non conform information. The lower 
section displays the location detail for the highlighted item including the location name, quantity, actual 
cost, lot #, division, and non-conform description. The data is put into the tables at the time of the ‘Date 
Created’ and will display the current data at that particular time. The relevant tables for this information 
are: ARINVT_PERIOD_VAL and ARINVT_PERIOD_VAL_DTL.   

The BOM/EOM Period Start and End dates are informational for reporting purposes. A comment can be 
added for additional information by the user. 

Note: Once a header row has been deleted, the data from that ‘point in time’ will be lost since the ‘Date 
Created’ field determines the date/time used for populating the inventory std cost and on hand data. 
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Inventory Miscellaneous Menu 

Cost Calculation 

The Cost Calculation feature calculates the standard cost for manufactured items. This is the same 
function as the Calculate Cost button on the standard cost tab. See Standard Costs for Manufactured 
Items for details. 
 

Roll Average Cost to Standard 

This function will roll the average cost to the future cost for selected items. A warning will appear first 
stating, "This option rolls average cost to future cost. Are you sure you want to continue?". When 'Yes' is 
selected a pop up filter form will appear to select for which items to roll the costs for. 
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The user may select a certain class, manufactured items, purchased items, all items, or 'this item'. 

This will populate the average cost into the future cost field located in the calculate cost screen so that 
the user may then roll it to the current costs, generating the general journal entry to revalue inventory 
for standard cost users. 
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Mass Update Pricing 

From these options users can update buying or selling pricing based on a percentage increase or 
decrease or a flat amount with an effective date for specific items. Pricing can also be manually adjusted. 
Select Mass Update Selling Pricing or Mass Update Buying Pricing, based on the pricing to be updated, 
from the Miscellaneous menu in Inventory.  
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To update pricing find the item(s) in the list that you would like to change the price breaks on. To find a 
specific item, enter information in the white box at the top of the form based on the sort criteria chosen 
(Item #, Rev, Description, Class, Ext Description, Inventory Group, Product Code, EPlant, AKA Description, 
AKA Item #, or AKA Rev). Advanced filtering is also available. By default only active items will be 
displayed. To view inactive items select the Active/Inactive toggle button.  Multiple items may be 
selected using the toggle buttons or the Ctrl and Shift buttons on your keyboard.  

For users with Multi-Currency set up (System Parameters->Regional tab) the pricing displayed is based 
on the selected currency, and price breaks cannot be entered without a currency. Use the search button 
next to the Currency field to select the currency from the pick list to view pricing for. The pricing will only 
be updated for the price breaks associated to the selected currency. 

Increment By 

Select the Increment By option in the Update Criteria section. Find the item(s) in the list that you would 
like to change the price breaks on. Once the item(s) are selected the prices can be changed based on a 
Percentage or Flat Amount. Select the option and then enter the corresponding value. (To enter a 
decrease put in a negative number). Enter the effective date from the drop down calendar and the 
decimal precision level required (up to six decimals).  The effective date can be a date prior to the 
current date. A comment (up to 255 characters) can be entered which will populate in the price break 
grid in inventory Selling or AKA Selling (depending on whether the customer is the Default or listed on 
the AKA Selling tab).  

Click on the OK button and the system will calculate the new pricing and populate the selling or buying 
price section on the Buy/Sell Pricing tab. The Price Date field will populate with the current system date. 

Manual Adjustment 

Select the Manual Adjustment option in the Update Criteria section. Enter the Effective Date for the new 
manually entered pricing using the drop down calendar. Find the item in the list that you would like to 
change the price breaks on. To create new prices breaks select the insert record (+) button. Enter the 
Quantity and Price. The Effective date will populate with the selected date. It can be overridden for an 
individual price break by choosing a different date from the drop down calendar in the field. Price breaks 
can be deleted by selecting the delete (-) button. 
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Enter a Price Date and an Inactive Date. If the effective date is in the future or the inactive date has 
passed, the line item will display in gray. (Note: If only the effective date is entered without an inactive 
date the line item will always be white). Enter the Inactive Date on old prices if applicable. To hide 
inactive pricing select the Hide Inactive toggle button. A comment (up to 255 characters) may also be 
entered. 

Existing pricing can be manually adjusted by overriding the current value in any field except currency. 

Additionally, the user can right click on an item in the list to jump to inventory. 

There are also modules for updating the pricing in Customer Maintenance (See Inventory Pricing 
Maintenance), and in Vendor Maintenance (See Vendor Inventory Pricing Maintenance). These modules 
will display items associated to the customer and vendor respectively. 

 
 

Inventory Location Information 

Inventory Locations are made up of several pieces of information including Location Types, Aisles, and 
Zones. The sections below will discuss each of the options available under the Inventory Location 
Information menu (Inventory->Miscellaneous menu). 

If the system does not have "Advanced WMS" licensing these lists will not be visible. 
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Inventory Aisles 

This option is only available if licensed for 'Advanced WMS'. 

Aisles can be accessed from System Parameters > Lists > Inventory Aisles, Inventory > Miscellaneous > 
Inventory Location Info > Inventory Aisles, or from the File menu in Inventory Transaction Rules on the 
WMS Control tab.  
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Create Aisles 

From this form users can created Aisles and associate locations to the Aisles. The proximity relationship 
to other aisles with a Proximity Level can be created for aisles. 

To add an Aisle select the insert record button in the Aisles section and enter the Aisle name. A 
Warehouse/Division can be associated to the aisle by selecting it from the drop down list. The EPlant will 
be assigned automatically based on the EPlant the user is logged into but can be changed by clicking the 
ellipsis button in the field to access the Assign EPlant form. The pick list will show aisles associated to the 
logged in EPlant as well as those not associated to an EPlant. 

Associate Locations to Aisles 

Associate locations to the Aisle by selecting the insert button in the Location in the Aisle section. Select 
the Location(s) from the list using the toggle buttons or the keyboard Shift and Ctrl buttons. Locations 
that are already associated to the current Aisle will display in green. Locations that are assigned to other 
Aisles will be gray.  

 

Proximity to Other Aisles 

This section will display the proximity to other Aisles and the proximity level. When creating a new Aisle, 
the system will add that Aisle in this section with a proximity level of one. To add other Aisles select the 
insert record button and enter a proximity level. The locations associated to the aisles will display in the 
right grid. 
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Location Types 

This option is only available if licensed for 'Advanced WMS'. 

Location Types can be accessed from System Parameters > Lists > Inventory Location Types, Inventory > 
Miscellaneous > Inventory Location Info > Location Types, or from the File menu in Inventory Transaction 
Rules on the WMS Control tab.  

 

Location Type maintains all types of locations where product is stored within a warehouse.  Location 
types primarily define dimensional information and storage preferences such as, number of items per 
location and stacking limitations. 

Description Description of the Location Type 

Sub Type Select the Sub Type from the drop down list: Default, Raw Material Staging, Milk Run, and 
Shuttle Trailer. 

Length  Length dimension of the location type.  Max length value = 9999 

Width  Width dimension of the location type.  Max width value = 9999 
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Height  Height dimension of the location type. Max height value = 9999 

Weight  Location type maximum weight.  Max weight value = 9999 

Items per 
Location 

Specifies how many different items may be simultaneously stored in a location with this 
location type.  Valid options are 1-9 or Multiple. 

Allow Mixed Lots Indicates whether a location is allowed to have multiple lots of the same item. 

Max Case Stack  Maximum number of cases that can be stacked in this location type.  Max value = 999 

Max Pallet Stack Maximum number of pallets that can be stacked in this location type.  Max value = 999 

Note: The Max Pallet Stack will be visible when hitting the F2 hotkey in several areas of IQRF 
such as: Search->Query label, and several Move and Disposition options. If the Max Pallet Stack 
is greater than 0 in inventory (ARINVT), IQRF will display the lowest (non-zero) value of the 
Max Pallet Stack between the inventory item (BOL Data) and the target location’s Location 
Type. 

Allocate 
Sequence 

Specifies the sequence in which items are allocated.  Valid options are FIFO or LIFO. 
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Lower Section Tabs: 

▪ The Locations tab displays the locations associated to the Location Type. When adding, a pick list of 
locations will appear that will allow the user to multi-select locations to add.  When removing 
locations, the user can multi-select locations, right click, and choose 'Disassociate Selected 
Locations'. 

▪ The Item Capacity tab allows the user to select specific items associated to the Location Type. Select 
the item(s) from the pick list accessed by clicking the ellipsis button in the Item # or Description field. 

▪ The Inv Group Capacity tab allows the user to select specific item groups associated to the Location 
Type. Select the inventory group(s) from the pick list accessed by clicking the ellipsis button in the 
Item # or Description field. 

▪ The Class Capacity tab allows the user to select specific classes associated to the Location Type. 
Access the pick list from the ellipsis button in the Class or Description field. 

Menu Options: 

File Menu: Location / Package UOMs – This allows the user to specify the UOM of dimensions for the 
Location, Loose, Case, and Pallet.  Valid options are: FT, IN, M, CM, and YD. There is also an option to 
specify the UOM for weights. The options are: LBS, KG, OZ, and GR. 
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Options Menu: Parameters - WMS – Verify Location Check Digit  

Aisle Location Generator 

Select the speed button  to access the Aisle Location Generator. This feature allows the user to 
generate locations based on an aisle, bay, and level. 

Select an Aisle from the pick list or select the New button to create a new aisle.  

 

Aisle Name Enter the name of the aisle of this location. 

Warehouse/Div
ision 

Division of the location. 
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EPlant The EPlant the locations will be created for. Note: The EPlant can only be changed if you 
are logged in as View All. 

Bay Prefix Enter the prefix that represents the bay of this location. 

▪ Start: Enter the starting number for the bay 

▪ End:  Enter the ending number for the bay 

▪ Interval: Enter the amount to increment each bay when going from the starting location 
to the ending location. 

Level Prefix Enter the prefix that represents the level of this location 

▪ Start: Enter the starting number for the level 

▪ End: Enter the ending number for the level 

▪ Interval: Enter the amount to increment each level when going from the starting location 
to the ending location 
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Parameters Value 

Values can be selected from the corresponding pick list in these fields to be populated to the generated 
locations. 

▪ Location Type  

▪ Building: Select the building from the user defined drop down list. This is the same list from master 
locations 

▪ Locating Zone, Allocating Zone, Drop Zone, and Work Zone: Allows the user to select zone types to 
associate with the location 

Update Current – Check this box next to the field(s) that should be updated for the existing locations. 

Once all of the information is entered, select Preview. The system will display a preview of locations that 
are existing in black, and new ones that will be generated in blue. Click Post to allow the system to 
generate the new locations, and/or update the parameters for existing locations.  A confirmation will 
appear stating ‘About to create <#> new locations in the master location table.  Please confirm to 
continue.’  When selecting Yes, the system will create/update the locations. When selecting No, the 
system will remain on the Aisle Location Generator to allow the user to modify any of the Parameters. If 
a parameter is modified, the user can select Preview again to review the locations that will be created.  

Note: The Start/End parameters in the Aisle Location Generator are numeric without leading zeros. To 
include leading zeros, create the locations in batches by setting the prefixes with the appropriate 
number of leading zeros. For example, enter 0 in the Bay Prefix field, then to create the first set of 
locations, enter 10 in the start field and 15 in the end field with an interval of 1. This will create 6 
locations starting with A1-010-10 through A1-015-10.  



Inventory Management Page 227 of 478 

 

 

Note: When a location is created through the Aisle Location Generator the Location Type information 
(such as Items per Location, Allow Mixed Lots, etc.) will be carried over to the master location.  If the 
location type information changes, the information will not change on the associated master locations.   
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Movement Class Maintenance 

This option is only available if licensed for 'Advanced WMS'. 

Movement Classes can be access from System Parameters > Lists > Inventory Movement Class, Inventory 
> Miscellaneous > Inventory Location Info > Movement Class Maintenance, or from the File menu in 
Inventory Transaction Rules on the WMS Control tab. 
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Inventory Movement Classes describe the frequency of transactions for the item.  It is used in Inventory 
Transaction Rules for driving product to various locations and how pick rules or locating rules may be 
assigned. Each inventory item should be assigned a movement class for it’s loose, case, and/or pallet 
movement. This movement class may be the same and should be based on the variations in the 
movement of the item. 

Ranking Based On 

This defines how the movement classes are ranked. The movement classes can be ranked based on 
percentage or defined amounts (equating to ‘Next’). 

If Percentage is selected, when adding movement classes, the total rank percentage must add up to 
100%.  If Defined Amounts is selected, when adding movement classes, the user can specify the top x 
amount of items, the next x amount of items, and so on. 

Lower Section Fields 

▪ Seq #:  Sequence number to define the order of the movement classes. 

▪ Movement Class: Code for the movement class 

▪ Description:  Description of the movement class 

▪ Transaction Rank % or Defined Amount: percentage of the ranking or amount of the ranking 

Movement Ranking 

Inventory Movement Ranking allows the system to suggest movement classes based on transactions in 

the Translog. To access this form select the  button. 
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Select the Pk Unit Type, then select the Recalculate button to calculate the movement rank for that Pk 
Unit Type. When calculating the movement ranking, the system looks at the TRANSLOG.PK_UNIT_TYPE 
based on the selected Transaction Types. The system will calculate for all PK Unit Types. The Pk Unit Type 
drop down is used to filter the data on the screen.  
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Select a From and To Date range. (Note: To include transactions for today’s date, set the To Date to the 
next date)  Select which transaction types the system should look at on the Available side and use the 
arrow buttons to send them to the Selected side and click OK. Select Yes on the warning to continue.  
The system will look at TRANSLOG records with the associated Pk Unit Type for the selected transaction 
types, within the selected date range.  

PK Unit Type allows the user to view the movement ranking for that unit type. If the system could not 
rank an item, check the ‘Not Ranked’ checkbox to view those items. 

The movement class for an item can be modified by clicking in the Move Class Description field and 
selecting the ellipsis button, or from the right click ‘Assign Movement Class’ option. If a movement class 
is manually changed for an item check the 'Lock Move Class' check box to prevent the system from 
reverting back to the calculated class when the movement ranking is recalculated. 

Other Jump To Options – Right click from the Movement Ranking screen to access: Jump to Inventory 
and Jump to BOL Data / Movement Class. 

 

Notes: 

When performing a transaction without a serial number, the system will populate 
TRANSLOG.PK_UNIT_TYPE with the default PK Unit Type from the item’s BOL Data. 

When performing a transaction with a serial number, the system will look at MASTER_LABEL.IS_PALLET.  
If IS_PALLET = N, then TRANSLOG.PK_UNIT_TYPE will be populated with C.  If IS_PALLET = Y, then 
TRANSLOG.PK_UNIT_TYPE will be populated with P. 
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Locations 

EnterpriseIQ requires that all inventory items exist in locations. The system may have an unlimited 
number of locations, but must have at least one location. 

Locations can be of any type. Some typical locations include: 

▪ Shelves and racking 

▪ Bins 

▪ Machines 

▪ Floor locations 

▪ Staging 

▪ Material 

▪ QC Inspection 

▪ Quarantine 

▪ Inspection stations 

▪ Non-Conforming / Non-Allocatable 

The Location designation can contain up to 30 characters and includes the ability to have a description 
for the location. Locations may be logical locations, where the physical location of two or more items are 
the same, but the lot numbers are different. 

NOTE: EnterpriseIQ will allow the same location to be assigned to the item multiple times for different lot 
numbers. The system will track all the material separately because of the different lot numbers. 

Setting Up the Locations Table 

To set up the Locations table, select Misc|Locations from the menu in Inventory or select Lists|Locations 

from the menu in Sys Setup|System Parameters. A pick list of existing locations will appear. Select a 
location or select the New button to add a new location. 
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This form can be toggled to table view which will display the top half as a table that will display 
applicable color attributes for In-Transit, Non-Conform, and VMI locations. 

 

Field Listing 

Note: Several fields on the Locations form are only applicable to users licensed for 'Advanced WMS'. 
Some of these fields are editable, but will be informational only. 

Location Location Name 

Description Location Description 

EPlant The EPlant will fill in based on the plant you are logged into. To change the EPlant select the 
ellipsis button in the field and select the desired plant.  

Building Optionally users can associate a building to a location. To create the Building list right click and 
select 'Edit User Defined List'. Once the list is created users can use the drop down to select 
the building. This field will be visible in pick lists. 

Warehouse/Divis
ion 

You can associate the location with a Division/Warehouse by selecting from the drop down list. 
Divisions/Warehouses are used to further define inventory locations. (See the 
Warehouse/Division https://my.iqms.com/cfs-
file.ashx/__key/Technote/Warehouse_2D00_and_2D00_Divisions.pdf TechNote for more 
information). 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Warehouse_2D00_and_2D00_Divisions.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Warehouse_2D00_and_2D00_Divisions.pdf
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Status This field only applies to users licensed for 'Advanced WMS'. 

Choose the location's status from the drop down list. The options are: 

▪ E-Empty - The location is empty 

▪ P-Picking - The location is used for picking 

▪ S-Storage - The location is used for storage 

If a user tries to set the Status to E-Empty, the system will check to see if there are any 
FGMULTI rows with On Hand > 0.  If so, a message stating, 'Existing Inventory Found Unable 
to change location 'xx' status.' with a grid of Items that are in that Location will display. 

 

Users can set the Location Status  to P-Picking or S-Storage as long as there are FGMULTI 
rows with an On Hand >0. 

From Receiving -> When the user transacts into a location, if the status of the location was E-
Empty the system will set it to S-Storage.  If the status was not E-Empty the status will not 
change.. 

From the Pick Ticket and Packing Slip ->  When an FGMulti is chosen to be picked, if the 
location status is S-Storage the system will change it to P-Picking.  If the status was not S-
Storage the status will not change. 

Reservation This field only applies to users licensed for 'Advanced WMS'. 

This will display the WO # and Item # for a Transaction Plan that has been reserved to the 
location. Locations can be reserved from the Transaction Location Plan accessed in the Work 
Order Material Staging->Work Order Planning tab 

Locating Zone This field only applies to users licensed for 'Advanced WMS'. 

A Locating Zone can be associated to the location. Click the ellipsis button int the field to 
access the Locating Zones pick list.  

Allocating Zone This field only applies to users licensed for 'Advanced WMS'. 

An Allocating Zone can be associated to the location. Click the ellipsis button int the field to 
access the Allocating Zones pick list. 
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Drop Zone This field only applies to users licensed for 'Advanced WMS'. 

Drop zones allow users to process directed tasks that cross work zones when the users do 
not have access to the tasks' end locations. The user without access will be prompted to 
drop off the material in a drop zone so that a user who does have access can pick it up 
from the drop zone and complete the task.  

To be able to pick up the material from a drop zone and complete the directed task, a 
user must have access to work both in the drop zone and in the end location's work zone. 

A drop zone may have any number of drop zone locations within it. 

A Drop Zone can be associated to the location. Click the ellipsis button int the field to access 
the Drop Zones pick list. 

Note: If a directed task's end location belongs to a drop zone that does not have any drop 
zone locations assigned, the user is directed to drop off the material in the end location 
itself. 

To add a drop zone location to a drop zone, access the drop zone within the 'Inventory 
Zones' list and access its 'Drop Zone Locations' tab in the lower half of the window. Users 
may add drop zone locations and move drop zone locations up and down the list by order 
of priority. 

Note: If the user processing a directed task either does not belong to a WMS team or 
belongs to a WMS team that has not been authorized to work in any work zones, the user 
will not be directed to a drop zone. 
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Work Zone A Work Zone is a section of locations in the warehouse. Work zones allow users to assign 
teams to particular sections of locations and restrict them from working in other sections. 
Since the teams work in specific zones, this ensures that each zone uses the appropriate 
resources. 

A Work Zone can be associated to the location. Click the ellipsis button in the field to access 
the Work Zones pick list. In the Work Order->Material Allocation screen there is a Filter 
options that allows the user to specify the Division and/or Work Zone to filter the available 
Inventory Locations by. 

Note: When a user begins processing a directed task with a start and end location, the 
system checks whether the end location's work zone matches a work zone to which the 
user's WMS team has been granted access.  

If the end location's work zone does not match any of the user's WMS team's approved 
work zones, the system then checks whether the end location belongs to a drop zone.  

If the end location does belong to a drop zone, the user is prompted to drop off the 
material in the drop zone location in first position in the sequence in the work zone. This 
allows a second user who has the necessary access to the end location's work zone to 
pick up the material from the drop zone and complete the task. 

To view the drop zone location sequence order for a work zone, access the work zone 
within the 'Inventory Zones' list and access its 'Drop Zone Locations' tab in the lower half 
of the window. Users may add drop zone locations and move drop zone locations up and 
down the list to change the sequence order. 

Note: If there are no users with access to the drop zone, this will cause a problem - no 
user will be able to drop off the material at the drop zone nor pick it up. To resolve this 
problem, access the 'WMS Teams' module and add the end location's drop zone to the 
list of work zones in which the WMS team's members are allowed to work.  

Users may also use this method to authorize a team's members to work directly in the 
end location's work zone itself. This would allow the team's members to skip the drop 
zone and move the material directly to the end location. 

Pick Path This is a numeric information field used to designate the picking route in the warehouse (up to 
22 numbers in length). This is used in IQRF for two different shipping features.  

▪ One is when the user profile is set to picking in Item mode and the Pick Path option is set to Y. 
The system will display the picking order using first in first out logic and then re-sorting for the 
picking path.  

▪ This is also used when the 'Serialized Routing' Pick Ticket parameter is checked. With this 
option checked when scanning items to a pick ticket using serial numbers the system will tell 
the user which serial number to scan based on the locations picking path. (For more 
information please see the IQRF documentation). 

Location Type This field only applies to users licensed for 'Advanced WMS' 

Select the Location Type to associate to the location from the drop down list. See Location 
Types for more information. 
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Plug Value This is used for informational purposes only. 

DT Drop Zone Use this setting to associate a 'Directed Task Drop Zone' with the location. Click the ellipsis to 
choose from a list of available DT Drop Zones, filtered by EPlant. 

Note: If the location itself has been set as a DT Drop Zone, this setting is disabled. To 
enable this setting, uncheck the 'DT Drop Zone' checkbox in the lower half of the screen. 

Note: If a partial amount is moved into the original end location as part of a directed task, 
the 'D-Drop Zone' option is not accessible for the remaining material. 

Note: If a partial amount is dropped into a drop zone as part of a directed task, the 
remaining material may only be dropped into the same drop zone. 

Dimensions These fields only apply to users licensed for 'Advanced WMS'. 

The Length, Width and Height for the location. This information comes from the Location Type 
associated to the location and cannot be manually entered. 

Weight This field only applies to users licensed for 'Advanced WMS'. 

The locations maximum weight.  This information comes from the Location Type associated 
to the location and cannot be manually entered. 

Pallet Count This field designates how many pallets a dock can hold. It provides information on the Pick 
Ticket if a Shipping Dock has been selected. If the number of pallets on the pick ticket exceeds 
the ship dock location’s capacity it will display in yellow in the middle section alerting the user. 

Inactive Select this box to mark a location as inactive which will hide it from pick lists. If the location is 
associated to an item it will still be visible in the locations screen. Under the options menu, 
users can view all locations, view active locations or view inactive locations. Note: Users are 
still able to select these inactive locations when toggling the pick list to view inactive, and 
assign them as new locations for inventory items as well as move inventory in and out of these 
inactive locations. 

General Fields in the Lower Section: 

Note: If the location was created from the Aisle Location Generator in Location Types these fields will be 
populated automatically. 

Aisle The Aisle associated to the location. See Inventory Aisles for details. 

This field only applies to users licensed for 'Advanced WMS'. 

Bay The Bay associated to the location. 

This field is informational only unless licensed for 'Advanced WMS'. 

Level The Level associated to the location. 

This field is informational only unless licensed for 'Advanced WMS'. 

Items per 
Location 

Specifies how many different items may be simultaneously stored in a location with this 
location type.  Valid options are 1-9 or Multiple. This information comes from the Location 
Type associated to the location and cannot be manually entered. 

This field is informational only unless licensed for 'Advanced WMS'. 



Inventory Management Page 239 of 478 

 

Allow Mixed Lots Indicates whether a location is allowed to have multiple lots of the same item. This 
information comes from the Location Type associated to the location and cannot be manually 
entered. 

This field is informational only unless licensed for 'Advanced WMS'. 

Max Case Stack  Maximum number of cases that can be stacked in this location type.  This information comes 
from the Location Type associated to the location and cannot be manually entered. 

This field is informational only unless licensed for 'Advanced WMS'. 

Max Pallet Stack Maximum number of pallets that can be stacked in this location type.  This information 
comes from the Location Type associated to the location and cannot be manually entered. 

Note: When evaluating remaining capacity we will adjust the location type height to be the 
lesser between location type height and item height * max stack. 

This field is informational only unless licensed for 'Advanced WMS'. 

Allocate 
Sequence 

Specifies the sequence in which items are allocated.  Valid options are FIFO or LIFO. This 
information comes from the Location Type associated to the location and cannot be manually 
entered. 

This field only applies to users licensed for 'Advanced WMS'. 

User Fields Two alpha-numeric user fields are available to enter additional information about the location. 
To change the field name right click and select 'Define label Text'. 

Last Cycle Count This will display the date the location was last cycle counted when doing a Physical Inventory 
by Location. This field is read only. 

Location Attributes: 

Note: The system will not allow users to toggle location attributes on or off if on-hand exists in the 
location. This applies to all attributes except 'Disable Auto Delete'. If attempted the user will get an error 
similar to the following: "General SQL error. ORA-20100: Unable to toggle location [LOCATION] Item # 
[ITEM #] is found in location ORA-06512: at "IQMS.TU_LOCATIONS", line 35 ORA-04088: error during 
execution of trigger 'IQMS.TU_LOCATIONS'". 

VMI The location can be designated as a VMI location (Vendor Managed Inventory). VMI is used to 
'ship' parts to a VMI location and invoice when the customer has consumed the parts.  

VMI locations are excluded when performing a physical inventory. 

Items in a VMI location are not considered for MRP purposes. 
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Non Conform The location can be designated as a Non Conform location. By default items in a non conform 
location are not included in the On Hand quantity and are not considered for MRP purposes. 
However, if the Allocatable box is checked the quantity in that location will be allocated and 
included in On-Hand quantity. Master locations marked Non-Conform are automatically 
created as allocatable or non-allocatable according to whether the Allocatable check box was 
marked in Master Locations. When adding as a new location in Transactions and Locations 
(and assigning the reason) the Allocatable check box is not available.  The allocatable 
attribute on master Non Conform locations can only be overridden from the Lot Control tab in 
Transactions and Locations. 

A Default Non Conform Code can be assigned to the location. This code will be used by default 
when dispositioning into a non-conform location so the reason is not N/A. This does not apply 
when adding the non-conform location to an item manually. 

An Authorization Required warning will appear when a user attempts to ship from a Non 
Conform location. Only users with security to select OK can proceed.  

Non Allocatable The location can be designated as a Non Allocatable location. Non-allocated indicates to 
EnterpriseIQ that the quantity is part of the On Hand inventory amount, but is not considered 
during the MRP evaluation.  

Ship Designator The location can be designated as a Ship Designator location. This is used in Pick Tickets and 
Packing slips. It is a default location where items that are shipped are removed from. When 
creating a packing slip, if a location associated to the item being shipped is marked as a 
shipping designator the user will only see shipping designator locations in the Assign Qty box. 
If the item does not have a shipping designator location assigned, then all locations will appear 
for the user to choose from. 

Ship Designator locations can be set up for a specific division/warehouse. Pick tickets can then 
be filtered for a specific division/warehouse and if using ship designators the system will pull 
from the correct location based on the division/warehouse. 

Note: Only one ship designator location is allowed per division/warehouse, or if not 
using divisions, then only one per EPlant. If a location has been marked as the ship 
designator and another location for the same division/warehouse or EPlant is marked 
as the ship designator, the first location will now be unselected as the ship 
designator. 
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Receive 
Designator 

A Receive Designator master location can be created. For EPlant users Receiving Designator 
locations can be created for a specific Division or EPlant. When receiving an item where the 
matching default receive fgmulti location does not exist yet in Transaction and Locations, when 
posting the receipt in EIQ (not IQRF/WMS) a message surfaces: “Location XXXXX is the 
designated receiving location.  Use this location for the receipt?” If there are Receive 
Designator locations set up for null divisions and specific division(s), the default receiving 
location is selected based on the Division associated to the item being received 
(PO_DETAIL.DIVISION_ID). With one default receive location assigned (for null division or one 
specific division), the system prompts the user with the default receive location regardless of 
PO Detail Division. If the user answers Yes, the location is added and received into. If the user 
answers No, for a null division item the pick list includes all existing fgmulti locations; for a 
division item, the system uses a soft division filter for the pick list. The user can select a 
location from the list or create a new location.  Note that regardless of location received into, 
for a different Lot# the user will still need to create a new location. During receiving, if a 
Receive Designator location is associated to the item the system will automatically use that 
location on the receipt screen when receiving an item using EnterpriseIQ or IQRF/WMS. When 
receiving from EIQ, the location can be changed by selecting the ellipsis button in the location 
field. When a default Receive Designator location is being used, a new Location or Lot# cannot 
be added from a scanner. 

A Receive Designator location can also be a Non Conform or Ship Designator location, but it 
cannot be a VMI location. 

Note: Only one receive designator location is allowed. For users with EPlants and 
Divisions, only one receive designator location is allowed per Division. If divisions are 
not used then only one Receive Designator can be set up per EPlant. For example, if 
there are two divisions per an EPlant, the EPlant could have three default receiving 
locations. One for each division and a one without a division.  

When selecting the Receive Designator check box on a location, the system will first 
check if another master location would be unselected as the Receive Designator if the 
user continues (i.e. due to a record that already exists that has Receive Designator 
option checked, with a matching EPlant ID and Division ID). If so, a message displays, 
'Location XXXX will no longer be marked as a Receive Designator. Continue?', with 
security on the Yes button and the 'Do not show next time' check box. 

When selecting/unselecting  the Receive Designator check box and the location 
exists is associated to items, a message displays, 'Location XXXX is currently attached 
to item(s) in Transactions and Locations.  Continue?'. Security is available on the Yes 
button and the 'Do not show next time' check box.  Note: This message will surface 
after the check for a current Receive Designator location. 

Disposition 
Designator 

Check this box to mark the location as a Disposition Designator. Multiple locations may have 
this option selected. When a location is marked with this option, when it is associated to an 
item it will be automatically marked as a disposition designator and will be used during auto 
dispositioning in production reporting. The 'Set as Default...' and 'Clear Designation...' options 
will be grayed out on the Assign Auto Disposition Designator form in Transactions (accessed by 
selecting the Edit button next to the Dispo Designator field). 
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Shipping/Receivi
ng Dock 

Multiple locations can be designated as a Shipping/Receiving Dock location. The locations with 
the ‘Shipping/Receiving Dock’ designation will display in the ‘Shipping Dock’ field in the pick 
ticket header, the Expected Receipts form, and in the Dock Scheduler module. 

If ‘Verify Inventory’ is not checked in pick ticket parameters, the Dock field is informational 
only.  

If ‘Verify Inventory’ is checked, when the pick ticket is  converted to a packing slip, instead of 
placing the inventory in an ‘In Transit’ location, it will be put in the Dock location indicated on 
the pick ticket header. This dock location is treated just like an ‘In Transit’ location, it is marked 
purple and locked from other transactions.  

No Ship If a user tries to ship from a location marked 'No Ship' through pick tickets and packing slips a 
status exception will display stating the location is marked No Ship. Depending on security the 
user can select OK to proceed or the cancel button may be the only option which will prevent 
the location being used to ship from. 

In RF/WMS the results will vary depending on whether Pick by Item or Serial is selected and 
whether the item is a serialized inventory control (SIC) item or not. 

Pick by Item:  All locations where fgmulti.no_ship = null or N are available to pick from 
(including 'No Ship' master locations toggled to Ship).  No locations are available where 
fgmulti.no_ship = Y. 

Pick by Serial: 

For a Non-SIC item: 

▪ Users cannot pick from a 'No Ship' master location even when the location is toggled to Ship. 
The user will receive a warning “Serial # xxxxx location is marked no-ship”. 

▪ Users can pick from regular locations toggled to ‘no ship’ without a warning.  A new location 
(fgmulti record) is created ‘on the fly’ for this location description, while the system retains 
the original fgmulti_id for the serial number in the master_label table.  When a pick ticket is 
converted to a packing slip, the inventory is removed from the new location that was created, 
driving it negative. 

For a Serialized item: 

▪ The system considers the individual fgmulti location status to determine whether serials can 
be picked from these locations.  For example, a regular location toggled to ‘No Ship’ in 
Transactions and Locations will surface a warning when picking (and picking is prevented).  
Conversely, a ‘No Ship’ master location toggled to ‘Ship’ in Transactions and Locations will 
allow serials in that location to be picked without warning. 

Note: The On Hand in a No Ship location is considered in MRP for allocation towards demand.  

No Backflush A user cannot backflush OUT of a location marked 'No Backflush' during production reporting 
auto dispositioning, PRA backflush, and IQRF/WMS backflushing.  

If a 'No Backflush' location is marked as a disposition designator, the system will put items into 
that location but it will create a temporary location to remove parts from. It will not pull from 
the 'No Backflush' location. 

(IN transactions are allowed with 'No Backflush' checked. OUT transactions are not allowed). 
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In Transit 
Location 

The In Transit location is used by the Intercompany Transfer module (ICT), Outsource Central 
and when the ‘Verify Inventory’ pick ticket parameter is checked. By default, an In Transit 
location is locked preventing users from manually adding or removing items. In transit 
locations are not included in physical inventories. 

If the Inventory Parameter 'Allow To Drive In transit Location Negative' (Miscellaneous menu) 
is checked, when receiving Outsourced items and backflushing the system will allow an In 
Transit location to be driven negative. If it is not checked users will not be able to backflush 
more than what is in transit.  

Note: This type of location should not be manually added to an inventory item. The system will 
add an In Transit location to an item when required. 

Note: The system does allow Outsource child inventory to be reallocated to a different parent 
from the Locations and Transactions module using a drag and drop from one In-Transit 
location to another if they have the same Vendor. Serialized Inventory Control items are able 
to be selected by serial number to move. This updates the Child Location in the database. 

Disable Auto 
Delete 

If the user has the 'Delete Empty Location' parameter checked in Inventory it can be 
overridden for specific locations by checking this box. This will prevent the location from being 
automatically removed when an out transaction brings the location quantity to zero. 

Do Not Process 
Shelf Life 2 

A Shelf Life 2 value can be assigned to inventory items. It can be used to track multiple shelf 
lives for raw materials. This is typically used for items that require refrigeration. While in 
refrigeration the system applies the Shelf Life. When the items are removed from a 
refrigerated location then the Shelf Life 2 value in days will kick in.  

Locations can be set to 'Do Not Process Shelf Life 2' to establish rules for if/when the shelf life 
2 will kick in. 

Location Shelf Life2 examples: 

Type A = Process Shelf Life 2 

Type B = Do Not Process Shelf Life 2 

Moving from Type B to Type A 

▪ Maintains Unique Date In – assigns System Date as In Date 

Moving from Type A to Type A  

▪ Maintains Unique Date In – current In Date stays the same  

Moving from Type B to Type B 

▪ No change from current system, uses standard Unique Date In rules  

Moving from Type A to Type B 

▪ No change from current system, uses standard Unique Date In rules  

Receiving New Inventory to Type A 

▪ Maintains Unique Date In – assigns System Date as In Date      

Receiving New Inventory to Type B 

▪ No change from current system, uses standard Unique Date In rules  

Inventory Out either Type A or B 

▪ No change from current system, uses standard Unique Date In rules  

See the information on 'Unique Date In' in the Additional Tab in Inventory section for details. 



Inventory Management Page 244 of 478 

 

DT Drop Zone Use this check box to designate this location as a 'Directed Task Drop Zone.' This designates 
the location to process directed tasks and their associated material. 

Once this location has been designated as a DT Drop Zone, other locations may designate this 
location as their DT Drop Zone to send their directed tasks and drop their associated material.  

Note: If this location has been designated as a DT Drop Zone itself, it will not be able to 
designate another location as its DT Drop Zone. The 'DT Drop Zone' field in the upper half 
of the screen will be disabled. 

Raw Material Staging 

(Only applies to users licensed for 'Advanced WMS'). 

If the location is associated to a Location Type with a Raw Material Sub Type a Raw Material Staging tab 
will be visible. This will list the work centers that have this location as their IN and OUT Transaction 
disposition location. 
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IN Transaction  

This section includes the following columns: Work Center #, Work Center Description, Inventory Pickup 
Threshold with linked columns below for Priority, # of Packages and # of Pallets. 

To add a work center to IN transaction section select the insert record (+) button and then click on the 
ellipsis button in the Work Center to field to access the pick list of work centers. Work Centers that are 
associated to another location will be gray in the pick list. They can be selected and the system will 
update the Shop Floor Disposition Parameters 'IN Transaction' field (Options menu in the Work Center 
module) with the location. Work Centers that are already have this location as it's IN transaction 
disposition location will be in green text in the pick list. 

To remove a work center select the Delete (-) button. The work center will no longer have an IN 
Transaction disposition location associated to it. 

Inventory Pickup Threshold - These settings are used for the system to compare the Dispo In items->BOL 
Data->Package or Pallet Items per (depending on the listed Default Packaging Type) to the quantity of 
items in the Dispo IN location. If the Dispo IN location Qty has any Pickup rows in TRANS_ALERT for this 
item that are greater than the Work Center based Inventory Pickup Threshold the system will add a row 
to TRANS_ALERT with: INV_ZONE_ID = the Dispo In LOCATION.WK_INV_ZONE; TRANS_IN_OUT = OUT; 
ALERT_DESCRIP = “Pickup XXXXXX from LLLLL” where XXXX = the Items Description and LLLL = the 
LOC_DESC. 

▪ Priority - The choices are: 1= High Priority, 2= Med Priority and 3= Low Priority 

▪ # of Packages 

▪ # of Pallets 

Note: If the # of Packages or # of Pallets is defined this location cannot be assigned as a Dispo Out 
location for any Work Center. 

OUT Transaction 

This section includes the following columns: Work Center #, Work Center Description, Staging Qty 
[hours] with linked columns for Default (non-editable) and This Work Center (editable). 

Work Centers can be added or deleted from this section as described above for IN Transactions. 

Staging Qty (hours) - This is the number of hours the system will use to determine the staging quantity of 
materials required for the 'Work Order Materials & Components' module (ShopData and Assy Data). This 
defaults to 8 hours but can be changed from this field or a specific value can be assigned to a work 
center that will override the default. 

▪ Default - This field cannot be edited from here. 

▪ This work center - This field can be edited from this table. 

Milk Run Staging Tab 

(Only applies to users licensed for 'Advanced WMS'). 
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If the Location has a Location Type with a Sub Type of Milk Run an additional tab will be visible from the 
Master Locations module. From this tab users can link in specific sales orders. 

The Milk Run Staging grid has the following columns: Order #, Item#, Item Description, Customer, Ship To 

Select the insert (+) button to add an order from the pick list. Select the minus button to remove an 
order.  

Note: If the Sales Order Detail line item is deleted it will be removed from this grid. 

File Menu 

Parameters (only applies to users licensed for 'Advanced WMS') - Do Not Allow Duplicate Master 
Inventory Locations by Division - When this box is checked, the system will not allow a new or updated 
location to be a duplicate within the same EPlant. 

Options Menu 

▪ Aisles and Location Types (only applies to users licensed for 'Advanced WMS'). 

▪ Zones 

▪ View Options - View All, View Inactive, or View Active 

 - For Advanced WMS users only. Select the Transaction Plans button to access a pick list of 
transaction plans associated to the location. From the pick list can select a plan to view. 

Note: The locations table can also be accessed any time a transaction is being made to allow for quick 
input of new locations. 

Deleting a Location from the table - A location that does not have any detail records (such as items in the 
location or work center disposition designator) can be deleted by selecting the Delete Record (-) button. 
If the location is associated to an MRO record a message will appear stating, 'This location is associated 
to MRO, do you wish to continue?'. If Yes is selected the system will remove the Location and 
Location_ID from the MRO record (in PMEqmt table), if No is selected the user is returned back to the 
master locations form. Security can be placed on this message. 
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Inventory Zones 

Zones can be accessed from System Parameters > Lists > Inventory Location Zones, Inventory > 
Miscellaneous > Inventory Location Info > Location Zones, or from the File menu in Inventory Transaction 
Rules on the WMS Control tab.   

For Non Advanced WMS Users 

For users that are not licensed for Advanced WMS, the only applicable inventory zone is a 'Work Zone'. 
Inventory Work Zones can be created, then locations and users are associated to the work zone. A 
location can only belong to a single work zone. Users can be attached to multiple work zones. Once set 
up this can be used to filter the available locations for allocating materials in work orders. When the 
'Work Zone Locations' option is selected from the Advanced Filter option in the Allocated Materials 
screen, only locations associated to Work Zones that the employee is associated to will be available to 
choose from for allocating materials to the work order. Employees are associated to work zones from the 
WMS Profile module (System Parameters->Lists menu). Select the User Zones option in the Available 
Modules section. 

For Advanced WMS Users 

 

Zones are used to group warehouse locations based on similar function and work teams.  There are 
four zones: 

1 Locating Zone 

2 Allocation Zone 

3 Work Zone 

4 Drop Zone 



Inventory Management Page 248 of 478 

 

These zones are assigned to individual locations.  The system uses the zones, in conjunction with 
inventory transaction rules, to assign put-away and picks from the most efficient locations. 

Code Code for the inventory location zone 

Description Description of the inventory location zone 

Zone Type ▪ Locating Zone: Use this zone to establish the different location groups the system should use 
to move product to.  For example, many warehouses establish one zone for piece picking for 
‘A’ movers and a different zone for pallet picking for ‘A’ movers. 

▪ Allocating Zone:  Use this zone to establish the different location groups to move product 
from.  When the system runs the allocation plan, it will search the Picking Rule Sets to 
determine which allocation zones to process. 

▪ Drop Zone: Use this zone to establish drop zones in the warehouse.  Drop zones are used to 
‘hold’ inventory in-transit to a location until the process can be complete.  Drop zones are 
useful during the following processes: put-away, replenishment, and shuttle transfer, cross-
docking and shipping dock. 

▪ Work Zone: Use this zone to assign teams to particular locations.  Configure the warehouse 
so each section requiring different equipment or picking constraints is a unique zone.  Since 
teams work specific zones, this ensures that the appropriate resources are used in each zone. 

Division/Wareho
use 

Division of the inventory location zone. Select this from the drop down list if applicable. 

EPlant EPlant of the inventory location zone. The pick list will show zones associated to the logged in 
EPlant as well as those not associated to an EPlant. If the Division/Warehouse field is 
populated the system will populate the corresponding EPlant automatically. 

Allocatable Determines whether inventory can be allocated from this zone. 

Cases per Aisle The number of cases that can be located to an aisle in this zone before the system attempts to 
find a different aisle.  Max value: 999 

Current Aisle The aisle that cases or pallets are currently being located to within a particular zone. 

Current Count The number of cases or pallets that have been successively located to the current aisle. 

Pallets per Aisle The number of pallets that can be located to an aisle in this zone before the system attempts 
to find a different aisle. 
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Inventory Locations Tab 

The bottom grid will display the locations associated to the inventory location zone. 

To add location(s) select the insert (+) button. A pick list of locations will appear that will allow the user 
to multi-select locations to add. The pick list is filtered based on Division and EPlant. 

To remove location(s), highlight the location(s) using the Shift or Ctrl keyboard buttons, then right click 
and choose 'Disassociate Selected Locations’. 

To access a location, right click and select ‘Jump to Location’. 

Add Locations from other types of zones – Select the button in the bottom section  to add locations 
from other zones. A pop up form will display with zones with types other than the one adding locations 
to. 
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Update Criteria 

There are two mutually exclusive choices for updating the locations to the current zone: 

▪ Only add location with blank locating zone – When this option is selected only locations that do not 
already have a corresponding zone will be added. For example, if adding locations from an allocating 
zone to a work zone, only the items associated to the allocating zone with a blank work zone will be 
added. 

▪ Add all location that match selected zones – This option will add all the locations from the selected 
zone and update the zone field in master inventory with the selected one. 

Drop Zone Locations Tab 

Some inventory zones are categorized as 'Drop Zones.' Drop zones allow users to process directed tasks 
that cross work zones when the users do not have access to the end location. The user without access is 
prompted to drop off the material in a drop zone in the first position in the sequence so that a user who 
does have access to the the end location can pick it up from the drop zone and complete the task.  

A drop zone may have any number of drop zone locations within it. 

If the inventory zone has a zone type of 'Drop Zone,' its drop zone locations will be listed in the 'Drop 
Zone Locations' tab above the bottom grid. 

 



Inventory Management Page 251 of 478 

 

Users can use the arrows above the grid to move drop zone locations up or down the list to change the 
sequence order. The system will always use the drop zone location in first position in the sequence by 
default. 

Users can also use the 'Drop Zone Locations' tab to add drop zone locations to the work zone. 
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Note: Not all teams are authorized to work in any given work zone. When a user begins processing a 
directed task with a start and end location, the system checks whether the end location's work zone 
matches a work zone to which the user's WMS team has been granted access.  

If the end location's work zone does not match any of the user's WMS team's approved work zones, the 
system then checks whether the end location belongs to a drop zone.  

If the end location does belong to a drop zone, the user is prompted to drop off the material in the drop 
zone location in first position in the work zone. This allows a second user who has the necessary 
authorization to work in the end location's work zone to pick up the material from the drop zone and 
complete the task. 

To view the drop zone location sequence order for a work zone, access the work zone within the 
'Inventory Zones' list and access its 'Drop Zone Locations' tab in the lower half of the window. Users may 
add drop zone locations and move drop zone locations up and down the list to change the sequence 
order. 

Note: If there are no users with access to the drop zone, this will cause a problem - no user will be able to 
drop off the material at the drop zone nor pick it up. To resolve this problem, access the 'WMS Teams' 
module under the 'WMS Control' tab and add the end location's drop zone to the team's list of approved 
work zones. 

Users may also use this method to authorize a team's members to work directly in the end location's 
work zone itself. This would allow the team's members to skip the drop zone and move the material 
directly to the end location. 

 

 

 

 
 

Inventory Codes 

From the Miscellaneous menu->Inventory Codes the user may access various lists: Non Conform Codes, 
Non Allocate Codes, Inventory Transaction Codes, Product Codes, Cycle Count Codes, Color Group Codes, 
UPC Codes and Tariff Codes. 

See the various sections below for details. 
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Discount Pricing 

There are several methods for discounting prices in EnterpriseIQ: 

▪ Tier Pricing 

▪ Aggregate Tier Pricing 

▪ Volume Pricing 

▪ SAC Discounts 

▪ BOGO Discounts 

▪ Threshold Discounts 

The following sections will discuss these methods. 
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Tier Pricing 

In many cases, proprietary manufacturers need to offer different pricing structures to different types of 
buyers. EnterpriseIQ supports the concept of Tier Level pricing, designed to provide a flexible mechanism 
for handling unique pricing levels. 

Pricing is based on the existing price structure supported in EnterpriseIQ. This serves as the basic price 
list. Discounts are applied against this list during Order Entry, and are automatically reflected on the 
order during entry. 

The system uses the AR Discount Tiers table to match Customer # to Item #, Customer # to Item Type, 
Customer Type to Item #, or Customer Type to the Item Type to determine the percentage discount. 
Depending on how the AR Discounts are set up, the system will use either the Tier Price Breaks, the Tier 
Discount Price, selling price breaks (AKA or if none the Sell tab prices) or the Std Item Price for the basis 
to deduct the discount from. Please see the Discount Pricing flow chart below. 

Notes:  

Discount Pricing does not apply to items that have the 'Use Lot Charge' option checked. If the item has a 
Lot Charge entered instead of price breaks the price field will be zero. When this is checked, when a sales 
order is created and the item is added, the system will pop up a field to allow the user to edit or enter 
the lot charge.  Once the lot charge is entered, a separate line will be created automatically for a 
miscellaneous item, with an item description of Lot Charge, a blanket quantity of 1, and the lot charge 
populated in the price field. 

If the 'AKA Pricing override Tier discount pricing' option in System Parameters->Purchase Order and Sales 
Order Setup tab is checked, during order entry the system will use the following hierarchy: 1. AKA Pricing 
on inventory item, 2. If AKA pricing has expired then use Tier Price, 3. If Tier Price does not exist or has 
expired use Buy/Sell Pricing, 4. If Buy/Sell Pricing has expired or does not exist use Std. Item Price. Note:  
If an AKA Price exists,  the system will use that price only with no further discounting. 

The system will also evaluate the Effective and Inactive dates associated to AKA pricing records. If the 
AKA pricing Effective date is in the future it will use the Buy/Sell Pricing, if not available, it will use Std 
Price. If the AKA pricing Inactive date occurs in the past, the system will use the Buy/Sell Pricing, if not 
available, it will use Std Price. 

Customer Tier Types can be assigned at the customer level, or the ship to level. The Tier Type Hierarchy 
will look at Ship To first and if null use the Tier Type at the Customer level (Customer/Credit Data tab). 
AR Tier Discounts can be set up for specific ship to addresses. If the Tier is associated to a customer, a 
specific ship to address can be selected by clicking on the ellipsis button in the ship to field to access the 
pick list. When looking up tier pricing, if the Customer+Ship To from the sales order matches, the system 
will use that Tier for the discount.  If the sales order's Customer matches but not a Ship To the system 
will use the Tier for the Customer. A tier with a blank Ship To will match any sales order Customer Ship 
To but if the Ship To is defined for a Tier it is only used when the sales order has the Customer and Ship 
To. 

If an order detail item has a unit of measure (UOM) that is not the default from inventory, the system 
will convert it to the default (native) UOM before looking to Selling, AKA, or Tier tables for pricing. 
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The last discount applied is the 'Threshold discount' based on the Total price after any additional 
discounts. See the Threshold Discounts section for details. 

 

 

 
 

Defining Customer Types 

To utilize Tier Pricing a few lists must be created: 

▪ Customer Types 

▪ Inventory Types 

Defining Customer Types 

The first step in defining Tier Types is to set each customer with a user defined Customer Type that is 
used to classify the customers. The Customer Types table is located under the File|Customer Types from 
within the Tier Type table (the Tier Type table may be accessed by selecting Misc|Tiers from the 
Inventory menu) or under Sys Setup|System Parameters|Lists|Discount Tiers form. 

In the example below, three separate levels of customers have been created based on amount of 
product purchased. A “Platinum Dealer” is the largest buyer of product, a “Gold Dealer” is a second level 
buyer, and a “Silver Dealer” is the third type of customer. 

 

Customer Tier Types can be assigned at the customer level, or the ship to level. The Tier Type Hierarchy 
will look at Ship To first and if null use the Tier Type at the Customer level (Customer/Credit Data tab). 

AR Tier Discounts can be set up for specific ship to addresses. If the Tier is associated to a customer, a 
specific ship to address can be selected by clicking on the ellipsis button in the ship to field to access the 
pick list. When looking up tier pricing, if the Customer+Ship To from the sales order matches, the system 
will use that Tier for the discount.  If the sales order's Customer matches but not a Ship To the system 
will use the Tier for the Customer. A tier with a blank Ship To will match any sales order Customer Ship 
To but if the Ship To is defined for a Tier it is only used when the sales order has the Customer and Ship 
To. 
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Defining Inventory Types 

The second step is to create Inventory Types. Each inventory item, like customers, can be designated a 
particular type. The Inventory Types table is located under the File|Customer Types from within the Tier 
Type table (the Tier Type table may be accessed by selecting Misc|Tiers from the Inventory menu) or 
under Sys Setup|System Parameters|Lists|Discount Tiers form. 

In the example below, three separate levels of inventory items have been created based industry 
classification. The products are classified as type “Electronics” or “Automotive” or “Computer.” 

 

Linking Inventory Items to Inventory Types 

▪ To link inventory items to a specific inventory tier type, select a tier type from the drop down menu 
on the Buy/Sell Pricing tab of the inventory item. 

Linking Customers to Customer Types - To link customers to Customer Types, follow the steps below. 

▪ Open up the Customer Maintenance screen and select the customer. 

▪ Find the Tier Type field on the main tab and select a Tier Type to assign to that customer from the 
arrow down list. 
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Creating the Tier Types Table 

The final step is to create a 'Tier Type' by creating the links (Customer # to Item #, Customer # to Item 
Type, Customer Type to Item #, or Customer Type to the Item Type), assigning a discount amount, and 
telling the system where to obtain the pricing information. As many Tier Types as needed may be 
created, each with a different discount percentage. The net result of this is that a customer may receive 
a discount based on both the type of customer and the product purchased. 

The Tier Type table may be accessed by selecting Misc|Tiers from the Inventory menu. The following 
screen will appear: 

 

Field Listing for Upper Section: 

Aggregate This only applies to Customer Type/Item Type tiers (not specific customer tiers). If the 
Aggregate Tier box is checked in the AR Discount Tiers form the customer / item tier 
handles pricing discounts based on the price breaks setup in tiers in the lower grid and the 
aggregate calculation is based on the first release date of the sales order. (See the 
Aggregate Tier Type Pricing section below for more information). 
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BOGO This box is checked for BOGO type discounts. When a qualifying line item is added to a Sales 
Order, the “Add Child BOGO Items” button will become enabled. When the “Add Child 
BOGO Items” is clicked, a pick list with all items that are associated to the specific BOGO 
discount item will display. The BOGO discounts are setup in the AR Discount Tiers screen by 
utilizing customer type and item type, and checking the BOGO check box. See BOGO 
Discounts for more information. 

Cust #/Customer When an Item Type tier is used a specific customer number can be linked to it. When a 
sales order is entered for that customer for an item associated to that item type the 
discounts will be based on that combination using the pricing hierarchy. 

Customer Type Tiers can be created based on a Customer Type. The Customer Type can be associated to a 
specific Item number or an Item Type. Select the Customer type from the drop down list in 
the field. If a Customer Type is selected the Cust # field will be grayed out making it not 
available for editing.  

Discount Price This is a field to enter the discount price that will be used for the Tier record when the ‘Tier 
Price Based on…’ is set to ‘Price Based on Std. Price’. A value up to six decimals can be 
entered. This value is not used if the ‘Tier Price Based on’ is set to use Price Breaks. 

Item 
#/Description/Class/R
ev 

When a Customer Type tier is used a specific item number can be linked to it. When a sales 
order is entered for that item for a customer associated to that customer type the 
discounts will be based on that combination using the pricing hierarchy. 

Item Type Tiers can be created based on an Item Type. The Item Type can be associated to a specific 
customer or a Customer Type. Select the Item type from the drop down list in the field. If an 
Item Type is selected the Item # field will be grayed out making it not available for editing. 

Less Than Min. 
Upcharge % 

A value between 0 to 100 % can be entered in this field to add an upcharge when the 
quantity ordered is less than the Selling Multiples Of (Main Inventory>General section).  

(In order for this to apply the Minimum Sell Qty and the Selling Multiples Of fields must be 
populated in Inventory). 

▪ If a value is entered in this field and the Selling Multiples Of is populated, and the 
Minimum Sell Qty is less than Selling Multiples Of, when the blanket quantity is less than 
the Selling Multiples Of the upcharge will apply. If they are equal, then standard tier pricing 
applies. The system will calculate the price break or Std price (based on the on 'Tier Price 
based on' setting) * Upcharge %.  ( Price + (Price *Upcharge %)). For example: With a tier 
price of $10.00 and an Upcharge of 20%, the Selling price = $12.00   

▪ If the Upcharge field is null no additional charge is applied. 

▪ If the blanket quantity is greater than Selling Multiples Of no additional charge is applied. 

Ship To If the Tier is associated to a customer, a specific ship to address can be selected by clicking 
on the ellipsis button in the ship to field to access the pick list. When looking up tier pricing, 
if the Customer+Ship To from the sales order matches, the system will use that Tier for the 
discount.  If the sales order's Customer matches but not a Ship To the system will use the 
Tier for the Customer. A tier with a blank Ship To will match any sales order Customer Ship 
To but if the Ship To is defined for a Tier it is only used when the sales order has the 
Customer and Ship To. 
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Tier Discount This is the percentage of discount offered for the Tier record when the ‘Tier Based on…’ is 
set to ‘Price Based on Price Breaks’. This field does not apply if the based on is set to Std. 
Price. This is entered as a whole number. 

Tier Price based on… Select the pricing that the discount will be applied to. Choose from: 

▪ Price based on Price Break – This will use the price breaks based on the following 
hierarchy: 

1. Tier Price Breaks 

2. AKA Selling Price Breaks 

3. Selling Price Breaks (Buy/Sell Pricing tab) 

4. Standard Item Price (Buy/Sell Pricing tab) 

▪ Price based on Std. Price – This will use the Discount Price entered in the top 
section of the Tier table. 

Note: If the 'AKA Pricing override Tier discount pricing' option in System Parameters-
>Purchase Order and Sales Order Setup tab is checked, during order entry the system will 
use the following hierarchy:  

1. AKA Pricing on inventory item,  

2. If AKA pricing has expired then use Tier Price,  

3. If Tier Price does not exist or has expired use Buy/Sell Pricing,  

4. If Buy/Sell Pricing has expired or does not exist use Std. Item Price.  

Note: If an AKA Price exists, the system will use that price only with no further discounting. 

 

Waterfall Select the Waterfall type from the drop down list if applicable. See Waterfall Pricing for 
more information. 

Price Breaks  

In the lower section the user can enter price breaks (2 decimal precision) or a Discount percentage to be 
used with AKA Selling or Selling price breaks entered in Inventory. The price breaks will be used when the 
‘Tier Price Based on’ field is set to use Price Breaks. Dates can be added to the Inactive, Effective and 
Price Date fields in order to enter future price information. 

Currency The price breaks can be set to a specific currency by selecting a currency from the drop 
down list. The system will match the tier price breaks to the customer currency, and if there 
is a tier price set for the currency it will use that, with no conversion. If there is not a tier 
price for the customer currency, and there is an inventory price break for the currency it will 
use that, with no conversion. If neither apply, it will use the STD item price, converted to the 
customer's currency. 

Discount Percentage A discount percentage can be entered which will be used to discount the price breaks 
entered in Inventory based on the standard hierarchy: 

▪ AKA Selling Price Breaks 

▪ Selling Price Breaks (Buy/Sell Pricing tab) 

Note: The Discount Percentage is not used in conjunction with the Discount Price entered. 
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Discount Price Specific discount price breaks can be entered. If price breaks are entered here they will be 
used for pricing without further discounts. The Discount Percentage value does not apply 
when Discounts Prices are entered. 

Dates Select the dates from the drop down calendar if desired. 

▪ Effective Date – The date the price is effective 

▪ Inactive Date – The date the price becomes inactive 

▪ Price Date – The price date 

To create a Tier Type: 

▪ Click on Add [+] to create a new record. 

▪ Use the arrow down list to select a Customer Type and the Item Type from the tables. 

▪ Enter the Discount%. 

▪ Select what price to apply the discount to by selecting Price Based on Price Breaks or Price Based on 
Std Price from the arrow down list. 

Once this is all set up when a user enters a sales order the system will check if tier types are associated 
to the item/customer combination and if so use the appropriate discount to determine the sales order 
price. 

 
 

Tier Pricing Flow Charts 

The flow charts below display how a price is determined depending on the discounts used. The flow 
charts are split into four sections, each section is relevant to how the system matches the item and 
customer: Customer #/Item #, Customer #/Item Type, Customer Type/Item #, and Customer Type/Item 
Type. 

Note: The flowcharts are not available in the pdf version of the manual as they are too large. Please refer 
to the online help (Inventory module->Help->Contents). 
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Customer Discount % Comparison Option 

The 'Customer discount % comparison' option is in System Parameters on the Purchase Order and Sales 
Order Setup tab. If this option is checked, and the customer has a discount % filled in (Customer 
Maintenance->Credit Status tab), the system will compare the selling price on the Buy/Sell pricing tab in 
inventory for the quantity on the order to the Standard Item Price multiplied by the customer discount 
%, and will use the lowest price. If an AKA price is populated the system will use that price. If the 
customer does not have a discount % the system will use the standard pricing hierarchy.  

Note: Tier discount pricing is not used, and instead the Discount % on the customer record Credit Status 
tab is used (whether there is one set there or not). 
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Aggregate Tier Type Pricing 

The Aggregate Tier Type pricing option is used only for Customer Type/Item Type tier pricing 
combination. If the Aggregate Tier box is checked in the AR Discount Tiers form, the customer / item tier 
handles pricing discounts based on the price breaks setup in tiers in the lower grid and the aggregate 
calculation is based on the first release date of the sales order. If the first release date on several items is 
the same date, the aggregate pricing calculation (sales order/options/calculate aggregate pricing) will 
sum the quantity and then look into the tier pricing table and apply discount into the price column. 

If the dates are not the same the discount percentage will be based on the blanket quantity for each 
item instead of the total ordered for all the items. 

Placing an Order Using Aggregate Tier Pricing 

To utilize the Aggregate Tier pricing feature in sales orders the user must select the Tier Discount option 
in Sys Setup->System Parameters-> PO & Order Setup tab in the Calculate Aggregate Pricing field. 

Once this is established and the links between a customer and a Customer Type and the inventory items 
and the Inventory Types are made, when a Sales Order is created, the discount will be applied by clicking 
on the Calculate Aggregate Pricing speed button or go to the Options menu from the Sales Order and 
select Calculate Aggregate Pricing. 
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Volume Pricing in EnterpriseIQ 

The system can automatically calculate volume discounts when creating sales orders for items that have 
been set up with product codes. There are two pricing options, the system can be set to use the Product 
Code price breaks only, or a hierarchy option where it will check for Price Book prices first, then AKA 
prices. To utilize this feature, product codes are established with price breaks and items are then 
assigned to the specific product code. When a sales order is created for items related to a product code 
the user can select the Calculate Aggregate Discount option and the system will accumulate the order 
quantity for all items on the sales order with the same product code to determine the correct pricing. 
The pricing comes from the Product Code pricing, Price Book pricing, or AKA depending on the System 
Parameter setting. (The Selling Pricing and Tier table pricing is not used). 

The information below outlines the set up steps required and the sales order creation process. 

System Setup 

Before using the volume discount feature based on product codes, the user will have to set up the 
aggregate pricing method. To do this, go to Sys Setup->System Parameters->PO & Order Setup tab. From 
the drop down box next to the 'Calculate aggregate pricing method based on' select Product Code or 
Product Code / AKA Pricing. 

▪ Product Code - If items with the same product codes are added to a sales order the user can choose 
to calculate the aggregate pricing and adjust the pricing based on the volume of items ordered. This 
will tell the system to use the price breaks set up on the Product Code form only to determine the 
volume discounts per sales order. 

▪ Product Code / AKA Pricing / Price Book - If this is checked the system will use a hierarchy to 
determine the aggregate pricing. It will first check to see if the item has Price Book pricing and if so it 
will use that for the aggregate calculation. If not then it will look at the AKA pricing, and if found it 
will use that. If not, then it will use product code pricing for aggregate calculation. (Refer to the Price 
Book Maintenance section for details on Price Book pricing). 

Inventory Product Codes 

Inventory Product Codes are used to group like products. This list defines the product groupings that 
have the same price breaks used to determine the volume discounts. These product codes are then 
linked to your actual inventory items. 
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To create a new product code, select Inventory Product Codes from the Misc menu in Inventory. Click on 
the ADD (+) button on the top navigator bar and enter the information in the related fields: 



Inventory Management Page 266 of 478 

 

Code This is user defined code describing the products types that will be linked to the code. 
This field is alpha-numeric. 

Description This is the description of the product code. 

Repair Cost This is related to RMA (Return Material Authorization) Work Orders only. The repair 
cost will be used to populate the unit price on the sales order created when the RMA 
work order is closed if the failure code is not warranty. 

UOM This is the Unit of Measure associated with the price breaks. 

Lead Days This is related to RMA Work Orders only. This is the number of lead days to perform 
the repair. This field will be used to calculate the Due Date for the work order (Start 
Date + Lead Days = Due Date). 

EPlant EPlant name associated to the product code. 

Decimal Precision Enter a value from 1 - 6 for the decimal precision the system will use when populating 
the price on the sales order. 

Plug Value This is used for informational purposes only.. 

Price Breaks Enter the price breaks associated with the product code. These price breaks will be 
used to determine the correct price on a sales order based on the total quantities 
ordered for items linked to the product code when the 'Product Code' aggregate 
pricing method is selected. The system will calculate the aggregate pricing based on the 
volume of items ordered for a specific product code. 

If the 'Product Code / AKA Pricing' aggregate option is checked the system will use a 
hierarchy to determine the aggregate pricing, first looking at AKA Selling then at 
Product Codes. 

To add a new price break click on the ADD (+) button on the bottom navigator bar and 
enter the quantity, price, and date information. Continue this process until all price 
breaks have been added. 

Product codes can be associated to a specific customer's price breaks. To link a 
customer, select them from the drop down list in the Customer field. Customer specific 
price breaks will be used when a sales order is entered for that customer rather than 
the non customer specific price breaks. 

Currency For Multi-Currency users: A specific currency code can be associated to a Product Code. 
If an item is priced using a product code the program will look for the customers native 
currency and apply the correct price based on the product code. 
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Documents Internal and/or external documents may be linked to a product code. These documents 
can be printed with the RMA Work Order or used for additional information associated 
with a specific product code. 

Assigning Product Codes to Inventory Items 

Once product codes are created they can be assigned to specific inventory items. On the Additional tab 
in Inventory there is a Product Code field to link the inventory item to the product code. Use the drop 
down arrow next to the field to link the item to a product code. 

Creating Sales Orders using Volume Pricing 

Once the user has set up the product codes, assigned them to inventory items, and established the 
aggregate pricing method in System Parameters, the Volume Discount feature can be used to determine 
the correct pricing when creating new sales orders. 

From the Sales Order module select New from the pick list or select the Add (+) button from an existing 
sales order to create a new order. Enter all of the customer information and the items and quantities 
they are ordering. Once all items have been added to the sales order, click on the Calculate aggregate 

pricing speed button or select Calculate Aggregate Price from the Options menu. The system will 
prompt you with a Confirm message, select Yes to continue. The system will then determine the items 
with like product codes, accumulate the totals, and determine the correct pricing from the price breaks 
from AKA or from the Product Code form (depending on the System Parameter setting). 

Note: All items must be entered in the detail section of the sales order before you Calculate Aggregate 
Pricing. 

Example: 

Three items are linked to a product code with the following price breaks. 
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A sales order is created with all three items entered in the detail section with varying quantities. Before 
the Calculate Aggregate Price option is selected the system determines the pricing based on the selling 
price entered on the Buy/Sell tab or the AKA tab in Inventory for each individual item. 

 

After the ‘Calculate Aggregate Pricing based on Product Code’ button is selected the system will prompt 
the user with a Confirm message, select Yes to continue. The system will then determine the items with 
like product codes, accumulate the totals, and determine the correct pricing from the price breaks from 
AKA or the Product Code form based on volume quantity and the specific customer if applicable. The 
system changes the pricing to reflect the volume quantity and uses the correct price break from the 
Product Code form. In this example the customer ordered a total of 4000 items linked to the "Buttons" 
Product Code so the correct pricing for each item is $0.1000 based on the 4000 piece price. (If the sales 
order was for the Customer ABCO, the pricing would be 0.257). 
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Waterfall Pricing 

Utilizing the Waterfall feature allows users to create sets of price breaks (Waterfalls) which can then be 
assigned to Items. Then waterfall tier records can be created by checking the 'Use Waterfall' check box. 
With this checked the bottom grid of the AR Discount Tier table shows a quantity level instead of a 
specific quantity. Specific Discount Percentages are associated to the Waterfall levels. If a waterfall is 
selected on an item it will only find tiers with the 'Use Waterfall' and use the tier record that matches the 
Customer Type and Item Type.  

Setup 

From the AR Discount Tier table select the File menu to access the Waterfall table. 

Enter a Description in the top section. From the lower section select the insert record button to create 
levels and associated quantities. 

Continue this process until all waterfall records have been created. 

  

On the Buy/Sell Pricing tab in Inventory select the Waterfall to associate to the item from the drop down 
list. 
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On the AR Discount Tier table create a record with the desired Customer Type and Item Type 
combination. Select the Waterfall type to assign to the record from the drop down list in the Waterfall 
field. 

The ‘Tier Price based on…’ field must be set to ‘Price based on Std. Price’. It will automatically set to that 
and the field is grayed out so users cannot make a change. 

Note: The system uses the Standard Item Price associated to the specific item, found on the Buy/Sell 
Pricing tab in Inventory. 
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In the lower section add the Waterfall Levels by selecting the + button. Enter the Discount Percentage 
for each level. A zero value is allowed. 

Effective and Inactive dates can also be entered.  

If a level is entered that is not found to be associated to the selected waterfall, the record will be 
highlighted in yellow. 

Levels can be added by selecting ‘Add All Levels’ from the right-click menu in the lower grid of the tier 
setup. This will add all the possible levels from all Waterfalls.  

If the WebDirect Settings option 'Waterfall Price Breaks - Default to Hidden' (System Parameters-
>Company File Information->Web tab) is checked, the waterfall price breaks marked 'WebDirect-Show' 
will display in WebDirect B2B.  

Notes:   

The system will only allow one unique combination of customer or customer type and item or item type. 

The Aggregate check box is disabled if 'Use Waterfall' is checked. 

If Multi-Currency is used, the customer must be assigned a currency and there must be discounts setup 
for that specific currency. 

Example: 

Customer Type is OEM and Item Type is Automotive with the Waterfall ‘A’ assigned. If the standard item 
price on the item is 10.00, using the screen shots from above, the system would determine the pricing as 
follows: 

Sales Order 
Blanket Qty                 

SO Price Calculation Notes 

1 10.00 10 – (10 * 5%) =  9.50 Qty of 1 is level 1 with a 5% discount 

24 10.00 10 – (10 * 5%) =  9.50 Qty of 24 is level 1 with a 5% discount 

25  9.50 10 – (10 * 15%) =  
8.50 

Qty of 25 is level 2 with a 15% discount 

100  8.50 10 – (10 * 20%) =  
8.00 

Qty of 100 is level 4 with a 20% discount 
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SAC Discounts 

This Discount option allows users to manually add SAC Discounts and process EDI SAC discounts, both at 
the Sales Order Header and Item levels. These discounts are automatically applied to invoices. The 
system uses the information in the Discount Parameters and Discount Group tables for SAC Discounts for 
Customers with the 'Use Discount Parameters' option checked. 

Setup 

Customer Maintenance: 

To utilize this discount option the customer must have the 'Use Discount Parameters' option checked 
(Customer Maintenance->Credit Status tab). When this check box is checked: 

▪ No other discounts or price breaks will be applied to items on sales orders or invoices for the 
customer. 

▪ An item's standard price will be used when the item is manually added to a sales order. 

▪ The Discount field will take the place of the Discount % field in the header section of the sales order 
for the customer. 

▪ The Tier Type, Discount Tier Price, and Discount % fields cannot be edited. 

▪ There is another option available in Customer Maintenance called Reverse Discount Order that can be 
checked if the 'Use Discount Parameters' option is checked. When this option is checked sales order 
discounts are applied before item discounts for the customer. (The default is to apply item discounts 
first). 

System Parameters: 

Discount Groups 

Discount Groups can be created and inventory items can be associated to the Discount Group. To create 
a Discount Group, select the insert record button in the top section and enter the group name and 
description.  To associate items to the Discount Group select the insert record button in the lower 
section and choose items from the pick list. Multiple items can be added by highlighting them using the 
toggle buttons or the Shift/Ctrl keyboard buttons.  
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Note: A Discount Group can also be applied to an item in the Inventory module (Inventory->Main 
Inventory tab->Additional tab->Discount Group). 

Discount Parameters 

This is the list of SAC Discount Parameters. The list contents are shown in sequence order, which is the 
order in which the discounts will be applied. Discounts can be created for Customers and/or 
Customer/Discount Group combinations. The Sales Order header discounts are listed first.  
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Double-clicking an existing row in the list or clicking the Insert Record button at the top of the list will 
bring up the Discount Parameter Entry screen to either edit an existing discount or add a new discount. 
Enter the SAC Discount information in the pop up entry form. Once complete, select the Save button. 

 

Field Listing: 

Discount Code and 
Description 

The SAC Discount Code and Description 

Customer A customer is required. Select the customer to associate to the discount from the pick list 
accessed from the search button. Only customers with the ‘Use Discount Parameters’ check 
box checked will be in the list. 

Discount Group A Discount Group can be associated to the SAC Discount by selecting it from the pick list. 

GL Account The GL Account is required. Select the GL Account to associate to the discount from the pick 
list. 

Default Discount Enter the default discount value. The discount can be set as either a percentage or as a flat 
discount. 

Percentage/Flat Select Percentage or Flat from the drop down list. 
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Sequence for this 
Customer/Inventory 
Combination 

This is the discount sequence. Use the up/down arrows to change the sequence number. 

Duplicate sequence numbers are allowed and mean that those discounts will be applied to the 
same price or subtotal. Sequence numbers can be repeated by manually editing the discount. 

Sequence numbers cannot be skipped. 

From the Discount Parameters list the discounts in the list can be re-ordered by selecting a 
row and using the up/down arrows at the top of the screen. A record with sequence 1 within a 
Customer/Discount Group combination cannot be moved up. A record with the highest 
sequence number within a Customer/Discount Group combination cannot be moved down. 
Duplicate sequence numbers which have the highest number in a sequence can be moved 
down to get a higher sequence number. 

Effective and 
Inactive Dates 

Select the Effective and Inactive Dates from the drop down calendars in the corresponding 
field. 

 

Sales Orders 

When a sales order is created manually for a customer using Discount Parameters the Discount field in 
the header section changes from Discount % to Discount. To select the discount(s) to apply, click the 
ellipsis button in the Discount field and then select the insert record (+) button. A pick list of discounts 
associated to the customer without a Discount Group assigned will display in the pick list to choose from. 
Once selected, click the ellipsis button to view the discounts that will be applied to the sales order.  
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Discounts can also be added at the line item level. If an item is associated to a Discount Group users can 
click the ellipsis button in the Discount field and then select the insert record (+) button. A pick list of 
discounts associated to the item's Discount Group will display in the pick list to choose from. Once 
selected, click the ellipsis button to view the discounts that will be applied to the line item.  
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AR Invoices 

A miscellaneous item line for each discount found on the related sales order will be added for each item 
on the invoice with a quantity equal to the quantity assigned to the discount on the sales order. The Unit 
Price will be shown as a negative amount. 

 

Examples:  

Discount Parameters: 
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Example 1: 

'Reverse Discount Order' not checked (Item discounts apply first).  

All discounts are applied to the sales order (both header discounts and both item discounts with a 
quantity of 100) 

Quantity Invoiced = 50 at $10.00 each 

AR Invoice Example: 

 

DISC PARAMETER QTY UNIT PRICE DISCOUNT TOTAL 

Item 50 10.00  500.00 

A1  (0.5 F) 50 50 * 0.50 -25.00 475.00 

B2  (2 %) 100 100 * 0.02 = 20 -20.00 455.00 

X1  (4 %) 1 455.00 * 0.04 = 18.20 -18.20 436.80 

Z1  (3 F) 1 1 * 3.00 -3.00 433.80 

 

Example 2: 

'Reverse Discount Order' is checked (Header discounts apply first).  

All discounts are applied to the sales order (both header discounts and both item discounts with a 
quantity of 100) 

Quantity Invoiced = 50 at $10.00 each 

 

DISC PARAMETER QTY UNIT PRICE DISCOUNT TOTAL 

Item 50 10.00  500.00 

X1  (4 %) 1 500.00 * 0.04 = 20.00 - 20.00 480.00 

Z1  (3 F) 1 1 * 3.00 -   3.00 477.00 
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A1  (0.5 F) 50 50 * 0.50 - 25.00 452.00 

B2  (2 %) 100 100 * 0.02 = 20 - 20.00 432.00 

 

EDI 

In order to process SAC Discounts from an EDI file parsed through the eCommerce module, specific SQL 
scripting will need to be added to the after-parse script to add discount information to the 
EDI_ORD_DETAIL_DISC table. When the EDI Order is converted, that discount information will be applied 
to the resulting sales order. 

 
 

BOGO Discounts 

In the AR Discount Tiers form BOGO type discounts can be set up. When a qualifying line item is added to 
a Sales Order, the “Add Child BOGO Items” button will become enabled. When the “Add Child BOGO 
Items” is clicked, a pick list with all items that are associated to the specific BOGO discount item will 
display. The BOGO discounts are setup in the AR Discount Tiers screen by utilizing customer type and 
item type, and checking the BOGO check box. 
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Create a BOGO Discount Tier 

Select the insert record button in the AR Discount Tiers form. Select the desired Customer Type and Item 
Type from the drop down list in each field. Check the BOGO check box. Note: If BOGO is checked, then 
the Tier Discount, Use Waterfall, and Discount Price options cannot be populated.  

In the bottom portion of the form enter the BOGO Discounts.  

Field Definitions: 

▪ Purchase Qty - The minimum quantity to purchase for the parent item on a sales order in order to 
qualify for that number of discounted items. 

▪ Discount Qty - The quantity that will be auto populated on the item when the discounted item is 
added to the order. 

▪ Max Qty - The maximum quantity that the discounted item can be assigned on the sales order line 
item level. This is a required field. Note: If a Max Qty is not entered an error will occur, "Max. Qty. 
cannot be null and must be greater than 0" 

▪ Discount Percent -  The amount that the line item is discounted.  The discount percent will apply 
to the price calculated for the specified item without current pricing rules.  

▪ Effective Date - The date the tier is effective. 

▪ Inactive Date - The date the tier is inactive. 

Example: 

Purchase Qty = 2; Discount Qty = 1; Discount Percentage = 100; Max Qty = 3 

When the customer buys 2 items they will get 1 free (100% off) up to a maximum of 3. 
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Note: BOGO items are limited to one child item type per one parent line item, to accommodate multiple 
child items the user will need to add multiple parent line items.  

Note: When a parent item is removed from the Sales Order the child item will automatically be removed 
as well.  

Note: After the BOGO Child item is added, it will be read-only and users will not be able to edit the line 
item. If attempted an error will surface: "Child of BOGO Item, cannot edit."  

The child quantity can be increased by increasing the parent quantity until the child quantity reaches the 
max qty that was defined on the BOGO tier.  

BOGO Exceptions on the Sales Order 

There is a field in the line item detail section of sales orders called 'BOGO Exception' that will display any 
validation errors that may occur when a parent item is updated to a state where the child item no longer 
qualifies for the BOGO discount in its current state.  At that time the child item will display one of the 
following BOGO Exceptions: 

▪ Max Qty Exceeded 

▪ BOGO Disqualified 

▪ BOGO Expired 

This will be evaluated/updated each time the parent item on the sales order is updated.   

Example BOGO discount: Buy 2 of an item, get 1 item free, max of 3. The start date for discount: 8/4; end 
date for discount: 8/6 

▪ Max Qty Exceeded: If the user enters a 4th line item for the item, where there is already 3 lines with 
a free discounted child, the exception message of “Max Qty Exceeded” will appear on the 4th line 
item and the button to add a BOGO item will not be enabled. 
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▪ BOGO Disqualified: If the quantity on the line item is decreased from 2 to 1, this line item no longer 
qualifies for a BOGO discount. The child line item is deleted and the exception message of “BOGO 
disqualified” is populated on the parent line item that was changed to have a quantity of 1. 

 

▪ BOGO Expired: This exception will populate when there are changes made to a sales order after the 
BOGO discount has expired since the creation of the sales order. This exception applies if the user 
makes an adjustment to a line item on a sales order on or after the inactive date (in this example on 
8/6). The exception message of “BOGO Expired” is surfaced on the line and the button to add the 
discounted child item is not enabled.  

 

Note: If a user attempts to add a new item to a sales order on or after the inactive date the “BOGO 
Expired” exception does not surface. The button to add the discounted child item will be enabled but the 
pick list will be empty indicating there are no items that can be discounted. 
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Threshold Discounts 

This option allows users to set up discounts that will be determined by the total Sales Order amount. 
Select this option from the AR Discount Tiers File menu and the following form will display. 

 

Create Threshold Types 

The Threshold Types list is accessed from the Options menu. These discount types are used to create the 
Threshold Discounts with specific discount ranges, which can be associated to customers. 
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Select the insert (+) button and enter the description of the Threshold Type. Continue this process until 
all Threshold Types have been created.  

Note: If a user attempts to delete a Threshold Type that is linked to other records an error will appear 
stating: "Discount tiers exist - unable to delete".  

Create Threshold Discounts 

In this form the user can create a discount for a specific customer or for several customers under the 
same Threshold Type.  

Select the insert (+) button and select a customer or a Threshold Type. If a user attempts to add both, a 
warning message will display stating: "A customer and discount type both cannot be assigned". Once a 
Customer/Cust# or a Threshold Type is created users can then create tiers for a Total Sales Order Price 
range. Enter the Total Sales Order Price and Threshold Percentage in the bottom section for each 
discount. 
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For example: Based on the screen shot above, a customer assigned the 'Good Customer' Threshold Type 
would receive a 15% discount off of the total sales order price if the amount on the sales order total is 
between $1,000.00 and $4,999.99 A customer would receive a 20% discount if the sales order total is 
between $5,000.00 and $9,999.99, and so on. 

A Threshold Type can be changed by selecting the ellipsis and selecting a different type. The Customer 
associated to a discount can also be changed by selecting a different customer from the pick list accessed 
by clicking the ellipsis in the Cust# field. A confirmation warning will appear stating: "Are you sure you 
want to change the customer associated with this discount tier?" The warning includes a Yes and No 
button, as well as a 'Do not show next time' check box. The fields can be cleared by using the right click 
options: 'Clear Threshold Type' and 'Clear Customer'. 

The discount is assigned on the Customer Maintenance record in the 'Threshold Type' field on the 
Customer/Credit Data tab. Once assigned, if a sales order is created for the customer, the customer will 
receive a Threshold Discount based on the tier created for that specific Threshold Type. The  ‘Threshold 
Type’ and ‘Threshold Disc%’ will display in the top section of the Sales Order. The 'Threshold Type' field 
will populate based on the ‘Threshold Type’ associated to the customer record if one exists. The 
Threshold Discount % will be based on the current total amount associated to the sales order (prior to 
taxes and freight) for the appropriate discount % based on the tiers that have been setup.  

Note: All item and additional customer specific discounts will still apply. The last discount applied is the 
'Threshold discount' based on the Total price after any additional discounts. 

Example: 

Customer is assigned the 'Good Customer' Threshold Type. They also are assigned the 'OEM' Tier Type, 
and the item on the sales order is assigned to a specific Item Type, which results in a tier discount of 
10%. 
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The List Price for the item is 3.73, the discounted price is 3.357, (3.73 - (3.73 * 0.10)). The Total for the 
sales order is 1000 * 3.357 = 3,357.00. This falls under the 15% Total Sales Order Price tier. So the 
Discount = 3357.00 * 0.15 = 503.55. 
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Using Product Codes for converting prices for UOM Conversions 

You can use product codes to convert pricing on a sales order for inventory items stored in one unit of 
measure with pricing in another. For example, this is useful for extrusion items that are stored in 
inventory in eaches and sold in feet. Below lists the set up steps: 

▪ Set the Calculate aggregate pricing method to 'Product Code' in Sys Setup->System Parameters->PO 
& Order Setup. 

▪ In the product code setup, select the UOM of the product code to be the one that pricing is 
established for. 

▪ Set up your price breaks to be per the selected UOM.  

▪ Attach this product code to the inventory item. 

▪ Using the Conversion Factor option on the inventory item, create the conversion from the native 
UOM to the pricing UOM. 

In the sales order, select Options->calculate aggregate price or use the speed button. This will take the 
quantity of product ordered, convert from the native UOM to the Pricing UOM. The system will use the 
price breaks found in the product code setup to determine the price. The system will then convert the 
price back from the pricing UOM to the native UOM on the sales order. 

Example: 

In this example there are three parts stored in inventory with a unit of measure of feet (FT) and sold as 
each.  

The user must set up the UOM Conversion to calculate the correct conversion form the inventory UOM 
to the Order Entry UOM. This is done in the Inventory module from the UOM Conversion form. (Please 
see the Unit of Measure conversion section in the Manufacturing Manual for more details).  

In this example the items have a conversion factor of .5. The check box in the OE Default designates the 
unit of measure to be used on the sales order. 

When the sales order is created for these items it will first display the pricing based on the selling price 
entered on the Buy/Sell tab or the AKA tab in Inventory for each individual item as with example one. 

As soon as the Calculate Aggregate Pricing button is selected the pricing will reflect the Product code 
pricing based on the total quantity on the sales order.  

The information below describes this example: 

Sales Order:      Item           Qty          ft conversion 

Line item #1:  TUBE-01         30    X    1ft. = 30 

Line item #2:  TUBE-02         30    X     2ft. = 60 

Line item #3:  TUBE-03         30    X     3ft. = 90 

                                     Total ft. for the order = 180 ft 
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Price Breaks:    

                Qty.                Price Break 

                0-99                 $2.00 per ft. 

                100-249           $1.50 per ft. 

                250-up             $1.00 per ft. 

Based on the total feet for the sales order, the customer qualifies for the $1.50 per ft. price break x ft. 
per line item. Using the $1.50 per ft. price break, the price per line item on the sales order will will be as 
follows: 

                        Item            Qty             Price           Total Price 

Line item #1:   TUBE-01      30              $1.50           $  45.00 

Line item #2    TUBE-02      30              $3.00           $  90.00 

Line item #3    TUBE-03      30              $4.50           $135.00  
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Price Book Maintenance 

A price book can be created per customer or for a specific customer ship to address and can contain 
multiple inventory items to enable users to update pricing in an efficient way. The price breaks added for 
items in a Price Book are relevant for all items in all EPlants with the same Item #/Class/Revision. The 
prices are used to populate sales orders based on the global pricing for the item if it belongs to a price 
book linked to the customer or ship to address. The display of price book and price type details are only 
available in the sales orders module. Price Book Price Types can also be utilized to create unique pricing 
based on user defined types such as shipment methods. The system uses the Price Book and Price Type 
associated to the item to determine sales order pricing.  

To create a Price Book select 'Price Book Maintenance' from the Options menu in Customer 
Maintenance or in Inventory under the Miscellaneous menu. A pick list of Price Books will display. Select 
an existing record, or select 'New' to create a new price book and the following form will appear: 
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Enter the 'Name' and 'Description' of the Price Book in the corresponding fields and save the record. 

Inventory Items Section: 

Item Information This includes the item's: Item #, Description, Class, Revision, and Ext Description. 

Inactive All 
EPlants 

If the item is inactive in all EPlants, this column will display 'Y'.   

If the item is active in at least one EPlant, this column will display 'N'. 

Product Code This is the product code associated to the item. If there are more than one matching item it will 
pull in the product code from the first item found. 

Color Codes: 

▪ Red - When an item is set to inactive in all EPlants it will be highlighted in red. 

▪ Blue - If the product code is not the same across all items for different EPlants it will be highlighted in 
blue. If one item has a product code and another does not it will also be marked blue. 

Price Types 

Price Types will allow users to define price breaks based on a price type for an item to control pricing 
based on shipping method or any other user defined price type. The price types, as well as a null price 
type, can then be associated to items on a price book.  Price types associated to an item must be 
unique.  Each item/price type combination can have different price breaks. Price Types can also be 
associated to a Customer and or Customer Ship To (in Customer Maintenance). The system will use the 
assigned Price Types to determine pricing when entering a sales order. (Refer to the flowchart below). 

Select Price Types from the File menu in Price Book Maintenance to create Price Types. 
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Enter a Code and Description. The Price Type Code field is 25 characters and the Price Type Description is 
255 characters.  Price types must be unique. The user will receive a unique constraint error if the same 
price type code is entered.  

Adding Inventory Items 

A price book can contain one to many inventory items.  Select the + button in the left grid to add items. 
The inventory pick list includes columns for Item #, Class, Revision, Description, Ext Description and the 
user defined 'Group Code' in Inventory (Inventory->Additional tab). The pick list has filtering capability to 
enable users to quickly find items to add to the price book. When logged in as View All the user will see 
all items belonging to all EPlants in the pick list.  If there is more than one record with a match on 
Revision, Item # and Class, the user will only see that item displayed once, since the Price Books are 
"EPlant agnostic". When logged into an EPlant, the pick list will only display items belonging to that 
EPlant. Once the item is selected, the Item #/Class/Revision that was created first will be displayed on 
the Price Book Maintenance form. For example, if there is an Item A, class = FG, Rev A in more than one 
EPlant, and the item in EPlant 1 was created first, that will be the one that displays in the list. The price 
breaks added for the item in the Price Book are relevant for all items in all EPlants with the same Item 
#/Class/Revision. 

Multiple items may be selected at one time to quickly add several records. In addition to the item 
information such as Item #, Description, Class Group Code, and Rev, the pick list includes a column called 
'Inactive All EPlants'.   

▪ If the item is inactive in all EPlants, this column will display 'Y'.   

▪ If the item is active in at least one EPlant, this column will display 'N'. 

All columns can be sorted and filtered on in the pick list.  
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The 'Inactive All EPlants' column is also visible in the Inventory Items section on the main Price Book 
Maintenance form and functions the same as in the pick list. In addition to the column, when an item is 
set to inactive in all EPlants it will be highlighted in red. Inactive items can be hidden by toggling the 

Filter Inactive Items button . 

Once items have been added to a price book, there is a search option available in the Inventory Items 
section to enable users to find specific items. 

Price Break Types 

In the lower left grid users can enter Price Break Types and Currency combinations to apply price breaks 
to. Select the insert button and select a Price Break Type from the pick list accessed from the ellipsis 
button in the Price Type Code field. The Price Type Description will populate based on the selected code. 
The Price Type Code field can be left null and prices can be associated to the null price code type. The 
price type codes must be unique. If the user selects a Price Type Code that is already assigned to the 
item a 'Unique Constraint' error will surface.  

The Currency will default to the Native Currency associated to the EPlant the user is logged into. A 
different currency can be selected from the pick list accessed from the ellipsis button in the field. Pricing 
may be entered and stored for multiple Currencies and Price Type Code combinations. Price breaks in 
different currencies will be visible for the item regardless of the EPlant the user is logged into.  

Price Breaks 

Price breaks can be added to each item for a specific Price Type Code and Currency combination. If a 
Price Type Code or a null code is not created prior to entering price breaks and error will display stating: 
"Please add a Price Break Type before trying to add Price Breaks".  

The price breaks will affect the Item #/Class/Revision that matches in all EPlants.  

To enter the price breaks, click on the + button and enter the price break information using the field 
description below as a reference. Users can enter in as many quantities and price breaks as they like. The 
maximum decimal places is six.  

Quantity The quantity associated with the price.  

Price The price of the item at that quantity. 

Price Date Optional. The date the price was created or revised. 

Effective Date Optional. The date that this price will be in effect. If the date is in the future the line item will be 
gray until the effective date. 

Inactive Date Optional. The date when this price will no longer be in effect. The system recognizes the inactive 
date as the date entered however the line item will not turn gray until after that date has 
passed. To show/hide inactive price breaks select the Inactive toggle button. 

Comment A price break comment (up to 255 characters) can be entered in this field. 
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Right Click Options 

▪ A right click option 'Assigned To...' in the top section will access a pick list to allow the user to view 
which customer(s) and/or ship to(s) the price book is assigned to. The pick list includes a column for 
'Attached To' that will indicate either Customer or Ship To. There is a soft EPlant filter in the 
'Assigned To' pick list.  The user can then select the Customer or Customer Ship To to jump to the 
record.   

▪ Users can right click on an item in the middle section and jump to Inventory. 

Active/Inactive Toggle - Select the toggle button in the price breaks section to toggle between viewing 
just active or both active and inactive. 

Note: When deleting an inventory item from the inventory module that is in multiple EPlants, the Price 
Book item and the Price Book price break records will not be deleted until all of the inventory item 
records with the same item number in all EPlants are deleted. 

Update Pricing 

Pricing can be quickly updated using the 'Update Price Book Prices' button. There are two options to 
update the pricing in the Price Book: 

▪ Update Pricing for Selected Items - This will update the pricing for the selected items. Items can be 
multi-selected using the Shift/Ctrl keyboard buttons. 

▪ Update Pricing for all Items - This will update the pricing for all items in the Price Book. Only the 
visible items in the Price Book will be updated. When logged into an EPlant, the price book will only 
display items belonging to that EPlant, so items in another EPlant will not get updated even if they 
are in the same Price Book. If the item belongs to both EPlants, the system will update the price in 
the price book which will be applicable to both items in both EPlants. 

Select an option from the drop down next to the speed button on the Price Book Maintenance form 

 . When using the 'Update Pricing for Selected Items', if no items are selected an error will display 
stating: "Please Select Records". 

Once a selection is made the following form will appear: 
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Select the Price Type(s) from the list that you want to updated pricing for. Multiple price types can be 
selected by using the Shift/Ctrl keyboard buttons.  

Use the drop down list next to the Currency field to select which currency to update pricing for.  

The pricing will only be updated for the price breaks associated to the selected currency and Price Type. 
If the user selects a currency/price type to update pricing and there are no price breaks for that 
currency/price type on an item the system will skip updating it. 

▪ Prices can be changed based on a Percentage or Flat Amount. Select the Increment By option and 
then enter the corresponding value. (To enter a decrease put in a negative number). The value 
cannot be zero, if a zero is entered an error message will display.  

▪ Enter the effective date from the drop down calendar. The effective date can be a date prior to the 
current date.  

▪ Enter a decimal precision value. This defaults to six. The decimal precision level required. 

▪ A comment (up to 50 characters) can be entered which will populate in the price break grid in the 
Price Book.  

Click on the OK button. A confirm message will display with Yes and No buttons. Select No to return to 
the 'Update Price Book Prices' form with no changes, or select Yes to continue and the system will 
calculate the new pricing and populate the price section in the Price Book. The system will update the 
price breaks that have an effective date equal to or before the new effective date and without an 
inactive date or the inactive date is after system date. The Price Date field will populate with the current 
system date. The old prices will be marked inactive automatically, the lines will be highlighted in gray and 
the Inactive date populates automatically with Effective Date of the new pricing. The Active/Inactive 
toggle button can be used to view active or both inactive and active. 

Adding Items to Sales Order  

When creating a sales order (in regular sales order mode, quick order entry, WebDirect B2B, and 
WebDirect B2C) or a sales quote and adding an item to the order/quote the system will use one of the 
following flowcharts to enter the price. Which flowchart applies depends on whether the Calculate 
Aggregate Pricing parameter is set to 'Product Code /AKA Pricing/ Price Book'. This parameter is found in 
System Parameters under the Purchase Order and Sales Order Setup tab->Sales Order section. 

Note: Price Book pricing does not apply to orders created from EDI. 

The system will use this flowchart when the Calculate aggregate pricing method is not checked: 
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If the calculate aggregate pricing parameter is set to 'Product Code /AKA Pricing/ Price Book', the system 
will use a hierarchy to determine the aggregate pricing.  It will first check to see if the item has Price 
Book pricing, and if so it will use that for the aggregate calculation. If not, the system will check to see if 
the item has AKA pricing, and if so it will use that for the aggregate calculation.  If not, the system will 
use the Product Code pricing for the aggregate calculation.  
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Warnings: 

The following warnings will only surface for customers that have a price book assigned at the ship to or 
customer level: 

▪ If the item is assigned to a Price Book but does not have a price at all, or there is not a match on the 
currency, a warning with an OK button will display stating: "Item # xxxx is assigned to a price book, 
but has no pricing." Once OK is selected the item is added to the sales order with a price of $0.00.  

▪ If the item is not assigned to a Price Book, a warning with an OK button will display stating: "Item # 
xxxx is not assigned to a price book." Once OK is selected the item is added to the sales order with a 
price of $0.00 and 0% discount. 

▪ If a Price Book item has an alternate item assigned, when the alternate item is selected a warning will 
appear stating it is not a Price Book item and the price will be 0. 

▪ If a non-Price Book item is added to a Price Book customer sales order and then an alternate item is 
selected, a warning will appear stating it is not a Price Book item and the price will be 0. 

Notes on Discounting: 

Note: Sales Order Discounts will be applied after determining the price pulled from the price book.   

Note: The customer 'Price Break Quantity' (Customer Maintenance->Miscellaneous tab) is not applicable 
for Price Books. 

The price will update in the following conditions: 

▪ When a new item is added 

▪ When the item is replaced 

▪ When the blanket quantity is modified 

▪ When the tax is added/modified 

▪ When the discount is added/modified 

▪ When a customer or ship to address is replaced on the sales order header, the price will 
automatically be updated based on the customer/ship to price book. 

Price Book Features on Sales Orders 

On the sales order (including Quick Order Entry), next to the Customer # and Ship To fields there is a 
button that will indicate whether a price book is attached at the customer and/or ship to level.  The 
user can select the button to quickly jump to the price book.  The button will be grayed out if a price 
book is not attached.   

In the sales order detail section, the Price Book field will display the price book the item is attached to. 
Users can right click in the middle section of the Sales Order and select 'Jump to Price Book' to access the 
Price Book associated to the item. 
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The 'Price Book Price Type' field in the Sales Order detail section displays the Price Type associated to the 
price book associated to the customer or ship to. The Price Type per item can be overridden on the Sales 
Order by selecting the ellipsis button in the 'Price Book Price Type' field. The Price Type pick list will 
display only those price types associated to the item; not including the null price type.  If the user 
would like to use the null price type, the existing Price Type must be deleted from the field in the order 
detail first. When the price type is overridden and there are active price breaks then the line item price 
will be updated to use the appropriate pricing based on the quantity breaks. When the price book 
changes on the customer header record due to changing the customer or ship to, the price type will 
reset to override at the item detail level based on the price book hierarchy flow chart. If the Price Type 
assigned to an item only has inactive or no price breaks, a warning will surface stating the item is 
assigned to a price book but has no pricing. This warning will also surface if the user overrides the Price 
Type where there is no pricing or only inactive pricing for the item. If no price book is assigned to the 
customer or ship to, the system will follow the default pricing hierarchy and the Price Type field will be 
read only.  

With an inventory item that does not have any selling prices (AKA Selling or Selling on the Buy/Sell 
pricing tab), when switching from a Customer/Ship To on a sales order that has a price book to a 
Customer/Ship To that does not have a price book, the sell price in the Item Detail section is cleared out, 
and the price, price book and price type will all be blank.  

Note: The 'Update Sales Price' right click option in the item details section of a Sales Order also applies to 
Price Book items. Refer to the Update Sales Price section for more information. 

Note: If a price book is not assigned at the customer or ship to level, the price of the item(s) will use the 
standard pricing hierarchy (Refer to Sales Order Line Item Details and Discount Pricing for more 
information). 

Note: When un-archiving Sales Orders, when using Price Books, if the price books have not changed the 
system will populate the original price book and price type, and the actual sales order price will come 
over as is, with no update. If the price book or price type is not the same a warning will display stating: 
"Order # xxx has one or more price book or price type mismatches in its order details, please investigate 
to ensure correct pricing". The system will  assign the same price from the archived order and set the 
book/type to null.  For example, the warning will appear if the price type is manually changed before 
archiving, a price book assigned to the customer or ship to is deleted after archiving, or a price type 
assigned to the customer or ship to is deleted after archiving. The system will not attempt to grab 
current price book/type or pricing on unarchive. 

Price Book Volume Pricing 

When the 'Calculate aggregate pricing method' parameter (in System Parameters->Purchase Order and 
Sales Order Setup tab) is set to 'Product Code /AKA Pricing/ Price Book', the system will use the following 
hierarchy to determine the aggregate pricing:   

1 Price Book pricing 

2 AKA pricing 

3 Product Code pricing 
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When creating a Sales Order or Sales Quote, users can select the ‘Calculate aggregate pricing’ button to 
calculate volume pricing based on a Price Book. The system will sum all quantities for items that have the 
same product code regardless of the price type.  The system will look at price type assigned to the item 
to determine the price breaks to use based on the sum of all quantities. The price of the item will update 
accordingly.  

Volume Pricing Examples: 

Scenario 1:  

If a customer has a Price Book assigned with no Price Type:  

▪ Item A with Product Code ‘PC-A’ has a blanket quantity of 5 with assigned Price Type ‘L’ in the order 
detail. 

▪ Item B with Product Code ‘PC-A’ has a blanket quantity of 5 with assigned Price Type 'T' in the order 
detail. 

➢ When looking up the price in the Price Book price breaks, the system will use the quantity 
break at 10 for Price Type ‘L’ for Item A, and the quantity break at 10 for Price Type ‘T’ for 

Item B. 

Scenario 2:    

If a customer has a Price Book assigned with Price Type 'X' assigned at the customer level: 

▪ Item A with Product Code ‘PC-A’ has a blanket quantity of 5 with no assigned Price Type in the order 
detail. 

▪ Item B with Product Code ‘PC-A’ has a blanket quantity of 5 with no assigned Price Type in the order 
detail. 

➢ When looking up the price in the Price Book price breaks, the system will use the quantity 
break at 10 for Price Type 'X'. If the Price Book does not have a matching Price Type 'X' for 

the item, then the normal pricing hierarchy will be used to determine the price for the item.  

Scenario 3:  

If a customer has a Price Book assigned with Price Type 'X' assigned at the customer level.  

▪ Item A with Product Code ‘PC-A’ has a blanket quantity of 5 with no assigned Price Type in the order 
detail. 

▪ Item B with Product Code ‘PC-A’ has a blanket quantity of 5 with Price Type 'T' in the order detail. 

➢ When looking up the price in the Price Book price breaks, the system will use the quantity 
break at 10 for Price Type ‘X’ for Item A and quantity break at 10 for Price Type ‘T’ for Item 
B.  Note: If the Price Book does not have a Price Type 'X' for Item A, the normal pricing 

hierarchy will be used to determine the price for the item.  
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Image File 

From the Image File form the user can associate an image to the inventory item. This image is used to 
display on the WebDirect product list for customers. 

 

To attach an image select the Assign Image speed button . Select the image file from the Images 
folder in your master home IQMS directory. 
 

Cycle Count Codes 

Cycle Count Codes is a user defined list used in Physical Inventory to perform Cycle Counts for items. To 
create the list click on the ADD (+) button and enter the Code, Description, Sales Rank %, and Counted 
Per Year. 
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Codes can be assigned to inventory items manually or based on a Sales Rank % or Transaction velocity. 
Typically the Sales Rank % is used for manufactured items as it uses AR Invoices, and the Transactions 
option is used for raw materials. 
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Seq # Enter the sequence number of the ranking. 

Code The Code can be up to 15 characters. 

Description The description of the Cycle Count Code. 
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Sales Rank % In order to have the system assign a code automatically based on a Sales Rank % select 
'Sales' from the 'Ranking Based On' drop down list. Enter the sales % rank to be associated 
with the cycle count code. The system can calculate the sales for an item and assign the 
appropriate cycle count code automatically based on the sales % rank. The highest Sales 
Rank % entered indicates both the highest cost items and the percentage of items to 
include in a specific code category (the code itself is arbitrary). 

The system considers all items with posted invoices for cycle count code assignment 
(regardless of standard cost). The items with posted invoices are sorted in descending 
order by highest total standard cost for each item. The system assigns the cycle count code 
with highest Sales Rank % to the same percentage of total items starting with the highest 
standard cost, and so on for each cycle count code.   

Example:  Cycle Count Code A has the highest Sales Rank of 40% and there are a total of 
100 items with posted invoices.  Cycle Count Code A will be assigned to the top 40 items 
according to the item’s total standard cost for posted invoices – even if that quantity is 
zero. If Cycle Count Code B has a Sales Rank of 30%, then the next 30 items according to 
total standard cost will be assigned, etc.   

Note:  For items with the same total standard cost (including zero), items could 
potentially be assigned different codes because system uses Sales Rank % to determine the 
number of items included within each code category. 

If this option is used, each code must have a % entered and the total of all Sales Rank %'s 
must equal 100%. If it does not add up to 100% a warning will appear stating, 'Every Sales 
Rank % must be assigned and the total must equal 100.' 

To automatically assign codes select the Recalculate button on the Cycle Count list and 
select Yes. The following form will appear listing the codes and the items associated to 
each code based on sales % rank: 
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Select the calculator button and select Yes on the confirm message. A Date Range form will 
appear. By default the calculation looks back 365 days each time it is recalculated. A user 
defined date range can be entered by selecting different dates/times in the in the From 
and To fields. Select Ok to proceed. It only evaluates the items associated to the EPlant the 
user is logged into. It uses the AR Invoice detail quantity  *  standard cost to determine 
the value of each item sold during that time. Then it determines the top X% based on the 
sales rank % for each code. 

The cycle code for an item can be modified by clicking in the Cycle Code Description field 
and selecting the ellipsis button. If a cycle code is manually changed for an item check the 
'Lock Cycle Code' check box to prevent the system from reverting back to the calculated 
code when the transaction ranking is recalculated. 

Note: This only affects Inventory Items that are on an AR Invoice. This allows users to use 
the Transaction based calculations for raw materials then use the sales based calculations 
for Invoiced items without wiping out the cycle codes on non-invoiced inventory items. 
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Transactions In order to have the system assign a code automatically based on Transaction Velocity 
select 'Transactions' from the 'Ranking Based On' drop down list. Enter the Rank % for each 
code to include based on the the frequency of transactions for the item.  

To automatically assign codes select the Recalculate button on the Cycle Count list and 
select Yes. The system will look at TRANSLOG records for the items. The following form will 
appear listing the codes and the items associated to each code based on transaction 
velocity. 

 

The movement class for an item can be modified by clicking in the Cycle Code Description 
field and selecting the ellipsis button. If a cycle code is manually changed for an item check 
the 'Lock Cycle Code' check box to prevent the system from reverting back to the 
calculated code when the transaction ranking is recalculated. 

Counted Per Year This is the number of times this code should be counted per year. This is used to determine 
if the item should be counted during a physical inventory when using the worksheet->cycle 
count code method. The system will utilizes the 'Last Cycle Count' date (Inventory-
>Additional tab) to determine if the item needs to be counted. 

For example: If the Counted Per Year = 4 and the item has been counted during the last 
three months (based on the Last Cycle Count date) it will not be added to the work sheet 
for counting again until the date is past three months. 

Note: Physical Inventory tags will NOT be created when ‘Counted Per Year’ is 0 and 
Physical Inventory tags will ALWAYS be created if 'Counted Per Year' is NULL. 
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Cycle Count Code 
Based On 

In the drop down list select from 'Adjustment Date' (default) or 'Transaction Date'. The 
Adjustment date is the date it is posted (system date), where the transaction date is the 
day the cycle count was started. 

In Physical inventory when Recording Inventory Adjustments the system will update the 
'Last Cycle Count' date (Arinvt.cycle_count_code_date) with either the current Adjustment 
Date or the Transaction Date based on the option selected for the code and the code 
associated to the item. 

When doing Physical Inventory "Worksheet" method using the cycle count codes, once adjustments have 
been posted, the cycle count date will be updated with the adjusted date and time. The translog reason 
will be Physical Inventory Adjustment, WS-Cycle Count. 

To manually associate a Cycle Code Code to an item, go to Inventory->Additional tab and select the code 
from the drop down list in the Cycle Count Code field. 
 

Parameters 

 

PO Safety Adds additional days to the lead days of the material when calculating the Must Order By date 
in the Material Exception List. 

PO Scope Used to determine the number of days of material requirements that should be entered as a 
single PO line item in the Material Exception List. Controls how much material to receive in 
against blanket order (i.e. only want to order enough material to complete production 
requirements over the next 7, 14, 21 days, etc.). 
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PO Range Used in conjunction with the Ideal vs. Existing PO evaluation tool in the Material Exception List. 
This tool makes recommendations on how your current purchase orders might be re-arranged 
to acquire materials more efficiently. The Range value provides a baseline for making some of 
these assumptions. It is a date function that helps determine when you might want to bring 
the materials in. 

FIFO Threshold This option is used for the RackTruck module only (a module specifically designed to aid in the 
movement of product in a large warehouse using Vehicle/Fixed-Mount Mobile Computer 
Devices).  

Each inventory item can have a specific FIFO Threshold (in days) established which will tell the 
system if product must be shipped prior to shipping production. 

Delete Empty 
Location 

If this option is checked the system will delete a location during a transaction if the on-hand 
inventory drops to zero. Refer to the Automatic Deletion of Locations for more information 
(Linking Locations to Items). 

Note: When using Actual Costing, the empty location is deleted once the items removed 
from the location are both shipped and invoiced.  

Transaction 
Code is 
Mandatory 

If this option is checked it will force the user to select a transaction code when doing a manual 
transaction (in or out), and when receiving. (This does not affect Floor Dispositions as it is not a 
manual transaction). To edit the list of transaction codes select the edit button to the right of 
this field or go the menu and select Misc/Inventory Trans Codes. Note: If this field is checked 
and you are using Pending ASN Receipts it is REQUIRED to enter a transaction code in the 
Vendor Maintenance record (Miscellaneous tab). 

Non Conform 
move requires 
MRB completed 

If this option is checked it restricts inventory in a Non-Conform location linked to an active 
MRB from moving to a conforming location until the MRB has been approved (MRB Approval 
Date filled in).  This also applies to moves made with a scanner. 

Note: Users are not prevented from moving material from one Non-Conform location to 
another Non-Conform location. 

Allow To Drive In 
Transit Location 
Negative 

If this parameter is checked when receiving Outsourced items and backflushing the system will 
allow an In Transit location to be driven negative.  

If it is not checked, users are unable to backflush more than what is in transit. 
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If licensed for 'Advanced WMS' another tab will be visible called Location / Package UOMs. This allows the 
user to specify the UOM of dimensions for the Location, Case, and Pallet.  Valid options are: FT, IN, M, 
CM, and YD. There is also an option to specify the UOM for weights. The options are: LBS, KG, OZ, and 
GR. These parameters can also be accessed from the File menu in the Location Types module. 

 
 

Edit UPC Codes 

Multiple UPC (Universal Product Codes) can be entered for an inventory item. Multiple items can share 
the same UPC code. From the Miscellaneous menu in Inventory select Edit UPC Codes and the following 
form will appear: 
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The left side displays all of the items in Master Inventory. This list can be sorted by any column. Use the 
white box to type the known information to locate the desired item. To enter UPC Codes select the ADD 
(+) button and enter the UPC Code and quantity. The Qty field indicates the quantity of inventory this 
UPC code represents. The sequence number will automatically fill in based on the order the UPC Codes 
are entered or it can be manually typed in. 

The first two UPC codes, sequence 1 and 2, will be captured in Master Label, the dbf and LMINVTRY.  
The fields are UPC_Code and UPC_Code2 respectively. 
 

Environmental Regulations 

This is a list of Environmental Regulations used in Environmental Regulatory Reporting. 

Enter the Regulation and Description for each. These regulations are then associated to the Chemical 
Abstract Service (Inventory->Miscellaneous menu) See Chemical Abstract Service. 
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Tariff Codes 

This is the list of Tariff Codes that can be assigned to inventory items in the Tariff Code field on the 
Miscellaneous tab. A tariff code is a number assigned to each type of product sold internationally. Each 
tariff code is issued by the World Customs Organization (WCO) through a database called the 
Harmonized System. The number of digits for each product ranges from six digits for common products 
to 10 digits for niche items. This information can be added to official shipping documents such as 
Commercial Invoices and Shippers Export Declaration. 

Select Tariff Codes from the Miscellaneous menu in inventory, or this list can also be accessed from Lists 
menu in System Parameters. From this form enter the Tariff Code and description for all codes relevant 
to the products you ship. Select the insert  (+) button and enter the code and corresponding 
description. Continue this process until all codes are created. 
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Chemical Abstract Service 

This is a list of Chemical Abstract Service (CAS) items. Enter the CAS # and Description for each item. 

  

Next, associate the applicable Environmental Regulation(s) by clicking on the ellipsis button in the 
Regulation field to access the Environmental Regulation pick list. This list can be accessed from this form 
by selecting the Environmental Regulations speed button at the top.  

Once both lists (CAS and Environmental Regulations Environmental Regulations ) have been created this 
information is used in Environmental Regulatory Reporting (Inventory->Options menu). See 
Environmental Regulated Components. 

Options Menu: 

Inventory Class MSDS Setup - From this option users can establish which classes of inventory should be 
enabled for the MSDS documentation requirements. This option can also be accessed from the speed 
button on this form. When selected the following screen will appear. Place a check in the box for the 
inventory class that is MSDS Authorable. Authorable items are uploaded to the MSDS provider in order 
to allow the user to see them on the website and setup documentation for that item. There are two 
levels that MSDS can be authorable, at the inventory class level and the item master level. The class level 
allows users to enable an entire class of inventory items to be MSDS enabled. If an inventory class is not 
enabled as a whole, then individual inventory items can be enabled via the MSDS Authorable checkbox 
on the Additional tab in inventory. 
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Enable MSDS Tracking – This turns on/off MSDS triggers on customers, orders and inventory that track 
whether an item needs to be uploaded to the web services. Note that enabling MSDS could take several 
minutes as the system evaluates all inventory, customers and orders for MSDS tracking. 

 
 

Modify GL Accounts for Inventory Items 

Use this feature to modify the default GL accounts for this item, as defined under System Setup|System 

Parameters|GL Setup. This is the same function as on the Buy/Sell Pricing tab. To modify the GL accounts 
for more that one item, select Misc|Inventory Accounts from the menu. (See Buy/Sell Pricing Tab for 
details). 
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Inventory Transactions 

Transactions are at the root of inventory control in EnterpriseIQ. All inventory items exist in locations and 
any change to an inventory quantity or a change in location is accomplished by completing a transaction. 
Each transaction is logged to the Transaction Log, providing a comprehensive history of activity. 

Transactions are used to add, subtract and move inventory. Below is a listing of some of the types of 
transactions that EnterpriseIQ supports: 

▪ Receiving - Receipt of material into inventory. 

▪ Location to Location - Movement of inventory items between inventory locations. 

▪ InterPlant transfers - To transfer items from one EPlant to another EPlant location. 

▪ Manual/Backflush - Manual inventory adjustments into and out of inventory. 

▪ Manual/Associate - Manual transaction where the 'Associate with In' option was selected. 

▪ Disposition - Moving manufactured items into inventory and relieving raw materials to document the 
production process. 

▪ Floor Disposition - Moving manufactured items into inventory before the shift change is complete 
(from RealTime only). 

▪ Packing Slip (Void Packing Slip) - Shipping inventory items to a customer. 

▪ Vendor Managed Inventory - managing inventory at the customer site. 

▪ Physical Inventory - Physical inventory adjustments. 

▪ RMA (Void RMA) - Returned items are received back into inventory. 

▪ Labor - Dispositioning labor for Job Costing. 

▪ Overhead - Dispositioning overhead for Job Costing. 

All inventory includes a location and an optional lot number. The user can create as many locations as 
needed, and then use the location list to easily identify where inventory resides. EnterpriseIQ includes a 
transaction engine that is used in production reporting to update many inventory items in succession. 

The Location and Transaction Form 

The Location and Transaction screen is the same for all classes of inventory. This form can be accessed 
from the Locations and transactions button on the Inventory form or directly from the Launcher bar. 
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Upper Section Fields: 

The upper portion shows the current item, with class, revision, unit of measure, item number and 
description, Ext description, Standard Cost (security can be placed on this field to hide it if desired), and 
EPlant. This section also shows the current On Hand, Non-Allocate, Non-Conforming, Non-Committed 
and No Ship amounts across all locations. 

Lower Section Details: 

The lower left grid lists the locations that the item is linked to, including the location, location 
description, lot#, cost, quantity in that location, Container number (entered during receiving), and the 
date the item was placed in that location. Other fields include: 

▪ The In Transit Origin field indicates the origin either as ICT or Outsource Vendor. 

▪ The Hard Allocated To field will display the work order the location has been hard allocated to. 

▪ For Outsource Central users the Outsource Vendor field displays the vendor the items are in transit 
to. (For more information please see the Outsource Central help file).  

▪ The Lot Date field can be used to enter the date of the lot for locations with a lot number. Select the 
ellipsis button to access the pop up calendar to select the Lot Date. If the location does not have a lot 
number the pop up calendar will not appear. Lot Dates can also be entered during PO Receiving 
through EIQ or RF. If the item has a value in the shelf life field other than zero on the Additional tab 
in inventory, when the difference between the system date and the lot date exceeds the shelf life the 
location will automatically be marked in red indicating it is expired. 

▪ Make To Order (SO/Line#) - This field will display the Make To Order sales order and line number that 
the items in the location have been allocated to. The line will display as lavender. 

▪ Last In Date - This field is updated when any transaction greater than zero adds a quantity to the 
location (FGMULTI) record. 

▪ Last Cycle Count - This will display the date the location was last cycle counted when doing a Physical 
Inventory by Location. This field is read only. 

▪ Exp Date - This is the expiration date of the location for items where a lot number and lot expiration 
date are mandatory. 

▪ MRB # - This will display the MRB # the location is linked to if applicable. 

Costs Associated to Locations 

The Actual Cost field for purchased items populates with the purchase order price. For standard cost 
users, if the item has a landed cost associated to it it will be included. If the purchase order price is zero 
and the item is received to a new location the cost associated with that location will be zero. If an item 
with a zero PO price is received into a location with a cost already associated with it, the cost will remain 
at that value (it will not average). If the purchase order price is different than the cost for the location 
the system will do a weighted average. For manual transactions (not PO receiving), the system will use 
the average cost for this field. (The average cost field is displayed on the Standard Costing tab). 

The Actual Cost field for manufactured items is based on the actual costs associated to the cost 
elements recorded during production. This populates whether Actual Costing or Standard Costing is 
enabled. 
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Note: For users with the 'Use Actual Cost during Posting Transaction' option checked, and the option 'Do 
not use Average or Standard Cost for Transactions'  is also checked (both in System Parameters-
>Inventory tab->Actual Cost Postings section), when doing a manual transaction or a disposition 
transaction, the Cost field in the Transactions module (FGMULTI.ACT_COST) will not be populated with 
the average or standard cost. 

Note: Outsource Items - The Actual Cost (which will appear in Translog, PIT and Process Costing) equals 
the PO unit price + the roll up from the component. The PPV is calculated off of the PO Unit Price. 

When performing Physical Inventory and adding inventory on hand, the actual cost of the IN transaction 
will be determined by the following hierarchy: 1. If the FGMulti already exists for the item, the system 
will use the actual cost of the existing FGMulti. 2. If a new FGMulti is created, with existing Lot # entered, 
system will scan and see if prior FGMultis, with the same lot # for that item exist. If an existing FGMulti is 
found, the actual cost of the existing FGMulti will be used. If multiple FGMultis, with the same lot #, the 
actual cost will be an average of the actual costs related to the multiple existing FGMultis. 3. If a new 
FGMulti, with a new lot # is created, the standard cost of the item will be used as the actual cost. 3a. If 
"Use Actual Costing during Post Transactions" and "Do not use Average or Standard Cost for 
Transactions" are both checked in System Parameters->Inventory Setup, the system will use 0 for the 
actual cost. 

When voiding a Packing Slip to a new location, the Actual Cost recorded on the location and in Translog 
will equal the Actual Cost of the original Packing Slip. If multiple locations were selected on the original 
Packing Slip, when voiding to a new location, a weighted average Actual Cost will be used.  

Location Color Codes 

These color codes are also used in pick lists throughout the system. 

▪ White - normal location. 

▪ Rust - This is a non conforming location. The reason the location is non conforming is displayed on 
the right side of the form. 

▪ Gray - This is a non allocatable location. The reason is displayed on the right side of the form. 

▪ Yellow - This is a VMI (Vendor Managed Inventory) location. 

▪ Blue/Green - The skid option is obsolete. 

▪ Red - The lot has expired. The system determines the lot is expired based on the lot date associated 
to the location/Lot and the Shelf Life value associated to the item (Inventory->Additional tab). For 
example, if the Shelf Life = 10 days and the lot date = 10/15, the lot will be marked expired on 10/26. 
The count starts the first full day after the lot date and expires the first full day after the shelf life 
number of days. 
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▪ Purple/Black - The In Transit location is used by the Intercompany Transfer module (ICT), Outsource 
Central and when the ‘Verify Inventory’ pick ticket parameter is checked. By default, an In Transit 
location is locked preventing users from manually adding or removing items. If the Inventory 
Parameter 'Allow To Drive In transit Location Negative' (Miscellaneous menu) is checked, when 
receiving Outsourced items and backflushing the system will allow an In Transit location to be driven 
negative. Also, the system will allow moves to and from In Transit locations, regardless of the In 
Transit Origin (and in the case of outsource origin, regardless of whether the Vendor's match). Note: 
This type of location should not be manually added to an inventory item. The system will add an In 
Transit location to an item when required. 

▪ Aqua Blue - This indicates the quantity of items that have been hard allocated to a work order. The 
work order number will appear in the ‘Hard Allocated To’ field associated to the location. Material 
cannot be removed or added to a location that has been hard allocated to a work order. An error will 
appear, “Location is marked as hard allocated to WO# XXXX. Transaction aborted.” The hard 
allocation can be released by right clicking on the location and selecting ‘Release Work order Hard 
Allocation’. If the work order has cycles required a warning will appear stating the work order is not 
complete. Depending on security the user will be able to select OK to continue with the release or 
Cancel to not release the hard allocation. Once the transaction is complete, the location will no 
longer have the work order associated to it and the color will go from aqua to white. The hard 
allocation will be disassociated from the work order. 

Material Hard Allocated to a work order can be moved to another location based on the following rules: 

▪ When moving from a hard allocated location to: 

Another hard allocated location associated with the same work order, a regular move is 
executed.  

Another hard allocated location associated with a different work order, a new location is created. 
(In the same manner as when lot #’s do not match).  

Any non hard allocated location, a new location is created like when lot #’s do not match. 

▪ When moving from a non hard allocated location to: 

A hard allocated location an error is raised. 

Any non hard allocated location, a regular move is executed. 

(For more information on Hard Allocation to a work order see Hard Allocation). 

▪ Lavender - - This indicates the items have been allocated to a Make To Order sales order. The sales 
order and line number will appear in the Make To Order field. To release the Make To Order 
allocation use the right click option. 

▪ When moving from a MTO allocated location to: 
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Another MTO allocated location associated with the same sales order, a regular move is executed 
for this MTO sales order. 

Another MTO allocated location associated with a different sales order, a new MTO allocated 
location is created for the source MTO sales order using the target location name .  

A non-MTO location, this creates a new MTO allocated location using the target location name. 

A non-MTO location that is a default non-conforming location, this creates an MTO location that 
is non-conformed using the source MTO sales order. 

Note: An MTO location can also be toggled to non-conform with the option to make it allocatable. 
This works similar to moving to a non-conform location except the existing location is being 
updated rather than a new location being created. Users can also toggle the location back to 
Conform with the MTO Sales Order linkage maintained. 

▪ When moving from a non-MTO location to: 

A MTO allocated location, this creates a new non-MTO location using the target location name. 

A non-MTO allocated location, a regular move is executed. 

For a complete discussion on this feature, please see the Make To Order https://my.iqms.com/cfs-
file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf TechNote. 

Additional Information (four Tabs): 

▪ The General tab is used to set the status of the item as it exists in the location highlighted on the 
lower left side. The location can be set as non conforming, non allocatable, no ship, as the disposition 
designator, the default shipping location, or receive designator, and may include a division 
designation (See the Locations section for details on the location status types, i.e. No Ship and 
Receive Designator) .  

▪ The Country of Origin applies to purchased items. It automatically populates with the country 
associated to the Vendor the item was received from if the location has a lot number. This 
information is also available as a right click option in the Transaction Log, within the Lot Control 
tab, and the Lot Tracking module. A numeric value will appear in this field, which signifies the 
following: 1 = ICT, 2 = Outsource Central, and 3 = Verify Inventory. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
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▪ The User Defined tab supports three fields (up to 250 characters each) that can be used for any 
purpose. These fields are visible in the translog. The data entered in one of these fields will appear 
on the transaction line in the Translog under the corresponding CUser column. The CUser1 field is 
filled in automatically if the user enters a Vendor Lot # during receiving. To change the user field 
name, right click and select Define Title. Type in the new title in the New Value field. When a title is 
changed for a user defined field on a inventory item other than PL it will be that name for all classes 
of material except PL. PL class inventory items can have a different user defined field label. NOTE: 
The column headings in the translog will not automatically change to the newly defined label text. 
The user must change the column title in the translog as well. 

▪ The InterPlant Locations tab is used to transfer items from one EPlant to another EPlant location. This 
will be discussed in more detail later in this section. 

▪ Lot Control - From within this tab there are two sections, the Supporting Lot Documents displays the 
documents scanned during receiving. During the receiving process the user can scan in a document 
associated to the Lot Number using a Twain compatible bed/image scanner. Note: A list of 
compatible scanners can be found at http://skylinetools.com/imagelib/index.html  
http://skylinetools.com/imagelib/index.html. From the website, on the left find Support -> Scanner 
Support, scroll down on the Scanner Support page and the list of compatible scanners is on the right 
side. External documents can also be added here and set to print with the Certificate of 
Conformance. The Lot Settings allow users to view information and make changes to entire lots of 
material which may be in several locations. This section will only be visible if the highlighted location 
has a lot number. Refer to the Lot Control section for details. 

This form also allows access to the translog via the translog button. Other icon options include direct 
access to various transaction methods. 

Location and transactions Screen Menu Functions 

Tool Bar Functions 

At the top of the Transactions Screen are several tool bar functions. They are listed below for your 
reference. 

 Search for Item - Used to access the inventory pick list. This pick list includes the sort and scope 
functionality. There is also a Search button in the lower location section of the form that allows users to 
search for a specific location associated to the item. This pick list will be color coded based on the 
location status. 

 Division Filter - Choose this option to filter the pick list based on a specific division. 

 Jump to Master Inventory - This will jump to the Master Inventory record for the current item. 

 Item's Transaction Log - Choose this function to view all transactions made to this particular item as 
shown in the screen below: 

 Create New Location - Select this button to link a new location to the item. 

http://skylinetools.com/imagelib/index.html
http://skylinetools.com/imagelib/index.html
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 Delete Location - Use this function to delete an empty location. If the location contains inventory, 
the material must be removed prior to deleting the location. 

 Add to Location - Select this function to add a quantity received to a particular location. 

 Remove from Location - This function allows you to 'subtract' a transaction amount from a 
particular location. 

 Show Linked Labels - This button is used to show the serialized labels that are linked to the 
serialized inventory item. (See Serialized Inventory Control for more information). The linked label form 
is also available for non-serialized items, however a warning will appear at the top of the form stating, 
'This is  a non-serialized item. Quantities between labels and locations may differ if non-serialized 
transactions have taken place'. 
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Reprint Selected Labels - Highlight the labels to be reprinted using the Shift or Ctrl keyboard buttons, 
then right click and select 'Reprint Selected Labels'. A popup form will appear to select the label and 
printer. 

 

Location Listing Section Buttons 

 Search - Select this to access a pick list of locations associated to the item. 

 Show Location Quantities by UOM - This will open a list of the locations associated to the item and 
the quantities in the Native UOM as well as any other UOMs that have been set up as conversion factors 
for the item. The system will display the number of conversions associated with this item next to this 
button.  
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Right Click Options 

From the upper General section users can Jump to MPS Time Phase. The rest of the right click options are 
available from the lower section: 

▪ Add to Location - Select this function to add a quantity to the location. Same as the speed button 
function. 

▪ Remove from Location - Select this function to remove a quantity to the location. Same as the speed 
button function. 

▪ Location to Location - When this option is selected from the right click menu the user will receive the 
following message: 'For location to location transaction use your mouse to drag FROM location and 
drop TO location'. 

▪ Translog for this Location -  This will show the translog form with transactions that are for just the 
highlighted row (the specific FGMULTI record). 

▪ Link Inspection for Non-Conform Inventory - This will be available on a non-conform location created 
during receiving for an item that requires an inspection, based on the when the 'Count' equals the 
'Rec Insp Threshold' (set up in Inventory->Additional tab). When selected, Quick Inspection will open 
to create a new inspection or link an existing inspection from the 'Past Inspections' button on the 
'Select from SPC Quick Inspections' list. If a failed inspection is linked to the location, and a user 
moves items to a conforming location, after selecting 'Yes' on the "Are you sure you want to move 
non-conforming/conforming?" confirm message, a warning with Yes and No buttons will appear 
stating, "Location Quantity Inspection has failed. Are you sure you want to continue?" Security can 
be placed on the Yes button. 

▪ Jump to Non-Conform Inspection - This will jump to the Non-Conform Inspection in SPC that was 
created for the Non-Conform Inspection type for the item. 

▪ Toggle to Non-Conform/Conform - This toggles the location from Non-Conform to Conform and vice 
versa. This functions the same as the toggle button as described in Material Status (Non-Conforming 
and Non-Allocated). Note: This option will not be available on master non-conform locations 
(locations set to 'Non Conform' in the locations list).  

▪ Toggle to Non-Allocate/Allocate - This toggles the location from Non-Allocate to Allocate and vice 
versa. 

▪ Toggle to No-Ship/Ship - This toggles the location from No-Ship to Ship. A Y will populate in the No 
Ship field if it has been marked as No-Ship. If it is toggled back to Ship a N will be in the field. For 
locations that have never been marked as no ship this field will be blank. If a user tries to ship from a 
location marked 'No Ship' through pick tickets and packing slips a status exception may display 
stating the location is marked No Ship. (See Inventory Locations for more information on the No Ship 
location designation). 

▪ New Location - Links a new location to the item just as the speed button option. 

▪ Delete Location - Deletes a location linked to the item just as the speed button option. 

▪ Clear Location - This option will reduce the location to zero by performing a remove or add to 
location transaction. If the Delete Empty Location parameter is checked the location will be deleted 
(unless it is marked as a dispo designator). If it is not checked the location will remain linked to the 
item with a zero quantity.  
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▪ Change In-Date - This will pop up a calendar form for the user to choose a different In Date to 
associate to the highlighted record. When the in date is changed it will only show a date and not a 
time. Note:  A specific time cannot be added to a modified In Date. 

▪ Jump to Lot Tracking - If the location has a lot number the user can jump to Lot Number Tracking 
form with the item/lot # displayed. If the location does not have a lot # the menu option will be 
grayed out. 

▪ Release Work order Hard Allocation -  Work order hard allocations can be released by selecting this 
option. If the work order has cycles required a warning will appear stating the work order is not 
complete. Depending on security the user will be able to select OK to continue with the release or 
Cancel to not release the hard allocation. Once the transaction is complete, the location will no 
longer have the work order associated to it and the color will go from aqua to white. The hard 
allocation will be disassociated from the work order. 

▪ Release MakeToOrder Allocation - This option will release the Make To Order allocation. Once 
selected a message will appear stating: 'Are you sure you want to deallocate MakeToOrder inventory 
location?'. Select Yes to continue and a pop up will appear to enter the quantity to be released (this 
defaults to the location quantity). Accept or enter the quantity and press OK to continue. Note:  
MTO allocations are released when the Sales Order is archived. (For more information see the  
Make To Order https://my.iqms.com/cfs-
file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf TechNote).  

▪ Inventory Cost Adjustment - This allows users to update the actual cost of a location to include 
additional costs (such as freight costs) for items received. This process will also create a GL entry for 
the costs incurred that will update the inventory and expense accounts as well. See Inventory Cost 
Adjustment below for details. 

▪ Edit Lot Number - Select this option to change the lot number for all locations with a matching lot 
number. This updates all matching master label and transaction records accordingly, including FG 
Lot# of consumed item transactions. The new lot # is entered in the pop up box. For example: Three 
locations for a SIC item, none have a lot #. Print five labels for five each, with no lot #. Add one label 
to one location. Edit the lot # on any location using the right click -> Edit Lot # option. All of the 
locations and all of the labels update with the new lot # because they all share the same lot #, in this 
case null. This is not allowed if there is an OUT transaction found in translog for the item/lot #. If a 
user attempts to edit the Lot Number after any OUT transaction has occurred for this item's Lot# a 
message will appear stating, 'OUT transactions found in the translog - lot number cannot be 
modified.'  This rule applies specifically to an Item/Lot# combo regardless of new/existing location, 
(i.e Moves, Add to New Location), and includes a RG Quantity OUT transaction for PL items.   This 
feature can also be used during physical inventory, in which the system updates records accordingly 
including current tags and resulting backup records. (The system will check and change the following 
tables: Translog,  fgmulti, PO_receipts, arinvt_lot_docs, ica_dtl, taginv, master_label, Vendor_Asn). 
This information is recorded to the Event Log with a class of INVENTORY TRANS so there is a record 
of who changed it and when.  Note: Since some large history tables are involved in the update it 
may take a while to finish the lot # change. 

▪ Jump To MakeToOrder sales order - If the location is allocated to a Make To Order sales order this 
option will be available to jump to the sales order. 

▪ Jump to Pack Slip -  This will be enabled for In Transit fgmulti locations with an In Transit Origin of 
'Shipment Staging'. This allows users to jump to the packing slip to verify the inventory. 

▪ Jump to BOM - If the location has a Disposition Designator set to ‘Associate with a Manufacturing #’ 
this option will be available to jump to the associated BOM. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
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▪ Jump to Location - this will open the Master Location module for the highlighted location. 

▪ Jump to MRB - Jumps to the linked MRB if applicable. 

▪ Link to MRB - This option allows users to link a non-conforming location to an MRB. A pick list of 
existing MRBs will appear to choose from, or the user can select New from the list to create a new 
MRB. 

▪ Unlink to MRB - This option allows users to unlink a non-conforming location from an MRB. 

▪ Trace - This option brings up the trace form to view changes to the fields set up in the Trace Tables. 

▪ Print Labels - Labels can be printed for non-serialized items in a specific location. Right click on a 
location and select Print Labels and the Print Label form will appear with the Box quantity equal to 
the Location quantity, and the Location field will populate with the location description. (Note: The 
Dispo_Scan field in the Master Label table will be marked as Y for manufactured items). 

▪ Show Location Linked Labels - This will show the labels linked to this location for both serialized and 
non-serialized inventory items. Right click and select 'Reprint Selected Labels' to reprint the 
highlighted labels. 

▪ Show All Locations Linked Labels - This will show the labels linked to all locations for both serialized 
and non-serialized inventory items. For non-serialized items a warning will appear at the top of the 
form stating, 'This is  a non-serialized item. Quantities between labels and locations may differ if 
non-serialized transactions have taken place'. Right click and select 'Reprint Selected Labels' to 
reprint the highlighted labels. 

Transaction Security  

Transaction security can be associated to specific users to prevent them from doing an In or Out 
transaction for the following location types: Non-Conform, Non-Allocate, and No Ship. Please see the 
'Excluded Inv Trans' section in Additional Tabs in Security Inspector. 

Note: Users can select the 'Freeze locations during worksheet' option (Physical Inventory->Options menu) 
to prevent transactions from occurring in a location that is associated to a Physical Inventory.  When 
this option is checked, users will receive a violation message, 'Location XXXX is part of active physical 
inventory count - operation aborted' immediately after the location is scanned/selected when 
attempting to perform a transaction on a location that is associated to an active Physical Inventory.  
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Linking Locations to Items 

As noted above, EnterpriseIQ requires that all inventory items exist in locations. The first step in creating 
locations is to create the master locations table. 

Linking Locations with Inventory Items 

To create the Master Locations table and link a location to an inventory item, complete the following: 

➢ Select Transactions|Locations and Transactions from the menu or click on Locations and 

Transactions button. The following screen will appear: 
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➢ Select File|Create New Location from the menu, click on the Create New Location button, or right 

click and select New Location. The following screen will appear: 
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If the location table has already been created, select the location from the arrow down list by scrolling 
down to the location or type in the first character of the location and the system will 'hyperbrowse' to 
the location,  or select the search button to access the pick list of locations. 

To create the master Locations table click on the Edit Master Location button to the right of the location 
field. See Inventory Locations for more information. 

➢ Once you have chosen or added a location, the system will update the Location ID field (this 

field cannot be manually changed).  

➢ Lot # -  Enter in the Lot Number of the item, if applicable. In the case of a manufactured 

item the user may enter the lot number or click on the arrow icon and the program will bring 

over the current lot number from the BOM. 

➢ Exp. Date - If the item has the 'Expiration Date is Mandatory' option checked (Inventory-

>Additional tab) this field will be visible. Select a date from the drop down calendar or click 
on the arrow icon and the program will bring over the current expiration date for the lot #.  

➢ The new location can be specified as a Default Disposition location.This is used during auto 

dispositioning in production reporting. If an item has a default location set up it will be used 
when adding or removing inventory during auto dispositioning. To set the location to be a 
default designator click on the check box next to the Associate with Mfg# or select the Set as 

Default Designated Location box next to this field. Both options can also be selected. These 

fields are discussed in greater detail in the Auto Dispositioning section in the Production 

Reporting chapter.  

➢ Note: Locations can also be set as a Disposition Designator in the Master Locations list. When 

a location is marked with this option, when it is associated to an item it will be automatically 
marked as a disposition designator. The 'Set as Default...' and 'Clear Designation...' options 

will be grayed out on the Assign Auto Disposition Designator form in Transactions (accessed 
by selecting the Edit button next to the Dispo Designator field). 

➢ Click [OK] to finish the entry and link the location to the inventory item . 

Note: If a user attempts to add a Non-Conform location to an item and select the 'Set as default 
designated location' option at the same time, a status exception message box will appear requiring 
authorization to continue. Select the OK button to continue to mark the default location as non-conform. 

Note: If a Master Non-Conform location is added to an item, for users licensed for the Quality modules a 
pop up message will appear asking, "Would you like to create an MRB?" If Yes is selected a pick list of 
existing MRBs will appear to add the item to, or select the New button to create a new MRB. If No is 
selected the material will be toggled to non-conform without being associated to an MRB.  

Deleting a Location Link with an Inventory Item 

To delete a location linked to an inventory item, the quantity in the location must be zero. If a location 
contains inventory, the inventory must be removed prior to deleting. The Remove From Location form 
will automatically appear to remove the material. Once removed the location will be deleted. 

To DELETE a location: 
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Select Transactions|Locations and Transactions from the menu or click on Locations and Transactions 
button.  

➢ Select File|Delete Location from the menu, click on the Delete Location button, or right click and 
select Delete Location. If the location has a quantity, the following screen will appear 

otherwise the location will deleted: 

 



Inventory Management Page 332 of 478 

 

➢ Accept or edit the Quantity to be removed. 

➢ The user can enter a Reason, Transaction Code, or other Options. See Removing Material 
from Inventory for more information. 

The location will no longer show in the list of locations associated with the inventory item. 

Automatic Deletion of Locations 

EnterpriseIQ can be set so that locations will be automatically deleted if the on-hand quantity in the 
location is brought to zero. This applies to all transaction types except Physical Inventory adjustments 
and and phantom in/out on-fly dispositions, in which the empty location will not be removed by the 
system. To enable this feature, click on Misc|Parameters from the menu and the following screen will 
appear: 
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➢ Click on the Delete Empty Location check box to tell the system to delete empty locations for 

all items. Locations currently at zero will not be automatically removed but will be removed 
on the next transaction taking the location to zero. If using Actual Costing, the empty 

location is deleted once the inventory taken from the location is both shipped and invoiced.  

NOTE: Locations which are set to be Disposition Designator or Shipping Designator locations in inventory, 
as well as VMI locations will not be automatically deleted from the list of locations associated with an 
inventory item. However, if the location was marked as a Disposition Designator because it was hard 
allocated to a work order, when the location goes to zero it will be deleted. Disposition locations 
associated to a work center are not an inventory Disposition Designator so they will be deleted (unless it 
is a phantom in/out on-fly disposition). 

Users may also override this option per location by checking the Disable Auto Delete box in the Master 
Location table for a specific location. 

The MASTER_LABEL.LOC_DESC will not be removed from the label when the quantity scanned brings a 
negative location to 0 and Delete Empty Location is turned on. 

Clear Location 

Selecting this function clears the quantity from that location. Right click and select “Clear Location” and 
the same screen as shown above in “Deleting a Location” will appear. Follow the steps above for 
removing the quantity from that location. 
 

Manual Inventory Transactions 

The general use of manual transactions pertain to virtually all items of class. However, some of the 
functionality changes depending on what class you are working with. These differences will be covered in 
the following pages. 
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Adding Material to Inventory 

To add material to inventory: 

➢ Select the inventory item that you want to add inventory to. 

➢ Next, select Transactions|Locations and Transactions from the menu or click on Locations and 

Transactions button. The following screen will appear: 

NOTE: If no Locations are associated with the inventory item, refer to Adding Locations to an inventory 
item, discussed above. 
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➢ Highlight the location that material will be added to. 

➢ Right click and select Add to Location from the menu, click on File located on the main menu 

bar and select the same option, or click on the Add to Location speed button. The following 

screen will appear: 

➢ NOTE: When this screen opens, in the Add to section, the system will always default to the 
third column from the left (which, by default is Quantity, but this can be changed as the 

user sees fit by rearranging the columns). 
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➢ The location field is populated based on the location that was highlighted when the Add to 

location option was selected. The location can be changed by clicking on the ellipsis button 
in the field and selecting a different location from the color coded pick list of locations 
associated to the item. Enter the Quantity to be added to the location (if adding an item of 

class PL, the option to enter a Regrind Quantity will also be available). 

PLEASE NOTE: Regrind quantity entry is only available when working with PL inventory items. However, 
note that this information is not used in actual or standard costing. It is recommended that regrind of a 
specific plastic have it's own inventory master record. 

Once you have finished scanning your label or manually selecting a label to add to the location, click 'OK' 
to execute the transaction. Doing so will launch a second window which will allow you to specify more 
details for the transaction. 
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➢ In the 'Add To' grid, there are additional fields: 

▪ Lot Date - If the location has a lot number a Lot date can be entered. Select the ellipsis button in the 
field to access the pop up calendar to enter a Lot Date for the record. 

▪ Country - If the location has a lot number a Country can be entered. Select the ellipsis button in the 
field to access the pick list. 

▪ Lot Expiry Date - If the location has a lot number a Lot Expiry Date can be entered. Select the ellipsis 
button in the field to access the pop up calendar to enter a Lot Expiry Date for the record. If the Lot 
Expiry date is already populated it can only be edited if allowed via security. If not allowed, the date 
can be edited in Locations and Transactions on the Lot Control tab. 

➢ Enter a Reason for the transaction (optional). You may specify the 'Reason' by entering it in 

the field, or you may select an established 'Reason' from the drop down menu. 

➢ Enter a Transaction Code from the arrow down list, if desired. 

NOTE: The Transaction Code arrow down list can be defined under Misc/Inventory Trans Codes or in Sys 

Setup| System Parameters|Lists|Inventory Trans Codes. The Trans Code can also be made mandatory by 
toggling a switch under Inventory|Misc|Parameters. 

➢ Enter the  Transaction Date. The date will default to the date/time based on the time zone 

setting of the EPlant the user is logged into. The user has the option to change it by 
selecting a different date from the drop down calendar. The Process Inventory Transactions 
function will look at the transaction date not the system date.  

(Optional) Check the Associate with IN transaction box if a dispositioned quantity for a manufactured item 
needs to be corrected due to an adjustment to the raw material. By clicking on the pick list button, the 
user can select the disposition transaction this 'Add To' should effect. The scope defaults to one month 
back, and will only display Disposition type transactions. The scope can be changed by selecting the 
Scope button and entering different From and To dates. The scope will be remembered the next time the 
'Associate with In' option is used. Once the desired transaction is selected, the translog entry will be 
posted including the FG Lot Number, MFG #, and work order that was associated to the production 
report. The actual cost in Process Costing will reflect the change. (Note: This will not change the 
production report). 
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Once the desired transaction is selected, the translog entry will be posted including the FG Lot Number, 
MFG #, and work order that was associated to the production report. The system will also adjust the 
process cost accordingly. (This will not change the production report). 

➢ (Optional) The Include Materials Backflush box can be used if an item to be added to inventory is 

being manufactured and the materials that should have been consumed in the process 
should be removed from inventory. The system will remove the raw materials from inventory 
when the manufactured item is moved into inventory. The process is similar to the 

Production Reporting process in that the materials backflush requirements are by default 
calculated and presented based upon the BOM, but can be adjusted. A work order can be 
assigned in the 'WO [Hard Alloc]' field by selecting one from the pick list. When calculating 

the materials to backflush, they will be based on the work order. The Materials to Backflush 
section will reflect whether it is BOM Based or Hard Alloc Based. 

To use this option, check the box next to Include Materials Backflush, and the following screen will be 
added to the bottom of the Add to Location screen: 
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Click on the Calculate button to calculate the materials consumed based on the amount of items to be 
added to inventory, adjust the amounts as necessary. The system will always calculate the materials 
according to the default BOM attached to the item. The system will use the decimal precision setting in 
Production Reporting->Options->Parameters to determine how many decimal places to go out to during 
backflushing. 

➢ Arrow over the material one at a time using the single arrow button, to the Relieve section 
and choose the location you want to remove it from by clicking on the button in the location 

field to access the pick list of locations associated with the material.  

➢ Or select the double arrow button to move all the material to the relieve side. A warning will 
appear stating, "Are you sure you want to reassign all 'Relieve' records?' Select Yes and the 

system will populate the locations based on the same rules applicable in production 
reporting during auto backflush (see Auto Dispositioning for the disposition hierarchy 
information). The location can be changed by clicking the ellipsis button in the location field 

and selecting a different location from the pick list.  

➢ You may exclude labor and overhead from being recorded to the translog by clicking on the 

'exclude' button near the Add (+) button on the left. (The labor and overhead transaction 

information will still be posted if you are using standard costing). 

➢ If all entries are correct, click [OK] to execute the transaction or click [Cancel] to cancel the 

current transaction. 

The new quantity is added to the Location and the On Hand quantity is updated. To view the transaction, 
press the items Transaction Log button to show the new transaction. 
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Location to Location Transfers 

EnterpriseIQ supports the ability to move material from one location to another location or to create a 
new location within the same inventory item. The procedure for the movements is very similar and is 
described below. This can be done via the Location to Location right click option, or by drag and drop. 

➢ Select the inventory item to be moved from one location to another. 

➢ Next, select Transactions|Locations and Transactions from the menu or click on Locations and 

Transactions button. The following screen will appear: 

Note: If there are no Locations are associated with the inventory item, refer to Adding Locations to an 
inventory item, discussed above. 
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Move Using the Location to Location Right Click Feature 

Right click on the location to be removed from and select 'Location to Location'. A pop up form will 
appear listing the highlighted location in the From section. 
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Select the ellipsis button in the 'To Location' field and select the location to move the items to from the 
pick list of locations associated to the item, or select the New button on the pick list to associate a new 
location to the item from the Assign New Location form. Select the new location from the drop down list 
in the Location field or click the search button to select from the location pick list. Once a location is 
selected, enter a Quantity and Reason. The reason can be typed manually or selected from the user 
defined list. To create the reason list, right click and select edit User Defined List and enter reasons in the 
Text field. The reason and regrind fields are optional but a quantity must be entered.   

Click [OK] to make the transfer and the quantity will be added to the To Location and subtracted from 
the From location. If the From location's lot number did not match the To location's lot number, a new 
location will be created for the selected To location with the From location's lot number. 

Move to an Existing Location using Drag and Drop 

To move the items between two existing locations: 

➢ Left click on the location that material will be removed from and hold the left mouse button 
down. 

➢ Move the cursor to the location that the item is being moved to and release the mouse 
button. If the location is and existing location, the following screen will appear: 
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The From and To locations will be shown. Enter in the Quantity (for class PL items a regrind field is also 
available) to be moved and a Reason for the move. The reason can be typed manually or selected from 
the user defined list. To create the reason list, right click and select edit User Defined List and enter 
reasons in the Text field. The reason and regrind fields are optional but a quantity must be entered.  

Click [OK] to make the transfer and the quantity will be added to the To Location and subtracted from 
the From location. 

Note: If the Lot Numbers or the In Dates (if using Unique Date In) in the two locations do not match, a 
new entry will be made in the Locations list. 

Note: When moving from a conforming location to an existing non-conform location by either dragging 
and dropping or location to location moves, the Non-Conform Reason form pops up after entering in the 
quantity of the amount to move. A non-conform reason must be selected from the drop down list. The 
location will be updated with the selected non-conform reason. If it is not desired to change the reason 
associated to the existing non-conform location, be sure to select the same reason that was already 
assigned to it. 

Note: If moving an item to a non-conform location that already has an existing MRB, if a different Non-
Conform Code is used the system will create a new location (FGMulti) regardless of whether a new MRB 
is created or if associating it to an existing MRB. If a different non-conform code is selected during the 
move and the user answers No to creating a new MRB, a new location is created without a link to an 
MRB. If the same Non-Conform Code is used a new location will not be created and the MRB will be 
updated with the new quantity. The MRB related transactions can be viewed from the MRB right click 
option 'MRB Transaction Log'.  This provides accurate traceability of the rejected components. 

Note: If the item has the Default FIFO method set to ‘Lot # Based FIFO', and the user is moving an item to 
a 'Disposition Out' location, the system will compare the lot # of the item being moved to the oldest lot# 
for the item. If the moving Lot# is not the oldest a list of locations that contain older Lot#s will display 
('Non-Conform' locations are excluded) with buttons for Continue or Cancel. 

Note: The Regrind quantity information is not used in actual or standard costing. It is recommended that 
regrind of a specific plastic have it's own inventory master record. 

Note: When attempting to move a child serial number through the drag and drop feature that is part of a 
pallet that has been associated to a pick ticket, the following error will occur: "This serial number is part 
of a shipment. Move is not allowed". 

To view the transaction, press the items Transaction Log button to show the new transaction. 

Move to a New Location Using Drag and Drop 

To move the items from one location to a new location: 

➢ Left click on the location that material will be removed from and hold the left mouse button 
down. 

➢ Move the cursor to a place in the list of locations that does not correspond to any location 
(the plain white area) and release the mouse button. The following screen will appear: 
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➢ Select the new location from the arrow down list next to the location field. 

➢ Enter a Lot # if desired. 

➢ The new location can be specified as a Default Disposition location.This is used during auto 

dispositioning in production reporting. If an item has a default location set up it will be used 
when adding or removing inventory during auto dispositioning. To set the location to be a 
default designator click on the check box next to the Associate with Mfg# or select the Set as 

Default Designated Location box next to this field. Both options can also be selected. These 

fields are discussed in greater detail in the Production Reporting chapter (See the Disposition 

Hierarchy information in Auto Dispositions). 

➢ Once the new location is selected, click [OK] and the following screen will appear: 

 

The From and To locations will be shown. Enter in the Quantity to be moved and a Reason for the move. 
The reason can be typed manually or selected from the user defined list. To create the reason list, right 
click and select ‘Edit User Defined List’ and enter reasons in the Text field. 

Click [OK] to make the transfer and the quantity will be added to the To Location and subtracted from 
the From location. 

To view the transaction, press the items Transaction Log button to show the new transaction. 
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Removing Material from Inventory 

To remove material from inventory: 

➢ Select the inventory item to be removed from inventory. 

Next, select Transactions|Locations and Transactions from the menu or click on Locations and 

Transactions button.  

➢ Highlight the location that material will be removed from. 

➢ Right click and select Remove from Location from the menu, click on Transactions located on 

the main menu bar and select the same option, or click on the Remove from Location speed 

button. The following screen will appear: 

NOTE: When this screen opens, in the Remove From section, the system will always default to the third 
column from the left (which, by default is Quantity, but this can be changed as the user sees fit by 
rearranging the columns). 
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➢ Enter the Quantity to be removed from the location (if removing an item of class PL, the 

option to enter a Regrind Quantity will also be available). 

➢ Enter a Reason for the transaction (optional). 

➢ Enter a Transaction Code from the arrow down list, if desired. (The Transaction Code arrow 

down list can be defined under Miscellaneous/Inventory Transaction Codes in the inventory 

module, or in System Setup/System Parameters/Lists/Inventory Transaction Codes). 

➢ Enter the Transaction Date. The date will default to the date/time based on the time zone 

setting of the EPlant the user is logged into. The user has the option to change it by 
selecting a different date from the drop down calendar. The Process Inventory Transactions 
function will look at the transaction date not the system date. 

➢ Scrap - If the material to be removed from inventory is going to be scrapped, check the 

Scrap box and select the Scrap Code from the arrow down list in the Scrap Code field. When 
entering scrap the system will look up the manufacturing cell on the BOM and only surface 

the reject codes with a cell that matches the BOM. Reject codes with no manufacturing cell 
will also display. When entering scrap where the BOM does not have a cell, the system will 
only surface the reject codes with no cell associated to them. Scrap transactions are written 

to the rejects table. You can also associate the scrapped parts with a particular production 
report, basically reducing the good parts. To do this click on the production report icon next 
to the Scrap check box. This will bring up a pick list of production reports associated with 

the item you are scrapping. This will change the production report to show the parts as 
scrapped and the Transaction Log will note that the material was removed to scrap. A Scrap 
Comment can be entered to provide additional information as to why the items are being 

scrapped. The scrap comment will display in the 'Comment' field in translog. 

Note: When removing a manufactured item from inventory, when the Scrap box is checked the Include 
Materials Backflush box will become disabled and be grayed out. Users are not allowed to backflush 
materials during a scrap transaction. 

Note: Security can be placed on the Scrap check box (the security item is: chkScrap). 
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➢ (Optional) Check the Associate with IN transaction box if a dispositioned quantity for a 

manufactured item needs to be corrected due to an adjustment to the raw material. By 
clicking on the pick list button, the user can select the disposition transaction this 'Remove 

from' should effect. The scope defaults to one month back, and will only display Disposition 
type transactions. The scope can be changed by selecting the Scope button and entering 
different From and To dates. The scope will be remembered the next time the 'Associate 

with In' option is used. Once the desired transaction is selected, the translog entry will be 
posted including the FG Lot Number, MFG #, and work order that was associated to the 
production report. The actual cost in Process Costing will reflect the change. (Note: This will 
not change the production report). 
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➢ (Optional) The Include Materials Backflush box can be used when removing an item from 

inventory and the materials that were consumed in the process should be replaced into 
inventory. The process is similar to undoing the Production Reporting process in that the 

materials backflush requirements are calculated and presented based upon the BOM, or 
work order, but can be adjusted. To select a work order click the search button next to the 
WO [Hard Alloc] field. If the user selects a work order, when selecting Calculate, the system 

will populate the materials to backflush based on the work order. If the work order does not 
exist, a message will pop up stating ‘Work Order does not exist.  Materials to backflush will 
be BOM based.  Add/Remove material if necessary.’  If the user does not select a work 
order, the materials to backflush will be BOM based. The system will then put the raw 

materials (or regrind for PL) into inventory when the manufactured item is removed from 
inventory.  

Note: This option will not be available if the Scrap box is checked, the Include Materials Backflush box will 
become disabled and be grayed out. Users are not allowed to backflush materials during a scrap 
transaction. 

To use this option, check the box next to Include Materials Backflush, and the following screen will be 
added to the bottom of the Remove from Location screen: 
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Click on the Calculate button to calculate the materials generated based on the amount of items to be 
removed from inventory, adjust the amounts as necessary. The system will always calculate the 
materials according to the default BOM attached to the item. The system will use the decimal precision 
setting in Production Reporting->Options->Parameters to determine how many decimal places to go out 
to during backflushing. 

➢ Arrow over the material one at a time using the single arrow button, to the Add To section 
and choose the location you want to add it to by clicking on the button in the location field 

to access the pick list of locations associated with the material.  

➢ Or select the double arrow button to move all the material to the Add To side. A warning will 
appear stating, "Are you sure you want to reassign all 'Add To' records?' Select Yes and the 

system will populate the locations based on the same rules applicable in production 
reporting during auto backflush (see Auto Dispositioning for the disposition hierarchy 
information). The location can be changed by clicking the ellipsis button in the location field 

and selecting a different location from the pick list.  

➢ You may exclude labor and overhead from being recorded to the translog by clicking on the 

'exclude' button near the Add (+) button on the left. (The labor and overhead transaction 

information will still be posted if you are using standard costing). 

➢ If all entries are correct, click [OK] to execute the transaction or click [Cancel] to cancel the 

current transaction. 

The new quantity is removed from the Location and the On Hand quantity is updated.  

If the quantity will drive the location negative a warning will display: 

 

Only users with security to select the OK button will be able to proceed, otherwise the transaction will be 
canceled. (Note: When setting security for this status exception be sure to click the OK button so the 
selected security settings will be established. Aborting the transaction that will rollback any changes 
including the security inspector settings). 

To view the posted transaction, press the items Transaction Log button to show the new transaction. 
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Material Status (Non-Conforming, Non-Allocated, Receive Designator, and No-Ship) 

EnterpriseIQ supports the ability to change the status of an item. The status can be normal, non-
conforming, non-allocatable, or non-conforming and non-allocatable. Because EnterpriseIQ supports 
multi-locations for an item, the status is set on a location by location basis. 

The status of an item affects the MRP evaluation in the following ways: 

▪ Normal - The item is included in the On Hand inventory amount, is available to be included in the MRP 
run and will be included in the MRP evaluation. 

▪ Non-Conforming - This indicates that some problem exists with the item. When set to non-
conforming, by default the item is NOT included in the On Hand inventory amount, but is tracked 
separately under the Non Conforming amount (displayed just below the On Hand quantity). For MRP 
consideration, any item under non conforming status will NOT be included in the MRP evaluation. An 
Authorization Required warning will appear when a user attempts to ship from a Non Conform 
location. Only users with security to select OK can proceed. However, if the Allocatable box is 
checked the quantity in that location will be allocated and included in On-Hand quantity. Non 
conforming items will be shown in the Location and Transaction screen with brown shading to 
ensure that users know the material is non conforming. The non conform reason will display in the 
Non-Conformed field, and if it has been marked allocatable that will show next to the reason in 
parenthesis. 

▪ Non-Allocated - Setting an item to non-allocated indicates to EnterpriseIQ that the quantity IS part of 
the On Hand inventory amount, but is NOT considered during the MRP evaluation. This situation is 
typically used when an item has been received or is in stock, but is on hold for some reason. Setting 
an item to non-allocated is a temporary way to tell EnterpriseIQ to ignore the quantity during the 
system evaluation, but maintain it in the On Hand inventory. Users can ship from a Non Allocate 
location. 

▪ No-Ship - If a user tries to ship from a location marked 'No Ship' through pick tickets and packing slips 
a status exception will display stating the location is marked No Ship. Depending on security the user 
can select OK to proceed or the cancel button may be the only option which will prevent the location 
being used to ship from.  

In RF/WMS the results will vary depending on whether Pick by Item or Serial is selected and whether 
the item is a serialized inventory control (SIC) item or not. 

Pick by Item:  All locations where fgmulti.no_ship = null or N are available to pick from (including 
'No Ship' master locations toggled to Ship).  No locations are available where fgmulti.no_ship = Y. 

Pick by Serial: 

For a Non-SIC item - Users cannot pick from a 'No Ship' master location even when the location is 
toggled to Ship. The user will receive a warning “Serial # xxxxx location is marked no-ship”. Users can 
pick from regular locations toggled to ‘no ship’ without a warning.  A new location (fgmulti record) 
is created ‘on the fly’ for this location description, while the system retains the original fgmulti_id for 
the serial number in the master_label table.  When a pick ticket is converted to a packing slip, the 
inventory is removed from the new location that was created, driving it negative. 
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For a Serialized item - The system considers the individual fgmulti location status only to determine 
whether serials can be picked from these locations.  For example, a regular location toggled to ‘No 
Ship’ in Transactions and Locations will surface a warning when picking (and picking is prevented).  
Conversely, a ‘No Ship’ master location toggled to ‘Ship’ in Transactions and Locations will allow 
serials in that location to be picked without warning. 
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▪ Combined - Under most circumstances, there is little reason to set all of these toggles. If the item is 
completely unavailable to production, and the user doesn't want it included in the inventory, use the 
non-conforming status. 

Receive Designator 

When selecting the Receive Designator check box on a location, the system will first check if another 
master location would be unselected as the Receive Designator if the user continues (i.e. due to a record 
that already exists that has Receive Designator option checked, with a matching EPlant ID and Division 
ID). If so, a message displays, 'Location XXXX will no longer be marked as a Receive Designator. 
Continue?', with security on the Yes button and the 'Do not show next time' check box. 

When selecting/unselecting  the Receive Designator check box and the location exists is associated to 
items, a message displays, 'Location XXXX is currently attached to item(s) in Transactions and Locations.  
Continue?'. Security is available on the Yes button and the 'Do not show next time' check box.  Note: 
This message will surface after the check for a current Receive Designator location. 

Non Conform Materials 

The first step in the non conform material status function is to define the non conform codes. Unlimited 
non-conform codes may be entered into the Non Conform Code table. To access the table: 

➢ Select Misc from the Inventory screen menu. 

➢ Select Non Conform Codes from the submenu. The non conform codes box will appear as 

shown here. The user can view, create new or delete codes from this screen by using the 
functions on the Navigator Bar. The codes can be marked inactive which will hide them from 
pick lists throughout the system. 
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Note: The deletion of non conform codes is not recommended as the codes may be linked to other 
inventory items. Deleting a code that is linked to an item may cause an error. The user may, however, 
edit the description field. 

Changing the Status of an Item to Non Conform 

To set a location to non conform status, complete the following steps: 

➢ From the Transactions screen, highlight the location to be made non conforming in the lower 

left grid. 

➢ With the General tab showing on the lower right side of the form, click on the icon to the 

right of the Non Conformed field.The following screen will appear: 
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➢ Select a Reason from the arrow down list.  The Reasons button accesses the Non Conform 

Codes list. Security can be put on the Reasons button in order to prevent users from adding 
reasons to the list. They will only be able to select an existing one from the list. 

➢ For users licensed for the Quality modules a pop up message will appear asking, "Would you 
like to create an MRB?" If Yes is selected a pick list of existing MRBs will appear to add the 
item to, or select the New button to create a new MRB. If No is selected the material will be 

toggled to non-conform without being associated to an MRB. Security can be placed on this 
message. 

➢ Select the Apply to Lot Number option if all of the locations with the same lot number as the 

highlighted location should be toggled to non-conform. This option will only be visible if the 
highlighted location has a lot number associated to it. (Refer to the Lot Control section for 
details). Note: VMI locations are excluded, they will not be toggled to non-conform if it is the 

same lot number. Note: If a user selects the 'Toggle Conformed' button from the General 
tab on a location/lot that was set to non-conform using the Apply to Lot Number option, 
they will receive a message stating, "Insufficient rights, setting is being enforced on the Lot 

Control level or Master Location is marked Non-Conform". 

➢ Select the Allocatable box if the items should be allocatable and be included in the on hand 

quantity. Note: The Allocatable box will not be available for locations marked as non 

conform in the Master Locations list. This attribute is established in Master Locations for that 
specific non conform location. The allocatable attribute on master non conform locations can 
only be overridden from the Lot Control tab in Transactions and Locations. 

➢ Click on [OK] when finished. The location will now be highlighted in a rusty brown color and 

the General tab of the Transactions screen will now reflect the entire non-conform code as 
shown in the screen below, and the On Hand and Non Conform inventory amounts will be 

affected. 

Note: If a user attempts to toggle a default designated location to non-conforming, or mark a non-
conforming location as a default designator, a status exception message box will appear requiring 
authorization to continue. Only users with security rights can select the OK button to continue to mark 
the default location as non-conform. 

Note: If the location is associated to a pick ticket a warning will appear stating, "This lot is currently 
associated to Pick Ticket # xxx. Please make the necessary adjustments to the Pick Ticket". After selecting 
OK the Non Conform Reason form will appear for the user to continue toggling it to non conform, or 
selecting cancel to return to the transaction screen with no changes. 
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Change Reason - The Reason can be changed by selecting the ellipsis button in the Non-Conformed field 
and selecting a Non-Conform code from the pick list. Note: If a non-conform reason was applied to the 
Lot# (Lot Control tab), if the user attempts to select the ellipsis button a message surfaces, "Insufficient 
rights or setting is being enforced on the Lot Control level." 

When toggling the material back to conforming a pop up box will appear where the user can enter any 
labor or overhead required to make the items conforming again. 
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To add overhead, select a work center form the drop down list or type an overhead rate in the field. 
Enter in the number of hours. To add labor select a labor rate from the drop down list or type in an 
amount in the field and enter in the number of labor hours. The labor rate list is established in the Quote 
module under Misc/Rates and Parameters/Direct Labor Rates. This information will appear in the translog 
for the item as well as in the Process Cost module as part of the actual costs. Security can be placed on 
the fields and buttons on this form. 

Note: If the Inventory parameter option ‘Non Conform move requires MRB completed’ is checked, and the 
Non-Conform location is linked to an active MRB, users will not be able to move to a conforming location 
until the MRB has been approved (MRB Approval Date filled in). A message will appear stating, "MRB# 
XXX that has not been approved is associated with the non-conform location being moved - operation 
aborted." 

Note: Users are not prevented from moving material from one Non-Conform location to another Non-
Conform location. 

Note: When dragging and dropping inventory from a Conform to Non-Conform, or Non-Conform to 
Conform location, a confirm pop up will display: "Are you sure you want to move conforming/non-
conforming to non-conforming/conforming?". Select Yes to continue the move, or No to return to the 
screen with no changes. It also includes a 'Do not show next time' check box. Security can be placed on 
this form, the Yes button and check box.  

Note: If a failed inspection is linked to a location, and a user moves items to a conforming location, after 
selecting 'Yes' on the "Are you sure you want to move non-conforming/conforming?" confirm message, a 
warning with Yes and No buttons will appear stating, "Location Quantity Inspection has failed. Are you 
sure you want to continue?" Security can be placed on the Yes button. (Linking an inspection is only 
available on a non-conform location created during receiving for an item that requires an inspection, 
based on the when the 'Count' equals the 'Rec Insp Threshold').  

Master Non-Conform Locations 

Master Non-Conform locations can be created (locations marked as Non Conform in the Locations list). A 
master non-conform location can be added to the item and then product moved into that location. Note 
that a master non-conform location cannot be toggled to conform. The right click option 'Toggle to 
Conform' will not be visible, and if the user selects the 'Toggle Conformed' button they will receive a 
message stating, "Insufficient rights, setting is being enforced on the Lot Control level or Master Location 
is marked Non-Conform". 

Non Allocate Materials 

As with non conform materials, the non allocate codes must be set up prior to assigning them to an 
inventory item.To access the non allocate table: 

➢ Select Misc from the Inventory screen menu. 

➢ Select Non Allocate Codes from the submenu. The non-allocate codes box will appear as 

shown here. Create new codes or delete codes from this screen by using the functions on 
the Navigator Bar. 
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Changing the Status of an Item to Non Allocate 

To set a location to a non allocatable status, complete the following steps: 

➢ From the Transactions screen, highlight the location to be made non allocatable. 

➢ On the General tab on the lower right side of the form, click on the icon to the right of the 

Non Allocatable field.The following screen will appear: 
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➢ Select a Reason from the arrow down list. The Reasons button accesses the Non Allocate 

Codes list. Security can be put on the Reasons button in order to prevent users from adding 
reasons to the list. They will only be able to select an existing one from the list. 

➢ Select the Apply to Lot Number option if all of the locations with the same lot number as the 

highlighted location should be toggled to non-allocate. This option will only be visible if the 
highlighted location has a lot number associated to it. (Refer to the Lot Control section for 

details). Note: VMI locations are excluded, they will not be toggled to non-allocate if it is the 
same lot number. 

➢ Click on [OK] when finished. The location will now be highlighted in a gray color and the 
General tab of the Transactions screen will now reflect the non allocate code as shown in the 

screen below. 

NOTE: The On Hand inventory amounts will not be affected because non allocatable material is tracked 
within the On Hand amount. 

NOTE: If the Non Allocatable location is a marked 'Non Allocatable' in the Locations table, it cannot be 
toggled to allocatable. Only the reason can be changed when clicking the toggle button. If the material is 
no longer non allocatable it must be moved to a location not marked as non allocatable. 

 

Marking a Location as No-Ship 

To set a location to a no-ship status, complete the following steps: 

➢ From the Transactions screen, highlight the location to be marked no-ship. 

On the General tab on the lower right side of the form, click on the icon to the right of the No-Ship field. 
A Confirm message will appear, select Yes to continue or No to not mark the location as No-Ship. 
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Zero Adjust with Associate 

This feature is designed to easily make adjustments to component inventories at the end of a 
manufacturing run. The components must have an 'Associate with MFG#' disposition designator location 
set up. When the item is dispositioned it will pull from that location. Then to easily adjust end-of-run 
quantities, right-click on the Locations and Transactions form for the item and select Zero Adjust w/ 

Associate from the menu. This will display the last transaction made to this component and what 
manufacturing number it was made from. The user can then easily associate the adjustment to inventory 
to a manufacturing number for process costing. 

 

To zero adjust the inventory, highlight the manufacturing number to associate the transaction with and 
select OK. This will remove all of the parts from the location and create an out entry in the translog with 
a transaction type of Manual/Associated. 
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InterPlant Inventory Transfers 

Items may be transferred from one EPlant to another EPlant. The item must have the same Class, Item 
number, and Rev in order for a transfer to be made between EPlants. The item must also have a location 
associated with it. An InterPlant transaction may not be made if no location exists for the item at the 
EPlant the item is being transferred to. Please note: If an item is manufactured in one EPlant, but not 
manufactured in the other, it is important for users to evaluate how they would like to handle the 
inventory item’s standard costing within the secondary EPlant. If the item should be handled as a 
purchased, non-manufactured item in the secondary EPlant, please ensure that there is one cost 
element associated to the item. There should not be more than one cost element on a purchased 
component. If it should be handled as a manufactured item, please ensure that there is a BOM 
associated to the record on the Manufacturing tab. This BOM can be marked Inactive if so desired. 

To transfer inventory from one EPlant to another select the InterPlant Loc's tab. 

 



Inventory Management Page 364 of 478 

 

This tab shows the EPlant name(s) that have this exact item and the corresponding location(s) for that 
EPlant. To move the item from one EPlant location to another highlight the location you would like to 
move the material from on the left side of the form and drag it to the location you would like to move 
the item to by holding the left mouse button down. (The locations in the other EPlant include the color 
coding for Non-Conform, Non-Allocate, VMI, MTO, Expired, Intransit, and Hard-Allocated status types). 

The Transfer Transaction form will appear: 
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Enter in the quantity and a reason (optional). To create the reason list, right click and select ‘Edit User 
Defined List’ and enter reasons in the Text field. If the lot number does not match a new location will be 
created. The product is now transferred. This transaction is recorded in the Transaction log as an 
INTERPLANT XFER. 

For Standard Cost users the journal entry is created using Post Inventory Transactions and selecting 
InterPlant Transfers as the transaction type. (Note: You cannot be logged into an EPlant to do InterPlant 
PIT transactions). The system will create a journal entry using the Recv/Dispo GL account associated to 
the inventory item on the Standard Costing tab for each EPlant. The entry will credit inventory for the 
EPlant the items were transferred from and debit inventory for the EPlant the items were transferred to. 
Below is a sample inventory transaction. 
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Lot Control 

The information on this tab will only be visible if the location has a lot number. The Lot Control tab has 
two sections: 

Lot Settings 

This section will only be visible if the highlighted location has a lot number associated to it. From here 
users can apply a status such as Non-Conform and Non-Allocate to a specific lot number of material that 
may be in more than one location. 
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To mark an entire lot of material as non-conform or non-allocate, after selecting the toggle button or 
right click option from the General tab, check the 'Apply to Lot Number' box on the Reason pop up form.  

     

 

This will mark all locations with the same lot number as non conform or non allocate for the selected 
reason. The reason will display in the corresponding field (non-conformed or non-allocatable) on the Lot 
Control tab. Once a lot is marked with an attribute, such as non-conform, anywhere that lot is moved the 
attribute will stay with it. 

Note: VMI locations are excluded, they will not be toggled to non-conform or non-allocate if it is the 
same lot number. 

Note: If a user selects the 'Toggle Conformed' button from the General tab on a location/lot that was set 
to non-conform using the Apply to Lot Number option, they will receive a message stating, "Insufficient 
rights, setting is being enforced on the Lot Control level or Master Location is marked Non-Conform". 

Non Conform items can be marked Allocatable by selecting the box on the Non Conform reason pop up 
box, or from the Lot Control tab. When a non conform location is marked allocatable the items will be in 
the On Hand quantity and not in Non-conforming, and they will be allocatable. 
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From the Lot Settings tab the Non-Conformed and Non-Allocatable reason can be cleared and a new 
reason can be assigned to all locations with the same lot number. Select the ellipsis button in the field to 
access the two options. Select Assign to associate a reason to all locations with the same lot number by 
selecting one from the pick list. Select Clear to remove the reason.  A pop up message will appear 
stating, 'Select 'Yes' to apply to the entire lot number or 'No' to apply to the selected location only'. The 
pop up also includes a cancel button which will return the user to the form with no changes.  

Note that when assigning a non-conform reason to a lot or clearing a reason for the entire lot, no 
transactions will occur in the transaction log. However, when toggling a single location back to 
conforming an In Conform transaction will be written to the transaction log. 

Expiry Date - An Expiry Date can be associated to a lot #. This can be entered during receiving or a date 
can be selected from the Lot Control tab. All locations with Lot # past the Expiry Date are marked 
‘Expired’ (red) in Transactions and Locations. 

No Ship -  All locations associated to a single lot number can be toggled to no ship by checking this box. 
If a user tries to ship from a location marked 'No Ship' through pick tickets and packing slips a status 
exception will display stating the location is marked No Ship. Depending on security the user can select 
OK to proceed or the cancel button may be the only option which will prevent the location being used to 
ship from.  

Note field- The note field can be used to enter up to 4000 characters of information specific to the lot 
number. Select the ellipsis button in the field to access the Lot Note pop up form. 

Country of Origin - For purchased items this field automatically populates with the country associated to 
the Vendor the item was received from if the location has a lot number. This information can be 
manually changed, if the user has security to do so, by typing in this field. This allows users to populate 
the Country of Origin per lot number for manufactured or purchased items. 

User Defined Fields - There are five character user fields, five numeric user fields, and five user date fields 
to add specific lot details. The field names can be changed by right clicking and selecting 'Define Label 
Text'. The five character user fields are also visible when receiving into a new location and from the Lot 
Tracking module. 

Configurator Information - This includes the Cost, Price, and Weight of the items in the highlighted 
location. This only applies to items that were configured in the CRM Quote module using the Sales 
Configuration Template feature.  

▪ Cost - This is the cost of the item. It equals the sum of unit price from the CRM Quote detail of the 
Sales Configuration Item plus the associated choices. 

▪ Price - This is the price of the item.  It equals the sum of list unit price from the CRM Quote detail of 
the Sales Configuration Item plus the associated choices. 

▪ Weight - This is the weight of the item which includes the weight of all components. 

(For more information on Sales Configuration Templates please see the CRM help file). 

Supporting Lot Control Documents 
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This displays the documents scanned during receiving. During the receiving process the user can scan in 
a document associated to the Lot Number using a Twain compatible bed/image scanner. External 
documents can also be added here and set to print with the Certificate of Conformance and/or the 
Packing Slip. When an item on a packing slip is shipped from a location/lot with the document assigned, 
when the COC or packing slip is printed, the system will print the attached documents. These documents 
are also visible from Lot Tracking. 

OEM Tab 

This tab will display the OEM Vendor, OEM Vendor Description, OEM Item #, OEM Item Description, and 
OEM Item Rev when applicable.  
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Inventory Cost Adjustment (ICA) 

This allows users to update the actual cost of a location to include additional costs (such as changes for 
labor and any additional costs that are not AP) for items received. This process will also create a GL entry 
for the costs incurred that will update the inventory and expense accounts as well.  

Note: There is also an ICA feature in the AP Invoice that can be used to adjustments due to 
Commodities/Freight increases. See Inventory Cost Adjustment (ICA) in the Accounts Payable section for 
more information. 

Right click on a location and select Inventory Cost Adjustment and the following form will display. 
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➢ Select an Expense Account from the pick list accessed by clicking the Search button.  

➢ The Date defaults to the current system date and time. A different date may be selected 
from the drop down calendar. 

➢ Enter the Amount to be allocated. 

➢ Select the Allocation Technique from the pick list. There are two options: 

▪ Flat Amount - This will add the amount entered to the actual cost of the location. 

▪ By Quantity - This option will allocate the amount across the quantity in the location. 

➢ Select the Allocate Cost button at the top of the form or in the middle. This will calculate the 

Unit Cost Adjustment based on the amount and allocation technique. 

➢ A reason may be entered in the Reason column to provide additional information as to the 

cost adjustment. 

➢ Select the Post button to post to the general ledger and update the location's actual cost. 

The GJ Group ID and Batch # are populated when the journal is posted. The general journal 

entry will be a debit to the Inventory Asset Account for the Amount, and a credit to the 
Expense Account for the same amount. 

For example: 

Location quantity is 210 with an actual cost of 0.702418; 25.00 is allocated by quantity to the location. 
The actual cost of the location is adjusted by 0.119048 (25 / 210) to a new value of 0.821466.  
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When preparing the journal the following would get posted to GL Prepost: 

If allocation technique = BY QUANTITY: 
Debit – Inventory Asset Account for the Amount 
Credit – Expense Account for the same amount 

If allocation technique = FLAT AMOUNT: 
Debit – Inventory Asset Account for the Amount * On Hand 
Credit – Expense Account for the same amount 

If the Flat Amount allocation technique is selected, the amount entered is added to the actual cost of the 
location. For example, with a flat amount of 10.00 entered, for a location with a cost of 0.702418, the 
new cost would be 10.702418 (10 + 0.702418). 
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Serialized Inventory Control 

For items that have the Serialized Inventory Control option selected on the Additional tab in the main 
inventory screen all transactions will be tracked by the serial number of the label. During any transaction 
in the Location and Transaction screen the user will be prompted to pick from the available serial 
numbers. 

NOTES:  

IQMS does not recommend using Serialized Inventory Control for material and components due to strict 
backflush location requirements in comparison to non-serialized items.  For example, if sufficient 
inventory does not exist in the backflush location found according to the hierarchy, the user will not be 
able to complete dispositioning a manufactured item in many areas of the software until sufficient 
serialized inventory is moved to the correct backflush location.  Labels can still be used on material and 
components, but it is recommended to not check the Serialized Inventory Control box. 

If an item is marked “Serialized Inventory Control” the system will automatically choose “Do not 
disposition partials” because all serialized items should be floor dispositioned. 

There is an option in Divisions/Warehouses called "Override Serialized Inventory Control".  If this is 
checked the system will allow the following transactions within the Division/Warehouse to occur without 
selecting specific serial numbers: drag and drop between locations (not moves), Pick Ticket, Receive 
Intercompany Shipments, and Physical Inventory. 

In order to prevent SIC items from going negative, an "ORA-20400: Insufficient SIC inventory. Transaction 
cancelled" message will surface whenever a transaction is about to drive a SIC item negative. This 
message will surface for all OUT transaction types where SIC items will be drawn negative. 

The information in the next section just discusses inventory transactions such as add, move or remove 
for items marked Serialized Inventory Control. For a complete discussion on Serialized Inventory Control 
please refer to the Serialized Inventory https://my.iqms.com/cfs-file.ashx/__key/Technote/Serialized-
Inventory.pdf TechNote. 
 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Serialized-Inventory.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Serialized-Inventory.pdf
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Add, Remove, and Move Transactions for SIC Items 

To adjust inventory for serialized items within Locations and Transactions, right click or use the speed 
buttons and choose add to or remove from location, or drag and drop to move to another location (or 
use the right click 'Location to Location' option). The select labels screen will appear.  

Enter the Serial # or select the ellipsis button to display the available labels. 
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Add to Location 

➢ Highlight the label(s) to add using the toggle buttons. 

➢ Select OK. 

➢ The Add to Location(s) form will appear with the location and quantity filled in. If the item 
has the Backflush Material option checked in Inventory, the Materials to Backflush portion 
will appear at the bottom of the screen. 

 



Inventory Management Page 377 of 478 

 

Note: When backflushing a serialized component, users can alter the quantity as long as it is less than the 
full label quantity. If a user attempts to change the quantity to greater than the label quantity an error 
will display: "SIC item entered quantity cannot exceed quantity on the label - operation aborted".  

Change Quantity (Add): 

➢ Highlight the label(s) to add using the toggle buttons. 

➢ If the quantity needs to be adjusted for a label click on the Adjust Labels Qty  button and 
the Adjust Label Qty box will appear, enter the new quantity for the label. 
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➢ Enter a Transaction Code and reason if required or desired. 

➢ Once all adjustments are made select OK. 

Note: If  two users attempt to simultaneously add the same serial number a message will appear 
stating: 'The location(s) associated with the label(s) in this transaction are no longer current - operation 
aborted.' 

Remove from Location 

After selecting Remove from Location the Select Labels form will display the labels associated to the 
highlighted location. 

Choose either ‘Delete By SN#’, or ‘Delete By Pallet SN#’ by clicking one of the radio buttons. The screen 
will display the available labels. 

 



Inventory Management Page 379 of 478 

 

➢ Highlight the labels to be removed using the toggle buttons. 

➢ Select OK. 

➢ The Remove from Location(s) form will appear with the location and quantity populated. If 
the item has the Backflush Material option checked in Inventory,  the Materials to Backflush 

portion will appear at the bottom of the screen. 

Note: Once the remove transaction is complete the loc_desc is removed from master_label, the 
dispo_scan field is set to 'N' and the dispo_date is changed to the date and time when the inventory was 
removed. 
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Note: If the serial number is associated to a pick ticket, the user is prevented from removing the serial 
numbers from inventory. A message is surfaced stating "Serial# xxxx is assigned to a pickticket - 
transaction aborted."   

Note: When deleting inventory by pallet serial or individual serial, the link between child and parent 
serial is maintained. When deleting by pallet serial and there are different locations (FG_MULTI) with the 
same location ID, the correct quantities are removed from each FG_MULTI. 

Change Quantity (Remove): 

➢ If the quantity needs to be adjusted for a label click on the Adjust Labels Qty  button and 
the Adjust Label Qty box will appear, enter the new quantity for the label. 
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➢ If the adjustment is due to scrap put a check in the scrap box and select the reason from 

the list. 

➢ Enter a transaction code if desired or required. 

➢ Click OK to complete the transaction and click OK again to exit the Select Labels screen. 

Note: When increasing or decreasing the quantity of a serial from the Linked Labels screen, the 
transaction is recorded in translog_master_label and displays the serial number in the transaction log 
right-click option to 'Show Serial Numbers'. 

Move Locations 

Drag and drop from one location to another to move the items. A form will appear to select the serial 
numbers to be moved. Users can select the 'Move By SN#' to move individual serial numbers, or 'Move 
By Pallet SN#' to move by pallets.  

Notes:  

▪ The target location will dictate what labels will appear. For instance, if the target location is not an in-
transit location then only non in-transit labels will display. If the target location is an in-transit 
location then only "similar" in-transit labels should show. 

▪ If the user moves the pallet, the boxes will retain their link to the pallet (parent_id).  If the user 
moves the boxes they will lose their link to the pallet. 

▪ When moving a mixed lot pallet for a Serialized Inventory Control (SIC) item using the ‘Move by Pallet 
SN' radio button the scanner must be used. If attempted from Inventory->Transactions and Locations 
a message will appear,  "Move by Pallet SN not allowed for mixed lot pallets, please use scanner 
instead."   
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Highlight the correct Serial #(s) and select OK. 

If items are moved into a negative on-hand location, the system will consume the label(s) based on the 
label amount. For example, if the location is -250 on hand and the user moves 1000 pieces, the label will 
be consumed by 250 pieces and be updated to 750 pieces total. 

NOTE: Manual Add or remove transactions that can have a transaction code applied, can be done on 
existing labels from the Linked Labels form. See Change Quantity on Existing Labels below for more 
information. 

Backflushing Serialized Inventory Control Items 

SIC items attached as consumed items on BOMs can be backflushed based on the serial numbers. This 
includes receiving Outsource items with a SIC consumed item. When backflushing a SIC item the system 
will open the ‘Select Labels’ form. Click on the ellipsis button in the Enter Serial # field to display the 
serial numbers. 

When Outsource Central is used, when backflushing during receiving an Outsource item the pick list will 
display the serial numbers in the In-Transit location (the serials sent to the vendor). When backflushing 
during a transaction the pick list will display all serial numbers available to consume (it will not show  
those In-transit or in a VMI location). 

If Outsource Central is not used when selecting the double arrow option the system will backflush based 
on FIFO. When using the single arrow option the screen will display all of the labels for the item, not just 
the ones sent to the vendor. (This is because the system does not have the required links to the sent 
serial numbers as it would when using Outsource Central). The Location is listed in the grid to enable 
users to choose the ones that were sent to the vendor.  
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View Linked Labels 

For Serialized Items only - From within the Locations form the user can right click on a location or select 
the Linked Labels speed button to view the labels associated to that location. A form will appear listing 
the serial number(s). 

 

To view all linked labels for all locations right click and select 'Show All Locations Linked Labels. A form 
similar to above will appear listing all linked labels for the item and there corresponding location 
disposition date, and label print date. 

Reprint Selected Labels - Highlight the labels to be reprinted using the Shift or Ctrl keyboard buttons, 
then right click and select 'Reprint Selected Labels'. A popup form will appear to select the label and 
printer. 
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NOTE: If the location is a VMI location there will not be any labels to view because the item has been 
shipped. In other words, once the shipment detail is filled into the Master_Label table, those labels will 
not show when you are in inventory. 

Change Item 

From within the linked labels form the user can change the item the linked label is associated to. 
Typically this is used to change the Rev/Grade of the item but can also be used to move the label to an 
existing item or create an entirely new item number. Right click and select 'Change Item'. A form will 
appear to enter the item information that this label will be changed to. 
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Enter the information to be changed and select OK. A new item can be created by changing the Class, 
Item # or Rev or the label can be transferred to an existing item by typing the exact information for that 
item in the fields. Once the information is entered a 'Summary - Confirm Move' form will appear showing 
the source and target information. When creating a new item the location the items will be transferred 
to defaults to the same location it came from but can be changed using the ellipsis button in the Target 
Location field. The actual cost associated with the from location will also be associated to the new item 
and location. 
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Select OK to continue. If an existing item was selected the quantity and label Transaction Log as a manual 
transaction with the reason as Change Item. 

If a new item was created the system will create a new inventory item and move this label to that new 
item. The item that gets created is similar to being cloned; it has all the aspects of the original item but 
will include the changes that were made to the class, Item #, or Rev/Grade. The new item will have the 
same BOM attached in order to keep Post Inventory Transactions working properly. 

If a user clicks OK on the 'Change Item To' form without changing a key field a message will appear 
stating, 'Unable to create new item - one or more key fields such as class, item# or rev must be changed.' 

Change Quantity on Existing Labels 

The quantity of a label can be changed from the Linked Labels screen by right clicking on a label and 
selecting Increase Qty or Decrease Qty. With either the increase or decrease type transaction, a 
Manual/Backflush type transaction will be recorded to the transaction log. When the Increase Qty option 
is selected the 'Add to Location(s)' form will appear. Enter the quantity to add to the specific label. The 
user can also select a transaction code to apply to the transaction. When the Decrease Qty option is 
selected The 'Remove from Location(s)' form will appear. 

Copy/Paste Cells within Linked Labels - Individual cells can be copied from this form and pasted 
elsewhere by highlighting the cell and selecting 'Copy Cell to Clipboard' from the right click menu. The 
entire line will be highlighted blue, but only the data in the actual individual cell (e.g. Serial #)  will be 
copied.  

Jump to Serial Tracking 

Select this right click option to jump to the label in the Serial Tracking module (See Serial Number 
Tracking for module details). Note: If the user has multi-selected labels then this option will be grayed 
out. 
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Transaction Log 

All inventory transactions are recorded and permanently stored in the Transaction Log. Select the 

Transaction Log button  from Master Inventory or from Locations and Transactions. The following 
form will appear.  

(Note: Other modules can be opened while the Transaction Log form is open). 

 

Drill down capability is also provided in the Transaction Log to allow for the viewing of dependent 

transactions. For example, if the transaction is a Disposition Transaction, then drill down capability is 
available to allow the user to view the dependent raw material, overhead and labor transactions that 
were recorded when the disposition occurred. This will include the specific item # that was dispositioned 
at the time the transaction occurred. The dependent transactions in Translog are filtered by batch + 
sub_batch, therefore only the records associated with the sub_batch are displayed. 
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Users can search for a specific transaction by selecting the Search button and using the pick list 
functionality. This pick list includes the sort and scope functionality. 

The Transaction Log can be filtered to display specific transaction type(s), for a specific date range. Select 

the ‘Apply Trans Type Filter’ button , then select the desired transaction types from the list by 
placing a check in the box. The selected transactions can be filtered for a specific date range by entering 
the From and To dates using the drop down calendars in the corresponding fields. 
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The transaction log will just display the transactions that match the selected type(s) for the specified 
date range. To see all transactions again, unselect all transaction types using the 'Unselect All' button. 

Right Click Options 

By right clicking in the form the user can jump to PO, Packing Slip, Vendor or Customer RMA, or 
Production Reporting if applicable to the highlighted line item. The Production reporting jump will be 
available for IN Disposition transactions only. 

Other right click options include: 

Exclude from Report - This toggle allows the user to filter out inventory items from custom written 
reports. If checked the item will not appear in a custom written inventory report. Note that all of the 
stock reports ignore this setting. 

Parent Item - The parent Item is the main item a transaction was done for which caused the transaction 
for the 'child' item. To view the information for the parent transaction, right click and choose Parent 
Item. A box will appear showing the parent item #, description, and transaction information. This 
displays the Sub Batch information for the specific record to allow for tracing back separate Floor 
Dispositions. 

Consumed VMI SN# - For Consume VMI Shipment transactions the user can right click to view the label 
serial number associated with the transaction. 

Edit Item Lot # - This option allows the user to correct the item’s lot number. Right click and enter the 
correct lot number in the pop up box. This will only change the lot number field. It will not affect the FG 
Lot Number for manufactured items. Security can be placed on this feature. 

Show Serial Numbers - This option displays serial numbers associated to individual transactions for the 
item made from anywhere in the system, including IQRF and WMSIQ. (This information is recorded in the 
TRANSLOG_MASTER_LABEL table in Data Dictionary). Select the lock button to ensure the serial 
number(s) remain in the pop up when another show serial numbers form is opened. If it is not locked 
when a subsequent Show Serial Numbers form is opened the previously opened one will refresh to 
display the second forms serial numbers. 

Country of Origin - The Country of Origin applies to purchased items. It automatically populates with the 
country associated to the Vendor the item was received from. This information is also available as a right 
click option in the Lot Tracking module, and is visible in the Transactions and Locations module.  

The table below lists the various transaction types and the possible corresponding reasons. Also each 
transaction type has a transaction type code associated to it, that populates in the Translog table 
(Trans_Type_Code), which is also shown in the table below. 
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Trans Type Code Description Possible Reasons 

ADJUST WIP 42 ASSY MFG Type WIP adjustment.  ▪ Process WIP Rejects 

▪ Void ASSY Reject MFG Parts 

▪ Void ASSY Reject Components 

CONFORM 01 When product is toggled from non conforming 
to conforming. The reason field will populate 
with Toggle to Conform or Non Conform. 

▪ Toggle to Conform 

▪ Toggle to Non-Conform 

CONSUME PO VMI 44 When purchased items are moved from a VMI 
location to a non VMI location 

▪  

CONSUME VMI 
SHIPMENT 

25 Out transaction showing the amount consumed 
from a VMI location.  

▪ Consume VMI Shipment 

▪ Web Consume VMI Shipment 
(from WebDirect) 

▪ Manual Reference # 

DISPOSITION 13 Transaction made as a result of production 
reporting using various methods RT Scan to 
inventory. 

▪ Floor Disposition 

▪ Floor RG Disposition 

▪ Floor Disposition/Backflush 

▪ Non RT RF Disposition 

FINISH PROCESS WIP 39 ASSY MFG Type Finish Process WIP transaction.  ▪ Final Assembly 

ICA 45 Inventory Cost Adjustment ▪ ICA in AP Invoice 

INTERPLANT 
TRANSFER 

27 Transfer between two EPlants.  ▪ Receive Intercompany 

▪ In-Transit PS# xxx 

INVENTORY SCRAP 22 Out transaction where the Scrap box is checked.  ▪ Reject Code selected 

LABOR 19 Associated Labor record for transaction ▪ Reason from parent 

LANDED COST 46 The Landed Cost record associated to a received 
item. 

▪ Receiving PO# xxx 

LANDED COST-ICT 50 The Landed Cost record associated to an 
intercompany received item. 

▪ Receiving PO# xxx 
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MANUAL 02 Manual transaction  ▪ Process WIP Rejects 

▪ Void ASSY Reject MFG Parts 

▪ Void ASSY Reject Components 

▪ Reject Code 

▪ Recycle Tag # xxx 

▪ User Entry 

▪ Receiving without PO 

▪ Reject In-Transit Outsource 
Inventory 

MANUAL / 
ASSOCIATED 

16 A manual transaction that has been Associated 
to an IN transaction.  

▪ User Entry 

MANUAL / 
BACKFLUSH 

14 A manual (non system generated) transaction 
into or out of inventory.  

▪ Scan/Backflush 

▪ Rejects Backflush 

▪ JobShop Dispo 

▪ Shop Data Rejects 

▪ Reject Code 

▪ User entry during Add/Out 
transactions in RF/WMS 

MOVE IN TRANSIT 32 This transaction is created when a packing slip 
that has not been verified is voided.  

▪ Void In-transit, PS # xxx 

MOVE LOCATION 03 A location to location transfer.  ▪ Outsource Transit PS# xxx 

▪ Batch Transfer 

▪ Direct Move WO 

▪ MTO Allocation, SO# xxx 

▪ Scanner Move 

▪ Scanner Pick Items 

▪ Scanner Direct Move 

▪ Hard Material Allocation, SO #xxx 

▪ Shipment Staging PS# xxx 

▪ Move 

▪ Receive Intercompany In-Transit 
PS # xxx 

▪ Transaction Code 

▪ User Entry 

▪ Repack 

NEW ITEM 0 An entry is made in the log when the item is 
created.  
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NON INV VEND RMA 0 Entry is made in the log when a miscellaneous 
item is rejected on a Vendor RMA. 

▪ Vendor RMA# xxx 

OVERHEAD 18 Associated Overhead record for transaction ▪ Reason from parent 

PACKING SLIP 04 Out transaction when a packing slip is created.  ▪ Relieve In-transit PS# xxx 

▪ PO# xxx 

▪ Packing Slip # xxx 

PHYSICAL 
INVENTORY 

17 Inventory adjustment made during a physical 
inventory.  

▪ Physical Inventory Adjustment. 
‘Type’ such as WS-Class/Loc or 
Cycle Count 

PM 20 An Out transaction for an item consumed in a 
PM work order.  

▪ Consumed by PM 

PO 08 Received from a purchase order.  ▪ Receiving PO# xxx 

▪ Receiving without PO 

PO NON INVENTORY 33 Receipt Record for non inventory or 
miscellaneous item. 

▪ Receiving PO # xxx 

▪ Voided Receiving PO # xxx 

PO NON INV VOID 34 Used when a receipt on a PO has been voided ▪ Void PO Receipt 

PO VMI 43 Used when a PO is posted to a VMI location ▪ Receiving PO# xxx 

PROCESS WIP 38 ASSY1 MFG Type Process WIP transaction.  ▪ Report Process WIP 

REJECT PO 12 Reject material from a purchase order receipt.  ▪ Rejected Receiving PO # xxx 

REPAIR 29 Consumed from Repair work order from RMA ▪ Repair 

REPAIR FINISHED 30 Finished Repair - Close work order from RMA ▪ Repair Finished 

RETURN IN TRANSIT 37  Outsource Central Return ▪ User Entry 

REVERSE 
BACKFLUSH 

41 ASSY MFG Type voids ▪ Void ASSY Good Parts 

▪ Void ASSY Reject Mfg Parts 

REV CHANGE  Revision change to item which occurs when the 
"Update to Rev __" is selected.  

▪ Prior Rev: xxx 

REWORK  35 Consumed from Repair work order from MRB ▪ Rework 

REWORK FINISHED 36 Finished Repair – Close work order from MRB ▪ Rework Finished 

RMA 06 Adding inventory based on a returned item.  ▪ RMA Trans 

▪ RMA# xxx 
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TOOLING 21 Consumed in the Project Manager module ▪ Consumed by Tooling 

VENDOR RMA 23 A transaction to remove material for a Vendor 
RMA.  

▪ Vendor RMA# xxx 

VMI INTERPLANT 
TRANSFER 

28   

VMI MOVE LOCATION 26 A transfer from a non VMI location to a VMI 
location via a packing slip  

▪ VMI Packing Slip # xxx 

▪ VMI Void PackSlip Disbursement, 
PS # xxx 

VMI RETURN 31 Return VMI ▪ Return VMI 

VOID PACKING SLIP 05 In transaction when a packing slip is deleted  ▪ Pack Slip Disbursement, PS # xxx 

▪ RMA Transaction, RMA # xxx 

VOID RECEIVED PO 11 Void of a purchase order receipt  ▪ Void Receiving PO # xxx 

VOID REJECTED PO 10 Void Rejected quantity in Receiving ▪ Void Rejected PO # xxx 

VOID RMA 07 Removing inventory based on a canceling 
receipt of a returned item.  

▪ RMA Void 

VOID VENDOR RMA 24 This transaction occurs when the quantity 
returned on a vendor RMA is deleted.  

▪ Void Vendor RMA # xxx 

 

The log consists of the following information (field listing is in alphabetical order): 

Act Cost The actual cost of the purchased item at the time of the transaction. This is the cost on the 
purchase order when the item is received.  If the PO cost  = 0, upon receipt the system 
will use the location.act_cost in translog. 

The cost field for manufactured items is typically zero unless using Actual Costing or the 
Production Reporting by Work Order module is used with the 'Post Actual Cost to Inv' 
Costing Parameter is checked. When the 'Use Actual Cost during Post Transactions' 
parameter is checked (System Parameters->Inventory Setup tab) the system will populate 
this field with the weighted average. 

Batch A batch is a group of transactions associated with one transaction. For example, if an item is 
dispositioned, the batch number is given for that item and all associated products 
consumed. The dependent transactions in Translog are filtered by batch + sub_batch. This 
prevents transactions from all records of the same batch from displaying when double-
clicking the IN transaction to see the associated OUT transactions. Only the records 
associated with the sub_batch are displayed. 

Reports can also group by batch + sub-batch to get all associated items with specific 
transactions. 
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Comment This displays the transaction comment if applicable, such as the 'Scrap Comment' from 
inventory scrap transactions, or the PO Receipt 'Transaction Comment'. 

Cost Element The cost element assigned to the inventory item. 

CUser1 - CUser3 User-definable titles and fields. Right click on the heading and select the Define Column Title 
option to change the column name. These can be used for user defined reports or for 
additional information on the screen. Information entered in the CUser1-3 fields in the 
Transactions and Locations screen will appear here. 

If a Vendor Lot # is entered at the time an item is received the information will populate the 
CUSER1 field. 

Date The date and time of the transaction based on the transaction date; not necessarily the 
system date. 

If the EPlant has a Time Zone associated to it (System Parameters->Enterprise tab) the date 
for transactions will be adjusted forward or backward according to EPlant time zone change. 
(The time zone will not be mentioned in the date field).   

Note: When a shift crosses midnight, the date for floor dispositions will be the date of the 
production with a time of 11:59:59pm. When that shift is Production Reported the 
disposition transactions will have the date of the production with a time of 11:59:59pm. This 
will ensure that the floor dispositions and disposition records are together in PIT, and ensure 
the transactions show up properly when Work Order Reconciliation is enabled for Actual 
Costing. The user can still see the actual time by looking at the system date in translog. 

For Prod Report by WO: The Translog shows the current date/time, it does alter time for the 
time zone differential.  

Division The division associated with the item. 

End Qty After a transaction, this displays the total On Hand quantity for all locations. For PL class 
items, there is an 'End RG Qty' column to display the total RG On Hand quantity after a 
transaction. 

EPlant ID The EPlant ID associated with the transaction. 

FG Lot # If this item was used to create a manufactured item, the FG Lot number of the item will be 
shown. 

In/Out Indicates whether the transaction added or removed items from the particular location. 

Item Information This includes the item #, class, description, extended description, and revision for the item 
associated to the transaction. 

Location The location affected by the transaction. Note that a MOVE transaction creates two 
transaction records - IN and OUT. 

Location 
Description 

The description associated with the location affected by the transaction. 

Location ID The Location ID associated to the record.  

Lot # The lot number associated with the location. 

MFG # The MFG # associated to the transaction. 
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Parent Item# The parent Item is the main item a transaction was done for which caused the transaction 
for the 'child' item. For example, when a FG item is dispositioned into inventory the 
materials used to create that item are dispositioned out. The FG item is the 'Parent' and the 
raw material is the 'child'. To view the information for the parent transaction, right click and 
choose Parent Item. A box will appear showing the parent item #, description, and 
transaction information. (If this field is applicable it will say 'Right Click to See P'). 

Posted This field will display a Y if the transaction was posted through the Post Inventory 
Transactions or Inventory Activity Cost Journal modules. 

Reason The reason for the transaction. This field is optional, but is often filled in automatically by 
EnterpriseIQ. (Maximum 50 characters). Please see the Transaction Types table above for 
details. 

Receipt # Receipt Id Number from the Receiving transaction. The original receipt # also displays for PO 
rejects and void PO rejects. 

Start Qty The amount of material initially in the location affected by the transaction. 

Start RG The amount of regrind initially in the location affected by the transaction. 

Std Cost The standard cost of the item at the time of the transaction. 

System Date This is the actual date and time the transaction was made based on the Oracle Server time 
(matching System Parameters > Regional time zone). 

Total Start Qty 

 

This is the total quantity on hand in all locations before the current transaction. (Non 
allocatable Non-conform locations quantities are not included in the total). 

Total Start RG This is the total amount of regrind on hand in all locations before the current 
transaction.(Non allocatable Non-conform locations quantities are not included in the total). 

 

Tran Code The transaction code assigned to the transaction. 

Tran Descrip. The transaction description associated with the transaction code. 

Tran Qty The amount of material involved in the transaction. The quantity will be based on the 
default UOM for the item. 

Trans RG The amount of regrind (if any) involved in the transaction. 

Trans Type The transaction type. See the table above for details. 

User The ID of the user who performed the transaction. 

WO # Work Order number associated to the transaction, such as a Disposition transaction.  

This will populate with the WO # for hard allocated materials on the IN transaction. 
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Note: Additional fields such as Program Name (the program used when the transaction was made) exist 
in the TRANSLOG table and can be used for troubleshooting. 

 
 

Inventory By Locations 

The Inventory by Location module displays all of the locations and the items in that location. To access 

this module select the speed button from the Manufacturing tab on the launcher bar  

This form consists of four sections: 

▪ Locations 

▪ Inventory 

▪ Details 

▪ Linked Labels 
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Locations 

The locations section lists all locations in the logged in EPlant. This section includes the Location name, 
description, warehouse, EPlant ID, and Location ID. Locations will be color coded based on their 
attributes (yellow = VMI, Rust = Non Conform, and Purple/Black = In-Transit). 

Additional Speed Button Options: 

▪ By default only active locations display. To view inactive locations select the Show Active/Inactive 
toggle button. 

▪ Select the multiple sort criteria (green arrow button) to select multiple columns for sorting. This 
feature is also available in the Inventory section. 

▪ The locations list can be filtered using the Filter Dataset button. This feature is also available in the 
Inventory section. 

For more information on these features refer to the Pick Lists section of the Using EnterpriseIQ manual. 

Inventory 

This section shows all of the items associated to the highlighted location. This information is very similar 
to the data in the lower left grid of the Locations and Transactions module except it lists all items in that 
location. It includes the item information such as; Item Number, Item Description, Class, Rev, and Ext 
Description. It also displays the On Hand, Lot#, Cost, and In Date, Lot Date. Other fields include: In Transit 
Origin, Hard Allocated To Outsource Vendor #, Make To Order (SO/Line#), Container #, Serialized, and 
Last In Date. The locations will be color coded if applicable. For more information on these fields please 
see Inventory Transactions.  

Note: Security is available on many fields such as cost. 

From within this section there are several right click options available: 

▪ Jump to Locations and Transactions for the highlighted item. 

▪ Jump to Inventory 

▪ Change In Date - This will pop up a calendar form for the user to choose a different In Date to 
associate to the highlighted record. When the in date is changed it will not have a time associated to 
it. 

▪ Toggle to Non-Conform - This toggles the location from Non-Conform to Conform and vice versa. This 
functions the same as the toggle button as described in Material Status (Non-Conforming and Non-
Allocated). 

▪ Toggle to Non-Allocate - This toggles the location from Non-Allocate to Allocate and vice versa. 

▪ Toggle to No Ship - This toggles the location from No-Ship to Ship. A Y will populate in the No Ship 
field if it has been marked as No-Ship. If it is toggled back to Ship a N will be in the field. For locations 
that have never been marked as no ship this field will be blank. 
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▪ Release Work order Hard Allocation -  Work order hard allocations can be released by selecting this 
option. If the work order has cycles required a warning will appear stating the work order is not 
complete. Depending on security the user will be able to select OK to continue with the release or 
Cancel to not release the hard allocation. Once the transaction is complete, the location will no 
longer have the work order associated to it and the color will go from aqua to white. The hard 
allocation will be disassociated from the work order. 

▪ Release MakeToOrder Allocation - This option will release the Make To Order allocation. Once 
selected a message will appear stating: 'Are you sure you want to deallocate MakeToOrder inventory 
location?'. Select Yes to continue and a pop up will appear to enter the quantity to be released (this 
defaults to the location quantity). Accept or enter the quantity and press OK to continue. (For more 
information see the  Make To Order https://my.iqms.com/cfs-
file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf TechNote). 

▪ Print Labels - Labels can be printed for non-serialized items in a specific location. Right click on a 
location and select Print Labels and the Print Label form will appear with the Box quantity equal to 
the Location quantity. (Note: The Dispo_Scan field in the Master Label table will be marked as Y for 
manufactured items). Note: This option is not available for Serialized Inventory Control items. 

Details 

This will list the details associated to the location/item number combination. The details include: Non-
Conformed reason, Non-Allocatable reason, Dispo Designator type, Ship Designator, and Warehouse 
name. 

Linked Labels 

This will list the linked labels associated to the location/item number combination for serialized items. 
The fields displayed include: Serial #, Quantity, Dispo Date, Pallet Serial #, and Print Date. 

Note: Users cannot sort on the following columns as they are calculated fields:  Hard Allocated To, In 
Transit Origin, Outsource Vendor#, and Make To Order (SO/Line#). 

Move Inventory 

Inventory can be moved from one location to another using the drag and drop functionality. 

To move a single item - Highlight a record in the Inventory grid and then using the mouse button drag it 
over to the Location you would like to move it to. To scroll up or down to a specific location that is not 
visible in the list, drag the mouse over the 'hot spots' at the top of the form and the very bottom. The 
form may optionally be opened twice for ease of target-source location moves. A confirmation box will 
appear, select Yes to continue with the move or No to not move the inventory. Mark the 'Do not show 
next time' box to not see this message when moving product from here. (It can be turned back on from 
the Dialog Check Boxes list in System Parameters). Once yes is selected a Transfer Transaction form 
showing the From and To locations will appear: 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Make_2D00_To_2D00_Order.pdf
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The Quantity will default to the full quantity that was in the from location but it can be changed by 
typing a different value in the field. A Reason can be entered manually or selected from the user defined 
drop down list, which will populate in the reason field in Translog. The system will create a new FGMULTI 
record and add an In and Out MOVE_LOCATION transaction type to the translog. 

To Move Multiple Items - Multiple items in a location can be moved at one time by either using the built 
in toggle speed buttons or the Ctrl or Shift keys. Once all of the desired locations are highlighted, drag 
them to the Location they are to be moved to. Select Yes on the confirmation box and the items will be 
moved. Note that when moving multiple items the entire quantity will be moved. The Transfer 
Transaction form will not appear to enter a different quantity. 

 
 

Inventory Reports 

All Inventory Reports can be found by selecting Reports from the menu bar (within Inventory or 
Locations and Transactions). Selecting this function will bring up a Reports dialog box that will list the 
reports available for viewing or printing. The reports listed in the reports menu will be based on the class 
of the item the user is currently viewing. Each inventory class has specific reports. Each report can be 
printed to the workstation screen, output to a printer, or printed to a file. 
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Vendor Managed Inventory for Customers -  VMI 

EnterpriseIQ supports the ability to manage inventory stored at another location (such as the customer's 
site or a local warehouse). The system includes the ability to ship the product to the customer, manage 
the shipment and quantity as another location within the inventory item master file, and support the 
invoicing of the product when it is actually consumed by the customer or at the time of packing slip. 

VMI uses the customer Ship To records and a special location as the basis for this functionality. Basically, 
a Ship To location is linked to a special inventory location, marked as a “VMI Location”. Whenever an 
item is shipped to this shipping address, via the packing slip function, the inventory transaction is 
actually recorded in the item master file. When viewing the item information, the VMI location is 
displayed, with the current quantity available. 

When the customer consumes the item, the EnterpriseIQ user can then manage the creation of the 
invoice and adjust the inventory level in the VMI location or the invoice can be created at the time the 
packing slip is done. VMI supports partial consumption of the item, so that multiple invoices can be 
created to handle the one or many transactions that occur on your customers floor. 

Initial Setup 

The first two steps involve creating a VMI location, then linking it to a Ship To address. 

Access the Master Locations list from the Miscellaneous->Inventory Location Info menu in the Inventory 
module. (This can also be accessed from the Lists menu in System Parameters). 

Step One 

Create the VMI location in the Inventory table: 

Create a new location with the standard location and description information, and the optional eplant 
information. The location name and description can be virtually anything, though you may find it helpful 
to describe it as a VMI location for easy reference later. The description used here will be displayed 
within the inventory locations record, so it is helpful to clearly identify the location. Find the VMI 
Location column and click the check box. Note that the location record changes color to a yellow 
background, indicating this is a VMI location. An example is shown below: 
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Step Two 

Link the VMI Location to a Ship To Address: 

Next, access Customer Maintenance and locate the customer record that requires the VMI service, then 
click the Ship To tab. In some cases you may need to create a new Ship To address. Note that you can 
have multiple records for the same location. This is useful when you want to handle some shipments of 
items in the normal, non-VMI fashion, and others with the VMI designation. It may be helpful to clearly 
describe the location, using the Company Name field, for example, to clearly show this is a VMI location. 

The lower right area of the screen contains a VMI Invoice option and a VMI button. Use this button to 
bring up the list to find the inventory location created in step one. 
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The VMI location must be unique for each customer SHIP TO address. This VMI location must also be 
unique for each customer. In other words, you cannot use the same VMI location for different 
customers. 

From this screen you can also edit the Master Locations list by clicking on the button in the upper, left 
corner of the form. 

This action now links the Ship To address with a VMI location(s). From this point on, any sales orders that 
ship to this exact address will create the necessary records to track the activity within the VMI location. 

From this screen the user may choose when to invoice for the items sent to a VMI location. The two 
options are Invoice on Consume or Invoice on Pack Slip. Invoicing on Consume will invoice when the 
items are consumed through the VMI module. Invoicing on Pack Slip will invoice when the items have 
been 'shipped' on a packing slip (prior to consumption). 

VMI Items 
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If a VMI Location is associated to the Ship To address this option will be available to associate specific 
items that will ship to the VMI Location. Select the item(s) from the drop down list and associate a VMI 
Location. Once an item has been added, then any time any inventory is shipped to this Ship To, only the 
items indicated in the VMI Items grid will go to the VMI location, anything else shipped to the same Ship 
To will process as a non-VMI shipment.  

Inventory Locations and VMI 

It is important to understand that a VMI location is simply another location linked to the item (all items 
in EnterpriseIQ can be maintained in multiple locations). However, there are important differences: 

▪ Items cannot be manually transferred into or out of VMI locations from non VMI locations except 
through the packing slip module and a special module that handles VMI inventory. This includes 
manual transfer/move activity. However, transfers may be made between VMI locations if the 
location address is the same. The result is that users can see what is in inventory by location, but 
cannot directly manipulate these values without going through the proper channels. 

▪ VMI quantities are not taken into account when calculating available to promise in Inventory 
Availability. A VMI location is automatically marked Non-Allocatable. 

▪ VMI locations are also not included in the Physical Inventory counts. 

When viewing the Inventory Locations form, the VMI locations are shown with a background of yellow. 

Note that inventory in a VMI location is automatically set to “Non-Allocatable”. This prevents the MRP 
engine from including these items in the work order calculations. Because the items have been shipped, 
the demand for the item has already been reduced buy the amount shipped, just as if you shipped the 
items using the standard procedure. If the items were not set to non-allocatable, then they would be 
included as on-hand and therefore available to ship. In this case, the system would not generate the 
proper work order amounts to fulfill actual demand. 

Sales Orders and VMI 

The sales order is the beginning of the transaction chain for VMI. Placing an order to be shipped to a VMI 
location uses the same procedures as any other sales order. However, the Ship To address MUST be one 
of the VMI Ship To addresses described earlier. This is where it is helpful to make sure the VMI address is 
clearly denoted so that it is easy to find on the pick list, especially if the customer has many Ship To 
locations. 

Moving Products to the VMI Location - the Packing Slip 

As mentioned earlier, you cannot directly move inventory into a VMI location. However, by creating and 
posting a packing slip - just like any other sales order during the shipment process - EnterpriseIQ will 
automatically make the correct inventory transactions. Therefore, to 'ship' the VMI item to the 
customer, simply create a standard packing slip for the item and post the record. The VMI location 
record will be automatically added (if it had not been added manually by the user) to the list of locations 
for the item, with the correct amount 'shipped' in the Qty column. 
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In the example above, the 'Create Packing Slip from Sales Order' option, from the Sales Order screen, 
was used to generate the packing slip record. Note that the Ship To Address has been color coded 
(yellow) to show that this shipment is actually going to a VMI location. Post the packing slip by clicking 
the OK button. 

In the example above, only 1000 of the 1400 parts on order were shipped. The Sales Order reflects the 
partial shipment, and reduces the total demand, as it normally would if this was not a VMI transaction. 

The inventory record for the item has been adjusted as shown below, following the post process: 
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Note that the On Hand quantity remains the total of those items physically on-hand (9380) and those in 
the VMI location (1000). However, the 1000 VMI parts have been marked as Non Allocatable. As 
mentioned earlier, this prevents the MRP engine from assuming these are physically on hand for future 
shipments against the new demand. 
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Consuming a VMI 

Invoice on Consume 

The user has two options for invoicing a VMI item.The first option is Invoice on Consume. With this 
option a shipped VMI item DOES NOT automatically create a record to be invoiced based on the 
shipment. The VMI item is held in a temporary state until the customer indicates he has consumed the 
item. When this occurs, the VMI shipment is then made available to invoicing. This includes the Auto-
Invoicing function. 

Consuming a VMI 

To access the Consume VMI form, go to the Sales/Distribution tab of the EIQ Launcher Bar displaying all 
outstanding VMI items. 
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The form displays the shipping information of each VMI item, including the packing slip number, the 
amount shipped to that location, consumed to date, and the amount invoiced to date. The upper section 
also includes an ‘In-Date’ which is the packing slip date + customer ship to ship time. 

To locate a specific item select the Search button.  

The table below lists all the fields in the lower section of the form. 
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VMI Shipped Qty The quantity shipped to a VMI address. 

VMI Consumed 
Qty 

The quantity consumed. 

Invoiced Qty The quantity invoiced associated to the packing slip. 

Order Invoiced 
Qty 

The quantity invoiced associated to the sales order. 

Order UOM The unit of measure associated to the sales order. The VMI consumption will be based on 
this UOM. 

Note: When consuming a VMI for an item with a UOM factor, the system is looking at the 
ord_detail.UOM_Factor, not the current UOM factor associated to the item. So if an items 
UOM was changed after an order was entered, the UOM would be looking at C_Ship_hist 
which comes from the order. 

VMI Returned The quantity returned. 

VMI Non 
Consumed 

The quantity of non consumed VMI items. This is the difference between shipped qty and 
consumed qty. 

Quantity to 
Consume 

The quantity to consume. Enter the amount that was consumed. 

Consumption 
Date 

The user can enter a Consumption Date to show the actual date the inventory was 
consumed. This date will default to the system date. 

Ship To A different Ship To address can be selected from the drop down list or the pick list 
accessed from the search button. 

Reference # The user can enter a VMI Reference number. This reference number is written to 
C_ship_hist and populates the VMI Reference Code field on the AR Invoice. This VMI 
Reference Code can be used when entering cash receipts. The reference # can be up to 35 
characters. Select the Edit Reference # button to view and/or print the entire text. 

NOTE: If you invoice the VMI consumption right away, this reference number from 
c_ship_hist will write to accounts receivable prepost. However, if you consume an item, 
write in a reference code, then consume more of the same item with a different 
reference code, the last reference code used will be what shows on the invoice for both. 
The C_ship_hist only has one field for VMI Reference. It is not possible to store a different 
one each time the item is consumed. 
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VMI Location 

 

The numeric value next to the VMI Location field shows how many location/lots are found 
for the VMI. The locations associated to the packing slip will display in red to the right of 
this box.  When shipping from multiple locations without lot numbers they will be 
grouped in one line. 

The location section will display the location details such as name, description, and on 
hand as well as the 'Available to Consume' quantity which is the quantity for each location 
and lot #, not the total shipped. 

For Non-Serialized Items: 

To consume all or a partial amount, enter the quantity in the Qty to Consume field. 

Highlight the correct location to consume from. Note the VMI locations/lots that are associated to the 
packing slip are color coded in red to stand out. They also show the available to consume value per 
location. If the user selects a lot/location that is not red a warning will appear: 'Not shipment associated 
VMI location'. The user can only continue if they have security clearance to select OK.  

Note: If a user chooses to continue through the warning they will not be able to void the consumption 
from the location/lot# they consumed from. Users will only be able to void from the location /lot# they 
should have consumed from originally.  

Apply VMI 

Click the Apply button to process the information. If the consumption quantity is greater than the 
shipped quantity a warning will appear stating, "VMI consumption quantity is greater than the shipped 
quantity. Do you wish to continue?" This warning has a Yes and No button. Select Yes to continue or No 
to return to the VMI screen. Security can be placed on this warning. There is also a 'Do not show next 
time' check box.  

The record is updated to show total consumption to date. In addition, the inventory transaction log for 
the shipped item is updated to show the removal of the items from the VMI location. In the example 
below, several VMI based transactions are shown: 
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The last transactions are VMI based. Note the MOVE_LOCATION transactions. These were created by the 
packing slip routine, which moved the items from the original location to the VMI location.  

For Serialized Items (SIC): 

Serial numbers can be consumed directly from EIQ, or users can use the Express Mode option in 
IQRF/WMS. (Note: The Confirm Mode cannot be used. The system automatically adds all scanned serials 
to the Consume VMI list so it is not possible to perform a Consume VMI by Confirm Mode for SIC items 
as the process has already been done for the user).     

Consuming SIC Items in EIQ 

When the pick ticket is converted to a packing slip the system changes the master_label.VMI_consume 
to 'Y' and adds it to the VMI Consume module automatically. To consume the label go into EIQ->VMI to 
apply the VMI Serial Number to a specific packing slip. This is done by highlighting the packing slip on the 
Consume VMI screen, right click and select 'Serial # VMI'. A pop up box will appear showing the serial 
numbers associated to the location highlighted in the lower section, quantity consumed, the scan date 
and time, and user. Highlight the line(s) and select Apply or Apply/Invoice. When Apply is selected the 
invoice is created later from the AR Invoice module. When Apply/Invoice is selected the system will 
automatically create an A/R invoice based on this consumption rather than doing the two step process. 
This option works for customers that are set up as 'Invoice on Consume.' This uses the Auto-invoice rules 
on creating the invoice. 
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Note: Users can consume less than the label's quantity by entering a value in the Qty field in the 
'Consume Serial # VMI' screen. The labels link to the VMI record is maintained so more can be consumed 
at a later time. 

Note: When partially consuming a SIC pallet label in VMI, both the parent and child labels maintain their 
link to the VMI location. 

Consuming from IQRF/WMS 

Note: The Confirm Mode requires an additional step in EIQ->Consume VMI to apply serials to a specific 
packing slip. and cannot be used for SIC items. 

▪ The Express mode requires scanning just the serial number. When the user selects this option the 
serial number is consumed immediately. The user will not have to go into EnterpriseIQ->VMI and 
consume the serial number. If a serial is scanned that is not in the list of consumable serials, the 
following error will occur: "Serial # X is not in the list of consumable serials or has already been 
consumed."  

▪ If the Confirm mode is chosen, the user scans the serial number and is then asked to confirm the 
displayed information. To finish the consumption the user must go into EIQ->VMI  to apply the VMI 
Serial Number to a specific packing slip. This is done by highlighting the packing slip on the Consume 
VMI screen, right click and select Serial # VMI. A pop up box will appear showing the serial numbers 
associated to the location highlighted in the lower section, quantity consumed, the scan date and 
time, and user. Highlight the line(s) and select Apply. 

Note: If a user attempts to apply a consumption by using the Apply button at the bottom of the form and 
not the right click option for a serialized item a warning will appear stating: "This is a serialized item - to 
maintain association with serial numbers, cancel here and apply using right-click option for 'Serial # VMI' 
in top grid of this form". Security can be placed on the OK button to prevent users from consuming the 
VMI in this manner. There is also a 'Do not shown next time' option that can be checked to not show this 
message. 

Non-Inventory Items 

If non-inventory items are shipped with an inventory item to a VMI location, they can also be consumed 
so that they will appear on the AR Invoice. Locations and transactions do not apply. Note: If a non-
inventory item is shipped alone (without an inventory item) it will not appear in Consume VMI to be 
consumed.  

Kitting and VMI 

VMI functionality works with phantom kit items and components of a kit. When performing a Consume 
VMI on a kit item, the system displays the finished phantom item (as grayed out per color chip) and the 
components shipped. A quantity to consume can be entered for the kit and/or the components, and the 
system will pull the items shipped from their respective VMI locations. When applying the quantity to 
consume for the kit, there will not be a VMI location displayed unless the phantom item was actually 
pulled from inventory during shipping. When voiding the consumption for a kit item and/or components, 
the system will put the items shipped back to the VMI locations. Return VMI will move the shipped kit 
and/or components back to non-VMI locations. 

Right Click Options: 

▪ Jump to Sales Orders 
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▪ Jump to Packing Slips 

▪ Serial # VMI - Opens the Consume Serial # screen for Confirm Mode consumption as described above. 

▪ Change Unit Price - Before consuming a VMI the user can change the unit price. The price change will 
affect all non consumed VMI quantities. To change the price right click on the form and select 
"Change Unit Price'. Enter in the new unit price in the pop up form. The new price will be carried over 
to the AR invoice. The AR invoice will always reflect the most recent price change. 

▪ Export Data - This option will create a spreadsheet of the data in the top grid and will also include the 
VMI Shipped Qty, VMI Consumed Qty, Invoiced Qty, and Order Invoiced Qty from the lower section. 

Creating an Invoice for VMI Items 

Once the consumption is applied, an invoice can be generated. To create an invoice, click the VMI 
Shipments option, then OK to continue. Creating the invoice from this point forward is essentially 
identical to creating an invoice for any non-VMI item. 
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On the Customer Maintenance->Ship To->VMI tab there is an option to 'Reevaluate Unit Price based upon 

Invoice Date'. If this option is checked, upon creating an AR Invoice for the VMI shipment the system will 
reevaluate the unit price by comparing the price when the item was shipped to the current price on the 
inventory item (based on the hierarchy: AKA Selling, then Buy/Sell tab, and then Std Item Price). If it is 
different than the system will use the current price on the inventory item as the unit price for the AR 
Invoice. If this is not checked the system will use the price from when the item was shipped 
(C_SHIP_HIST.UNIT_PRICE). 

Apply and Invoice 

Users can select the Apply/Invoice button to have the system automatically create the Invoice rather 
than the two step process described above. This option works for customers that are set up as 'Invoice 
on Consume.' After entering the quantity to consume and the reference number (optional), the system 
will automatically create an A/R invoice based on this consumption. This uses the Auto-invoice rules on 
creating the invoice. 

Note:  When the 'Apply' or 'Apply/Invoice' button is selected the system will update the 
c_ship_hist.std_cost with the current arinvt.std_cost. This will update the shipment standard cost to the 
current one and keep inventory standard cost balanced. Any VMI consumption will be at the current 
standard cost. Invoicing will then pickup c_ship_hist.std_cost at current when posting Shipments in PIT. 

Invoice on Pack Slip 

Another option for invoicing a VMI shipment is to invoice at the time of packing slip. This option is the 
same as if you were shipping to a non VMI location. The packing slip record will immediately appear in 
the Uninvoiced Shipments in the invoice module. You do not have to go through the consumption 
process mentioned above in order for the item to be invoiced. 
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Void or Return VMI 

Void VMI 

If a VMI consumption needs to be voided the user can select the Void button to bring up the list of 
consumed VMI's. The list will display all of the VMI details such as quantity shipped, quantity consumed, 
packing slip #, order #, etc.  

Note: This screen will only show consumptions that have not yet been invoiced or consumptions that 
have unposted AR invoices. 
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For Non-Serialized Items: Select the correct VMI consumption from the list and enter the quantity to void 
in the Enter Quantity field. In the Return to Location section, highlight the location to return the items 
into. Only the locations associated to the packing slip will show up in the VMI void screen. Only these 
location(s) are available to Void, not exceeding any one location's "Available to Void".  Once all of the 
information is entered, select OK to void the consumption. 

For Serialized Items: Enter the quantity and then select the ellipsis button in the Serial # field. Choose the 
serial number from the pick list. Select the insert (+) button to add additional serial numbers. Once all of 
the labels have been entered, select OK. This will revert the label(s) back to pre-consumed status. If the 
quantity of the selected labels does not match the void quantity the user will receive an error stating, 
"This is a serialized item. Associated labels qty must match assigned total qty". 

If the serialized item was not consumed using serial numbers (not the recommended method), users can 
select the 'Suspend SIC processing on VMI' option to void without assigning serial number(s). If it is not 
checked the user will receive the error mentioned above and will not be able to void the consumption. 

Non-Inventory items can have the consumption voided just like regular inventory but the user can only 
enter a quantity, locations do not apply. 

If the packing slip also needs to voided it can be voided from the packing slip module. If a user tries to 
void a packing slip for a VMI shipment without first voiding the VMI consumption a message will appear 
stating the VMI consumed quantity must be voided first. 

NOTE: If an unposted invoice exists for the consumed VMI a warning will appear: 
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From this warning the user can still select the Void button to void the consumed VMI quantity but it is 
recommended that the invoice be deleted before the consumed VMI is voided. Select the 'Jump to 
unposted AR Invoice' button to access the invoice associated to the VMI record to delete it.  

If the invoice is not deleted users may end up with more invoiced than consumed.  For example, 
consume and Apply/invoice for 100 pieces.  Consume and Apply/Invoice for another 200 pieces. If the 
user wants to void the 200 they should jump to the unposted invoice for 200 and delete that invoice, 
then they can void the 200 consumed. The next consumption and Apply/Invoice will be generated for the 
consumed amount.   

In the above example, if the user does not void the unposted invoice and still voids the 200, then 
consumes and selects Apply/Invoice for 300, there will be 3 unposted invoices: One for 100, 200 and 300 
but only 400 will show as consumed. 

Note: When the original location that the VMI inventory was relieved from has been deleted from 
Master Locations and the item has ‘Lot # is mandatory’ checked,  when voiding the  VMI consumption, 
the system will create a new location (fgmulti) using a substitute location found by the system, and it will 
use lot# from translog of original OUT transaction. 

Return VMI 

SIC and Non-SIC items can be returned from the Consume VMI screen. To return items enter the quantity 
in the Qty to Consume field and select the Return VMI button. An Assign Qty box will appear with the 
location the items were shipped from as the default return to location. If the location no longer exists 
the user will be prompted to choose one.  It is not required that the default location be selected, users 
can return inventory to another location. Enter the quantity being returned in the Assign Qty field and 
select OK.  For SIC items the Assign Qty field will be populated with the quantity from the selected 
label. The VMI Shipped quantity will be reduced by the amount returned and the VMI Returned field will 
populate with the quantity returned. The quantity returned will be removed from the VMI Location and 
put into the selected location and a VMI RETURN transaction will be recorded in the transaction log. 
When returning VMI for an item that has a different UOM than the inventory default UOM, the quantity 
returned to inventory will be calculated based on the UOM from the sales order. The sales order will not 
be affected. 

Note: A fully consumed VMI does not appear in the table. In order to return a totally consumed VMI you 
must first void the consumption, then return them. 
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Vendor Managed Inventory for Suppliers - 
Consignment 

This functionality allows you to manage inventory on consignment. Receipts are posted to a VMI location 
which is automatically marked as Non-Allocate in inventory. When the inventory is moved to a non VMI 
location the system will create a posted PO receipt that will then be available in AP Invoices. All 
transactions are recorded in the Translog. 

Summary of the Process: 

▪ Associate VMI Location(s) to the item in Inventory->AKA Buying. 

▪ Create a PO normally. 

▪ When the PO receipt is posted, the system will check if it is VMI and if it is only the VMI location(s) 
will be available in the location pick list.  The VMI Received Qty field will be populated on the 
receipt and not the Received Qty field. The PO will show as received and the on hand and Non-
Allocate quantities for the item is increased by the receipt quantity. (Note: For Vendor VMI receipts, 
the system will ignore the default Receive Designator location assigned in Master Locations if one 
exists). 

▪ A Transaction Type called PO_VMI will be made and be visible in the Translog. 

▪ Performing a move out of the VMI location into a normal location will trigger the creation of another 
PO receipt and post it.  The Receipt is then available in AP Invoices.  

▪  The VMI PO# is carried over when performing moves between VMI locations. 

▪ The Translog row for the move out of the VMI location will have a Trans Type = PO.  This will allow 
PIT to process the move as a PO receipt.  

Associate a  VMI Location to the AKA Item 

The first step is to associate a VMI Location to the purchased item on the Inventory->AKA Buying tab. 
Select the record in the AKA Buying tab and select the VMI Locations tab. Then select the ellipsis button 
in the Location field.  
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A pick list of VMI locations will appear. These are locations that have been marked as VMI in the Master 
Locations list. (New VMI locations can be created by accessing Locations from the Miscellaneous menu in 
Inventory). Once the record has a VMI Location linked it will be highlighted in yellow. More than one VMI 
location can be assigned. Only locations marked VMI that are not used by another AKA Buying row can 
be added. 

Note: Each inventory item will need its own unique VMI location(s). The same VMI location cannot be 
associated with any other item. 

PO Receiving 

From the PO Receiving module, to receive a single item click on the Add(+) button in the Received 
section. Select the ellipsis button in the Rec. Qty field to bring up the release form. Choose a release or 
multiple releases from the form by highlighting the rows using the toggle buttons on the form or the Ctrl 
or Shift keys on your keyboard. Next, select the 'Assign Qty' button and assign them to the receipt.  

When the receipt is posted the system will automatically default to receive the vendor VMI items into 
the current VMI designated location. To add or change the location select the New button on the pick 
list. Select a location from the drop down list. Only VMI locations that are associated to the AKA item will 
be in the list.  If there are no existing VMI locations for the item in Inventory Transactions and 
Locations, the location pick list will appear but it will be empty. Select New and this will allow you to add 
a VMI location. (The list is constrained to VMI locations associated to the AKA item).  

 

The quantity received will populate in the 'VMI Received Qty' field (not the Received Qty field). 
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The transaction will be recorded in the Transaction Log as a PO_VMI transaction type with the Reason 
stating, 'Receiving PO # xxxx'. 

The Transactions module will list the receipt in the VMI location which is marked yellow, and the values 
in On Hand and Non-Allocate will increase by the quantity received. With multiple VMI PO's for same 
Vendor VMI item, when receiving the system creates a VMI location that matches the PO #.  Move 
transactions are allowed from one VMI location to another (that are set up on the same AKA Buying 
record). 
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Move Transaction 

When the items are moved to a non VMI location, the system will create an OUT transaction with a Trans 
Type of 'Consume PO_VMI', and an IN transaction with a Trans Type of 'PO'. This will trigger the creation 
of another PO receipt and post it. The Comment field in PO Receiving will state 'Consume VMI PO'. If the 
'Delete Empty Location' parameter in Inventory is checked, when a VMI is consumed and the VMI 
location drops to zero it will be deleted. 

 

The Receipt is then available in AP Invoices.  
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Physical Inventory 

The ability to conduct physical inventory counts is supported using this module. Physical inventory 
updates are performed against a “frozen” inventory. The first step in the process is to create an image of 
your current inventory. Once all products are physically counted, additional transactions against any 
item can be made such as shipping and receiving. When the update is finally completed, the system will 
adjust all inventory figures based on the physical count, and a notation is placed in the Translog file 
noting any changes that were made. 

Unlimited physical inventory worksheets by EPlant+Division can be created.  Each worksheet will have a 
description that is pre-populated by the system with the chosen method (WS or T) and the EPlant and 
Division name, but can be edited.  As the criteria for adding to the worksheet is processed, the system 
will ensure that the same item/location (arinvt_id+fgmulti_id) is not found in any in-progress cycle 
counts. If it is, an error will display ('Found conflicting Cycle Count ID 'x' in progress - unable to begin new 
Cycle Count'), and the new physical inventory is not created. 

This module, like the main Inventory module, supports multiple locations. The user must make multiple 
entries of the same item to account for any number of physical locations or lot numbers. 

Note: It is not recommended to run multiple physical inventories for different locations that include the 
same the SIC/Non SIC item as this might cause mismatching between labels, quantities, and locations. 

Access this module from any inventory item under Options|Physical Inventory. A pick list of existing 
physical inventories will appear. Select an existing one from the list or select the New button to create a 
new physical inventory. See Begin Count Process for details on creating a new record. If an existing 
physical inventory is selected the following screen will appear: 
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The top section will list the specific details for the selected record including the ID, Kind, Description, 
Method, EPlant, Warehouse/Division, Current State and State Date. 

ID The ID associated to the Physical Inventory. 

Kind This will be either Worksheet or Tag based on what was selected when the Physical Inventory 
was created. 

Description Each worksheet will have a description that is pre-populated by the system with the chosen 
method (WS or T) and the EPlant and Division name. The information in this field can be edited. 

Method This is the method selected for the Physical Inventory. It includes the Kind (WS or T), and for 
the Worksheet types it will include the method selected in the main criteria, such as Cycle 
Count or Class/Location. 

EPlant The EPlant associated to the Physical Inventory. 

Division This will populate with the Division if one was specified on the Worksheet Selection Criteria 
form in the Warehouse/Division field. 
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Current State This is the current state of the Physical Inventory:  

▪ Count Began - This is the status of a new Physical Inventory. 

▪ Compared - Once the 'Prepare Adjustment File' button is selected the state will be Compared. 

▪ Recording - When the 'Record Inventory Adjustment' button is selected, after the user 
proceeds through all three prompts, this is the state of the Physical Inventory while the system 
is recording the adjustments. 

▪ Adjusted - The state once the adjustments are recorded. 

▪ Cancelled - The state of a Physical Inventory that was cancelled . 

State Date The date and time associated with the current state. 

The lower section displays the log details showing the event date/time and event description relevant to 
the specific physical inventory. 

Options Menu: 

▪ Record Inventory Adjustments for Changed Quantities Only or for All Tags - The user has the option of 
recording all physical inventory adjustments in the translog regardless of changes to quantities, or 
record physical inventory adjustments to the translog for only those items that had quantity changes. 
The default method is to record inventory adjustments for changed quantities only (button is up). 
This will prevent a line being created in the translog for items without any quantity adjustments. See 
Record Inventory Adjustments for more information. 

Note: If the system is recording physical inventory adjustments and gets interrupted somehow, 
rerecording the adjustments causes the system to adjust the last tag written to Translog a second 
time. 
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▪ Append to history tables - Select this option to have the posted physical inventory written to the 
Taginv_backup table. The information in this table is permanent where the information in the 
Taginv_bak is temporary. 

▪ Remove zero locations after adjustment - Select this feature if you want any locations that have zero 
on hand to be removed after posting the physical inventory. Note: Empty Disposition Designator, 
Ship Designator, or Disable Auto Delete locations are not removed when posting physical inventory 
adjustments. 

▪ Freeze locations during worksheet - When this is checked it prevents transactions from occurring in a 
location that is associated to a Physical Inventory. With this option is checked, users will receive a 
violation message, 'Location XXXX is part of active physical inventory count - operation aborted' 
immediately after a location that is associated to an active Physical Inventory is scanned/selected. 
The applicable transactions in EIQ are: Add to Location, Remove from Location, and Move to 
Location – SOURCE and TARGET (in both 'Transactions & Locations' and in' Inventory by Location' 
modules). This also applies to Move and Transaction functions in IQRF, such as Direct Move Item and 
Add by SN.   

▪ When creating a new physical inventory, prior to saving, the system will check to see if any 
locations selected for the physical inventory are associated to a pick ticket.  If there are the 
system will raise a warning, 'Location XXXX is associated to a pick ticket.  Are you sure you want 
to continue?'  If users select 'Yes' they will not be able to ship out of that location.  Security 
can be placed on the 'Yes' button.  If users select 'No' the new Physical Inventory will not be 
created.  Please note users will only receive this message once even if there are multiple 
locations that will be frozen that are associated to multiple pick tickets.  
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▪ Freeze/Unfreeze Locations for Serialized Inventory Control Items - The Freeze/Unfreeze screen displays 
a list of all locations chosen during the Physical Inventory Worksheet that contain items with serial 
numbers. The Freeze/Unfreeze screen lists the location ID, description, lot number, EPlant, Item 
number, Item description, extended item description, revision, class, tag header ID and eligibility to 
unfreeze. Serials that have not yet been scanned during Physical Inventory counting will be 
highlighted in red. As serials are scanned during the Physical Inventory process, the red highlighting 
will be removed from the serials. Once all serials have been scanned, the location will become 
eligible to unfreeze. To unfreeze a location, select the location and select either the 'Unfreeze' speed 
button or toggle the UnFreeze check box. Once a location has been unfrozen, the location is eligible 
to conduct move transactions, shipping transactions, disposition transactions, etc. while the Physical 
Inventory process continues for the remaining locations. If a location needs to be frozen again, select 
the 'Freeze' speed button or un-toggle the 'Unfreeze' check box. The serials will need to be 
recounted if a location is frozen. Once all locations have been unfrozen, the Physical Inventory 
process is ready to be completed.  
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The physical inventory must be completed in a step-by-step manner. Do not skip any steps or the 
inventory update will not be accurate. 

There are two types of physical inventories in EnterpriseIQ: 

▪ Tags - In a full physical tag inventory, the user must enter all tags manually. The tag numbers will be 
automatically generated, starting with 1, or the user may enter in their own tag numbers. Tags for 
ALL items currently in the inventory must be entered before updating the main inventory files. Any 
items NOT accounted for will be reset to zero after the inventory adjustments are recorded. 

▪ Worksheet - EnterpriseIQ will create all the tags based off the multi locations for each inventory item 
and then the tags are edited based on the actual inventory quantities. Users can select 'Do Not Auto-

Create' and the tags will not be automatically generated but will have to be entered manually based 
on the selected method as in the Tags option above. Four worksheet methods are available in 
EnterpriseIQ. These include a full physical inventory, an inventory based on an individual class of 
items with the ability to select the locations to inventory, a full physical inventory based on 
production needs for a specific scope of days, and the based on specific cycle code(s). 

What is Tag Inventory? 

Tag Inventory normally involves using a series of “tags” which are used to record the inventory item, the 
location and the amount. Two copies of each tag are usually made, with one copy being physically 
attached to the inventory item to show it has been counted, and a second copy maintained as a control 
copy. When all the counts are made, the tags attached to the inventory items are collected and 
reconciled with the control copies. The final count is then entered in the inventory log. 

Whether you use physical tags or simply base the count on inventory worksheets, the entry procedure in 
EnterpriseIQ is the same and consists of the following steps: 

▪ Begin Count Process 

▪ Maintain Count Entries 

▪ Prepare Adjustment File 

▪ Record Inventory Adjustments 

The main Physical Inventory menu options are displayed in this order and the physical inventory should 
be done in this order. 
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Begin Count Process 

To create a new physical inventory record, select the New button from the pick list, or select the Begin 
Count Process button or the insert record (+) button from the Physical Inventory/Cycle Counting form. 
The menu to select the count based on method (Tags or Worksheet) will appear. The first time this is 
opened it does not default to either method. Once the user selects a method it is remembered in the 
registry. If the user does not select a method and tries to click OK a message, ‘A method must be 
selected to continue’ will appear. 
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Select Tags or Worksheet and click [OK]. (Note: Security is available for the radio buttons and the OK 
button in the 'Choose Tag or Worksheet Method' form). 

▪ Tags - In a full physical tag inventory, the user must enter all tags manually.  

▪ Worksheet - Four worksheet methods are available in EnterpriseIQ. These include a full physical 
inventory, an physical inventory based on locations with the ability to select the classes and cycle 
count codes to inventory, a full physical inventory based on production needs for a specific scope of 
days, and the based on specific cycle code(s). 

➢ If Tags is selected you will be prompted to proceed to the next step. 

➢ If Worksheet is selected, the following screen will appear: 
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➢ Select the type of inventory worksheet to be generated from one of the four options 

available: 

Full Physical Inventory - This option creates a tag for all items in all locations. It will not create tags for 
inactive items with zero on hand. 

Based on Cycle Count Code 

  

This option allows the creation of tags for only those items assigned a cycle count code. The user may 
select one or more cycle count codes from the list or all. 

▪ To include all codes check the ‘Include All Cycle Codes’ box.  

▪ To select a single cycle count code check the 'One Cycle Code' box and select the code from the drop 
down list in.  

▪ To select multiple codes, check the 'Include selected Cycle Codes' box and then select the codes 
using the toggle buttons or the Shift and Ctrl keyboard buttons.  

The system will only include items that require counting based on the Counted Per Year field and the 
items Last Cycle Count date. For example, if the Counted Per Year = 12 for a cycle count code, only those 
items with that code that have a Cycle Count Date more than 30 days from the system date will be 
added to the worksheet for counting. 

Based on Production Need (Scope in Days) - This option creates tags for only those items required for 
work orders (both scheduled and unscheduled) within the scope of days entered. The scope defaults to 
the 'Scheduling Scope in Days' Scheduling Parameter but can be changed by entering a different value in 
the 'Scope in Days' field. 
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Based on Location/Class/Item/Cycle Count Code 
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This option creates tags for one or more classes of inventory (such as PL, FG, IN) in selected locations, or 
for specific inventory items in selected locations, or for specific cycle count codes in selected locations. 
This allows evaluation of a particular inventory class or specific items without affecting the other 
inventory class quantities. 

▪ Class Tab -  Select the inventory class or classes and then use the arrow over buttons to select the 
locations to be evaluated. To select multiple classes use the toggle buttons on the form or Shift and 
Ctrl buttons on your keyboard. The Tags will be created for each location found for each item in the 
specified inventory class(es). If the inventory classes selection criteria is left blank, the system will 
create tags for all classes of items in the locations chosen. This allows the flexibility of only counting 
inventory in certain locations. 

▪ Item Tab - Select this tab to specify specific items to be counted. To select multiple items use the 
toggle buttons on the form or Shift and Ctrl buttons on your keyboard. The Tags will be created for 
each location found for the selected items.  

▪ Cycle Count Code Tab - Select this tab to specify cycle count codes to be counted. To select multiple 
codes use the toggle buttons on the form or Shift and Ctrl buttons on your keyboard. By default, the 
Tags will be created for each location found for the selected cycle count codes. Users can select the 
'Requiring Count Only' toggle button on this tab to have the system only create tags for those items 
that require counting based on the Counted Per Year field and the Cycle Count Date 
(FGMULTI.CYCLE_COUNT_DATE) for the selected location(s)/cycle count codes. When this button is 
not checked, the system creates tags for all items within the location(s) and cycle count codes 
regardless of last cycle count date. 

Note: In-Transit and VMI Locations are excluded from Physical Inventory Adjustments. The In Transit 
location is used by the Intercompany Transfer module (ICT), Outsource Central, and when the ‘Verify 
Inventory’ pick ticket parameter is checked to place the item "in transit". An In Transit location is locked 
preventing users from manually adding or removing items.  

Note: If a location still exists on an Inactive item, the inactive item will be included in the pick list for 
Physical Inventory and a tag will automatically be created by the system.  To prevent this from 
occurring, remove any existing inventory and locations when marking an item ‘Inactive’. 

Additional Criteria 

Warehouse/Division - Users can also do a physical inventory based on Division/Warehouse. The Physical 
Inventory can still be based on Cycle Count Codes, Production Need, or Class/Location but it can be 
broken down further to count only those items whose location is assigned to a specific 
division/warehouse. 

There are two additional options to select from. If the ‘Do Not Auto-Create Tags’ is checked the ‘Require 
All Tags to Be Counted ‘option cannot be checked and vice versa. Both options were designed for users 
who perform physical inventories using scanners. 
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➢ Do Not Auto-Create Tags - If the user selects the option 'Do Not Auto-Create Tags,' all tags will 

need to be entered manually based on the criteria selected. This function was designed to 
allow worksheet counts when using IQRF/WMS. Users will select the ‘Maintain Tags’ option 

from IQRF/WMS. Each scan of a serial number (not an item number) on a label will create a 
tag. Note: The system requires the use of serial numbers with this option, so be sure that all 
items have been labeled properly through EnterpriseIQ. The serial numbers can only be 

scanned once during a physical inventory. 

Note: For Serialized items (SIC) – When attempting to conduct a Physical Inventory by Worksheet for SIC 
items and 'Do not Auto Create Tags' is not checked, the following prompt occurs, "Some of the items are 
SIC, the 'Do Not Auto Create Tags' option will be checked. Do you wish to continue?". If the user selects 
"yes", the 'Do not auto create tags' option is enforced and tags are not created. If the user selects 'No', 
the user is returned to the Physical Inventory by Worksheet screen. Security is available for the prompt 
as well as for the Yes button.  

It can also be used without scanners to utilize the worksheet method but manually create the tags. For 
example, if the user wants to do a worksheet physical inventory for a single location with the ‘Do Not 
Auto-Create Tags’ checked they will manually create a tag (in ‘Maintain Count Entries’) for every item in 
that location.  

With the ‘Do Not Auto-Create’ option not checked a tag will be generated automatically for all items 
associated based on the selected criteria.  

Note: For non-serialized items -  When using this method, if a tag is not created for a non-serialized item, 
(either manually or through scanning), that exists in inventory and the physical inventory is posted, the 
system will do an OUT transaction bringing the quantity in that location to zero. Any associated serial 
numbers will also be brought to a zero quantity. The count sheets in physical inventory do accurately 
reflect what needs to be counted even when you do not auto populate tags, and therefore when viewing 
the physical inventory adjustments it will be clear that a tag was not created as the physical quantity will 
be zero.  

Notes: For serialized items (SIC) - If a serial number is not scanned during a physical inventory, that serial 
number is put into a non-conform location with a Non Conform Reason called `Missing'. For example: 
Part A, serial # 123435 did not get scanned but is in the fgmulti table at 500 pieces. The physical 
inventory post will move that serial number to a non-conform location and mark it missing. The original 
disposition date remains intact because it is still in inventory. The item can then be moved once the 
correct location is known. Also the system will retain pallet association for SIC child serials that have not 
been counted in the physical inventory. 

There is an option in Divisions/Warehouses called 'Override Serialized Inventory Control' that allows 
some transactions to occur without selecting specific serial numbers. One of the transactions is Physical 
Inventory. The system overrides the SIC restrictions for SIC items in a location associated to a 
Division/Warehouse with the Override SIC option checked when posting the physical inventory. 
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➢ Require All Tags to Be Counted - This option is used in conjunction with scanners. If this option 

is selected, tags will be created by the system based on the selected criteria (i.e. location) 
and the user will select the 'By Worksheet' option in IQRF/WMS. The information is entered 

by Item number and not serial number. As tags are counted the system will check the ‘WMS 
Counted’ box on the tag. All tags must be counted before the physical inventory can be 
posted. 

Note: Serialized items are not included when using the ‘Require All Tags to Be Counted’ option. 

Note: When using the 'Require All Tags to Be Counted' option, if a tag was entered with a zero quantity, 
before recording adjustments the system will delete any tags with a zero quantity in order to complete 
the inventory. 

➢ Select [OK]. The system will generate the tags for the method chosen unless the Do Not 

Auto-Create option is selected. 

Additional Notes:  

Physical Inventory Count Sheets are available from the Physical Inventory Reports menu. The count 
sheets are generated based on the type of worksheet method selected 

The critical step in the physical inventory process is between Begin Count Process and Maintain Count 
Entries. Physically count your inventory immediately after step 2. IF YOU PRODUCE PARTS OR RECEIVE 
RAW MATERIALS AFTER THE PHYSICAL INVENTORY HAS BEEN STARTED, AND BEFORE INVENTORY 
COUNTS ARE COMPLETE AND ACCURATE, BE SURE TO ISOLATE TO AVOID A DOUBLE COUNT. You may 
continue to do regular transactions to inventory unless the 'Freeze locations during worksheet' options is 
selected. Just be sure what was supposed to be counted has been counted. For example, if items being 
shipped are part of the physical inventory be sure to count them before shipping. Or if raw material is 
received after starting the physical inventory be sure not to count it. The Update Physical Inventory 
reconciles all transactions that take place after the tags have been entered. 

There is an option to freeze locations to prevent transactions from occurring in a location that is 
associated to a Physical Inventory. Select the 'Freeze locations during worksheet' from the Options menu 
in Physical Inventory. 

It is not recommended to do move transactions as the tag does not get updated with the move and 
when the physical inventory is posted the items will be put into the tag location. For example -  you 
have 50 pieces in location A and you move 25 to B after freezing the inventory. Then you change the 
location on the tag for the 50 pieces to location C. It will move 50 pieces from A to C leaving A with a 
negative 25 pieces, B with 25 and C with 50. The on hand is correct but the locations are not.  

If a serial number is shipped before posting physical inventory adjustments for a serialized inventory 
control (SIC) item, once a serial is shipped it is ignored for physical inventory entirely and no quantity 
adjustments are made to inventory for that serial when posting.  For non-SIC item, although the serial 
is shipped, any quantity adjustments to the serial are still going to be posted to inventory but without 
any association to a serial number (the original serial number is not adjusted, since it was already 
shipped out).  
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Once the physical inventory process has begun, do not change label quantities for physical inventory 
related transactions. Any adjustments to labels during physical inventory need to be performed through 
IQRF/WMSIQ maintain tags option. When scanning the label, use the edit quantity function to update 
the label with the correct quantity. If the label quantity is changed elsewhere, for physical inventory 
transactions, the label quantity will be updated based off of the adjustment amount and will have 
incorrect quantities (based on actual label quantity). Any actual transactions with the label, can still be 
performed without error. 

 
 

Maintain Count Entries 

 The next step is to input the tags (full tag physical inventory method or if the Do Not Auto-Create 
option was selected) or review and modify the tags created by the system (worksheet method with the 
Do Not Auto-Create option not selected). The program is designed to enter a tag for each item in each 
location and each lot number. You may have several tags for a single item stored in different locations 
and/or lot numbers. The entry of tags may be done concurrent with the actual physical inventory. 

➢ Click on the Maintain Count Entries button or select File|Maintain Count Entries from the menu to 

access the tag screen, as shown: 
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For a full tag inventory or if Do Not Auto-Create was selected on the Worksheet inventory, all the 
information on the tag will be blank and must be input. For a worksheet inventory with the Do Not Auto-
Create not selected, the tags will be populated based on the information in the inventory tables. 

The Tags are divided into areas as discussed below. 
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Tag The tag number generated by the system. 

Serial # Serial number associated to the item. 

Status The Type of inventory entry. Inventory is the default. Other options are Void Tag and Non 
Inventory. A reason is required for the Non Inventory option. 

User ID This is the User ID associated to the person that created the tags. If the tags are created 
using the worksheet method in EnterpriseIQ, the User ID is the name of the user who 
created the tags there. If the tags are created using IQRF or WMSIQ then the user ID will 
be based on who is logged into the scanner. 

EPlant ID The EPlant ID associated to the tag. 

Reason This field is shown if the Non Inventory option is selected. 

Item # The item that is being counted on the tag. Change the item by clicking on the arrow down 
list of inventory items and 'hyperbrowsing' to find the new item. The class, revision, 
description, ext. description, and unit will fill in automatically. 

Serialized This will be Y if the item is marked as 'Serialized Inventory Control'. 

Location Select the current location for this item by clicking on the arrow down key near this field 
or by selecting a new location. The list includes: Location, Lot#, Lot Date, and Division 
fields. There needs to be a different tag (entry) for each location of an inventory item. 
This is a required field. 

Lot # The lot number (if any) for the item. This cannot be edited. 

Non-Conforming If the item is Non Conforming, a reason can be entered by selecting from the arrow down 
list. 

If the item is a 'Serialized Inventory Control' item and there are multiple tags in the same 
location a message will appear stating, 'The Nonconforming specification in the following 
Tag(s) ([Tag ID #(s)]) differs from your current specification. Since there can be only one 
Nonconforming specification per location, do you wish to override those tags with your 
current selection for Nonconforming?' Selecting Yes will update the other tag(s) with the 
non-conforming reason. The message includes a 'Save to file' icon to record the tag 
details. 

MTO This displays the Make To Order sales order number and line item sequence if applicable. 

Quantity The quantity of the item in this location. 

Regrind PL items only. The quantity of regrind in the location. 
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WMS Counted This is used when the ‘Require All Tags to Be Counted’ option is selected. When an item is 
scanned using IQRF/WMS that is associated to a tag this box will be checked 
automatically. Recording Inventory Adjustments cannot be done until all tags have been 
counted. This box cannot be manually checked or unchecked. 

Not Counted This is used to mark cycle count items where the count was not completed. If this is 
checked, the items will not be included in the posting of the record inventory adjustments 
and the cycle count date will not be updated in inventory. 

➢ Enter all the tag information or edit the tags for any information that is not correct based on 
the actual physical count. To add additional tags, click on the Add [+] button. A pick list of 

active inventory items will appear. Inactive items can be displayed by selecting the 'Show 

Active/Inactive' toggle button on the pick list. To delete tags, click on the Delete [-] button. 

Note: The tags may be sorted by ID, Location, Lot#, Class, Item#, Description or Tag#. To change the 

sorting method, click on the Sort button  and select the sort method by clicking on the arrow over 
button. 

Note: Select the Hide button at the top of the form to hide any zero quantity tags. 

To edit the location click on the drop down arrow or the Search button and select another location from 
the list. If the desired location does not exist you must select the Add a New Location button to create a 
new location. 

Do not change the location in the Locations & Transactions screen in inventory, but instead change the 
location from the Maintain Count form in physical inventory. 

To create a new location click on the New Loc button and select a location from the Master Locations 
list. 

When all tags are input and correct, proceed to the next step of Preparing the Adjustment File. 

NOTE: As stated earlier, DO NOT make any inventory transactions through the system after freezing the 
inventory and before completing the physical count, or at least segregating what needs counted.  Just 
be sure what was supposed to be counted has been counted. For example, if items being shipped are 
part of the 'frozen' inventory be sure to count them before shipping. Or if raw material is received after 
freezing the inventory be sure not to count it. The Update Physical Inventory reconciles all transactions 
that take place after the tags have been entered.  You may make unlimited transactions after these two 
steps are completed and prior to the actual update. The physical count does not need to be input as tags 
immediately, though this is recommended. The system will reconcile the current counted quantity with 
any additional transactions. 
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Prepare Adjustment File 

 Once all tags have been input into the system, the next step is to build the adjustment 
(comparison) file, generate adjustment reports and update the EnterpriseIQ files with new information. 
To generate the adjustment file, click on the Prepare Adjustment File button or select File|Prepare 

Adjustment File from the menu. Confirm that you want to do this and let EnterpriseIQ complete the 
process. 

This creates the basic report file. To print out a list of the adjustments. select Reports|Print from the 
menu and select the Physical Inventory Adjustments report. Use this report for final auditing of the 
inventory inputs. 

Note: If additional input is necessary, return to Maintain Count Entries and make further adjustments. Be 
sure to run the Prepare Adjustment File option again if changes are made. If prepare adjustments is not 
run the user will receive a message stating: "Current State: COUNT BEGAN  - The Prepare Adjustment 
File process must be run before proceeding". 

Note: When printing the adjustments report be sure to include the Physical Inventory ID in the selection 
criteria so that only the adjustments for the current physical inventory are shown and not past records. 

Note: If running simultaneous Physical Inventories for different locations where the same item was 
counted (not recommended) then make sure to Prepare Adjustment File for all worksheets, prior to 
posting. 
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Record Inventory Adjustments 

 The final step is to post the adjustments to the master inventory files. To record the inventory 
adjustments, click on the Record Inv. Adjustments button or select File|Record Inv. Adjustments from the 
menu. A confirm message will appear stating, "This option writes the Inventory Adjustments to the 
actual inventory table for Cycle Count ID 'x'. Please confirm to continue".  Select Yes and then another 
confirm message will appear asking the user if they are sure, select Yes to continue. Select the date for 
the transactions then confirm that you want to do this and let EnterpriseIQ complete the process. If the 
'Append to History' table option is not selected the system will display a message, "Do you want to write 
Physical Inventory data to history tables?', select Yes to write the information to the Taginv_backup 
table.  

Note: If an update was made to the tag inventory after preparing the adjustment file, the state of the tag 
inventory is reverted from 'Inventory Compared' back to 'Count Began'. If a user attempts to record 
adjustments, a message will appear stating: "Current State: COUNT BEGAN The Prepare Adjustment File 
process must be run before proceeding". 

 The user has the option of recording all physical inventory adjustments in the translog regardless of 
changes to quantities, or record physical inventory adjustments to the translog for only those items that 
had quantity changes. The default method is to record inventory adjustments for changed quantities 
only (button is up). This will prevent a line being created in the translog for items without any quantity 
adjustments. 

Note: This setting will affect the Inventory Accuracy report. If it is set to record all the total transactions 
will equal the total tags counted. If it is set to only record adjustments, the total transactions will equal 
the number of tags that were adjusted. For example,  if I have 9 tags to count, and I make an 
adjustment on 1, when the button is down (record all), the inventory accuracy will be 88.89% (8/9). If the 
button is up (only record adj’s) then the report will show Total transactions = 1 and transactions with no 
adjustments = 0, so the accuracy percent = 0 (0/1). 

NOTES: 

If an error occurs during this process it is possible to re-post without duplicating the posting of items that 
posted correctly. EIQ will only pick up the records that were not yet posted. 

For serialized inventory items only: After posting the physical inventory the system will query the labels 
and compare the sum of the labels to the fgmulti on hand.  If there are any discrepancies the system 
will update the on-hand to be the sum of the labels and write the Item number, location, fgmulti_id, and 
quantity to the Event Log for class Tag Inventory with a message, 'adjusted on-hand to match sum of 
labels'. This message will also be visible from the main Physical Inventory form as an event as well. 

For items that are shipped out before posting the inventory adjustments, if it is a serialized item it is 
ignored for physical inventory entirely and no quantity adjustments are made to inventory for that serial 
number when posting. For non-serialized items, when a serial number is shipped before posting, 
quantity adjustments to the item will be posted to inventory but without any association to a serial 
number (the original serial number is not adjusted, since it was already shipped out). 
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When the process is complete, the following screen will appear: 
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It is recommended that you clear the Tag table at this point as this eliminates any possible links between 
the master inventory records and the temporary tag/worksheet table. If Yes is selected, tags are cleared 
from taginv, xfgmulti, and xfgmulti_serial tables, and allows fgmulti locations associated to this physical 
inventory to auto-delete (with ‘Delete Empty Locations’ selected in Inventory parameters) for 
subsequent transactions that take the location quantity to zero. 

Check the Translog of your individual master inventory items to view the actual adjustment entries made 
to inventory. 

Note: When doing a Physical Inventory By Location, when the tags are posted, the system will update the 
'Cycle Count Date' field on the master location and in the Transactions screen for items counted in that 
location. The date used depends on the 'Cycle Count Code Based On' option that is selected for the code 
associated to the item (in the Cycle Count Codes list->Miscellaneous menu). In Physical inventory when 
Recording Inventory Adjustments the system will update the 'Last Cycle Count' date 
(Arinvt.cycle_count_code_date) with either the current Record Adjustment Date (default) or the 
Transaction Date 

Restore TAGs Table from backup 

Once a physical inventory has been posted and cleared a file is created (TAGINV_BAK) from which the 
tags can be restored. This can be used to reprint reports if necessary. When a physical inventory is 
posted the records in the TAGINV table are removed and the information is added to the TAGINV_BAK 
table. This feature is found in the File menu on the Physical Inventory screen. If you are using EPlant this 
feature will only require that tags be cleared for the EPlant that is doing the restore and will only restore 
tags associated with that EPlant.  This table is overwritten when a new physical inventory is started. To 
maintain a permanent record of the tags check the Append to history tables option described below. 

Append to History Tables 

From the Options menu select 'Append to history tables' to have the posted physical inventory written 
to the Taginv_backup table. The information in this table is permanent where the information in the 
Taginv_bak is temporary. 

Remove Zero Locations After Adjustment 

Select this feature from the options menu if you want any locations that have zero on hand to be 
removed after posting the physical inventory. Note: Empty Disposition Designator, Ship Designator, or 
Disable Auto Delete locations are not removed when posting physical inventory adjustments. 

Note: With the ‘Remove Zero Locations After Adjustments’ or ‘Delete Empty Locations’ checked, users 
will not be able to use the ‘Restore Tags from Backup’ feature because any deleted locations are no 
longer available to repopulate the tags.  
 



Inventory Management Page 445 of 478 

 

Cancel Cycle Count and Clear the Tags Table 

A physical inventory cycle count record can be cancelled or deleted. 

Cancel 

To Cancel a cycle count select the red x button  on the Physical Inventory/Cycle Counting form. If 
the Current State is anything other than Adjusted, a confirm box will appear asking, 'This option clears 
the Tag Worksheet ID 'x' and Cancels the Cycle Count. Are you sure you want to continue?'. Selecting No 
returns the user to the form with no changes. When Yes is selected another confirm box will appear 
stating, 'Cycle Count is about to be cancelled. Are you sure you want to continue?'. Selecting No returns 
the user to the form with no changes. When Yes is selected an information box will appear stating the 
cycle count is cancelled. The Current State field will populate with 'CANCELLED', and the Log will show an 
event stating it was cancelled. The tags will no longer be in the tag inventory table. 

If the Current State = ‘Adjusted’, a pop up a confirmation displays stating. "Adjustment file has been 
posted.  This option will clear the Adjustment File.  Continue?". If Yes is selected the system will clear 
the  XFGMULTI table, but does not change the Current State of the physical inventory.  The Log will 
show ‘Adjustment file cleared’. 

Clear Tags File  

When starting a new physical inventory/cycle count the tags tags are cleared for the record, ensuring 
that the entries are only associated with the current physical inventory being conducted. While working 
on the actual count of your inventory, you will be entering data into this tags file, so the first step is to 
clear this file. The tags file is cleared even if there are no existing tags.  

Users can select the eraser button to clear the tags  manually, which will clear the Tags table for 
the selected physical inventory/cycle count. Several warnings are displayed prior to the actual clearing 
because if you have already been entering data on the tags the information will be cleared. If you need 
to make additional adjustments or entries, DO NOT clear the tag file. Doing so will force you to start 
over.  

Note: If a new Physical Inventory/Cycle Count record is created which includes item/location information 
from the record that had the tags cleared. If the header record still exists an error will appear stating, 
'Found conflicting Cycle Count ID 'x' in progress - unable to begin new Cycle Count.' The header record 
must be deleted before the user can create a new record that includes the same item/location 
information. 

Delete  

A physical inventory/cycle count record can be deleted by selecting the delete record (-) button. A 
warning will appear, 'Cycle count is in progress - are you sure you want to delete this record?'.  
Selecting Yes will delete the record and all log information. Selecting No returns the user to the form 
with no changes. 
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Lot Number Tracking 

EnterpriseIQ supports unlimited locations per inventory item. Each location may optionally 
maintain a unique lot number. For manufactured parts, a finished good lot number is normally assigned 
to the part and its location. The lot number is normally controlled by the BOM, though it can be modified 
in several areas of the system. Lot numbers should be unique to prevent duplications. 

For example, the lot can be assigned during production from the RealTime screen, at any time from the 
BOM or even during the production reporting process. Raw materials are normally assigned lot numbers 
and locations during the receiving phase of material handling. 

During the production reporting process, the system asks which locations were used to draw raw 
materials from. This links the raw material lot number with the produced item. Any single finished good, 
or work in process part, can be linked to one or many raw material items. Subsequently, a work in 
process part can be “consumed” by another finished good. In this way, your part can have many 
“dependent” lot number links. 

EnterpriseIQ includes a module that displays finished goods lot numbers and their associated raw 
material component lot numbers. The transaction log stores the location and lot number activity, and is 
used for displaying this data. 

Find the Lot Number Tracking tool on the Manufacturing tab of the main launcher. Click to open the 
form. The initial filter is displayed (shown below). This tool is used to search a particular part number and 
its associated lot numbers. 

The basic procedure is to first set the filter, then drill down to view the details. 

This tool supports two views of data - from the finished part number looking back at all raw material lot 
numbers consumed, or from the raw material, showing other finished lot numbers that consumed the 
item. This is called the 'Reverse Lot # Tree' view. 

You can search for a lot by item number, or, if you know the lot number of interest, you can search 
directly by Lot number. When building the tree the system uses the Item ID and the Lot # combined to 
ensure logical results. 
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The form consists of a grid showing the items in your inventory, a list of associated lots (with options) 
and a Date Range to filter out unwanted data. 

Search for a Lot # 

This allows users to search for a specific lot number. Select the Search for Lot # speed button  at 
the top of the form. 

➢ Enter a Lot# in the Lot # field. Wildcards can be used (% as a wildcard and _ as a single 
character wildcard).  

➢ Select the Apply Filter button next to the Lot # field and the form will display relevant 

records based on the Lot # entered. The grid includes Class, Item#, Rev, Description, Ext 
Description, FG Lot # and Trans. Date. 
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➢ Highlight the desired item and select OK the item will be highlighted in the Set Tracking 

Filter form with the searched for Lot # entered in the Lot # field . Select OK to access the 
Lot # Tracking form for that item. 

Select the Item in Lot Tracking 

Select the item of interest by scrolling through the list or by using the search field shown immediately 
above the part number grid. To search for a specific item, type information based on the sort field in the 
white area at the top. Type as much information that is known in the search field. The system will search 
for items that match the typed data based on the sort field. (The item grid can be sorted by any available 
field (Class, Item #, Rev, Description, Ext. Description, and EPlant ID). To select the sort click on the field 
header or right click to select the sort field. 

If the item has lot(s) assigned, then these will be displayed in the Lot# drop down box. Note that each 
part may have one or many lot numbers associated. 

Use the drop down list to see all lot numbers associated with the part selected. If you want to find 
activity against a particular lot, select the lot from the drop down list, set the Date Range filter then click 
OK to show the result. 

View All Lots 

With the All Lots box checked, the filter will return a view of all lot numbers in the transaction log linked 
to the part number. Using the All Lots check box will return all lots including any old lots or old locations 
formerly associated with the item that still reside in the transaction log. 

Date Range Filter 

Use the Date Range tools to limit the returned data by date, production date or transaction log dates. 
Use the date fields to set the limits. Selecting All Dates overrides the date ranges. 

Other 

Select the Include Translog Archive option to include records from the translog history table 
(Hist_Translog) as well as the non archived translog records. 

Filter by EPlant - Select this to only display items for the logged-in EPlant.  If it is unchecked there the 
information will not be filtered for the EPlant. This setting is remembered in the registry. 

With the filter set up, click the OK button to display the results of the search. 

Below is an example of the Lot Number tracking screen after selecting All Lots for All Dates. Notice only 
the top section populates with the lot number information. Only the following transactions will be 
included in the Trans Qty total:  

▪ PO 

▪ Physical Inventory 
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▪ Disposition 

▪ Manual (associated/backflush) 

▪ Finished Process WIP 

To access the Dependent Transactions associated with a specific Lot number double click the item or 
right click and select 'Show Dependent Transactions'. Note: Drill down capability for dependent 
transactions is available for ASSY transactions after reporting Final Assembly – please see Assembly Track 
help files for more information.  
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Double clicking on a highlighted record will display the Dependent Transactions. In this case, the 
information shown originated with the production report process, and various raw material lot numbers 
were attached. 
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For example, the Manufacturing lot number is 111821, and the raw material lot number for Item B is 
111843. 

Lot Documents 

Both sections include a tab for Lot Documents. These are external documents associated to the specific 
lot on the Lot Control tab in Inventory Transactions. This tab functions as it does throughout the system. 
Documents can be added, viewed, etc. 

 



Inventory Management Page 454 of 478 

 

Lot Control 

This tab in the upper section displays the ten user fields from the Lot Control tab in Inventory 
Transactions. Information cannot be entered in these fields from here. 

 

Lot # Tree 

Select the Lot # Tree option from the right click menu on the main Filter screen or from the Lot Number 
tracking screen to see a list of attached lot numbers via a tree view.  
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To access the Lot# Tree from the 'Set Tracking Filter' screen first find the item of interest. Check the Lot 
Number check box, and select the lot of interest. Then right click and select Lot# Tree.  

To access the Lot # Tree from the Lot Number Tracking form highlight an item in either the upper or 
lower section, right click and select Lot # Tree. 

Reverse Lot # Tree 

EnterpriseIQ also supports a reverse view of the lot numbers. The Reverse Lot # tree can be accessed by 
right clicking on the main 'Set Tracking Filter' screen or from the Lot Number tracking screen. 

To access the Reverse Lot# tree on the main Filter screen. Find the item of interest, check the Lot 
Number check box, and select the lot of interest. Then right click to bring up more options. Select 
Reverse Lot# Tree. To access the Reverse Lot # Tree from the Lot Number Tracking form highlight an item 
in either the upper or lower section, right click and select Reverse Lot # Tree. 

This view is often used for raw material tracking, as it can show a particular lot number and where it was 
used in other products. It can also be used to determine lot numbers of work in process items.  
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From the Lot # Tree forms users can select the Printer speed button to print a copy of the tree.  

Transaction Detail in Lot Tracking 

A portion of the Translog information can be obtained for an item by right clicking from the Lot Number 
tracking form and selecting Transaction Detail. Once opened right click and select Show Details to view 
any details associated with the item. In the example below the top section displays the transaction 
details such as Transaction Quantity, Batch number, and date information for a dispositioned 
manufactured Item. Note: The transaction details are not limited to the specific transaction types that 
make up the Trans Qty field (as listed above) but will include all transactions including moves. 

The lower section displays the associated child records that occurred due to the dispositioning of the 
manufactured item. 

Additional Right Click Options in Lot Tracking 

Jump to Inventory - From the Lot Number Tracking screen users can right click and Jump to Inventory for 
a highlighted item in either the upper or lower section. 

Country of Origin - The Country of Origin applies to purchased items. It automatically populates with the 
country associated to the Vendor the item was received from. This information is also visible in the 
Transactions and Locations screen and is available as a right click option in the Transaction Log. 

Lot Tracking Reports 

The Lot Number Tracking information can be printed in report format. The report will print the 
information currently displayed on the Lot Number Tracking screen only. It will not print any drill down 
information as the tables are re-populated each time a user drills down. Select Reports->Print from the 
menu. Select Reports->Print from the menu. A confirmation box will appear to confirm the change to the 
composite information. 
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Select Yes and the Registered Reports form will appear. Choose the destination and select Print. 

Below is an example of the report: 

 
 



Inventory Management Page 458 of 478 

 

Serial Number Tracking 

Serial Number Tracking is used to view label information for specific Serial Numbers. 

EnterpriseIQ uses a master label table to manage the data from the creation of labels. Every label 
created through EnterpriseIQ adds a record to this table, and each record/label is assigned a unique 
serial number. 

The information stored within this table is based on when the label was created. It is essentially a record 
of the label itself, though other tables are actually used to create the label. Note that data elements such 
class, itemno, description, serial number and FG_lotno are part of this table. This provides easy access to 
the pertinent manufacturing data included in the box or package containing the label. 

The serial number is stored as a character string (typically nine digits), preceded by leading zeros. It is 
based on the unique ID number automatically assigned during the creation of the label. 

Entries in the Weight field are taken from the Gross Weight of the top level (Seq# = 1) packaging item on 
the Item Details tab of the BOM. 

To view the label data based on the serial number select the Serial # Tracking speed button on the 
Manufacturing tab of the main launcher bar. A pop up form will appear to enter the serial number, or 
select the search button to access the pick list of serial numbers associated to the EPlant the user is 
logged into. The pick list includes fields such as: serial #, item information, print date, quantity, and VIN 
#.  
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Once entered select OK, or the Enter key. 
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The Serial Number Tracking form will appear displaying the details about the label.  

Serial # Transaction Tracking - The transaction log details for the serial number will be visible on the Serial 
# Transaction Tracking tab for packages that have been dispositioned with labels.  

Repack To and Repack From Information 

If the label has been repacked to or from another serial number that information will display in the 
'Repacked To SN#' and 'Repacked From SN#' fields in the upper section.  Only the first serial number 
will appear in the top section. An additional grid displays at bottom of the form for 'repacked to' serials. 
This will list multiple serial numbers when applicable. Right click in the lower grid and select 'Jump to SN' 
to jump to the repacked to serial number. The Serial Number tracking form will open to the highlighted 
serial number. 
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Container Labels - If the label is a pallet label the form will display information for the pallet, containers 
on the pallet, and if foreign serial numbers were used to fill the containers those will show also. 

 

VIN Tracking 

This tab will be available for users licensed for VIN Generator.The information comes from the 
VIN_HISTORY table which is populated based on the table below. 

Note: The VIN History table will not populate the VIN # unless the Config Code is populated in inventory 
on the Manufacturing tab.  

Field Name in 
system 

(if applicable) 

Column Name in data 
base 

When the field is populated 

VIN Number VIN_NO VIN Generation 
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Serial # SERIAL VIN Generation 

Config Code SMART_CODE VIN Generation 

 ARINVT_ID VIN Generation 

Item # ITEMNO VIN Generation 

Rev REV VIN Generation 

Class CLASS VIN Generation 

Description DESCRIP VIN Generation 

Ext Description DESCRIP2 VIN Generation 

Mfg # MFGNO VIN Generation 

 STANDARD_ID VIN Generation 

Weight CONFIG_WEIGHT VIN Generation, can be edited 

This is taken from the BOL Data 
page(s) of component(s) attached to 
the BOM. Entries are calculated as 
Case Info: Weight (Lbs) divided by Case 
Info: Items per Case.  

For example, if BOL Data: Case Info 
shows Qty = 1, Weight = 32, and Items 
per Case = 10, then VIN Tracking: 
Weight = 3.2, derived as the weight of 
a case (32) divided by the number of 
items in the case (10).  

GAWR GAWR VIN Generation, can be edited 

GVWR GVWR VIN Generation, can be edited 

Tire Size TIRE_SIZE VIN Generation, can be edited 

Rim RIM VIN Generation, can be edited 

PSI PSI VIN Generation, can be edited 

Single/Dual SINGLE_DUAL VIN Generation, can be edited 

Vehicle Attributes VEHICLE_ATTRIB VIN Generation 

Spare Tire SPARE_TIRE VIN Generation, can be edited 

Number of Axles NUM_AXLES VIN Generation 

Model Year MODEL_YR VIN Generation 

 ARCUSTO_ID VIN Generation 

Company ARCUSTO_COMPANY VIN Generation 

Order # ORDERNO VIN Generation 

Updated with Packing Slip generation 

 ORD_DETAIL_ID VIN Generation 
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PO # PONO VIN Generation 

Work order Number WORK ORDER_ID VIN Generation 

 LM_LABELS_ID VIN Generation 

 CRM_QUOTE_DETAIL
_ID 

VIN Generation 

Sales Value UNIT_PRICE VIN Generation 

Sales List Price LIST_UNIT_PRICE VIN Generation 

Dispo Date DISPO_DATE Reporting Final Assy or RT Scan to 
Inventory 

Lot # FG_LOTNO Reporting Final Assy 

Location LOC_DESC Reporting Final Assy 

 SHIPMENT_DTL_ID Packing Slip creation 

Config Choices ARINVT_CARGO.DATA
1  

VIN Generation, can be edited 
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Note: When a VIN label is generated/printed it contains customer and sales order information, and it 
also generates a master_label record with the same detail.  When a RF/WMS user has the Verify order 
option=Y and ships the label toward a different order and customer the ARCusto_ID, ARCusto_Company, 
OrderNo, Ord_Detail_ID, PONo, and CRM_Quote_Detail_ID fields in master label and VIN_History tables 
are updated. The system will also update this information if an item was allocated to a sales order, 
released from that order and then re-allocated. 

Note: The ARCUSTO_ID and ARCUSTO_COMPANY fields are updated in VIN_HISTORY when the customer 
is changed on the sales order. 
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Dimensional Inventory 

This tab will display the Dimensional Inventory information for the serial # for serialized inventory 
control (SIC) items. The information on this tab is not editable. (The tab is visible for non-SIC items as 
well but will not have information). See Printing Labels for more information on Dimensional Inventory. 

 



Inventory Management Page 466 of 478 

 

User-Defined 

This tab displays the user fields from the Print Label form. The information on this tab is not editable. 

Right Click Options from the Upper Section 

▪ Drill Down by Lot # - This option opens the Lot Number Tracking form for the item associated with the 
label. 

▪ Jump to Inventory - Jumps to the inventory module for the item associated to the label. 

▪ Jump to BOM - Jumps to the BOM for the item. If the item is not associated to a BOM, the BOM pick 
list will appear. 

▪ Jump to Work Order - If applicable users can select this option to jump to the work order. 

▪ Jump to Packing Slip - If a packing slip is associated to the label this option will be visible to jump to 
the packing slip. 

▪ Copy Cell to Clipboard - This option will copy the information in a cell to the clipboard to be pasted 
elsewhere. 

▪ Show Serial Numbers - This option is available from the Serial # Transaction Tracking tab. This option 
displays serial numbers associated to individual transactions for the item made from anywhere in the 
system, including IQRF and WMSIQ. (This information is recorded in the TRANSLOG_MASTER_LABEL 
table in Data Dictionary). Select the lock button to ensure the serial number(s) remain in the pop up 
when another show serial numbers form is opened. If it is not locked when a subsequent Show Serial 
Numbers form is opened the previously opened one will refresh to display the second forms serial 
numbers. 

Speed Button Options 

▪ Search Serial # - This brings up the form to enter the serial number to search for. 

▪ Reprint Label - This option will reprint using the original label from master_label.lm_labels_id 
column, regardless of ‘Reprint Original Label’ setting in System Parameters > Label Setup tab. For 
older labels if master_label.lm_labels_id was not filled in, this will reprint according to the label 
hierarchy. When reprinting LM labels through Serial Number tracking, the printer set on the LM label 
will be used.  (See Reprint a Range of Labels section below for details on printing a range of labels). 

▪ Inventory Move Transaction Location Plan Simulation - (This option is only available if licensed for 
'Advanced WMS') - When selected the Transaction Rules will be processed based on the SN that is in 
focus. The Transaction Plan will be displayed for troubleshooting purposes. No Move transaction will 
take place. (For more information refer to the Advanced WMS https://my.iqms.com/cfs-
file.ashx/__key/Technote/advanced_2D00_wms.pdf TechNote). 

https://my.iqms.com/cfs-file.ashx/__key/Technote/advanced_2D00_wms.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/advanced_2D00_wms.pdf
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Reprint a Range of Labels 

Select the Reprint option on the 'Enter Serial Number' form to reprint a range of labels. 
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Enter the From and To serial numbers and select Apply. The labels will be listed in the lower section 
displaying the label details such as Item #, Description, Qty, Shipped, etc. 

Note: Serial Number Tracking is filtered by EPlant to prevent users from printing labels from other 
EPlants. Labels in the selected range not from the users EPlant will not appear.  When in view all, users 
can print labels from from any EPlant. 

Default Label - Select the search button to select a label format to use to reprint all the selected labels. 
Once a default label format is picked a pop up message will display stating, "Do you wish to update all 
the labels in the range?". Click Yes to update all of the selected labels with the selected label format. 
Clicking No will return the user to the reprint form with no changes. A different label can be selected for 
a specific serial number by clicking on the ellipsis button in the Label field in the lower section. The pick 
list of labels will appear to choose from.  

Setup CRW Printer - This allows users to select the CRW printer for reprinting the labels. This alleviates 
the user from having to select a printer for each Crystal label. Select the ellipsis button to bring up the 
Print form to select a printer.  If a printer is selected, when clicking on Reprint, the system will use the 
specified printer for printing all of the CRW labels.  

To reprint all of the listed labels select the Reprint button. 

Note: Without a default label applied, the Label column fills in with the label format used when last 
printed. The label format entered overrides a label assigned to an item (example: Inventory > Additional 
tab), and regardless of the ‘Reprint Original Label’ option in System Parameters > Label Setup tab. If it is 
not desired to reprint based on the last label used be sure to change the default label for all records 
(Default Label option in upper section), or the label for a specific record (Label field in lower section). For 
older labels the Label column may display as null if the master_label.lm_labels_id was not filled in, and in 
this case will print according to the label hierarchy unless another label is selected. 
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Foreign Serial Numbers 

Foreign Serial numbers are serial numbers from labels typically from purchased items. Foreign serial 
numbers may contain up to 50 alphanumeric characters. Foreign serial numbers can be linked to boxes 
with labels bearing EnterpriseIQ generated serial numbers. This link is done through the Scan Line 
module. (Please refer to the Scan Line https://my.iqms.com/cfs-file.ashx/__key/Technote/ScanLine.pdf 
TechNote for more details). Once in place, the system can be used to trace foreign serial numbers back 
to the box and pallet used during packing and shipment. 

To trace a Foreign Serial number, select the 'Foreign' box on the Serial Number form and enter the 
foreign serial number. The system will display the boxes/pallets that are associated with that foreign 
serial number. 

 
 

https://my.iqms.com/cfs-file.ashx/__key/Technote/ScanLine.pdf
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Void Labels 

This option will allow the user to void a range of labels. The label can only be voided if it has not been 
dispositioned or used in a shipment. This function will remove the label permanently from the master 
label table. 

Select the Void button from the search form and the following screen will appear: 
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Enter the range of labels in the from and to fields and select Apply. The selected labels will appear in the 
lower section. If the label cannot be deleted it will appear in red. 

 

Select the Void button to complete the process. To exit without voiding the labels select Cancel. 
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